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ALACARTE USER MANUAL
Version 1.0

Compilation of digital geologic maps and associated databases
 with ALACARTE, an easily used menu interface cast in geologic terms
that controls ARC/INFO, a commercial geographic information system  

Carl M. Wentworth and Todd T. Fitzgibbon

1991 

INTRODUCTION

ALACARTE offers a convenient way to compile geologic maps in the computer as spatial databases 
that can be used to prepare both cartographic images and analytic derivatives.  It is a menu-controlled 
shell, organized in geologic terms, that provides on-screen control of the program ARC/INFO, a 
commercial geographic information system (GIS).  Input can be from imported scans, digitizer trac-
ing, or on-screen tracing or mapping with a mouse-controlled cursor over a digital topographic base, 
and interactive editing can be done on-screen using a broad suite of edit functions.  Compilations 
begun in other digital systems can be imported for completion as digital databases in ARC/INFO.  The 
digital files that represent a geologic map can be used to prepare near-publication-quality color plots 
of the maps with full symbology or to create high-quality printing negatives.  These files also consti-
tute a digital database that can be used for computer-based query and analysis as well as for digital 
distribution of the map and associated data.

ALACARTE allows the non-specialist to use ARC/INFO without having to struggle with its excruci-
ating details and hundreds of line commands.  ARC/INFO is a powerful GIS that, because of its 
breadth and flexibility, requires considerable training and experience to be used directly from the 
command line.  Even ARC/INFO experts will find that ALACARTE offers a preferable ease of use in 
working with geologic maps.  Functions called by picking menu items on the screen include many 
complex sequences of ARC/INFO commands that are prohibitively time consuming or awkward to 
use directly.  The menus are organized according to major compilation and editing procedures and 
permit great flexibility in working with maps.  The system and ARC/INFO command lines are always 
accessible from within ALACARTE if needed.

This is not just a drafting system, although it serves that purpose well.  ALACARTE-ARC/INFO 
supports the creation of a sophisticated geologic database in the course of compiling a digital geologic 
map.  Lines, points, and the perimeters and identities of areas are recorded in vector form and can have 
essentially unlimited digital information attached to them.  For display, symbols for lines and points 
and colors for areas are separately assigned to these features as a function of feature attributes in the 
database, which permits great flexibility in on-screen display, plotting, and preparation of printing 
negatives.  Plots can be made at any stage in compilation using custom geologic line and point symbol 
sets, and can include a digital topographic base map. Plots made with high-resolution color plotters 
approach the quality of published maps.
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The ability to manipulate and analyze the feature attributes and two-dimensional topology in the da-
tabase of a digital map is a development offering great promise for geology.  Various data layers can 
be overlaid for comparison or actually combined into a new map.  The database can be searched both 
topically, according to feature attributes or information in other cross-referenced databases, and-or 
spatially, according to the location or spatial interrelations of map elements.  Rules can be specified to 
control such searches and the way in which a derivative interpretation or statistical result is prepared.  
Data can be extracted from the digital geologic map for use in other quantitative or graphical opera-
tions and the result returned to ARC/INFO for further use. 

Compilation of geologic maps with ALACARTE - ARC/INFO thus offers several important benefits: 
(1) efficient preparation for print publication,  (2) easy map revision and preparation of derivative 
maps,  (3) creation of a spatial database for use in computer-based manipulation and analysis,  (4) the 
ability to make color plots of near-publication quality showing any or all aspects of a map database, 
and  (5) the ability to store, transfer, and publish the resulting geologic map files in digital form.  It is 
the combination of convenient drafting of geologic maps with uniformly high quality of line work and 
symbols, the ability to work interactively with all aspects of the maps in digital form, and the auto-
matic creation of a digital database that makes ALACARTE - ARC/INFO an attractive system.

The ALACARTE user manual describes the value of compiling maps digitally using the 
ALACARTE-ARC/INFO system, summarizes the digital approach, and provides more detailed de-
scriptions of ALACARTE and its use in compiling geologic maps.  It is divided into five main 
sections:

Introduction - general information on the character and uses of ALACARTE-ARC/INFO, the de-
sign and compilation of digital maps, and how to get started.

Self-Guided Tour - a tutorial that introduces you to ALACARTE-ARC/INFO by demonstrating 
the parts of a digital map and their on-screen appearance and guiding you to use various 
ALACARTE functions to prepare a simple map.

ALACARTE Basics - description of the kinds of digital map features, the primary database, and 
the basic techniques involved in using ALACARTE-ARC/INFO.

Procedures - description of the procedures involved in entering and editing the various elements of 
a digital map and in preparing plots.

Structure and Functions - systematic listing of all bar and pulldown menus in ALACARTE and 
brief description of the function of each menu item.

There are two companion documents to this user manual that address other aspects of ALACARTE:  
(1) ALACARTE User Interface - AML Code and Demonstration Maps, (Open-File Report 91-587 A), 
which describes how to obtain the executable code, and  (2)  ALACARTE Installation and System 
Manual (Open-File Report 91-587 B), which describes how to install ALACARTE and provides 
technical details about ALACARTE.

Development of ALACARTE

ALACARTE is designed by T.T. Fitzgibbon and C.M. Wentworth, with assistance from P.K. 
Showalter, and is written by Fitzgibbon with assistance from Showalter, P.H. Rice, D.L. Knifong, 
T.A. Lindquist and others.  R.K. Mark assisted in deciphering the Transform function.  Creation of the 
program was stimulated by the confluence of several factors, particularly the emergence of powerful 
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and affordable computer workstations with high-resolution color displays, the experience gained from 
various CAD programs and the PC-based geologic compilation program GSMAP (Selner, G.I, and 
Taylor, R.B, GSMAP System version 7.0, U.S. Geological Survey Open-file Report 91-1), and com-
mercial release of a full-featured vector GIS with a macro programming language that supports menus. 
 ALACARTE is written in ARC Macro Language (AML) and runs in association with ARC/INFO 
(version 5.0.1) on UNIX and Prime computers.  Its development was supported in the U.S. Geological 
Survey by programs for National Geologic Mapping and Development of Assessment Techniques and 
by the Survey’s GIS Research Laboratory in Menlo Park.

Scope of Version 1.0

Work on the present version has concentrated largely on the set up and geographic projection of maps 
and the entry, editing, and attributing of map features (the Setup and Edit sections of ALACARTE).  
These address the map itself, and not cross sections, explanations, or other marginalia (except through 
access to MAPX).  A Version 1.1 release is planned to include bug fixes, minor enhancements, and a 
revised manual. Further work will address cross sections and marginalia, will expand the more rudi-
mentary sections on plotting, conversions, databases, and analytic procedures, and will accommodate 
version 6.0 of ARC/INFO.  

ARC/INFO

ARC/INFO is a commercial geographic information system (GIS) that operates in vector mode (ver-
sion 5.0.1).  It supports a broad range of input, editing, and projection functions required to compile 
geologic maps, offers powerful plotting, analytic, and database functions, and continues to be im-
proved by its vendor, Environmental Systems Research Institute (ESRI).  Lines, areas, and points are 
stored geographically, can be plotted in a great variety of symbols, and can have essentially unlimited 
digital information attached to them.  Various analytic functions are available in ARC/INFO for use 
with these data and the two-dimensional spatial topology that the program maintains for each map.  
Superposition of map layers on screen and in plots allows separation and overlaying of data and the 
use of digital topographic bases as backgrounds.  Selected elements or areas can be extracted from 
maps and separate maps can be combined.  ARC/INFO can be controlled by entering commands at the 
command line or through custom scripts and macros, of which ALACARTE is a sophisticated 
example.

ARC/INFO runs in multi-user form on a variety of mini-computers (such as Prime and VAX) and in 
both single- and multi-user form on various UNIX workstations and fileservers (such as Sun and Data 
General).  In multi-user form, it can be used concurrently by numerous users working remotely from 
various kinds of terminals or from terminal emulators running on other computers (such as worksta-
tions, PC’s, and Macintoshes).  PCArc, a version of ARC/INFO that runs on IBM PC’s and 
compatibles, is not addressed here because the PCArcprogramming language and GIS functions are 
incompatible with ALACARTE.  

Version 1.0 of ALACARTE is designed to work with version 5.0.1 of ARC/INFO and has been tested 
on Sun, Data General Aviion, and Prime hosts and with remote access from some Tektronix terminals 
(4207, 4225) and terminal emulators (Isotek, TGraf, TNet, and VersaTerm-Pro) (see System Details, 

p 35, for details).
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Uses of  ALACARTE - ARC/INFO

ALACARTE is designed for use by geologists to compile geologic maps and associated spatial data-
bases, although non-geologic maps and databases are easily accommodated.  Version 1.0 of 
ALACARTE focuses on the map itself -- its lines, areas, structural symbols, other points, and map-
face annotation.  Any or all of these features can be entered by hand from a digitizer and additional 
information can be entered into the database.  Scanned linework converted to vectors can be edited and 
tagged in ALACARTE, and base maps can be imported as digital images from scanned originals or as 
attributed digital files (Digital Line Graphs).  Point maps and database entries can be imported directly 
from tabular text files.  Maps that have been digitized in other systems can be imported and processed 
or completed in ALACARTE-ARC/INFO.

The digital files composing these maps can then be plotted as line drawings or as full-color maps or 
can be used to prepare color separations for printing.  Digital maps can be plotted in any projection at 
any scale, limited only by the detail and spatial resolution of the data.  Various map layers can be 
overlaid at the same scale and in the same projection on screen or in plots.  Overlaid or adjoining maps 
can be combined and part of a map can be cut out to create a separate map. Because a map in 
ALACARTE-ARC/INFO is a database and not just a picture, the map files can be queried in various 
ways to extract information or to create interpretations.

Print Publication  -  Digital compilation removes the necessity of final drafting or scribing and of 
hand preparation of color separations for printing, because high-quality plots and color-separation 
negatives for printing can be made directly from the digital map files.  The digital contribution can 
range from  linework and symbols for a black-and-white map through definition of polygons for color 
fill to the whole of a full-color map.  The digital geology can be plotted to negatives and then com-
bined with a photomechanical base or the base can be included as one or more digital layers.

Revisions  -  Once a map is in digital form, revision is as simple as changing the relevant parts of the 
map.  The revised digital files can then be used to make plots or color-separation negatives of the 
revised map or can be released directly in digital form.

Compile New Work  -  If new mapping is compiled in the computer as field work proceeds, a hand-
drafted author compilation need never be prepared, high-quality draft plots at final or enlarged scale 
can be made in color for office or field use at any stage of the work, and a digital map and database 
will be a painless by-product.  Line input can be by hand digitizing from field sheets or by scanning of 
field originals or of photographic or hand-traced copies.  Mapping or transferring from photos or field 
sheets can also be done directly on screen over the digital base.  Previous mapping can be digitized and 
plotted on a digital base for use during field work.  Where digitized or edited by the geologist author, 
correctly drawn line work will not be vulnerable to later modification by an assistant or draftsman.  
Field stations, fossil localities, and other data can be entered at points and then searched, plotted, and 
otherwise used in ongoing study and analysis as the mapping proceeds.

Small-Scale Compilation  -  The scale and projection of digital maps are easily changed, which 
makes the fitting of various source maps into a smaller scale compilation straightforward.  Generali-
zation can begin during digitization of sources and is aided by easy on-screen editing and a limited 
suite of generalization functions in ARC/INFO.
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Comparison of Data Sets  -  Maps of different topics for the same area that should be used together 
are easily converted to a common scale and projection for direct visual comparison on screen or in 
separate or overlaid plots.

Map Analysis  -  A geologic map in ARC/INFO is a digital database that can be used for study and 
analysis and for the preparation of derivative products based on the geologic map. This database can 
be expanded in custom fashion to include whatever categories and forms of data are needed.  Areal 
topology is automatically established by ARC/INFO, which permits spatial relations of all map ele-
ments and associated data to be used in computer-based query and analysis.  Independent computer 
programs can be incorporated into analytic procedures, and information can be selectively extracted 
from a digital map for use in other programs.

Derivative Maps  -  Preparation of derivative maps from the primary database simply requires precise 
statement of the interpretive procedure and the availability of any other needed data in digital form.  
The areal units of different map layers can be combined, for example, or combined where specified 
conditions are met, and database attributes can be used and manipulated to produce new attributes.  
The resulting derivative maps can be plotted, printed, or released digitally with the same ease as the 
original geologic map.

On-Demand Printing -  Plotting of geologic maps and derivatives according to specific requests can 
replace print publication where demand for a map is immediate, map content changes through time, or 
expected circulation is low.  High-resolution color plotters can produce large maps of near-
publication-quality in a few minutes.  Such printing can also accommodate user specification of layers 
to be included and symbols and colors to be used.  Different plots of the same map might thus combine 
or distinguish base separations or include or omit color fill of map units, or various topical layers for 
the same map area might be overlaid for comparison or joint use.

Digital Publication  -  The ability to prepare and use digital map files allows publication of the maps 
in digital form.  Such publication can consist simply of a digital version of a standard geologic map or 
it can take advantage of the digital format to expand the map content.  Possibilities include various 
topical map layers and associated data (such as fossil collections, chemical analyses, or radiometric 
ages), sequential map layers showing temporal changes (such as landslide or volcano histories), or the 
detailed sources of a smaller scale compilation.

Kinds of Digital Maps

Digital maps can take various forms that differ in the method of areal representation (raster or vector), 
in the kinds of features that are included (lines, points, areas, spatial interrelations), and in the amount 
of information that is attached to map elements.  ALACARTE-ARC/INFO maps are recorded and 
edited in vector form in a highly flexible database.  Raster versions of these maps are generated as 
needed, both for plotting and for use in various analytic procedures.

Raster maps and images are represented as a regular grid or checkerboard in which values are assigned 
to every cell (pixel).  Information in each cell can be as simple as the presence or absence of black, as 
in a line drawing, or can be values representing such factors as colors in a satellite image, units in a 
geologic map, or altitudes in a digital elevation model.  Resolution in raster maps and images is con-
trolled by cell size, which in turn is determined by considerations of data character, intended 
application, and system capacity and speeds (raster files can be very large).  Cells in plot files and 
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raster scans typically range from 200 to as fine as 1200 per inch on the map (grid spacing of 0.1-0.02 
millimeters), whereas cell size in satellite images, digital elevation models, and raster geologic maps 
typically ranges from 10 to 100 meters or more on the ground.  Some kinds of data are inherently 
raster, such as various kinds of remote images, altitude grids, and their derivatives.  Raster form may 
also be chosen to speed analytic manipulation, because of the relative efficiency of performing arith-
metic operations on cell values. 

Vector maps, in contrast, store information only at points of interest, with their locations defined by 
x,y values in a coordinate system.  Lines are represented by sequences of such points (vertices) con-
nected by straight lines.  The precision with which ALACARTE-ARC/INFO typically records x,y 
locations, 1 millimeter on the ground, is independent of map scale and far exceeds the requirements of 
most geologic work.  The capacity for separately attaching information to each point, line, and poly-
gon is essentially unlimited, with basic attributes placed in the primary database and other information 
cross referenced (related) from separate databases.

The maps are typically prepared as a series of layers that contain different kinds of information.  The 
attributing of elements within each layer may be as limited as assignment to a single class or can 
involve an extensive database, perhaps with cross reference to other databases.  A vectorized scan of 
a base map may be simply an un-attributed image, for example, whereas lines in a geologic map may 
be distinguished both by line type (contact, fault, etc.) and scale of source.  The whole of a geologic 
map may be recorded digitally, or digital procedures may be used only on color boundaries to prepare 
color separation negatives for use with scribed or drafted line work in printing.

COMPILING A DIGITAL MAP

The basic steps in compiling a digital map in ALACARTE - ARC/INFO are much like those for a 
conventional map:

-  Obtain a digital base map or other geographic framework for the map
-  Enter the line work and attribute by type of line (tag)
-  Process line work to identify closed polygons and tag those by geologic unit
-  Enter structural data (oriented symbols, fold axes, etc.)
-  Enter other points and associated data (fossils, chemistry, radiometric dates, etc.)
-  Add graphic unit labels and other map-face text

The details of procedure will depend on your purpose in compiling the map digitally, on the character 
of the map, and on the available resources.  Most of the work on a map can be performed from within 
ALACARTE with minimal use of the keyboard, except for scanning of base materials or line work.  
Scanning and plotting involve separate pieces of equipment as well as steps in ARC/INFO that are not 
all automated in ALACARTE.

Digital maps are organized in layers that separate different kinds of information (contacts and faults, 
areal units, structural data, etc.).  They are entered into the computer first in their original projections, 
using latitude/longitude marks as registration, and can then be converted into other projections and 
combined with other maps.  Data are entered by hand digitizing, by scanning and on-screen editing, or 
by importing pre-existing digital files.  Scanning is most useful for line work, whereas point data are 
generally entered by hand.

6



Maps that have been prepared initially in GSMAP or other vector systems can be imported for com-
pletion or use, and raster drawings can be imported if a satisfactory means of converting them to vector 
format is available.  Data in tabular text files can be imported and assigned to existing map elements 
or, where geographic locations are included, can be used directly to create a new map.

Compilation Goals

Geologic maps can be compiled digitally while original field mapping proceeds, as a means of con-
verting an existing map into digital form, or to provide sources for smaller-scale compilation.  The 
digital map can be intended for print publication or for a variety of digital applications, including 
on-demand plotting, digital publication, or use as a digital database for computer-based analysis.  
These differences lead to different requirements and procedures for digital compilation.  Regardless of 
short-term goals, the value of a geologic map in the future will be greatly enhanced if it is available in 
digital form.  Digital preparation by the author will ensure that the geology is represented as the author 
intends. 

Print Publication  -  Production of a satisfactory graphic image of the geologic map from digital files 
for print publication requires that line work be edited for presentation at publication scale and that each 
line be tagged for assignment of plotting symbols.  If map units are to be colored or patterned, all 
breaks in polygon boundaries are closed and polygons are tagged.  Data for oriented symbols are 
digitized and a map layer is prepared that contains graphic unit labels, leaders, and any other map-face 
text.  Unless a digital version of the base map will be used in printing, the finished digital geologic map 
and the photomechanical base must be fitted together for printing.

Digital Map and Database  -  On-demand plotting and digital publication require, at a minimum, the 
same suite of files needed for print publication, except that a digital version of the base map may be 
essential.  The requirements for a digital database can be similar or expanded, depending on the 
application.  Preparing a map database in digital form offers the opportunity to include any type of data 
that can be spatially referenced to the geologic map.  Because there is no need to present all included 
layers or kinds of data concurrently, clear graphic presentation is not necessarily an issue.  

Digital Base Map  -  A digital base map will be needed if the line work is to be fitted to the base in 
the computer, if plots are to be made that include the base, or if new mapping is to be entered directly 
into the computer as field work proceeds.

Entering Line Work  -  The best way to digitize an existing map will depend on the kind of original 
that is available and the character of the map.  Ideally, line work should be scanned from an original 
that contains nothing but the lines, with all lines continuous and unmodified by thrust teeth or other 
ornaments.  The effort of preparing such material for scanning must be balanced against the resulting 
decrease in the amount of on-screen editing that would be required if a more complex original were 
scanned.  A tracing of the map can be made in pencil for scanning, a film negative can be edited with 
a fine paintbrush before scanning, or the map can be scanned directly.  Hand-digitized lines require 
less subsequent editing, but hand digitizing is tedious in large quantities and can introduce error.  Hand 
digitizing is generally required, however, to tag polygons (identify map units) and to enter structural 
data and other points.

Resolution and Simplifying  -  If the sole objective is a small-scale map generalized from larger scale 
sources, the best approach will probably be to trace and concurrently generalize the source maps at the 
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original (or a reduced) scale, scan and import these intermediate tracings, assemble the pieces onto the 
smaller scale base in the computer, and then complete the editing at final scale.  If the source maps are 
needed in their original detail, however, then they must be digitized with full resolution and all the 
generalization carried out later on screen.

Geographic Framework

An essential step in preparing a digital map is to define its geographic framework.  Unless the map is 
to be kept as a drawing in map inches, it must be assigned geographic coordinates in a specified map 
projection.  During input, the projections of the source map and the digital equivalent must be 
matched.  Mosaicking of quadrangles or incorporation of a map into a smaller-scale compilation may 
then require subsequent change in projection (a simple procedure in ALACARTE-ARC/INFO).  Care-
ful registration between layers and with the ground is essential both for accurate ground locations and 
to obtain adequate precision between layers for comparison and plotting.

BASE MAPS

Digital compilation of most maps will be greatly aided by having a digital base on which to edit and 
adjust the geology on screen and for plotting.  Topographic maps can be scanned, converted to vectors, 
and imported to serve as base images or, where available, USGS Digital Line Graphs (DLGs) can be 
used.  Scanned images have the advantage of including names, numbers, and symbols that can be read 
visually, whereas the lines in DLGs, which do not automatically display text and symbols, have at-
tributes that can be used in map analysis and to assign distinctive plotting symbols.  Attributes 
associated with the individual elements of the topographic map are not essential for on-screen editing 
or for plotting, although application of distinctive line symbols to some features, such as roads and 
railroads, can improve the appearance of the base.  If the identity of elements in the base are to be used 
in analysis of the map, however, then attributed base layers will be needed.

Base maps can be scanned as composites or, preferably, in separations that will permit later distinction 
of the different components.  If possible, the wider index and thinner intermediate contours should be 
separated during scanning or subsequent processing in order to allow them to be plotted with different 
line weights.  A useful set of base separations prepared by scanning might include four layers, for 
which attribution is limited to the identity of the layers:  index contours, intermediate contours, drain-
age, and culture.  Closed water boundaries (needed to complete adjoining polygons in the geologic 
layer) can be extracted from the drainage layer or, where necessary, can be scanned separately.

The resolution at which a base should be scanned depends on the detail of the map and intended use.  
A typical resolution of 300-400 lines per inch is adequate for many maps for use on screen and for 
draft plots, but resolutions as high as 700-800 lines per inch may be needed to reproduce very detailed 
or intricate maps, especially where print or digital publication of the scanned base is intended. 

The base image will be in scanner dimesions (typically inches) and, once imported into ARC/INFO, 
should be transformed into a set of digital registration tics in its original projection unless work is to 
proceed in map inches.  Importing scanned geology and hand digitizing from a digitizer onto a base 
require that the projections of the geologic original and the base be matched.  The base may already 
match the area and projection of the geology directly, or it may be prepared digitally by combining 
larger scale maps or cutting out part of a smaller scale map and then reprojecting.
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Scans of physical mosaics of separate maps, in contrast to single quadrangles and smaller scale maps 
of uniform projection, may not be able to be projected together in ARC/INFO without internal 
distortion.  This is because the maps in the mosaic may not share the same projection or projection 
parameters.  These distortions, although generally small, can be significant both for location of map 
elements in spatial databases and for graphic presentation. The various parts of mosaicked maps 
should therefore be treated separately in the computer.  Once all needed work in the original projec-
tions is completed, the separate parts can be combined digitally into a single projection.  If needed, a 
photomechanical base can then be mosaicked by fitting each part to a plot of this common projection.

PROJECTION, SCALE, AND DIMENSIONS

The geographic projection of a digital map is determined initially by the projection of the hard-copy 
original (geology or topographic base), although this can be changed once a digital version has been 
made in the original projection.  In hand digitizing, maps can be entered in inches and later trans-
formed into the projection of the base map or can be transformed on the fly, the typical procedure in 
ALACARTE.  In scanning, maps are entered in inches and later transformed into the appropriate 
projection.  Any work with azimuthally oriented data will require a projected map.

Geographic registration is obtained by placing digital registration tics at graphic registration marks in 
the original map for which the latitude/longitude locations are known.  Map dimensions in projected 
maps are recorded and measured in meters on the ground and locations are recorded as x,y coordinates 
in meters from the origin of the projection.  Once in digital form, a map can be plotted in any supported 
projection at any scale.  ALACARTE supports the projections most commonly used in geology in the 
United States (Lambert, Transverse Mercator, Oblique Mercator, Polyconic, UTM, Albers, DNAG, 
and the State Plane equivalents) and ARC/INFO supports a great many others as well.

Because projected maps are stored in ground coordinates, scale has no direct meaning for most 
ALACARTE maps except as a measure of the spatial resolution of the data.  ARC/INFO maintains 
ground locations to a fraction of a meter on the ground, a meaningless precision for most geologic 
maps, and any digital map can be viewed or plotted at any scale.  Enlargement beyond the input scale 
is easy, but adds no information and magnifies insignificant mislocations and line irregularities.  It is 
important, therefore, to document input scales and resolutions and to qualify applications by the spa-
tial resolution of the data.

MAP REGISTRATION

Accurate ground location of map elements and precise registration between map layers, always im-
portant aspects of maps, are even more important for digital maps.  Not only do they bear on obtaining 
a good fit between the geologic layers and the topographic base for making plots, but they directly 
affect the quality of computer-based analysis that involves more than one map or map layer.  Attend 
carefully to registration in preparing materials for input and whenever separate layers or sources are 
overlaid or combined.

The key to good registration is precise graphic registration marks of known location in the coordinate 
system of the original map (typically latitude/longitude) that can be used either from the digitizer or in 
scanned images to register the map geographically.  If clear graphic registration tics or corners are not 
already present, add precise registration marks to the original map with a fine pen or stickup at four or 
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more perimeter points of known location, and include internal registration marks as well where 
possible.

Use these graphic marks to register the map on a digitizer for hand input and to place digital registra-
tion tics in scans and other imported maps.  Once the digital registration tics are properly located in 
one map layer, they can be copied to create other precisely registered layers.  Separately scanned 
layers should all be transformed into a common set of projected tics.

Map Features

The principal emphasis in digitizing maps is on the line work, because lines will require the most 
effort, just as they do in hand-drawn maps.  Lines can be digitized in three basic ways.  If the line work 
is clean and sharp and free of interfering clutter and background, it can be scanned and imported into 
ALACARTE - ARC/INFO for on-screen editing and tagging (assigning attributes).  Or a pencil trac-
ing can be made specifically for scanning.  Some maps may better be traced from the original by hand 
on a digitizer (or on screen from an imported scan in the background).  As a third alternative, new 
work can be mapped, or existing work transferred, directly by eye on screen over a digital topographic 
base.

Polygons are created by digitizing and tagging label points within the line boundaries to identify them 
and then processing the line work and labels together.  All points (polygon label points, oriented 
structural symbols, field stations, etc.) are typically entered by hand.  Tabular files of data (word pro-
cessor or spread sheet) can be imported directly and assigned to existing map elements or, where point 
locations are included in the file, can be used to create attributed points directly.

Lines  -  In contrast to traditional ink work, all lines are digitized as continuous lines, regardless of 
intended line symbol, and are tagged (attributed) by line types (such as normal fault, concealed) that are 
selected from menus or entered from the keyboard.  These tagged lines amount to templates to which 
any chosen line symbol can be assigned for screen display or plotting as a function of line type.  A full 
range of geologic line symbols is available and others can be created in the symbol editor.  Lines can 
be digitized by hand from a digitizer or on screen with a mouse-controlled cursor and can be concur-
rently tagged by line type.  Line work from imported scans is first edited on screen to correct scanning 
artifacts and to close broken lines and is then tagged.  Symbols for the various kinds of lines are 
assigned for plotting as a function of line type in the database.

Polygons  -  Closed polygons defined by the lines are established in a bulk process (the Clean or Build 
functions) and are identified by digitizing label points.  These points are placed one to each polygon, 
regardless of its size, and can be tagged concurrently in ALACARTE.  Area types such as geologic 
units can be entered from the keyboard or picked from custom lists that are entered as text files and 
then opened on screen as menus.  This tagging of areas can be done either on screen or from a digitizer. 
Search-and-display techniques aid in the location of errors for correction:  polygons without labels, 
with multiple labels, or with incomplete boundaries.  Colors for different map units are assigned as a 
function of area type in plotting.

Structural Symbols  -  Structural data can be entered graphically from a digitizer or on screen.  The 
symbols are not recorded directly.  Instead, the type of structural feature and its orientation are re-
corded in the database for a point location.  During on-screen display or for plotting, the appropriate 
symbol is assigned as a function of point type with the specified orientation at the recorded location.  
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Dip and plunge values are automatically placed on the map, but can be repositioned easily where 
desired.  A full range of structural symbols is available and others can be created in the symbol editor.

Other Points  -  Other kinds of points (field stations, fossil localities, chemical analyses, radiometric 
dates, etc.) can be digitized and labeled.  Any amount of information can be associated with a point in 
the database by entering it in the data input form, by importing existing digital files, or by cross 
referencing (relating) to other digital databases.  Any entry in the database can then be displayed or 
plotted at the point or used in computer-based analysis of the map. 

Unit Labels and Other Annotation  -  Graphic unit labels are entered as text annotation on the map. 
The polygon tags can be posted automatically at their label points to begin creating the graphic unit 
labels, but the posted tags are not fitted to the map for graphic presentation and will require editing.  
Other text, such as the names of faults, can be placed on the map at any angle or along curved lines.  
Various scalable fonts are available.

Database

A map compiled in ALACARTE - ARC/INFO automatically contains the essential elements of a map 
database.  Each line segment, polygon, and point is uniquely identified and located.  Basic topologic 
relations are determined and recorded each time the map topology is processed (built or cleaned), 
including line lengths, polygon areas, and identity of neighbors.  Several additional items (fields) are 
routinely added to the database in using ALACARTE, particularly to record the types of line, point, 
and polygon and to record the orientation of structural features.  Other items can be added as desired 
to record additional information about specific map elements, such as scale of source maps, fault 
names, characteristics of map units, or stratigraphic boundaries in wells.  Any or all of these records 
are then available for automatic searches as part of various analytic routines. 

Layers

Digital maps should be prepared in layers that distinguish kinds of information or features.  Thus, 
although polygons must be separated from points because of the way ARC/INFO treats these two 
kinds of features in version 5.0.1, it is also desirable to separate them because they represent different 
kinds of information.  Separating the map information into layers provides the greatest flexibility in 
on-screen use and plotting and minimizes processing time when working with one part of the data set. 
The design of layers for a map will depend on its content and purpose, but a good organization for a 
typical geologic map will include several layers.  These can be changed during work on a map, be-
cause separate layers can be combined and specified elements in one layer can be moved into another.

Base  -  One or more base layers will typically be involved.  If the base is to serve solely as a visual 
background, it can be scanned as a composite or in separations (topography, drainage, culture).  If 
digital attributes in the base such as contour values are required, however, then digital line graphs 
(DLGs) of the base layers must be obtained.

Faults, Contacts, and Units  -  The lines define the main framework of most geologic maps and here 
include the map boundary and all contacts and faults, whether or not they will serve as polygon 
boundaries.  If polygons are to be identified, then the boundaries of water bodies and any needed 
scratch boundaries must be included as well.  Fold axes, cross-section lines, structure contours, iso-
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grads, leaders for unit labels, and other cross-cutting lines should be placed in other layers to avoid 
complicating the polygons.  When completed, the lines layer will contain nothing but the needed 
contacts, faults, and other polygon boundaries, all tagged by line type.  Closed polygons (the distri-
bution of map units) are identified through a bulk processing step (the build function) and their 
identities specified by digitizing a tagged label point in each polygon.  Any polygon boundaries left 
incomplete during preparation of the lines layer will have been completed. 

Structure  -  Structural data (bedding attitudes, lineations, etc.) are entered as a special kind of point 
at which the orientation data and point type are recorded.  The oriented symbols that display this 
information on the map are generated at the time of screen display or plotting.  Cross-section lines, 
fold axes, and structural contours can also be included here.

Stations  -  Field stations and all other points can be combined in a single layer or different kinds of 
points can be placed in separate layers to facilitate analysis.  Text labels to identify the points or to 
report data (age, chemistry, etc.) can be included here or placed in the annotation layer.

Annotation  -  All map-face text (except dip or plunge values) can be placed in one layer.  This will 
include map unit labels and leaders, fault names, point identities or data, and any special annotation.  
This is strictly a graphic layer that serves no database role.  Any information that should be available 
for use in map analysis must also be placed in the appropriate database in association with particular 
map elements.  Annotation can be generated automatically from database attributes for direct use or 
for subsequent editing.

Other layers  -   Various other topical features may best be placed in one or more separate layers.  This 
is certainly the case for lines that would unnecessarily complicate the map-unit polygons.  

GETTING STARTED

The ease of starting to use ALACARTE-ARC/INFO will depend on whether you must start from 
scratch or can join an established system.  You may simply need to learn to use ALACARTE from an 
existing station or, at the other extreme, may need to obtain all the needed equipment and software 
before you can begin.  Regardless, getting help from a local expert will make things much easier.  
Considerable computer expertise will be needed to procure and install equipment and software, 
whereas joining an established system from which advice is available will be relatively painless.

Equipment and Software

Arranging to use ALACARTE-ARC/INFO can be as simple as finding a station on an existing system 
from which to work or can involve setting up a whole new system.  ARC/INFO is a commercial 
program for which a license must be purchased from its vendor, ESRI;  ALACARTE is available from 
the U.S. Geological Survey at nominal cost.  The basic requirement is to have ARC/INFO (and 
ALACARTE) running on an independent workstation or in multiuser form on a central machine 
(ARC/INFO host).  Central hosts are accessed remotely over network or hardwired connections from 
color-graphics terminals or terminal emulator programs running on desktop computers (Macs, PC’s, 
or workstations).

Considerable on-line storage is needed to hold the programs, provide work space, and hold active map 
files.  Records for the complex example map in the Tour directory, for example, which represents 
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about 10 percent of the area of the 7-1/2 minute quadrangle, require 1,843 kilobytes of disk space 
(Unix, or 1123 Prime records).  For that complete quadrangle, the base layers require 6 MB, the 
geology scan  about 5 MB, and the finished geology and structure about 1.5 MB. 

Digitizer input requires a digitizing table, tablet, or pad to be connected either to an independent 
workstation or to a terminal that is linked to an ARC/INFO host and is equipped with serial pass-
through.  Terminal emulators do not support digitizer input.  Scanning input requires a means of ob-
taining scans, converting raster scans to vector form, and transferring the vector files to ARC/INFO.  
Plotting requires some kind of plotter and a means of getting plot files to it from ARC/INFO.

ALACARTE runs under ARC/INFO on a subset of the hosts supported by ARC/INFO.  It has been 
tested on Sun and Data General workstations and Prime minicomputers, and should run unmodified 
on any Unix system supported by ARC/INFO.  ALACARTE can be modified to run on DEC 
VAX/VMS systems, but will not run under PCArc on IMB PC’s.  

ARC/INFO is available in single-user mode for workstations and multi-user mode for workstations, 
fileservers, and minicomputers.  The workstation monitor itself is used for display in single-user 
mode.  Multi-user ARC/INFO is accessed over serial lines or Ethernet from Tektronix graphics ter-
minals and terminal emulators running on IBM PC’s, Macintoshes, and workstations that have no 
ARC/INFO license.  Because the type and mode of access of scanners, plotters, and digitizers will 
vary between sites, you should consult your system administrator for details.  ALACARTE is de-
signed to support all the peripheral devices that are supported by ARC/INFO.

Learning to Use ALACARTE-ARC/INFO 

ALACARTE is best learned by using it.  This manual is designed both to introduce you to 
ALACARTE and to serve as a reference while you are working.  Reading the manual will help you 
decide what uses you want to make of ALACARTE-ARC/INFO and how to go about it, but not until 
you actually sit down in front of a terminal and start playing with the menus, the automated demon-
stration, and the example map files will you really begin to learn to use ALACARTE.

Begin by reading the introductory sections of the manual.  Then, with help from a colleague or your 
system administrator, find a station to work from, log in to the demonstration directory (Tour), start 
ALACARTE, and look around.  The Self-Guided Tour of ALACARTE will lead you through the 
initial steps and help you run the automated demonstration of map elements, which shows you how 
maps and their constituent features look on the screen.  Then explore the menu structure, experiment 
with the use of the different kinds of menus, and begin learning the functions and procedures of 
ALACARTE - ARC/INFO by following the tour instructions to prepare a simple map.

With this introduction, begin working on your own map.  The sooner you do this, the better.  Learning 
progressively as you work is more efficient than trying to learn the whole system in advance.  Use the 
Self-Guided Tour and Compiling a Digital Map to determine the scope of ALACARTE and the issues 
you must address for your own map and focus on those issues in your exploration of ALACARTE.  
Then start work and refer to Compiling a Digital Map and other sections in ALACARTE Basics and 
Procedures to resolve problems as you go.

Before you begin your own work, you will want to consult your system administrator both to obtain 
an account on the system and to determine how to perform those operations that are specific to each 
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computer system (see System Details, p. 35).  The quickest way to learn ALACARTE is to use it, 
consulting the various parts of the manual for help as necessary.  It will also be useful to recruit a 
colleague who can help you when needed.  Remember that mistakes can do no harm as long as you 
maintain a recent backup copy of your map.  You can remove the effects of missteps with the Oops 
function and always have the choice of not saving any changes that you have made (see Saving, p. 80).
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SELF-GUIDED TOUR

A first step in learning to use ALACARTE or to examine how it works is to run the automated 
ALACARTE demonstration, explore and experiment with the ALACARTE menus and functions, and 
then make a very simple map.  You can do this on your own, once you have established the basic 
requirements:  (1) you have a station to work from,  (2) you have a login account on a host computer 
running ARC/INFO with ALACARTE, and  (3) you know the few computer commands needed to call 
the host computer, log in, run ALACARTE, and quit when you are through.  Consult System Details 
(p. 35) and a colleague or your system administrator for help with these.  Throughout, remember that 
you may make some mistakes initially, but that recovery from most mistakes is easy and it is hard to 
do any real damage.

ALACARTE includes a map directory called Tour that contains a suite of demonstration map layers 
based on the geologic map of the Loma Prieta 7-1/2 minute quadrangle (McLaughlin and others, U.S. 
Geological Survey Open-File Map 88-752), which straddles the San Andreas fault on the San Fran-
cisco peninsula in California.  ALACARTE will help you to copy this demonstration directory into 
your home directory for use in running the automated ALACARTE demonstration and in subsequent 
experimentation (use the Demonstration menu to copy the directory, as described in ALACARTE 
Demonstration, p. 16, and Copy the Tour Directory, p., 49).

The Tour directory requires about 2 megabytes (MB) of space (1000 Prime records).  If disk space is 
short, as is often the case, consider logging in to a directory that already contains a Tour directory.  If 
you do copy Tour into your own directory, be sure to delete it when you are through to avoid using 
unnecessary space.  It is always easy to copy it again.

Before starting, it will be useful to have read the introductory sections of this manual (Introduction, 
Compiling a Digital Map, and Getting Started, p. 1-14) as well as Starting ALACARTE (p. 46).  As you 
proceed, be sure to look at the other sections of the manual that are cited here, both to supplement the 
information provided here and to become familiar with the various parts of the manual. 

How to Start

Go to the station from which you will work (terminal or computer), turn it on and/or start the terminal 
emulator, and call the host computer.  When the prompt for the host system appears, log in to an 
appropriate directory.  Exactly how to carry out these steps will depend on your particular system; see 
Accessing Systems with ALACARTE-ARC/INFO (p. 35) and consult a colleague or the system admin-
istrator for instructions: write the steps down precisely, for computers don’t accommodate error or 
approximation very well.

Once you are in the appropriate directory (probably your home directory or a Tour directory set up for 
introductory use), start ALACARTE.  The manual section Starting ALACARTE (p. 46) provides step-
by-step instructions for doing this.  

How to Quit

It is helpful, before you start, to know that you can get back out of ALACARTE gracefully.  From any 
part of ALACARTE, move up and out of the hierarchy of bar menus by clicking on the right-hand item 
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on each of the bars until you reach the Alacarte bar, and then use  QUIT  to close ALACARTE and 
ARC/INFO and return to the system prompt.

Close an open pulldown, popup, or forms menu by picking  Close menu  or  cancel,  and close reports 
forms with  OK  or  Quit.  Picking  OK  on a forms menu will activate the function controlled by that 
menu.  If you happen to do this and errors result, simply ignore them, close any reports forms that 
appear, and proceed.  As long as you stay in your own copy of the Tour directory, the worst that can 
happen is that one of the Tour files might be modified.

If you have listed something on the screen from ALACARTE or have caused a question to be asked at 
a prompt in the dialog area, you may need to hit the return key (<return>) in order to reassert control 
from the current bar menu.  If you have started a key menu, close it by entering a  9  (see Using the 
Menus, p. 59, to determine how to enter these numbers).  If you have trouble entering a  9  from a 
mouse (some emulators are balky until set properly), try entering it from the keyboard and <Return>; 
this may yield errors, but it should close the key menu.  

If you have gone out to one of the command lines, you will need to enter one of several commands in 
order to return to ALACARTE.  Try  quit,  exit,  &return,  QUIT,  or  QUIT  STOP, or consult Command 
Lines (p. 64) for a description of the use of these various commands.

Breaks - If all else fails, or a runaway process starts and takes over the system, terminate program 
operation with a break.  On Unix hosts use CONTROL-C to do this, and on Primes use CONTROL-P 
(hold the control key and then hit the appropriate letter key).  You will then be asked in the dialog area 
if you really want to do this,  y/n.  Try n (= no) first, and if this doesn’t correct the problem, repeat the 
break and respond  y (= yes).  You should end up at the system prompt with ALACARTE -ARC/INFO 
closed down.  Use this break procedure only as a last resort, because it can leave temporary files 
behind that will have to be deleted separately.

ALACARTE Demonstration

A good way to see how ALACARTE maps work is to run the automated Alacarte demonstration, 
which illustrates the structure of map data and shows how the various elements of a geologic map look 
on your display screen.   Once the demonstration is started from the Alacarte bar menu, you simply 
page through the twenty-one illustrations by hitting <Return> (hit the key sharply and release imme-
diately).  These are not just pictures displayed on the screen, for the demonstration program is actually 
running ARC/INFO in the same fashion that you would in using ALACARTE.  You can terminate the 
demonstration after any illustration and be returned to the Alacarte bar.

The demonstration illustrates the structure of map data through a series of illustrations and shows how 
the various elements of a geologic map look on your display screen.  The demonstration starts with a 
full-color map containing standard line symbols and bedding attitudes (this can be slow to draw on a 
busy multiuser system) and then backs off to the more typical "wireframe" lines and uncolored poly-
gons used in editing.  The series displays the on-screen appearance and database for lines, polygons, 
structural data, and an example points layer containing fossil data, incorporates a digital base map as 
a background, and illustrates text annotation and the digital tics used for geographic registration.
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To prepare for the demonstration:
1.  log in and go to a Tour directory or, if none is available, to your home directory,
2.  start ALACARTE and go to the first (Alacarte) menu bar (pick  none  for digitizer),
3.  open the Commands popup menu by clicking on  [Alacarte]  at the left end of the Alacare bar,
4.  open the Demonstration menu by clicking on  alacarte demo  on the Commands menu.

Start the demonstration from the Demonstration menu:

Start the ALACARTE demo.  You must be in your copy of the ALACARTE tour
directory.  For more information click on the ’HELP’ button.

change to your copy of tour directory:

/HOME/CWENT

copy tour directory to current directory:  copy tour

Start demo      HELP      CANCEL

You must be in a Tour directory in order to run the demonstration.  If the pathname shown beneath the 
heading  change to your copy of tour directory:  does not end with the word  TOUR (as is the case for 
the CWENT directory shown here), you are not in a Tour directory.  If a Tour directory is available, 
you can click in the pathname blank and enter its pathname from the keyboard.  Otherwise, click on 
the  copy tour  button to have ALACARTE place a copy of the Tour directory in your current directory 
and automatically move you to that new directory.  This copying will take a minute or so.  

Start the demonstration by clicking on the  Start demo  button.

The first frame is a brief description of the demonstration.  Move on from this and proceed through the 
illustrations in sequence by hitting <Return> when you are finished with each panel or list.  You can 
quit the demonstration and return to the Alacarte bar menu after any panel by typing q (for quit) before 
hitting the <Return>.  The brief text in the dialogue area beneath each illustration describes the main 
points of each illustration.

When the demonstration is completed, or if you quit earlier, you will be returned to the Alacarte bar 
menu.  Proceed then to look around in the menu structure, or close ALACARTE and return to the 
system prompt by clicking on  QUIT  at the right end of the Alacarte bar.  

Experiment

You should explore the ALACARTE menu structure and experiment with how the menus and various 
ALACARTE functions work.  You can start by just looking around without actually running any 
ARC/INFO functions, simply by not picking any menu items that are all lower case.  Only lower case 
items actually do anything, the others just manipulate the menus.  Consult Using the Menus (p. 59) to 
determined how these various kinds of menus work.  Then follow the suggestions below to look 
around in the menu structure and experiment with some of the basic Edit functions.

Structure and Functions (p. 203) provides a systematic listing of all the bar and pulldown menus in 
ALACARTE and figure 4 (p. 205) shows the hierarchical framework of the bar menus.  
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Go down from the Alacarte bar to each of the six principal bar menus (but reserve the Edit bar for last 
- see below).  These bars represent the principal functions of ALACARTE.  Open some pulldown and 
popup menus to see what they look like and to become comfortable with using the menus.  You can 
consult Structure and Functions to see what the various menu items do.  In looking around, remember 
that you activate a menu item by moving the crosshairs over it and clicking a mouse button (or the 
space bar) and that you can always get back to the current bar menu by closing an open pulldown or 
popup menu (see Using the Menus, p. 59, for further information on picking menu items).  If you do 
activate an ARC/INFO function and any error messages result, ignore them, close any reports forms, 
and proceed.  

EDIT-BAR FUNCTIONS

Now that you have some idea of how to manipulate at least the simpler menus, try some of the control 
and edit functions that are used to display and work with a map.  If you are beginning a new session, 
be sure that you are in the Tour directory, and then start ALACARTE and go to the Alacarte bar as you 
did to run the Demonstration.

Go down to the Edit bar (pick  EDIT  on the Alacarte bar).  As described in Edit Map (p. 65), you must 
specify a map on which to work (the Edit Map);  the Choose Map menu pops up to let you do this.

Pick the  Choose Map  button on this menu to list the maps from the current directory on the screen, 
and click on  CLP.GEOL  from the list to choose it (this is the polygon layer for the demonstration 
geologic map).

The Setup file for the map will be read and a report will appear on the screen:

Map currently being edited is:  CLP.GEOL
     in directory   /REDHOME/CWENT/TOUR
Weedtolerance 0
Intersectarcs ALL
Arcsnap ON,  15
Nodesnap CLOSEST,  15
Grain 4.351 . . . .
Editdistance 61
Mapscale is 1:24000 (0 indicates unknown)
Mapunits are METERS

Click on QUIT to continue
QUIT

This report appears every time that you open an Edit Map.  Use it to be sure that the map you have 
opened is the one that you intend to work on, and to check how the snapping tolerances are set.  These 
settings control some important aspects about the behavior of the editing functions (see Snapping and 
Other Controls, p. 123).  For now, note that you did open CLP.GEOL and that Arcsnap and Nodesnap 
are on with distances set to 15 meters in map units (that is, in meters on the ground).  Close the report 
by clicking on the  QUIT  button.
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You are now presented with the Edit bar, which provides access to the working bars for the different 
kinds of features in a map:

[ Edit ]  |  Map  |  LINES  |  PTS  |  AREAS  |  ANNO  |  TICS  |  Save  |  Dw  |  Zm  |  ^ALC  |

This bar also offers two important pulldown menus, the Map pulldown and the Save pulldown, 
which are opened with  Map  and  Save,  respectively:

Map (Map): Save (Save):

choose edit map cur map(ow)
show current edit map
show all open edit maps cur map(new) 
remove edit map(s)
create new map all maps (ow)

choose background save-select?
show current backgrnds save-symbol?
remove background save-audit?
remove all backgnds show settings

change workspace save setup
show workspace use setup
list dir

register map
describe map
record mapscale
record mapunits
show scale, units
change coord device

Open the Map pulldown by picking  Map  on the Edit bar.  From this menu you can change the current 
Edit Map, add or remove backgrounds, and register a source map on a digitizer (see Edit Bar Menu, 
Map Pulldown, p. 211, for a systematic description).   

The Save pulldown (open with  Save)  offers a range of save options (see Saving, p. 80, for a full 
discussion).  Working on a map with ALACARTE-ARC/INFO, like working on a manuscript in a 
word processor, modifies a temporary copy of the document.  You must save that temporary copy if 
you want to keep your work (and you can abandon new editing by not saving).  Here at the Edit bar 
you can save the current edit map by overwriting the permanent file  (cur map(ow))  or by specifying 
a new file  (cur map(new) );  you can also save from any of the various Options pulldowns in Edit, but 
only by overwriting the current map.  While you are experimenting, you can avoid affecting any per-
manent files by not saving anything, but later you will want to be sure to save frequently as you work 
(at least once an hour).

Draw and Zoom Controls

Controls on which kinds of features in a map are drawn and what part of the map is shown on the 
screen are provided by two standard popup menus that can be opened from any bar in Edit (described 
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more fully in Draw Controls, p. 67, and Zoom Controls, p. 69).  Use the Draw menu to define content 
(open with  Dw) and the Zoom menu to navigate within the map (open with  Zm):

Draw  (Dw): Zoom  (Zm):

draw map zoomin(box)
draw(noclear) overview
set draw/back envir zoomout(#)

zoomin(#)
select many
set drawsel symbol zoom 9/36
draw select zoom 8/32
set $symbol(S) xy box

Pan
auto dw sel on
auto dw sel off draw area of:

   selected features(S)
clear screen    map boundary
graphics on    map corners
graphics off

draw to scale
save this frame
redraw saved frame

Open the Draw menu and pick  draw map.  Nothing happens because at the Edit bar no features are 
turned on in the draw environment.  You have control over which kinds of features in a map actually 
draw.  Set the draw environment from the Draw/Back Environment menu, which is opened from the 
Draw menu with  set draw/back envir.  Open this menu, and turn arcs on in the foreground by picking 
the  ON  button opposite the  Arc:  heading ( note that the setting changes from  OFF  to  ON).  Then 
draw again, this time using the  DRAW  button at the bottom of the open Draw/Back Environment 
menu.  The menu will close and the lines in the geologic map will draw on the screen.

Now zoom in on the map.  Open the Zoom menu and pick  zoomin(#);  A prompt in the dialog area 
will instruct you:

Give zoomfactor,  <Return> = 2:

Accept the default of a two-fold magnification of the draw area with a <Return>, and you will be asked 
to:

Enter center of zoom area

Do this by clicking on the map and the screen will be redrawn at a two-fold larger scale with the 
clickpoint at the center.  You could also have entered a different magnification factor from the key-
board at the Zoomfactor prompt before hitting <Return>.

A common need during editing is to be able to zoom in on a map detail to fix it and then to restore the 
larger view.  Try this by saving the current draw area (frame), zooming in on a detail, and then re-
turning to the saved frame.  Do this by opening the Zoom menu and picking  save this frame.  Then 
open the Zoom menu again and try the Zoombox function:  pick  zoomin(box)  and, at the instruction 
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to define the box, click the diagonally opposite corners of a box on the map.  When you click the 
second corner, the box will be redrawn to fill the screen.  Finally, pick  redraw saved frame  from the 
Zoom menu to return to the larger view.

Return to the full area of features in the map with  overview  on the Zoom menu.  Hit <Return> at the 
prompt:

Confirm:  draw entire map,  <Return>  =  yes?

Because a large map can take a long time to draw on some systems, especially if a busy background 
map is turned on,  the Overview function asks in the dialog area that you confirm the action or cancel 
it by entering  n(o).

Using Backgrounds On Screen

On-screen work is greatly facilitated by the ability to display registered layers in the background be-
hind the edit map.  Open the Map pulldown and choose  CLP.INDEX  as a background (pick  choose 
background, then pick  CLP.INDEX  from the resulting list of maps) and specify a neutral gray color 
(15) from the Colors popup that follows.  Then add  CLP.HYDRO  as a second background, and specify 
blue (4).

If you were to draw now, no backgrounds would appear on the screen.  Just as with the edit map in the 
foreground, features in the background maps are controlled from the Draw/Back Environment menu.  
Turn arcs on in the background from that menu and draw.  The gray index contours and blue drainage 
lines should now place the geologic lines in a topographic context on the screen.  Note that the order 
in which the backgrounds draw is the order in which you chose them.

WORKING WITH LINES

The Edit bar offers access to subordinate bars from which you can work on the various kinds of 
features in a map: lines, points, areas, annotation, and tics.  Lines are the fundamental component of 
geologic maps and are the most complex kind of feature.

Go down to the Lines bar (pick  LINES  on the Edit bar):

[ Lines ] | DIG |  RSH  |  Snap  |  SYMB  |  Db |  Sel |  Op  |  Dw  |  Zm  | ^EDIT |

This bar illustrates the basic character of each of the feature bars.  They provide access to other bars 
from which to digitize and to modify that kind of feature (see figure  4, p. 205);  for lines, these are the 
Digitize and  Reshape bars.  They also provide access to the Database pulldown menu and the standard 
pulldown and popup menus that are available from every working bar in Edit - an Options pulldown 
and the Select, Draw, and Zoom popups. 

The features appropriate to each of the feature bars are turned on automatically for the edit map by 
ALACARTE.  By coming down to the Lines bar, for example, you have automatically turned lines on 
in the foreground. This setting can be overridden or modified at any time from the Draw/Back Envi-
ronment menu.
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Start looking at lines by drawing the lines in CLP.GEOL in color according to their major identities:  
use  draw w/ default colors  on the Options pulldown to have ALACARTE search the database and 
color all faults red and all contacts aquamarine. 

Now turn nodes on in the foreground and draw the map again; this will mark every intersection and 
change of line type in the edit map with a white dot.  Do this by opening the Draw/Back Environment 
menu from the Draw menu and clicking the  ON  button for Nodes in the edit map, and then drawing.

You can examine the database for individual lines from the Database form (see Using the Menus, 
Database Form, p. 62, for a description).  Open the Database pulldown (pick  Db  on the bar) and pick 
 forms  to open the Database form.  Initially the form will contain no information, because no lines are 
selected.  To display the database for a line, click on the  SELECT  button on the form, move the 
crosshairs onto the line, and then enter a  1 (in short, click on the line).  The database entries for that 
line will be shown in the form:

Arc                 Internal 37 User-ID   1225

fnode# 32
tnode# 14
lpoly# 13
rpoly# 9
length 1290.031
clp.geol# 37
CLP.GEOL-ID 1225
LTYPE normal fault, inferred
SEL 0
SYMB 0

SELECT   NEXT   SAVE   WHO   CANCEL

Note the kinds of information that are present.  The items listed in lower case are controlled by 
ARC/INFO (see Topology, p. 56), whereas the upper case items are under your control and can be 
changed here from the keyboard or elsewhere using other ALACARTE functions.

Try changing the line type for this line.  Click in the LTYPE box to highlight it and enter your first 
name from the keyboard.  Saving such a change requires two steps,  (1) saving it to the temporary open 
copy of the map by clicking on the  SAVE  button here, and then  (2) saving the temporary copy before 
quitting ALACARTE.

Lines are added to a map from the Digitize bar.  Go to that bar by picking  DIG  on the Lines bar:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

A current line type is maintained here at the Digitize bar that can be changed as you wish.  Click on  ? 
to obtain a report of the current type (the default of  contact, certain  will be reported),  and then change 
it to something else, first from the pulldown menus and then from the keyboard (see Set Line Type, p. 
130, for a description of how to do this).  The current line type is automatically assigned to new lines 
as they are digitized here and can be used to tag a selected line or to select lines by their recorded line 
types.  
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Try digitizing a new line (see Enter Lines, p. 131, for a description of this process).  Zoom in to a 
relatively open area to add a line that crosses at least one existing line and connects at each end to other 
lines.  Set a line type for the new line, start the Digitize routine by picking  dig  on the bar, and click 
in the vertices of the line using a  2  at the beginning and end nodes and  a  1  to place each internal 
vertex.  Close the Digitize routine with a  9.

If you placed the ends of this new line within the snapping distance of the existing lines, Arcsnap will 
have closed the junctions precisely (watch for the lines to blink as they snap).  The new intersection 
will also have been recognized by Intersectarcs and the lines will be split there and joined by a node.  
If you want to redo this line, back up with  oops  (on the Options pulldown,  Op) and redigitize it.

Go back up to the Lines bar and look at these new lines in the Database form. The lines that you 
digitized remained selected after you closed the Digitize routine, and database entries for one of them 
will be displayed when you open the Database form.  Note that the line type was recorded automati-
cally in the LTYPE item.  Cycle through the selected set of lines in the form by clicking on  NEXTREC.

Now go down to the Reshape bar (pick  RSH  from the Lines bar) to look at line details and to change 
the shape of a line:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

Reshape  (Rsh): Split/Combine  (Sp): Vertex  (V): Options  (Op):

reshape(S1) split(S1) add vertex(S1) oops
dash to solid split  at  vertex(S1) delete  vertex(S1) Undelete(S):
move in place move vertex    last
Grain: combine arcs(S) draw vertex(S1)    all
   grain  *    in red    for expression
   grain  distance    in other color delete(S)
Spline: select many
   help draw sel’d features
   spline(S) show sel’d features
Densify: list  attributes(S)
   help PUT
   densify default(S) get
   densify  *(S) distance
   densify distance(S) where
Generalize: flip line dir’n(S)
   gen default(S) change coord device
   gen *(S) save(OW)
   gen distance(S)

The Reshape bar is complex because, in modifying the shape and interconnections of lines, you need 
a wide variety of edit functions ready at hand.   Four of the pulldowns from the Reshape bar are listed 
here and a full annotated listing of the bar and its pulldown menus is provided in Reshape (Lines) Bar 
Menu (p. 217). 

Most operations on lines require first that the line be selected.  Two often-used select functions are 
located directly on the Reshape bar (Select Many -  sm,  and Select Polygon Within -  sp), and a wide 
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suite of select functions is available on the standard Select popup menu (open here with  Se;  see 
Selecting Map Elements, p. 73, for an full discussion).

Select a long line on the screen by picking  sm  on the bar and clicking a  1  on the line to select it, as 
instructed by the key menu, and then close the key menu with a  9.  ALACARTE will redraw the 
selected line in yellow (the default Drawselect color).

Draw the vertices of this selected line by opening the Vertex pulldown  (V  on the bar) and picking  in 
red  under  draw vertex(S1).  If red is not appropriate because of the color of the line, use  in other color 
to pick a vertex color from the Colors popup.

Change the shape of the selected line by redrawing part of it on the screen.  While the line is selected, 
open the Reshape pulldown  (Rsh)  and pick  reshape(S1).  You will be instructed to

Enter the new segment   <3  -  Curve,   9 -  Quit>

Click a new shape for the middle third of the line by clicking  1’s:  start by crossing the original line, 
then define the new shape, and end by crossing the original line again.  When you close with a  9,  the 
new segment will become part of the line.

Nodes are special parts of lines that require separate treatment.  Go down to the Nodes bar from the 
Reshape bar (pick  N  on the bar):

[ Nodes ] |  move  |  Snap  |  Symb  |  Op |  Dw  |  Zm  |  ^RSH  |  

The sole editing function that can be applied to nodes from the Nodes bar is to move them (see Edit 
Nodes, p. 136).  Moving a node moves the whole intersection with all lines attached.  (If you want to 
separate a line from an intersection, work with the end vertex of that line from the Reshape bar.)  Move 
a node by starting the Move Node routine (pick  move  on the bar) and then following the key menu 
code;  specify a node by clicking on it with a  1,  confirm the selection with a  4,  and then click a new 
location for the node with another  1.  Do this for as many nodes as you wish in sequence, and then 
close the routine with a  9.  After moving a node for practice, return to the Reshape bar (pick  ^RSH).

Lines have a direction that can be controlled.  Open the Draw/Back Environment menu (from the 
Draw menu), turn Arrows on for lines, and draw.  Note the arrow heads that mark the line directions.  
Note also that redrawing clears the vertex marks and removes the drawselect color from the selected 
line.  Redraw the selected line with  draw sel’d features  on the Options pulldown.  Now reverse its 
direction with  flip line dir’n(S)  on the Options pulldown.  Turn the arrows off again.

Select a line and delete it.  Try Select Polygon Passthru this time.  Open the Select popup menu (pick 
Se  on the Reshape bar), and set the Select Type to  select,  the Option to  polygon,  and the Choice to  
passthru.  (In terminal emulators, making choices in this kind of menu may require moving the high-
light with the tab or arrow keys and choosing a highlighted item with <Return>; see Menu Operations, 
p. 59.)  In contrast to Select Within, Passthru selects lines that are crossed by the polygon as well as 
those enclosed by it.  Select one line by crossing it with the polygon, then delete it with  delete(S)  on 
the Options pulldown. 

Presume that you want to tag the two halves of a line differently in order to assign different line 
symbols to them in plotting.  First you must split the line:  select the line, this time by trying Select 
Polygon Within from the bar  (sp).  This requires that you enclose the target line with a polygon 
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clicked with  1’s.  With one line selected, open the Split/Combine pulldown  (Sp  on the bar), pick  
split(S1),  and click on the selected line where you want it to be split.  The line will be split at the 
clickpoint, and a node will appear there.

Go back to the Digitize bar (up to Lines and down to Digitize), chose a line type for one of the new 
line segments, and select and tag the line and then color it distinctively.  You can do this most easily 
with  sel,tag,color  on the Select pulldown (open with  Sel  on the bar).  

With this introduction to working with lines, try experimenting with the various functions.  Open the 
Select popup, consult Selecting Map Elements (p. 73), and try selecting lines in various ways, includ-
ing By Expression and with the Select-by-Current-Linetype functions.  Consult Edit Lines (p.135) and 
try some of the other line-editing functions.

WORKING WITH AREAS

Areas (polygons) are addressed through the label points that identify them.  Go down to the Areas bar 
from the Edit bar (pick  AREAS): 

[ Areas ]  |  DIG  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

Both lines and label points (arcs and labels) will be turned on automatically in the Draw Environment 
and any other settings you have made will be retained.  When you draw the map, note that nodes are 
still on.  Turn them off and draw again.

The principal bar in Areas is the digitize bar, from which you can digitize, tag, or retag label points.  
The only way to modify labels other than to retag them is to move or delete them.  Go down to the 
Digitize (Areas) bar (pick  DIG):

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  key  |  m1  |  m2  |  m3  |  Op  |  Dw  |  Zm  |  ^AREAS  |

Like the lines bar, a current area type is maintained at this bar (pick  ?  to check it).  In contrast to lines, 
standard area types cannot be defined for a geologic map and the area type is set either from the 
keyboard (pick  key)  or from user-defined menus (see Tag Polygons, p. 162, for a discussion).  

Look at the database for a label point by selecting and listing it (you could also use the Database form, 
which is reached from the Areas bar).  To select a label point, open the Select pulldown  (Sel  on the 
bar), pick  select many,  click on the label point on the map, and close with a  9.  The selected point 
will redraw as a yellow dot.  List the database with  list attributes(S)  on the options pulldown.  The list 
will appear in the dialog area. (If not all the list can fit on the screen, you may be asked if you want to 
continue?  Just use <Return> to do so.)  Note the database items, and particularly the PTYPE, which 
is the record of the geologic unit to which this polygon is assigned.

You can display all the PTYPE entries for all the label points on the screen by opening the Options 
pulldown and picking  Post attribute: on.  Now every time you draw or zoom the PTYPEs will be 
posted.  Later, when you want to turn this function off again, simply pick  Post attribute:off  on the 
Options pulldown.  (Be sure to do this before you leave Areas.).
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Digitizing new label points is as easy as setting the area type and clicking points:  set a new area type 
from the keyboard  (key),  start the digitize routine (pick  dig),  and click some points at arbitrary 
locations on the map.  As you click, the new points will draw, and if you still have Post Attributes on, 
the PTYPEs will be posted as well.

These points that you have just added are not yet recognized as part of the polygon topology of the 
map.  That would require building the map for polygons (see Topology, p. 56).  Were you to do that 
now, ARC/INFO would recognize that there are extra label points in some of the polygons.  Delete 
these extra label points:  because you have just digitized them, they should still be selected, and all you 
need to do is pick  delete(S)  on the Options pulldown.

Polygons in a map that has unedited polygon topology (as does the permanent file for CLP.GEOL) can 
be colored on screen (see Color Selected Polygons, p. 169).  Open the Options pulldown and pick  
color units in backgnd  to open the Color Units menu.  Accept the default shadeset, pick the  unit to be 
colored  button and choose a unit to be colored from the list, then pick the  select color for unit  button 
to specify a color.  Then draw.  Polygons of the specified unit will be filled with the specified color.  
This coloring will continue with every zoom and draw until you turn it off by picking  color units: off 
from the Options pulldown (be sure to do this before you leave Areas).

WORKING WITH POINTS

Points are used both to record such oriented structural data as bedding attitudes and lineations and to 
represent sample localities and other point data (see Points and Point Data, p. 175, and Oriented 
Symbols and Data, p. 179).  Because points in ARC/INFO 5.0.1 use the same database file as polygons 
(the PAT), no single map layer can contain both types of features.

Go back up to the Edit bar and choose  CLP.ATT  for the current edit map.  This is the layer in the 
demonstration map that contains bedding attitudes.  Then go down to Points (pick  PTS):

[ Points ]  |  Dig/tag  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

Digitize/Tag (Dig/Tag):

POINT 

PLANAR 

LINEAR 

MAP SYMBOLS  

no attribute

In contrast to the other kinds of features, there is more than one kind of digitize bar for points, because 
the different kinds of data recorded at points in ALACARTE involve different input routines and 
different database formats.  The Digitize/Tag pulldown offers access to separate digitize bars for 
points, for planar features recorded at points, and for linear features recorded at points (Map Symbols 
is not implemented in version 1.0).
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Go down to the digitize bar for planar features (pick  PLANAR  on the Digitize/Tag pulldown):

[ Planar ]  |  dig  |  tag  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

Set Symbols (Set):

draw first time w/ current
show current settings

Choose markerset
Choose lookup table
Select db items

set dip numeral height
set attitude entry format

ALACARTE will automatically select and draw all the points in the edit map, using oriented structural 
symbols.  The particular symbol used at each point is a function of the entry in the PTTYPE item in 
the database, and the orientation of the symbol on the map is a function of the azimuth recorded in the 
STRIKE item.

The association of a symbol with a point in drawing is controlled by a lookup table, which assigns 
symbols by number as a function of PTTYPE, and by the markerset of numbered symbols to which the 
lookup table refers.  ALACARTE has automatically chosen the markerset for oriented structural 
symbols and the lookup table that assigns symbols sized for display at map scale.  Because these 
structural symbols do not change size as you zoom, an alternate lookup table is available with which 
to draw double-sized symbols.

Change to this larger set of symbols:  open the Set Symbols pulldown (pick  Set),  pick  Choose lookup 
table,  list the options (enter a  ?  or click with the middle mouse button in the blank), pick 
CLP.ATT.LUT2X  from the list, and then pick the  OK  button.  In order to assign these new symbols to 
the points, you then open the Set Symbols pulldown again and pick  draw first time w/ current,  and the 
new symbols will draw on the screen.

If you don’t like the size of the dip numbers in relation to the symbols, use the zoom functions to 
adjust, as the numbers do scale with zoom.  (Or, use  draw to scale,  as described in Set the Draw Scale, 
p. 181.)

Select an attitude and look at the database.  To do this, open the Select pulldown (Sel  on the bar), pick 
 select many,  click on an attitude (at its center), and close with a  9.  The attitude will redraw in yellow. 
Then list the attributes from the Options pulldown  (list attributes(S)),  and hit <Return> if necessary 
to complete the report in the dialog area.  Note the way that the structural data are recorded.

To digitize an attitude graphically, set the symbol type from the Point Tag pulldown and start the 
digitize routine.  A full description of the procedure is given in Enter Structural Data (p. 183), but you 
can see how it works simply by following the instructions in the dialog area.  Click at one end of the 
strike line, then at the other, and ALACARTE calculates the azimuth according to the right-hand rule, 
determines the midpoint of the strike line, and posts the symbol;  finally, you enter the dip from the 
keyboard.  ALACARTE records the data in the database, posts the dip on the map, and prompts for 
another symbol.  Close the digitize routine with a  9.
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Look at the database for the attitude that you have just entered.  Go back up to the Points bar (close the 
markerset report on the way), open the Database pulldown, and pick  forms.  From the form, pick 
SELECT,  then click on the attitude.

  
WORKING WITH ANNOTATION

The dips on the screen are an example of text that can be incorporated into any map layer.  
ALACARTE both recorded the dips in the database and posted them as annotation on the map.  These 
numbers can be selected and moved, and other text can be added to the map  (see Add and Edit 
Annotation, p. 187).

To experiment with this, go to the Annotation bar (go up to the Edit bar and pick  ANNO).  For present 
purposes, simply accept the settings in the Annotation Environment form by clicking  OK, and you will 
be at the Annotation bar: 

[ Anno ]  |  DIG  |  CHANGE  |  Symb  | Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

Like the other feature bars, this offers access to a bar for digitizing and one to change annotation.  To 
move a dip number, go to the Change bar  (pick  CHANGE): 

[ Change ]  |  Change  |  Move  |  Rot  | sm  | sp  | Se  |  Op  |  Dw  |  Zm  |  ^ANNO  |

The Select-and-Move routine on the Move pulldown offers cyclic Select One and Move functions:  
pick  Select and Move and, at the prompt  (1 = move     9 = Quit),  click a  1  at the lower left corner of a 
dip number.  The number will blink and you will be instructed to  Point to the coordinate to move from.  
Do this with another click at the place on the number with which you want to reposition it.  At the final 
instruction  Point to the coordinate to move to,  click where you want to position the number.  The number 
will be moved and the prompt given to start another cycle, at which point you can close with a  9.

To add some text to the map, go to the Digitize Annotation bar (go up to the Annotation bar and pick  
DIG):

[ Dig ]  |  add  |  Add options  | Sel  |  Op  |  Dw  |  Zm  |  ^ANNO  |

There are a great variety of ways to place annotation on the map, of which the simplest is the default.  
Pick  add  on the bar, and at the prompt  Text:,  enter any text string from the keyboard.  When you hit 
<Return>, you will be instructed to  Enter position (1);  do so by clicking on the map, and the text will 
be placed at the clickpoint.  Close the add routine with a <Return> at the  Text:  prompt.  If your entry 
is too small to read, zoom in on it.
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Make a Simple Map

Compiling a digital geologic map involves use of the edit functions and a suite of other functions to 
prepare layers and enter the data.  You can explore this process without spending a great amount of 
time on any one editing step by making a simple map according the the following instructions.  A more 
complete description of the process is given in Steps in Preparing a Map.  The simple map will be a 
small part of the Loma Prieta quadrangle used in the ALACARTE demonstration.

Work in your copy of the Tour directory, do save your work this time, and don’t hesitate to try things. 
The worst that can happen is that an attempted step will not work or, at the extreme, that you will 
freeze the system and have to break out (see Self-Guided Tour, How to Quit, p. 15).  Focus on the 
procedures rather than on making an elegant map, and consult other parts of the manual as necessary. 
 

MAKE THE LINES LAYER

The first task is to establish the geologic line work for the map.  This can be done in various ways, but 
for this example you will use part of a scan of the conventional author line work for the Loma Prieta 
quadrangle.  This drafting was scanned at 17 lines per millimeter (430 lines per inch), converted to 
vectors,  and imported into ARC/INFO (layer  CLP.SCAN17  in the Tour directory).   To make the line 
work, you will prepare a tic framework and database, cut out part of the scan and put it into this 
prepared framework, and then clean up and tag the lines.

Prepare New layer

Go to the Setup bar and prepare a new layer for faults, contacts, and units, using CLP.GEOL as a 
template.  Do this from the New Layer pulldown, call the layer  smpl.ln,  and include the save items.  
The Setup file and symbols lookup tables will be copied automatically from the template.

Define the Box 

Go to the Edit bar (the new layer will be opened) and change edit maps to  CLP.SCAN17.  Then go to 
Lines, open the Snap pulldown, and set Intersectarcs to  ADD  and the Nodesnap distance to  0.  These 
settings will be important as you cut out and copy part of the scan into the new layer.

Go next to the Digitize Lines bar and use  zoom x,y(box)  on the Zoom menu to draw an area with x,y 
coordinates of:

xmin: -3000
ymin:    8000
xmax -1000
ymax:    9000

This will display a relatively simple area of the scan.  Save the frame (Zoom menu), and look around 
at the scan a bit.  Then redraw the saved frame (Zoom menu).
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The next step is to digitize a box enclosing most of the draw area that will intersect all the lines and 
permit the box and its contents to be selected and copied into  SMPL.LN.  Start the digitize routine using 
 no attributes  on the Other pulldown (pick  O  on the bar);  this will avoid producing ALACARTE 
errors due to the absence of a prepared database in the scan.  Change the digitizing option from  (line) 
to  (box)  by first entering an  8  (control - middle mouse button) to get the Options key menu and then 
a  6  (shift - right mouse button) to change to  Arctype box.  

From the resulting digitize prompt -  (Box)  User-ID:  22113  Points  0  -  click a  2  at each of two opposite 
corners of the draw area to define an area that will be the simple map.  Try not to intersect unit labels 
or attitudes (include rather than exclude).  When you click the second  2,  the box will draw and 
intersect all the lines that it crosses.  Close the digitize routine with a  9.

Put Box into New Layer

Go to the Put bar (up to Lines, down to Reshape, pick  PUT  on the Options pulldown).  Select the box 
and its contents with Select Polygon  (sp  on the bar) by clicking just outside the corners of the box (or 
use Select Box Within from the Select popup).  Be sure that the whole box and its contents redraw in 
yellow (some 400-500 lines will have been selected); if not, try it again.

Now put the selected lines into the SMPL.LN layer:  pick  put  from the bar, list the available maps 
from the form  (?  or click with the middle mouse button in the blank), and pick  SMPL.LN  as the 
receiving layer.  When you start the function with the  ok  button, ARC/INFO will interrupt to ask:

Coverage   / /TOUR/SMPL.LN
  already exists.  Do you want to append  <Y/N>  :

Respond by entering  y(es)  <Return> and the selected lines will be copied into  SMPL.LN.

Go back up to the Edit bar, choose  SMPL.LN  as the edit map, and save it  (cur map(ow))  on the Save 
pulldown).

Clear the Excess

The next step is to delete everything from the scan you have copied into  SMPL.LN  that will not 
become part of the geologic line work; that is, all attitudes, dip numbers, unit labels, and leaders.  Also 
remove queries, dots, and any other messy line elements that will better be traced from the original 
scan.

Work from the Reshape bar, and remember that it is easier to delete and trace than it is to repair 
complex messes produced by the scanning.  The fastest way to delete this material is to use Select 
Polygon (sp  on the bar) to enclose the target lines, then delete the selected set with  delete(S)  on the 
Options pulldown.  Cross any lines with the polygon that you want to retain (this version of Select 
Polygon is Within; see Selecting Map Elements, p. 73), gather modest groups of lines in each selection 
round, and don’t be delicate.  Repairs and tracing are easy.
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Edit the Lines

Once the debris is removed, you are ready to clean up the lines and tag them by line type.  Your goal 
is to edit the existing lines in the scan into simple, continuous line work with no superfluous nodes and 
with all junctions closed.

Go up to the Edit bar and put the original scan in the background  (CLP.SCAN17) with a distinctive 
color such as red (8) or light green (10).  Come back to the Lines bar and set the snapping for line 
editing (this step is important):

weed tolerance 0
intersectarcs ALL
arcsnap type ON
arcsnap distance .02     (inches)

nodesnap type CLOSEST
nodesnap distance  .02     (inches)

Go to the Reshape bar, turn the scan on in the background (arcs on), turn Node Errors on in the fore-
ground, and redraw the saved frame.  

Your problems in cleaning up the lines are basically five:  (1)  close gaps in lines,  (2)  combine line 
segments across pseudonodes,  (3) extend lines to make intersections, including with the bounding 
box,  (4) adjust intersections that were deformed by the line thinning (which preceded conversion of 
the scanned lines to vectors), and  (5) trace any missing or deleted lines.

Close gaps in lines by moving nodes (from the Nodes bar), by applying  dash to solid  (Reshape 
pulldown) where dashes are regular and gaps are relatively small, or by digitizing new line segments 
into the gaps (from the Digitize bar, and don’t worry about line type at this stage).

Add lines by tracing from the Digitize bar.  In this case you can set the line type appropriately, and 
then flag the line as tagged by coloring it  (set $symbol(S)  on the Draw menu).

Combine connected line segments (joined by pseudonodes) by selecting them and then applying  
combine arcs(S) (on the Split/Combine pulldown from the Reshape bar).  Because there will be no 
changes in line type across pseudonodes in this example map, you can apply  Combine Arcs  to the 
whole map occasionally by selecting all the lines first (use Select ALL on the Select popup menu).

Connect T intersections by selecting and extending a line  (both ends *  on the Extend pulldown, and 
click the distance to extend on the screen) or by moving the end of one line across the other line (move 
the node), letting Intersectarcs create the intersection, and then selecting and deleting the dangle.

Adjust intersections by moving nodes.

Consult Edit Lines (p. 135) as necessary to determine how the various editing functions work.

When you think that you are done, draw with node errors on and check for incomplete intersections 
and other dangles and for pseudonodes in any of the lines.

Be sure to save your work.
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Tag the Lines

Assign line types to the lines from the Digitize Lines bar.  Set the line type, use  sel,tag,color  on the 
Select pulldown, and tag and color each kind of line.  For this exercise, just use contacts and faults with 
the default modifiers, and conceal the faults beneath the landslide.

Be sure to save your work.

MAKE THE POLYGON LAYER

The polygon layer is made from the lines layer by first processing it to establish polygon topology 
from the lines and then tagging the polygons according to map unit.  This is a very simple process 
compared with making the lines layer.

Build for Polygons

To build the lines layer for polygons (actually you will use Clean at this stage), go up to the 
ALACARTE bar (be sure that you have saved your work on lines), and then down to the General bar. 
Pick  Clean  from the Topology pulldown, specify  SMPL.LN  as the input map and  SMPL.PY as the 
name of the output map.  Retain the ALACARTE-set values of 0 for dangle and fuzzy tolerance, and 
start the process with  ok.  This will take a minute or so.  (Because you started with a layer prepared 
for units as well as faults and contacts, the map already has a PAT and doe not need to be separately 
processed for units.)

Identify the Map Units

Tag the polygons from the Digitize (Areas) bar.  Draw the map with the scan in the background, set 
the line type, pick  dig,  and click in the label points.  You may want to use  Post attributers: on  to let 
you see the tags on screen as you proceed (see p. 25). 

Some of the unit labels in the original scan are difficult to read.  It isn’t important for this exercise, but 
the suite of units in the example area consists of Qal, Qls, Tp, Tme, and Te2.  You can zoom out a ways 
to help get a better perspective from the background scan.

Place one tagged label point in each polygon, regardless of its size.  When you are finished, save your 
work, go to the General bar, and build the map for polygons  (Build  on the Topology pulldown).  To 
help establish good practice, build into a new layer (call it  SMPL.PY2).

Test the result with Labelerrors, which will check for unlabeled polygons and those with multiple 
labels (see Edit Polygons, p. 171).  Pick  Labelerrors  on the Topology pulldown and specify the map 
name.  Watch in the dialog area to see the report.  If nothing is wrong, a single unlabeled polygon will 
be reported (the background polygon).

If more than that one polygon is reported, you have errors to correct.  Consult Edit Polygons for 
procedures.  Save your work and Build (or Clean) the map again after fixing any errors.

With a completed polygon layer, you may want to try coloring the units on screen, one by one (see 
Color Selected Polygons, p. 169).
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MAKE THE STRUCTURE LAYER

The structure layer contains such oriented structural symbols as bedding attitudes and lineations and 
any structural lines, such as fold axes and structure contours.  These lines are not included in the lines 
and polygons layers to avoid breaking up the polygons unnecessarily.  A new layer is prepared using 
the polygon layer as a template and the data are entered, typically by hand.  For this example, you will 
trace the attitudes that were included in the scan.

Prepare the Structure Layer

Go to the Setup bar and prepare a new layer for geologic structures called  SMPL.SR  with  SMPL.PY2 
as the template.  Include the save items.

Digitize Attitudes

Digitizing attitudes is done graphically after setting the Symbols Environment (see Oriented Symbols 
and Data, p. 179).  Got to the Edit bar, be sure the new structure layer is the edit map, the original scan 
is in the background, and add the polygon layer as a second background.  Then go to the Points bar, 
open the Digitize/Tag pulldown, and go to the Planar bar. 

Reset the lookup table to double-sized symbols:  pick  Choose lookup table  from the Set Symbols 
pulldown, list the options, and pick  CLP.ATT.LUT2X. Then draw the map with the scan and the geo-
logic lines in the background.  Nothing will draw in the foreground because there are no points entered 
as yet.

Enter the attitudes by tracing those in the background scan.  Set the point type for the kind of symbol, 
start the digitize routine, and click in the attitudes and enter the dips (see Enter Structural Data, p. 
183).  Take care to click the ends of the strike lines in the proper order, as it is inconvenient to correct 
errors.

If you do want to correct a mistake, back up with  oops  (seven times per attitude) or select and delete 
the offending point, go to the Annotation bar and select and delete the dip number on the map, then 
return to Planar Points and reenter the attitude.

Be sure to save your work.

MAKE THE ANNOTATION LAYER

The Annotation layer is strictly a graphic layer that contains unit labels and leaders and any other 
map-face text (dip and plunge numbers are left in the structure layer).  Graphic unit labels are created 
from the PTYPEs in the polygon layer and then edited, and any leaders or other text are added.

Prepare the Annotation Layer

Go to the Setup bar and prepare a new layer for  annotation + leaders  called  SMPL.AN  using  SMPL.PY 
as a template.  Then use  create unit annotation  on the New Layer pulldown to copy the PTYPE entries 
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from  SMPL.PY  into  SMPL.AN.  Keep the default feature type of  POLYGON, specify the source and 
receiving layers and PTYPE as the source item, accept the other default entries, and run the routine.  

Edit the Annotation Layer

Go to Edit, be sure that the new Annotation layer is the edit map, put the polygon layer in the back-
ground, and proceed down to the Annotation bar.  For this exercise, accept the default values in the 
Annotation Environment menu.  An Annosize of 0 produces a standard character size of .1 inch on the 
screen (and the height in map units thus depends on the current draw scale).

Turn arcs on in the background and draw the map (unit labels should draw in the foreground and 
geologic line work in the background).

You will also need to draw the attitudes in the background in order to arrange the graphic appearance 
of the map.  To accomplish this, go to the Symbols bar (pick  SYMB on the Annotation bar), and open 
the Points pulldown (pick  Pts).  Pick  draw cov in back  on the pulldown, and check on the popup 
menu that the current markerset and lookup table are  ALCGEOL.MRK  and  SMPL.SR.LUT2X.  If they 
are not, cancel the menu and set the markerset and/or the lookup table properly from the same 
pulldown.  Then go back to  draw cov in back,  specify  SMPL.SR  in the blank for structure layer, and 
click  ok.  Now when you draw, the attitudes will be displayed in the background.

Use  draw to scale  on the Zoom menu to draw the map at a two-fold magnification over map scale (see 
Set the Draw Scale, p. 181), and you are ready to edit the annotation.

Move, delete, or copy the unit labels to produce the desired appearance.  Go to the Digitize Lines bar 
and add any leaders that are needed.  

Try adding a name for a fault using an Annotype of  LINE  to place it along the trace of the fault (see  
Add and Edit Annotation, p. 187, for discussion of the procedure). 

Save your work.
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ALACARTE BASICS

System details, database formats, kinds of menus, and various techniques and operations are funda-
mental to the use of ALACARTE-ARC/INFO.  Refer to this section on ALACARTE basics as you are 
learning to use ALACARTE and then as questions arise.

System Details

You will need to know some basic details about your computer system in order to use ALACARTE 
effectively, particularly how to log in to your system, to move around in the directory structure, and to 
perform a few basic operations.  Your system administrator should supply you with a system account, 
a user name and password, and may offer basic training in the use of your specific computer system, 
terminals, plotters, digitizers, and printers.  Here we address basic system operation, hardware devices, 
the structure of ARC/INFO maps, and map workspace strategy.

ACCESSING SYSTEMS WITH ALACARTE-ARC/INFO

 ALACARTE runs under ARC/INFO version 5.0.1 on UNIX workstations and fileservers and on 
Prime minicomputers.  UNIX and Primos (the Prime operating system) use different commands, but 
the operations you need to perform and the directory structures are similar in the two systems.  Refer 
to the four Quick Reference charts (tables 1-4, p. 42-45) that summarize basics about UNIX, the vi 
UNIX text editor, Primos, and the Emacs Primos text editor.  
 

A normal ALACARTE session involves accessing the ALACARTE-ARC/INFO computer (host) 
from a workstation or terminal, starting ARC/INFO, and invoking ALACARTE.  The exact sequence 
depends on the type of device, how it is linked to the host, and whether the device and host both 
support a windowing system. The typical configurations are described below.  Your system adminis-
trator should be able to supply you with details. 

Single-User Workstation

When ARC/INFO runs on a UNIX workstation in single-user mode, it is accessed from the worksta-
tion console (display, keyboard and mouse attached to the workstation).  The ALACARTE startup 
sequence from a workstation console is as follows:

1.  Power up the workstation, if it is not already on, and let it boot (start up and display the login 
prompt).  Your system administrator may want to perform this step.

2.  Log in at the workstation console.

3.  Start the workstation’s windowing system:  Sunview on Sun workstations (not OpenWindows) 
or X-Windows/Motif on other workstations.  Your account may be configured to start the win-
dowing system automatically.
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4.  Optional: change directories to the workspace that contains your maps (you can also do this 
after starting ALACARTE).

5.  Start ARC/INFO and ALACARTE (see Starting ALACARTE, p. 46).

Multi-User Host

ARC/INFO can also be run on a remote, multi-user host where it can be accessed from a graphics 
terminal, from a graphics terminal emulator running on a PC, Macintosh or UNIX workstation, from 
an X-terminal, or from X-Windows server software running on a PC, Mac, or workstation.  These 
devices might be linked to the host by modem, direct serial connection, or local area network, typically 
Ethernet.  

Terminals:  ALACARTE can be accessed from those terminals supported by ARC/INFO that can 
display both graphics and menus.  These are Tektronix terminals with model numbers of 4105 and 
above (for example, 4107, 4207 and 4225) and terminals from other vendors that emulate them.  Most 
Tektronix terminals connect to host computers via a serial port either directly (hardwired) or through 
a modem or digital data-phone.  Some more recent Tektronix terminals can connect through built-in 
Ethernet interfaces.

Terminal Emulators:  Software that emulates Tektronix graphics terminals is commercially available 
for IBM PC and compatibles, Apple Macintosh, and various UNIX workstation computers.  
ARC/INFO (and therefore ALACARTE) specifically supports Grafpoint’s Tgraf07 emulator, which 
is available for PC’s, Macintoshes and UNIX workstations, and Synergy Software’s VersatermPro 
Tektronix 4105 emulator for Macintoshes.  Several other Tektronix terminal emulators work with 
ARC/INFO but are not specifically supported.  Isotek (The Bristol Group, Ltd) for Sun workstations 
emulates the Tektronix terminals numbered 4225 and below and is known to work with ALACARTE. 
Most of these emulators support both serial and Ethernet connections.

X-Terminals:  X-terminals connect to a host through Ethernet and display text and graphics under 
X-Windows.  ARC/INFO 5.0.1 supports X-Windows on most of the UNIX platforms for which 
ARC/INFO is available.  On Sun computers, however, ARC/INFO 5.0.1 runs under Sunview rather 
than X-Windows (OpenLook), and therefore X-terminals will not work with ARC/INFO on Suns.  If 
you plan to use an X-terminal, it is important that your system administrator configure your account 
for the various permissions and environment settings required.

X-Windows:  Just as there is software to emulate graphics terminals, software is available that dis-
plays X-Window graphics on networked PC’s and Macintoshes.  Check with your system adminis-
trator about appropriate software, network hookup, and configuration.  UNIX workstations that do not 
have a local ARC/INFO license can access multiuser ARC/INFO on a UNIX host (typically a fileserv-
er) over Ethernet and display the graphics on the workstation console.  The requirements are that the 
host have X-Windows software installed, that ARC/INFO runs under X-Windows on that host (that is, 
not Suns with ARC/INFO 5.0.1), and that the workstation is running compatible X-Windows that is 
properly configured.

36



The ALACARTE startup sequence for multiuser ARC/INFO running on a remote host is generally as 
follows:

1.  Make sure that your system (terminal, PC, Mac or workstation) is on and booted.  If you will 
be using an emulator or X-Windows server software, you will need to start it before connecting 
to the remote host.  If you will be using a workstation as a terminal or X-server device, you must 
login and start your emulation software or X-Windows system before making the connection to 
the host.

2.  Establish a connection to the ALACARTE-ARC/INFO host.  How this is done depends on the 
type of connection between terminal and host.  If the connection is by Ethernet (as would be 
typical for an X-terminal or emulation or for X-server software running on a networked PC, 
Macintosh, or workstation), then the  rlogin  or  telnet  command is used.  If a terminal is directly 
connected by serial lines, you simply log in.  If the link is by modem or digital phone system, 
then some local command is required to call the host.

3.  Optional: if the host is a UNIX system (other than Sun) and you are working at an X-terminal 
(or X-Windows server software running on a networked PC or Macintosh or a UNIX worksta-
tion), start the host’s windowing system.  ARC/INFO version 5.0.1 runs under Sunview on Sun 
systems, but only on workstation or fileserver consoles.  You must use a graphics terminal or 
emulator in order to access multiuser ARC/INFO 5.0.1 running on a Sun host.

4.  Optional: change directories to the workspace that contains your maps (you can also do this 
after starting ALACARTE).

5.  Start ARC/INFO and ALACARTE (see Starting ALACARTE, p. 46).

NOTES ON SYSTEM COMPONENTS

A variety of peripherals may be available at a site in support of digital map compilation.  These might 
include scanners, plotters, printers, and/or digitizers.  Your system administrator should have infor-
mation on what devices are available and how to access them.  Here we briefly discuss some of the 
issues related to the use of peripherals, describe a typical workstation configuration, and touch on 
working with local-area networks.

Scanners - Individual scanners vary greatly in their capabilities and use but they must, at a minimum, 
be able to scan and vectorize black-and-white maps and convert them into a format that ARC/INFO 
can import.  Other desirable features include raster-edit capability for scan-cleanup prior to vectoriz-
tion, the ability to scan color originals, and network hookup.  Some scanners are easily used, whereas 
others must be operated by specialists.  Scanning is available commercially; in fact, any degree of map 
automation is available commercially, from a simple scan to creating a complete GIS database.

Plotters - The best type of plotter to use depends on the purpose of the plot and the expense permitted 
in making it.  The simplest output is a screen-dump to a color or black-and-white dot-matrix  printer.  
Small, high-quality plots can be made on Postscript laser printers and high-resolution color inkjet 
printers that support one of ARC/INFO’s plotter formats.  Large-format plots are made on pen plotters 
or electrostatic plotters.  The speed and ability to color-fill makes the electrostatic plotter the preferred 
choice, where available.  Electrostatic plotting is also available commercially.  Pen plotters are useful 
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for simple check and line plots.  Color fill is possible with the judicious design of fill patterns and a 
ready supply of fresh plotter pens.

Digitizers - Access to a digitizer is desirable, although its use may be minimal if all maps are to be 
scanned or imported digitally from other systems.  A 24-by-36 inch digitizer will accommodate most 
standard USGS quadrangles.  Smaller digitizers can be used by not registering the whole map on the 
digitizer at at once (given the presence of sufficient internal registration tics), although this approach 
is less satisfactory for large and unwieldy maps.  Digitizers up to 40-by-60 inches with back lighting 
are available.  Digitizers can be used with UNIX workstations (attached to the serial port) or with 
terminals ( accessing ARC/INFO hosts over a phone system, direct serial connection, or Ethernet), but 
will not work with terminal emulators.  ARC/INFO works best with a 16-key digitizer puck.  Instruc-
tions for connecting a GTCO Digipad digitizer to a Sun workstation are given in the Appendix of the 
ALACARTE Installation and System Manual.  Procedures for other digitizers may be similar.

Terminal Emulators - Most emulators of Tektronix terminals work satisfactorily with ARC/INFO if 
properly configured, but a few issues should be mentioned.  A terminal emulator must offer overlaid 
dialog and graphics to work properly with ALACARTE menus.  On some emulators, the menus are 
transparent and allow the underlying map to show through the menu text.  This can make the menus 
very difficult to read, especially when they are displayed over a busy map. ARC/INFO is designed to 
work with a three-button mouse in conjunction with the keyboard SHIFT and CONTROL keys, in 
order to permit entry of single-digit numbers.  Be sure to determine how an emulator works with your 
particular mouse (which may have only one or two buttons), with mouse-buttons plus the SHIFT and 
CONTROL keys, or whether it requires keyboard entry of numbers.

X-Windows - X-Windows (X-server) software running on a PC, Macintosh or UNIX workstation 
gives you all the functionality of a terminal emulator plus the advantages of multiple windows, al-
though there are some limitations.  The systems must be connected over a network for satisfactory 
performance, whereas terminal emulators operate acceptably at 9600 baud over phone lines or serial 
cables.  X-Windows can only be used to connect to an ARC/INFO host that also runs X-windows and 
for which an X version of ARC/INFO is available and installed.  Prime computers and Sun systems 
running ARC/INFO 5.0.1 do not support X-Windows access.  (ARC/INFO 6.0 does run under X-
Windows on Suns).  X-Windows must be carefully configured to work.  This includes setting up 
permissions to authorize the ARC/INFO host to display graphics on your screen  (xhost  command), 
setting your environment to enable the host to send graphics to your workstation  (setenv DISPLAY 
command), and installing the required X-Windows libraries properly.  Additional setup may be re-
quired if you will access ARC/INFO from a machine of different architecture than the ARC/INFO 
host.  For instance, accessing ARC/INFO on an Aviion from a Macintosh running Mac-X may require 
aliasing fonts and other procedures.  Ask your system administrator for help.

UNIX Workstation - A typical configuration for a UNIX workstation running ARC/INFO would 
include:

Minimum processor speed of 16 MIPS;
Minimum of 16 MB memory, 32 MB better;
Large color monitor with excellent definition (cheap monitors may be hard to read);
Mouse;
Digitizer with 16-key puck, 24 by 36 inch size adequate for standard quadrangles (optional);
Printer, or access to one over a network;
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Additional items (attached to a stand-alone workstation or available over a network) that are important 
to efficient operation include:

Minimum of 1.0 GB hard disk space (unless few or small maps are to be worked on);
Tape drive, either 150 MB cartridge or 8MM Exabyte, for backup and loading software;
CD-ROM drive for loading software and data.

NETWORKING

If you work in a networked environment, then a basic understanding of how a network affects your 
work is helpful.  Networks are intended to be transparent to the user, but can be confusing at first. 
When one talks about networks and GIS, one generally means Ethernet running in a UNIX environ-
ment, although other types of computer systems have networking thatmay operate in a similar fashion. 
 A simple example of network use is in printing from a computer in one room to a printer in another.  

Another common network function is fileservice, making hard-disk storage on one machine accessible 
to other machines over the network.  Any UNIX workstation is capable of providing fileservice, but 
larger systems (called fileservers) with many hard disks are more commonly used.  Fileservice is 
provided by mounting a fileserver disk or portion of a disk onto your own system.  You may not even 
know which of the directories on your machine are local and which are remote.  You change to and 
use directories in the exact same manner, irrespective of their physical location.  The UNIX df com-
mand will report your disk configuration (along with other information).

A further consideration is the system on which you actually run ARC/INFO and ALACARTE.  If you 
have an ARC/INFO license on your workstation, then you start ARC from the system prompt of that 
machine.  If you do not have a local license, then you must log in to the ARC/INFO host, probably 
your fileserver, in order to run ARC.  You must be running X-Windows or a terminal emulator on your 
local machine for this type of access.  Because map files can be physically located on any machine, it 
is possible to run ARC/INFO on a fileserver but access maps on your workstation’s local hard disk.  
Or, more commonly, you may run ARC/INFO on your local workstation and access maps located on 
the central fileserver.  If this is confusing, ask a knowledgable user to sit down with you as you 
experiment with logins, changing directories, and running ARC/INFO.

USING ARC/INFO REVISION 6.0

The use of ALACARTE with ARC/INFO 6.0 is still experimental and is not recommended for normal 
work.  ALACARTE is designed to run under ARC/INFO Revision 5.0.1 and limited testing under the 
preview version of ARC/INFO 6.0 on a Sun workstation shows that there are some problems and 
limitations, although much of ALACARTE does operate properly.  Close menus by clicking on the 
normal ALACARTE close menu items (for example,  ^EDIT,  or  close menu) not by pulling the menu 
push-pins. ALACARTE has no specific code for this function and pulling a pin may hang the menu. 
Some ALACARTE functions will not operate properly because of differences in syntax between Rev. 
5.0.1 and 6.0.  When an execution error is encountered, it can be difficult to determine whether 
ALACARTE is still running.
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WORKSPACES AND MAP FILES

ALACARTE-ARC/INFO maps consist of one of more map layers (termed coverages in the 
ARC/INFO user manuals) that are organized into map directories called workspaces.  Each map layer 
consists of two components in the workspace directory, the map-layer subdirectory, and the layer’s 
database tables in the INFO subdirectory.  These two components are managed as a single unit by the 
ALACARTE-ARC/INFO management commands (see below) and must never be manipulated di-
rectly with system file and directory commands.

The name of the subdirectory for a map layer is that of the layer itself, typically an abbreviated quad-
rangle or sheet name followed by a filename extension indicating the type of layer (see Layers in 
Compiling a Digital Map, p. 11, and Steps in Preparing a Map, p. 85).  Several files containing map 
features and coordinates and one or more ALACARTE files are located in the map layer subdirectory. 
Attribute tables for all map layers in a given workspace are located under the single INFO directory 
within that workspace.  These tables are used in many ALACARTE operations and can be directly 
accessible from the INFO command line.  Most operations do not require direct use of INFO, how-
ever, and users are cautioned that data files can be damaged easily.  A log file in each map-layer 
subdirectory records the ARC commands used on the layer and the dates of their execution.

All the layers for an individual quadrangle map should reside in the map’s workspace.  More than one 
version of each layer may be present as backups;  these should be numbered consecutively and ar-
chived and/or killed as soon as they are no longer needed.  Only a single ALACARTE-ARC/INFO 
user should work in a given workspace at a time or else serious problems can result, because INFO is 
a single-user system.  A workspace log file records all ARC commands run on layers in the workspace. 
Related workspaces should be organized into map-sheet or project directories. 

ARC/INFO always operates on a temporary copy of your map.  Many temporary files are automati-
cally created and deleted during the course of an ARC session.  If ARC/INFO crashes, some of these 
files may be left behind.  If you don’t delete these files, you can try to recover the lost edits by running 
 restore an edit session  (on the Files pulldown from the General bar).  Also, never delete temporary 
files from a workspace in which someone is working: it will crash their session!  Temporary files can 
build up in a workspace over time, however, and should be deleted.  Their names always begin with 
xx on UNIX systems, where they can be deleted with: rm xx*.  On Primes their names start with T$, and 
they are deleted with: delete t$@@ -nvfy.  You can create a UNIX alias for deleting temporary files by 
adding the following line to the .cshrc file in your home directory:

alias purge ’rm xx*’

The corresponding abbreviation on a Prime is created by entering the following command:

ABBREV -ADD PURGE DELETE T$@@ -NVFY

Typing purge will then delete all temporary ARC/INFO files in the current workspace.  If you abort 
ARC with the system break (CONTROL-C on UNIX systems or CONTROL-P on Primes), no tem-
porary files are left behind and you cannot restore an ARC/EDIT session.
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WORKSPACE MANAGEMENT MENUS

ALACARTE provides functions (on the Files pulldown from the General bar) for managing map 
layers and workspaces:

Copy Use this function to copy a map layer into another workspace.  Do not use the 
system copy command (cp on UNIX, COPY on Prime) to copy map layers be-
cause it does not copy all the components of a map layer.

Rename Use this to rename a map layer.  Do not use the system rename command (mv 
on UNIX, CNAME on Primos) because it does not rename all the components of 
a map layer.

Kill Use this to delete a map layer from a workspace.  Do not use the system delete 
command (rm on UNIX, DELETE on Primos) because it does not delete all the 
components of a map layer.

create workspace This creates a new map workspace (directory).  

rm  -r    (UNIX) Use the system Delete Directory command to delete an entire workspace or an 
DELETE  (Primos) entire project directory; exercise caution, however, to ensure that you specify 

the correct directory and that all files have been properly archived first.

cp  -r   (UNIX) Use the system Copy command to copy entire workspaces.  Afterwards you  
copy   (Primos) must use the ARC Externalall command to reset some database pointers (see 

below).

externalall This executes the ARC command to reset database pointers after a workspace 
has been moved, restored from tape, or copied across a network.

Copy ALC files This copies ALACARTE files stored in a map layer subdirectory to another 
map layer.  These are the files whose filenames end in .alc, and include the 
projection file(s), the setup file, and any custom tagging menus.  This step may 
be necessary after executing certain ARC commands at the command line that 
create a modified copy of a map layer, but which do not properly copy the 
ALACARTE files.  If you need to create a setup file for a map use  copy setup 
file  (on the Options pulldown from the Setup bar) or  use setup  (on the Save 
pulldown from the Edit bar).
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Table 1.  Primos Quick Reference

Logging in and out:

OK, login username (OK,  is Prime system prompt on most systems)

password? yourpassword (your password is not displayed on screen)

OK, logout

CONTROL-P Break (if process hangs)  Hold down Control key and press the p key

ice Reset after crash, places you in home directory

Basics:
Primos is case insensitive (either caps or lowercase are ok).  INFO is case sensitive, generally all caps.

Filenames are free-form (may include periods, underscores) but must start with a letter, not contain @ or % or =

Pathnames take the form: <disk>partition>userdirectory>subdir>.....>filename         (<disk> may usually be omitted)

For example:      <user3>gis3>tfjordan>arcmaps>worldmap

A pathname may be substituted below where ever filename appears.

When you log in you are placed in your user or home directory, tfjordan in the example above.  You move to other 

directories with the following commands:

up move up in directory structure down dirname move down to named directory

attach path move directly to dir specified by path or        places you back in your home or origin directory

ld list directory slist filename list file to screen (screen list)

spool filename print file to system printer

create dirname create subdirectory dirname

delete filename delete file or subdirectory name (don’t delete ARC/INFO maps this

way;  use the ARC KILL command, or see ALACARTE General menu)

cname old new change directory name  or file name from old to new (don’t change the name of ARC/INFO maps this

way;  use the ARC RENAME command, or see ALACARTE General menu)

copy old new copy file or directory old to path new (don’t copy ARC/INFO maps this

way;  use the ARC COPY command, or see ALACARTE General menu)

@ wildcard, e.g., delete   @.aml

deletes mynew.aml but not my.new.aml

@@ wildcard, e.g., delete   @@.aml deletes anything.aml including my.new_great.aml.  

delete @@ deletes everything in current directory

use delete  t$@@   -nvfy to delete all temporary ARC files w/o verify prompts

>== means to retain original names, e.g.,   copy   @@.aml   gis3>tfjordan>newamls>==

copies all amls in the current directory to the newamls dir keeping their original names

*> denotes current directory, so that 

copy   help.txt   *>helpdir>== 

copies help.txt file to a dir named helpdir in the current directory. 

help command provides online help for  command, for example: 

help slist
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Table 2.  Emacs Prime Editor Quick Reference

Emacs is a screen editor available on most Primes as well on many other systems.  The minimal Emacs commands needed 
to create and edit files are given below.  Ask your Prime system administrator if Emacs is available, if special 
abbreviations have been created to access it, and for more information on advanced Emacs commands.

Emacs is normally configured by the ALACARTE-ARC/INFO system administrator to be accessible from ’screen edi-
tor’ on the ALACARTE commands menu (which is displayed by clicking on the left-most item on any 
ALACARTE bar menu).  Emacs commands may be entered in either upper or lower case.

emacs filename -ttp vt100 filename may be new or existing. -ttp vt100 specifies a vt100 terminal (typical  spec-
ification for Tektronix graphics terminals.  See your system administrator for specific 
Emacs terminal information).

CONTROL-L redisplay text.  If you are using a Tek terminal and you get gibberish the terminal is 
probably not in ANSI (text) mode.  Press the SETUP key on the terminal, type CODE 
ANSI, press the SETUP key again, then press CONTROL-L to redisplay the text.  The 
text should now be displayed normally.

Once emacs has started up you may simply start typing.

arrow keys position cursor with the terminal arrow keys or, if these don’t work on your terminal, 
use:

CONTROL-Z up CONTROL-N down

CONTROL-B left CONTROL-F right

CONTROL-A move cursor to beginning of current line

CONTROL-E move cursor to end of current line

CONTROL-V move down one screen

Esc V move up one screen.  Press the Escape key, release it, and then press V.

BACKSPACE delete character to the left of the cursor

CONTROL-D delete character at the cursor

CONTROL-K delete (kill) current line

CONTROL-X S save and exit Emacs.  Hold down the CONTROL key and press X, release both and  
then press the S key.

CONTROL-X CONTROL-C quit Emacs without saving  First enter CONTROL-X (hold down the CONTROL key 
and press X) and then enter CONTROL-C.
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Table 3.  UNIX Quick Reference

Logging in:

login: username

password: yourpasswd Your password is not displayed on the screen.

% % is the standard UNIX csh (c-shell) prompt.  (Note, ARC must be run in csh)

Logging out:

%CONTROL-d    Hold down Control key and press the d key, or

%logout Some systems require typing logout rather than CONTROL-d, or

%exit exit always works as logout command.

CONTROL-c Break (if process hangs).  Hold down Control key and press c-key

UNIX is case sensitive.  Almost all commands are lower case.  UNIX comes in two flavors, BSD or Berkeley UNIX (Suns) 
and AT&T UNIX (Aviions).  The commands given here work on both except as noted.

Filenames are free-form but shouldn’t contain special UNIX characters.  Recommend sticking to upper and lower case 
letters, numbers, period, underscore.

Note:  The names of ARC/INFO coverages, workspaces and AML’s must be lower case.  They may be given in either 
upper or lower case from within ARC/INFO as ARC performs case conversion for you.  INFO itself is case 
sensitive such that INFO filenames are generally all caps.

Pathnames take the form: /home/tfitz/arcstuff/mycoverage,  where the first / refers to the root or top level directory.  A 
pathname may be substituted below where ever filename appears.

When you login you are placed in your user or home directory,   tfitz in the example above.

cd /home/pst/mydir change directory to mydir specified with absolute pathname from the root dir /

cd dirname change directory to a subdirectory in my current directory

cd change to my home (login) directory

cd .. cd ../.. go up one directory, go up two directories

ls (ls -c) ls -l list directory contents BSD UNIX (AT&T UNIX), long listing (both UNIX flavors)

pwd display name of current directory (print working directory)

more list contents of text file page-by-page to screen, advance with spacebar or Return, q to quit

lpr filename print file to lineprinter

mkdir dirname create subdirectory dirname in current directory

rm filename delete file filename

rm -r dirname delete directory dirname (don’t delete ARC/INFO maps this

way;  use the ARC KILL command, or see ALACARTE General menu)

mv oldname newname change name of file or directory or move it to new directory if different directory is specified 
with newname  e.g.  mv olddir /home/myname/newdir   (don’t change the name of ARC/INFO 
maps this way;  use the ARC RENAME command, or see ALACARTE General menu)

cp oldname newname copy file oldname to newname.  May include complete pathname

cp -r olddir newdir copy directory oldir to newdir.  (don’t copy ARC/INFO maps this way;  use the ARC COPY 
command, or see ALACARTE General menu)

passwd change your password 

* wildcard for filenames, e.g. *.*  *.aml  *

? wildcard for character in filename, e.g. cov? could refer to cov1, cov2, etc.

man command where command is any UNIX command.  UNIX help.  man ls gives help page on the ls 
command.
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Table 4.  vi UNIX Editor Quick Reference

vi is the standard UNIX screen editor (pronounced vee-eye; stands for visual editor), equivalent to Emacs on many other 
systems.  It may be complex if used to its fullest extent, therefore recommend that you restrict yourself to these 
minimal commands at first.  If you are using a workstation console you should have access to a mouse-driven 
window-based editor;  if so, use it!

vi is normally configured by the ALACARTE-ARC/INFO system administrator to be accessible from screen editor on 
the ALACARTE Commands menu (which is displayed by clicking on the left-most item on any ALACARTE bar 
menu).

vi filename filename may be new or existing.  You are placed in "command" mode

arrow keys when in command mode position cursor with the terminal arrow keys  or, if these don’t work 
on your terminal, use:

k up j down

l left h right

i insert text starting at cursor location.  I.e. press i and start typing.

or
a appends after current cursor position.

Esc escape key to end insert mode and return to command mode

x in command mode, deletes character under cursor

dd in command mode, deletes current line

: colon in command mode moves you to command line at bottom of screen with colon prompt 
for file manipulation commands:

:wq write file and quit vi

:w write file and continue

:w filename write file to existing or new filename

:q quit vi after saving edits

:q! quit and do not save edits

You are returned to command mode following each file manipulation command (unless the 
quit command is given).

Summary:

Start vi with specified file

You are now in command mode.  Position cursor, delete characters or lines, etc.

Insert or append once you have positioned cursor.  Terminate insertion and return to command mode with Esc

Press colon when in command mode in order to save and exit, quit without save or perform other file manipula-
tion operations.  

Remember, there are many more commands and some people actually like vi!?!
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Starting ALACARTE

You are ready to start ALACARTE once you have a terminal from which to work, have access to 
ARC/INFO and ALACARTE on the host computer, know how to log in and move through the direc-
tory structure, and know how to leave the host computer and close down your machine.

Begin by turning on your machine (start your terminal emulator) and calling the host computer.  Log 
in to the account containing your map directory and go down to the directory containing the map that 
you want to work on.  For your first exploration of ALACARTE, use the demonstration directory 
called Tour.  Just how you perform these operations depends on your particular system (see System 
Details, p. 35) and will require information from a colleague or the system administrator.  If no Tour 
directory is available, begin in your home directory and copy the Tour directory into it, as described at 
the end of this section.

Start ALACARTE from the system prompt by typing arc <space> alacarte followed by a carriage 
return (<return>):

systemprompt:    arc  alacarte

This command starts ARC/INFO and ALACARTE together and assures that when you quit 
ALACARTE you will be returned to the system prompt in your host computer.  There may be other 
commands available in your system to start these programs (such as an abbreviation), but this method 
should always work. 

SETTING THE DEVICES

Once ALACARTE has started, the first step is to tell it how to communicate with your machine.  Later 
you can save a station file to provide this information, but initially you must specify the various 
devices and settings individually, using both the keyboard and some popup menus (see Using the 
Menus p. 59).

After the version of ALACARTE that you are running is reported, you will be asked if you want to 
specify a station file by which you can describe your equipment and desired settings automatically for 
ALACARTE: 

Enter station name, if any, (do not include the stat prefix),
       <RETURN> = NONE,        ? = list,      q=quit:

If you have already saved a station file, or if there is a standard one for the station at which you are 
working, enter the name of the station file here (that is, type in the name and hit <Return>).  
ALACARTE will bypass the Devices sequence, characterize your station automatically, and then 
display the first bar menu (Alacarte).  If you can’t remember the name of the station file that you want, 
enter  ?  to list the custom station files in the current directory and the standard files in the ARC/INFO 
stations directory. The latter contains such standard stations as 4207 (for a Tektronix 4207 or equiv-
alent) and 9999 (Unix workstation).  ALACARTE searches for the station file first in the current 
directory and, if it is not found there, looks for a standard file of the same name.  If the station file is 
not found, the Devices sequence starts automatically.
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If you don’t want to specify a station file, simply hit <Return> at the station prompt to start the Devices 
sequence.  ALACARTE will ask you a series of questions about the devices that constitute your 
station.  These must be specified before you can reach the first bar menu in ALACARTE, but they can 
also be changed later from within ALACARTE.

First, what  kind of terminal are you using?

Please enter your terminal type,  <RETURN> = 4207,  h = HELP:

Enter the code for your terminal (table 5) or use the default (<return>) to specify 4207, indicating a 
Tektronix 4207 terminal or equivalent.  ARC/INFO and ALACARTE support many terminals (and 

47

Table 5.  Graphics terminals/displays supported by ALACARTE

Terminal Description

 100 Selanar HiREZ 100XL

 220 DEC VT220 with Selanar SG220 Graphics Board

 250 GraphOn GQ-250

 550 Visual 550

4105 Tektronix 4105

4107 Tektronix 4107

4109 Tektronix 4109

4111 Tektronix 4111

4125 Tektronix 4125  Note:  Only newer or enhanced 4125 terminals are 
supported.  See ARC/INFO release notes for details.

4205 Tektronix 4205

4207 Tektronix 4207

4208 Tektronix 4208

4208BW Tektronix 4208 with menus in B&W instead of blue and white

4209 Tektronix 4209

4211 Tektronix 4211

4224 Tektronix 4224

4225 Tektronix 4225

4235 Tektronix 4235

4236 Tektronix 4236

4237 Tektronix 4237

4324 Tektronix 4324

4325 Tektronix 4325

4335 Tektronix 4335

4336 Tektronix 4336

4337 Tektronix 4337

TGRAF07          IBM PC or Mac using Tgraf07 or TNet07 4107 emulator

Versaterm or v Apple Macintosh using VersaTerm Pro 4105 emulator

9999 or WS       Any UNIX workstation (e.g., Sun, DG, Tektronix, X-Terminal)

OTHER            Terminal/display device other than above



emulators) that permit display of menus and color graphics.  Enter  h  (for help) to list both the sup-
ported terminals and the codes with which to specify them at this prompt.  Because ALACARTE 
tailors the sequence of device questions to the responses, some of the following details are specific to 
this first response (here assumed to be 4207).

How do you want to pick menu items from the screen?

Using one of the devices listed below, you will move a cursor (crosshairs) on the screen until it is 
positioned over the menu item and then click with a mouse button or the space bar.  This question asks 
you to specify which device you will use:

Enter device used to pick menu items: m, c, or t
M(mouse),  C(ursor, = joydisk),  or T(ablet, = Tek 4957),  <RETURN> = mouse: 

To answer, enter the appropriate letter code (m,c, or t), or just hit the return key to pick the default.  
Because the best choice for a Tektronix 4207 is the mouse, that is offered here as the default.

The system now has enough information to present menus on your screen.  From here on, any question 
for which the possible answers can be anticipated will be asked in the form of a menu.  

What kind of digitizer are you going to use, if any? 

Choose your digitizer type -  Pick your digitizer or pick   NONE.
NONE -  pick  NONE  where no digitizer will be used in the session.

Altek AC90C/40C
Digicon (metal puck)
GTCO Digipad 5
HI HIPAD
 " 1 button cursor
Summagr.  Bit-Pad 2

  "   1  button cursor
Summagr.  ID-2
Talos/CalComp 600
Talos/CalComp 2000
Talos/CalComp 8000
Talos/CalComp 9000
Talos/CalComp 9100
Talos/CalComp dual
Talos/CalComp Wedge
Tek 4957 + 4208
Tek 4958
Tek IGL LOCATE
OTHER -  enter digitizer type (no validation by ALACARTE).

HELP

If  you won’t be using a digitizer at all in this session, but instead plan to work entirely on the screen, 
answer  NONE.  Do this by moving the cursor (cross hairs) that has now appeared on your screen over 
the appropriate word(s) on the menu and then clicking with the left mouse button (or with the space 
bar, if you have no mouse).  If you want to work partly on the screen and partly from a digitizer, you 
can specify the digitizer here or do so later from the Devices bar.
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If you do indicate a digitizer, you will be asked how the digitizer is connected (the number or name of 
the serial port);  pick  0  unless your system administrator has indicated otherwise:

Choose digitizer tty line
0 (typical) -  usually the correct line.

OTHER -  specify digitizer tty line from the keyboard.

UNKNOWN -  close the menu with no tty line specified.

HELP

On UNIX workstations this may be a serial-port device such as  /dev/ttyb  (pick  OTHER  and enter at 
the prompt).

How do you want to specify map locations (map coordinates):  

Pick coordinate input method
mouse -  preferred method to control on-screen crosshairs.

cursor -  use where mouse is not available.

digitizer -  pick only for input from a digitizer.

keyboard  (coords typed in)  -  not installed in version 1.0 of ALACARTE.

tablet -  Tektronix digitizer tablet or equivalent.

The method used to specify map locations need not be the same as that used to pick menu items.   And 
even if you have specified a digitizer, you can select  mouse  as the input device here, and change to 
digitizer input later (using  change coord device  on any Options pulldown or on the Map pulldown 
from the Edit bar).  This question is tailored to earlier responses.  For working with a 4207,  mouse  is 
the best choice.  If you had specified a 4107 initially, the mouse option would be omitted here because 
the 4107 has no mouse.

Once the devices are specified, you are presented with the Alacarte menu bar, from which you can 
proceed to whatever part of ALACARTE that you want to use.  (For a description of how to leave 
ALACARTE, see How to Quit, p. 15). 

Copy the Tour Directory

If you want to copy the example Tour directory into your current directory, proceed as if you were 
going to run the ALACARTE demonstration.  Open the Commands menu from the ALACARTE bar 
(click on the bar name,  [Alacarte])  and pick  alacarte demo  from that menu to open the Demonstration 
forms menu.  Pick the Copy Tour button in the forms menu:

copy tour directory to current directory:  copy tour

The Tour directory will be copied from the ALACARTE directory into your current directory and this 
new directory will become the current workspace.  You can then start the Demonstration or close the 
forms menu  (cancel)  and experiment with ALACARTE directly. 

CHANGING THE DEVICES 

The device settings can be changed within Alacarte at any time.  You can change the coordinate input 
device from on-screen crosshairs to a digitizer or from the digitizer back to the screen from any Op-
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tions pulldown in the Edit section.  Simply open the pulldown (click  Op  on the bar), pick  change 
coord device,  and then pick the new device from the Coordinate Device menu that follows.

Any of the devices can be changed from the Devices bar, which is reached from any Commands popup 
menu.  Open a Commands popup by picking the bar name (menu item at far left on every bar), pick  
DEVICES  from the popup to go to the Devices bar, then pick  Devices  to open the Devices pulldown. 
The relevant parts of this menu are:

show devices -  list the current device settings.

station -  reset devices to those previously saved as a station file. 
save station (described below in Saving a Station File)

terminal -  specify a terminal type. 
display:
  set to term - set display device to match the presently specified terminal.

  other display -  specify a display device name and a display option if desired.

digitizer -  specify digitizer from popup menu (or enter from  other). 
coord device -  pick method of entering map coordinates from popup menu. 

fastmouse -  make crosshairs more responsive to mouse movements (terminals only).

fastdisk -  make crosshairs more responsive to joydisk movements (terminals only). 

From this menu you can list the current device settings, reset the devices with a station file, or make 
individual changes in the devices.  These individual options are like those already described under 
Setting the Devices (p. 46), except that Terminal and Display are separated.  When you set the terminal 
in the Devices start-up sequence, the display is automatically set to match.  Here, in contrast, you must 
set both the terminal (which controls presentation of menus) and the display (which controls presen-
tation of graphics): after setting the terminal, use  set to term  to make the display match the current 
terminal setting, and use  other display  to set the display in some other fashion.  This alternative may 
be desirable, for example, to improve the performance of some emulators or to avoid opening the 
graphics window in Edit on workstations (enter 0 as the display number).  Such special settings can be 
saved in a station file for repeated use (see below).

The speed at which the crosshairs move on the screen of a Tektronix terminal can be increased for 
more efficient work:  use  fastmouse  for terminals with a mouse and  fastdisk  for a 4107 or other 
terminal with a joydisk. 

SAVING A STATION FILE

The current device settings in ALACARTE can be saved as a station file from the Devices bar.  Pick  
save station  from the Devices pulldown and then enter a name for the station file at the prompt in the 
dialog area.  Keep the name short, simple, and specific.  The station file is saved in the current direc-
tory, which means that you must be in that directory in order to use it.  To change a station file, simply 
overwrite it by saving new settings with the same file name.

Use such a station file to set the devices automatically.  This can be done at the station prompt that is 
presented when you first start ALACARTE or at any time from the Devices bar.  Although the name 
of the station file will have been recorded with a standard prefix (stat_ or stat-) that will be included in 
the name if you list it, omit that prefix when you enter the file name at the station prompt.
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Features of Maps

ALACARTE maps are composed of three principal kinds of features  --  lines, areas (polygons), and 
points  --  that are separately entered and recorded in ALACARTE - ARC/INFO.  Each map element 
is uniquely identified in the database by number and its position is recorded with x,y values in the 
coordinate system of the map.  Essentially unlimited information can be attached to each map element, 
although the content of the primary database should be limited to speed processing.  The elements 
recorded in the map database serve in effect as cartographic templates to which symbols are assigned 
at the time of on-screen display or plotting.  Map-face text (annotation) can also be included, but 
without database attributes, and uniquely numbered digital tics provide the initial geographic 
registration.

Elements can be entered in the map database directly by digitizing on the screen or from a digitizer.  
ALACARTE supports the concurrent tagging (attributing) of the elements according to the current 
[line, area, point] type, which is set by picking from menus or by entering from the keyboard.  Existing 
elements can be selected on screen or from the digitizer and then tagged (or retagged) and can be 
selected according to the recorded tag.  Polygons are identified in Edit by their label points, although 
the Select Outline function can be used to select closed polygon boundaries.  Lines can be entered by 
importing scans to be edited and tagged, and all three types of elements can be imported as digital files 
from other systems, including tabular text files that include location (x,y).

Data associated with selected elements can be entered, viewed, or modified in the database form once 
the needed database items (fields) have been established.

Annotation can be entered from either the screen or a digitizer or can be created from entries in a 
database item.  Like digital tics, annotation cannot have information attached to it in the database.

TICS

Digital tics provide the geographic registration for a map.  They can be assigned geographic locations 
automatically when a map is started from the Setup bar or individually by working directly in INFO.  
Tics are automatically placed at arbitrary locations in imported scans during conversion into 
ARC/INFO.  These tics are then moved on screen by hand to the location of graphic registration marks 
in the scan to control transformation of the scan into a framework of projected tics (see Map Regis-
tration, p. 115, and Projections, p. 101).

A minimum of four digital tics is needed in a map.  When a regular quadrangle is started from the 
Setup bar (see Start a New Map or Layer, p. 93), ALACARTE automatically generates digital tics at 
the four map corners once you have specified the latitude and longitude of the southeastern corner.  
These tics are numbered clockwise from that specified corner.  Internal tics can also be included 
automatically as an option (see Projections, p. 101, for numbering scheme).  The tic framework of an 
existing map can be copied to form the framework of a new layer.

Digital tics can be added to a map (digitized), selected, deleted, moved, and renumbered.  The tic 
number ($ID number) is the only information other than location that can be assigned to a tic.  Because 
ARC/INFO will not tolerate duplicate tic numbers in a map, adding tics with duplicate numbers to a 
map (by digitizing, for example) will delete the existing tics with those numbers.
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LINES

Line segments (termed arcs) are defined by a series of points with x,y locations that are connected by 
straight lines (vectors).  These control points are termed vertices; the vertices at the beginning and end 
of each line segment are termed nodes.  Nodes are automatically placed at line intersections by 
ARC/INFO, and otherwise continuous lines (no intersections) can be broken with pseudonodes to 
mark changes in attribute, such as line type (contact or fault, for example).  Hanging nodes at uncon-
nected ends of lines are termed dangles.  Lines have a direction and therefore a right and left side, 
which are used in maintaining topologic relations in the database and in plotting such asymmetric line 
symbols as queries and thrust teeth.  All line segments are continuous in the database, regardless of the 
intended line symbol, which is a graphic aspect addressed at the time of plotting.

Lines can be entered by hand digitizing or by importing scanned line work and editing on screen.  
Lines are tagged automatically during digitizing or during hand editing by applying the current line 
type, which can be set from standard or custom menus or from the keyboard.  The shape and position 
of lines can be modified in a variety of ways (working from the Reshape bar), both internally by 
redefining vertices and externally by moving or rotating one or more line segments together.  Indi-
vidual line segments can be split and segments that are joined at pseudonodes can be combined.  Arcs 
are limited to a maximum of 500 vertices.  ARC/INFO will refuse to combine two arcs having more 
than 500 vertices and in digitizing creates a pseudonode at 500 vertices and automatically starts a new 
arc.

The database for lines (arc attribute table, or AAT), automatically records the following information:

fnode# -  identity of the from node (beginning of line).

tnode# -  identity of the to node (end of line).

lpoly# -  identity of the polygon to the left of the line.

rpoly# -  identity of the polygon to the right of the line.

length -  length of the line in map units.

[map name]# -  unique internal number assigned automatically by ARC/INFO.

[map name]-ID -  user ID number (=  $ID), assigned by ARC/INFO or controlled by user.
 

Additional database items typically added in ALACARTE include:

LTYPE -  line-type tag recorded by ALACARTE.

SEL -  item used to save a selected set.

SYMB -  item used to save symbol assignments (such as color).

LTYPE is the default item in which the line tag is recorded by ALACARTE.  LTYPE is automatically 
added to the AAT for the map when it is started in Setup and lines are specified or when a scan is 
prepared there for lines, and it and any other item can be added to a map database (to the AAT).  SEL 
and SYMB can be added automatically during setup or separately later.  The lines database can be 
viewed on screen and entries can be viewed or modified from the database form.

Plotting symbols for lines are of two principal types:  (1) the simple, continuous lines used on screen 
for editing, to which colors can be assigned and saved for restoration after saving or in a new edit 
session, and (2) standard geologic line symbols that are assigned as a function of line type for hard-
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copy plotting (see Symbols, p. 197).  These geologic line symbols are not generally used on screen in 
editing (but see the first color frame in the ALACARTE demonstration).  They maintain a constant 
size in both on-screen and hard-copy plotting, regardless of the scale of presentation.

POLYGONS

A polygon consists of a closed figure of lines and is identified by a label point located within that 
closed perimeter.  Polygons are created initially by entering the lines that form their perimeters, but are 
not recognized by ARC/INFO until a processing step (Build or Clean) has been run for polygons.  The 
perimeters of individual polygons (including internal boundaries, or "island" polygons) are limited to 
10,000 arcs.   Exceeding this limit around the boundary of any one polygon in a map can block the use 
of such bulk processes as Build.   

The ends of line segments that constitute the perimeter of a polygon must close precisely.  If the 
perimeter is even minutely incomplete, ARC/INFO will not recognize it as a separate polygon.  Clo-
sure can be accomplished during digitizing by setting the snapping properly (see Snapping and Other 
Controls, p. 123) and taking care in placing the ends of lines.  Small gaps in existing lines can be 
closed by hand editing or in bulk process (see Edit Lines, p. 135).  It can be difficult to assure during 
line editing that all polygon boundaries are closed, particularly in complex maps, but several methods 
are available to find and fix broken boundaries later during polygon editing (see Check Labels, p. 165, 
and Edit Polygons, p. 171).

Label points for polygons can be entered from the screen or from an annotated plot or an original 
mounted on a digitizer.  During digitizing, the label points are tagged automatically with the current 
area type, which can be set from the keyboard or by picking from a custom menu of map units (see 
Digitize and Tag, p. 162).  Alternatively, the Createlabels function can be used to place a label auto-
matically at the centroid of each valid polygon, and these labels can then be selected on screen and 
tagged (see Tag Existing Labels, p. 164).  Once present, label points can be selected and retagged, 
moved, or deleted.

The database for polygons ( polygon attribute table, or PAT), automatically records the following 
information:

area -  area of the polygon in square map units

perimeter -  length of the perimeter of the polygon in map units

[map name]# -  unique internal number assigned automatically by ARC/INFO.

[map name]-ID -  user ID number (=  $ID), assigned by ARC/INFO or controlled by user.

Additional database items typically added in ALACARTE:

PTYPE -  area-type tag (polygon type) recorded by ALACARTE.

SEL -  item used to save a selected set.

SYMB -  item used to save symbol assignments (such as color).

PTYPE is the default item in which the area tag is recorded by ALACARTE.  It is automatically added 
to the PAT for the map when it is started in Setup and polygons are specified or when a scan is 
prepared there for units, and it and any other item can be added to a map database (to the PAT).  SEL 
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and SYMB can be added automatically during setup or separately later.  The polygon database can be 
viewed on screen and entries can be viewed or modified from the database form.

Polygons in maps that have been built and not further edited can be filled on screen with solid colors 
and a limited set of colored lines as a function of area type.  The label points can be assigned a variety 
of colored symbols that can be saved for restoration after saving or in a new edit session.  In hard-copy 
plotting, possible area fills are limited only by the plotting device, except that only a small variety of 
overprints (shadeset patterns) are available in ARC 5.0.1.

POINTS

Points are defined by an x,y position on the map and are entered by clicking the position on the screen 
or digitizer or by importing a tabular list that includes x,y locations.  Points can represent simple points 
(such as sample localities) or the position of such oriented features as bedding or lineation.  These 
features can be planar (type, strike, and dip), linear (type, azimuth, and plunge), or such oriented 
relations as strike-slip arrows or bar and ball on a fault (type, orientation).  Symbols and their orien-
tations are specified for plotting as a function of these recorded data.

The database format for points is the same as that for polygons, but the PAT here is a point attribute 
table.  Because the same attribute table is used, points and polygons cannot exist together in the same 
map layer (in ARC 5.0.1). The data automatically recorded for points are limited to the identification 
numbers:

area -  not applicable to points (always 0).

perimeter -  not applicable to points (always 0).

[map name]# -  unique internal number assigned automatically by ARC/INFO.

[map name]-ID -  user ID number (=  $ID), assigned by ARC/INFO or controlled by user.

Additional database items typically added in ALACARTE:

PTTYPE -  point-type tag or type of oriented feature recorded by ALACARTE.

SAMPNO -  standard item for recording sample number.

STRIKE -  azimuth of oriented symbol.

DIP -  plunge or dip of linear or planar feature.

SEL -  item used to save a selected set.

SYMB -  item used to save symbol assignments (such as color).

PTTYPE is the default item in which the basic point tag is recorded by ALACARTE.  It is automati-
cally added to the PAT for the map when it is started in Setup and points are specified or where a scan 
is prepared there for point data, and it and any other item can be added to a map database (to the PAT). 
 SAMPNO is the default item used by ALACARTE to record sample numbers for the Sample Number 
routine, and STRIKE and DIP are the items used to store azimuth and dip or plunge for structural 
orientations.  The points database can be viewed on screen and entries can be viewed or modified from 
the database form.

A varied set of standard geologic symbols for both  points and oriented symbols is available for on-
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screen and hard-copy plotting (see Symbols, p. 197).  Markerset ALCWRG.MRK is used by 
ALACARTE for  displaying such oriented data as bedding attitudes and lineations during on-screen 
digitizing and editing.  The symbol is assigned as a function of point type and is oriented according to 
recorded azimuth with the dip or plunge posted automatically as annotation.  These symbols maintain 
a constant size in both on-screen and hard-copy plotting, regardless of the scale of presentation.  A 
double size (2X) set of point symbols is also available (see Set the Symbol Environment, p. 180).

ANNOTATION

Map-face annotation (text) is entered from the keyboard at a prompt, entry by entry, and is placed on 
the map by a variety of methods.  It can also be created automatically from database entries and then 
edited if desired.  Annotation can be placed on the map as part of any map layer or in a separate 
annotation layer.  The database content for annotation that has been entered directly is simply the 
annotation itself; there is no attribute table for annotation in which further information can be stored.

Annotation is entered and then placed on the map on screen (or from the digitizer) extending from an 
initial clickpoint along a specified straight or curved line at any angle on the map, or along or offset 
from an existing line in the map.  Once entered, annotation can be repositioned and resized on the 
screen.  The height of the text characters is expressed in map units and the characters scale with the 
map on the screen as display scale is changed with the Zoom functions.  Although each map layer in 
ARC/INFO can have as many as ten separate levels of annotation, ALACARTE routinely uses only 
level 1.

Various IGL fonts are available in version 5.0.1 of ARC (see Appendix B, Fonts, in ARC/INFO  Sym-
bols of the ARC/INFO Users Guide) that are scalable and can be drawn or plotted in color.  
Combinations of font, color, size, slant, and letter spacing can be established in the Font Editor (on the 
Symbol Editors pulldown from the General bar) and saved as symbols in a text set that can then be 
used for on-screen or hard-copy plotting.  The annotation used by ALACARTE (unless reset) is textset 
PLOTTER.TXT, symbol 0, in which the characters are easily read and quickly drawn on the screen.  
Annotation can be entered and displayed on the screen with this default set of characters and can then 
be converted to another font, size, etc., for final screen editing and/or plotting.

DATABASE ITEMS

The database for a map layer includes an attribute table for each kind of feature in the layer (arc 
attribute table for lines - AAT;  polygon or point attribute table for polygons or points - PAT).  These 
tables contain various fields (items), in which information about the individual map elements is stored 
(see Features of Maps, p. 51).  Each map element is uniquely identified by the #ID number, which is 
assigned by ARC/INFO and cannot be modified by the user.  The values of some other items (such as 
line length) are determined automatically from map relations.  The attribute tables and these automatic 
entries are recreated for the specified feature type each time the map is built (or cleaned) for that 
feature.

Other items can be added to the attribute tables to record additional information.  Standard items used 
in ALACARTE include LTYPE, PTYPE, and PTTYPE, in which the feature tag is recorded, and DIP, 
STRIKE, and SAMPNO for various kinds of points.  The items for feature tags are added automati-
cally to the database for maps that are begun in Setup, and any of these standard database items can be 
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added automatically with functions available on the Files pulldown from the General bar, once the 
map layer has been built (or Cleaned) for the feature type.

Custom items can be added as well.  Be sure the map has been built (or cleaned) for the feature type, 
then use the Add Items forms menu to add the desired item (pick  Add item  on the Files pulldown from 
the General bar):

Additem  -  add item to Info file

<in file> . . . . . . . . . . . . . . . . . . . . . . . . .
<out file>   . . . . . . . . . . . . . . . . . . . . . . . . .
<item name> . . . . . . . . . . . . . . .
<item width>   . . . . . .
<output width>. . . . . .
<item type>   . . 
{decimals}    #  . .
{start item} . . . . . . . . . . . . . . .

OK    HELP    CANCEL
 

Fill in the blanks in the form:

<in file> -  the name of the file to which the item should be added:  call the Map Names      
   popup (use  ?  or click the middle mouse button in the blank) and pick the file     
   name that consists of the map name followed by the extension  .AAT  or               
   .PAT,  depending on the type of feature involved.

<out file> -  same as the in file; this will be entered automatically.

<item name> -  enter a name for the item; make it distinctive and keep it short (no more than     
   8 characters).

<item width> -  enter the maximum item width (number of digits or characters).

<output width> -  same as item width.

<item type>  -  kind of item; open a subordinate menu (? or middle mouse button) from which to pick:

I -  ASCII integer.

B -  binary integer.

F -  binary floating point number.

N -  ASCII floating point number.

C -  ASCII character string.

D -  date, stored as YYYYMMDD, but retrievable in various forms.

{decimals} -  number of decimal places to be maintained for floating point numbers.

{start item} -  existing item after which new item is to be placed (default is to place it last).

When you are satisfied with the form, click  OK  to activate the function and add the specified item to 
the specified attribute table.

TOPOLOGY

The spatial topology of a map is maintained by ARC/INFO through the operation of the Clean and 
Build functions.  In its complete form, the map topology consists of (1) the identity and length of lines 
(arcs) and the identity of their from and to nodes (which define the direction of lines and their left and 
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right sides),  (2) the identity of nodes and of the lines connected to them,  (3) the identity of polygons, 
the identifying label points within them, and the lines that bound and define them, and  (4) the identity 
of the polygons that adjoin lines on their left and right sides.

This topologic information is stored in the files that form the map database (arc attribute table, poly-
gon attribute table, and others) and is established and revised through the operation of the Build and 
Clean functions on arcs and labels.  Both functions analyze topology; the Clean function also adds 
nodes at intersections and can delete dangles and simplify a map to a specified resolution (through 
application of the Fuzzy tolerance).

The sequence of operations recommended for ALACARTE maps herein will produce and maintain 
well-defined spatial topology.  Modification of the database files for a map directly from the INFO 
command line can introduce problems that ALACARTE cannot address.  DO NOT work on an 
ALACARTE map from the INFO command line unless you fully understand what you are doing.

Build 

The build function establishes or revises map topology and the associated databases, but cannot create 
nodes at intersections where unsplit lines cross.  Use Build to create a database for a map with points, 
lines, or polygons (ALACARTE does this automatically for maps started or processed from the Setup 
bar), and to revise polygon topology as you label and edit the polygon layer of a map.  Use Clean, 
instead, if you know that you have added crossing lines while Intersectarcs was turned off, or if a Build 
fails because it detects an intersection:

An intersection was detected while building polygons
[reports coordinates]
Use CLEAN instead of BUILD or alter the fuzzy tolerance if using CLEAN.
Bailing out of BUILD

Open the Build menu (pick  Build  on the Topology pulldown from the General bar):

Build  -  build topology and feature attributes

<input coverage> /REDHOME/CWENT/TOUR/TEST.LN
{output coverage}
{POLY  |  LINE  |  POINT} POLY . . .

ok     help    cancel

Specify the layer to be built (input coverage:  list with  ?  or middle mouseclick in blank and pick from 
the list).  Enter the name of a new version for the output map or omit an output name to build back into 
the input map.  Building into the same map is generally harmless, but follow the general safety rule of 
moving to a new version of a map after every major increment of work.  The default feature type in 
the menu is polygon, because with ALACARTE maps your principal use of Build will be to revise 
polygon topology as you are tagging polygons.  Change to another feature type if appropriate.

Clean

The Clean function performs the same topologic processing as Build after first creating any needed 
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intersections and, if specified, deleting all dangles less than the indicated dangle length and simplify-
ing coordinate geometry according to the resolution indicated by the Fuzzy tolerance.  Clean is thus a 
more complex function than Build, takes longer to run, and can impose significant changes in a map. 
Use Clean when you first prepare a lines layer for polygons, and thereafter only if required because 
Build fails after detecting an intersection.  

 Open the Clean menu (pick  Clean  on the Topology pulldown from the General bar):

Clean  -  intersect arcs and build topology.  # indicates use of default
tolerance value.  Tolerance values are in map units, typically meters.

input map /REDHOME/CWENT/TOUR/TEST.LN . .
output map test.py . .
{dangle length} 0 . . . . . . The default value (#) is read from

the map’s TOL file if it exists.
Otherwise it is 0.

{fuzzy tolerance} .001 . . . . The default value (#) is read from
the map’s TOL file if it exists.
Otherwise it is .002 if width of BND
is between 1 and t00, else it is the
width of BND / 10,000.

{POLY  |  LINE} POLY . .

ok     help    show default tols     cancel

Specify the layer to be cleaned (input map:  list with  ?  or middle mouseclick in the blank and pick 
from the list).  You must also specify a new output map.  It is not wise to Clean back into the input map 
(and ALACARTE will not permit it), because a failure in cleaning can destroy the map.  Accept the 0 
dangle length or change it to a larger value for specific purposes (in map units, typically meters for 
ALACARTE maps).  Leave the Fuzzy tolerance at .001 map units or change it for specific purposes.  
You can also set a dangle length and fuzzy tolerance for the Setup file (TOL file) at the time you first 
start a map and then invoke these default values by entering  #  in the menu blanks here.  Use  show 
default tols  to check that such default values are available and what they are.  Clean will fail if there 
is insufficient disk space or if the map contains a polygon boundary with more than 10,000 arcs. 

The dangle option in Clean permits the automatic deletion of all dangles (lines with at least one un-
connected end) that are shorter than the specified dangle length.  This option can be used to advantage 
to remove very small dangles, but care is warranted because many valid lines in a geologic map are 
dangles.  ALACARTE automatically sets the dangle length to 0 in the form, but this can be changed.

The fuzzy tolerance defines a resolution that Clean applies to x,y coordinates throughout the map.  
Coordinates spaced closer than this distance are combined, a process that can remove tiny polygons 
(including slivers) and arcs and will thin out the vertices and nodes along lines.  This simplification 
leads to movement of elements in the map.   Keep the fuzzy tolerance as small a possible, but no 
smaller than .0001 (map units), because otherwise ARC/INFO will revert to the value in the map TOL 
file or to the standard defaults described on the Clean menu.  ALACARTE sets the fuzzy tolerance to 
.001 as a compromise between a very small value and the longer processing time required by even 
smaller values.
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ALACARTE Operations

A number of operations are basic to the use of ALACARTE.  These include using the different kinds 
of menus, manipulating the display of a map on the screen, specifying (selecting) map elements on 
which to operate, and saving your work.

USING THE MENUS

To the user, ALACARTE consists of a suite of menus from which items can be picked both to move 
around in the menu structure and to drive ARC/INFO to work with maps.  The main framework con-
sists of a hierarchical series of bar menus organized according to different kinds of map operations fig. 
4, p. 205).  Each bar offers access to other menus and to various ALACARTE functions.  The orga-
nization of the menus and a listing and brief description of each bar and pulldown menu item in 
ALACARTE is given in Structure and Functions (p. 203). 

Several different kinds of menus are used.  Three, the bar, pulldown, and popup menus, offer a variety 
of menu items that can be picked by clicking on them (move the crosshairs over the item and click with 
mouse key or space bar).  On these menus the kind of operation produced by a menu item is indicated 
by its capitalization:  menu items all in CAPITAL LETTERS take you to other bar menus, those with 
only Initial Capitals open popup or pulldown menus that close and return control to the current bar 
menu, and those all in lower case letters perform an action (typically on the edit map in the fore-
ground) and then return control to the current bar menu.  

Another type of menu, the forms menu, is used for database input and modification and for 
ALACARTE functions that require the specification of input and output maps, tolerances, options, 
and other variables.  Blanks are provided into which information can be entered, or in some cases 
inserted by picking from subordinate menus.

The final type of menu, the key menu, is presented as part of certain basic ARC/INFO routines.  Key 
menus offer various options that are selected by entering their associated numbers from the keyboard 
or the mouse.

ALACARTE also presents some kinds of information in popup reports that look like menus, but are 
not.  

Menu Operations

Working with ALACARTE menus involves picking menu items and buttons, listing options from 
entry blanks and making a selection, and entering information from the keyboard.  The methods used 
to do these things will depend on your particular system.  Experimenting in a forms menu is harmless 
as long as you avoid the  OK  button.

Picking - Pick a menu item or a button by clicking on it or by highlighting it and then hitting the 
Return or Enter key (<Return>) or clicking the right button on a three-button mouse (for this mouse 
equivalent of <Return>, the position of the crosshairs on the screen is irrelevant).  Click on an item by 
moving the crosshairs over it on the screen and then clicking the left mouse button (or hitting the space 
bar on some terminals).  
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Highlights -  On many terminals and terminal emulators, one item on a menu will be highlighted when 
the menu is opened (the first item, the one last used from that menu, or the Quit or OK button).  This 
highlight can be moved through the menu items before picking by hitting the tab or arrow keys.  Pick 
a highlighted item in a menu with <Return> or by clicking the right button on a three-button mouse.

Entry Blanks - Forms menus contain blanks into which values or selections must be entered before 
the function controlled by the menu is activated.  Highlight a blank by clicking in it (or by moving a 
highlight onto it) and then type the information from the keyboard and <Return> (that is, enter it from 
the keyboard).  Where one of several known options is to be entered in a blank, the options can be 
listed in a subordinate by typing a  ?  in the blank or by clicking in the blank with the middle mouse 
button of a three-button mouse.  Pick an item from the resulting list to enter it in the blank.  In some 
menus, the options are also represented by buttons (located above or to the right of the blank) that can 
be picked to enter an option in the blank.

OK, Quit, and Cancel - Popup reports and forms menus remain on the screen until they are closed or 
activated by picking an appropriate button.  Pick a Quit or Cancel button to return to the current bar; 
use the OK button to start the function controlled by the menu using the settings shown on the menu.  
Pulldown menus can be closed by picking  close menu  or by picking another item on the bar above. 

Help -  Help items or buttons are present on many of the menus.  Pick them to obtain whatever on-
screen help is available in ALACARTE for that item.  Help is not uniformly available, and may consist 
of a message from ALACARTE, display of the ARC/INFO help for the appropriate command, or 
nothing at all.

Bar Menus

The bar menus define the framework from which you work in ALACARTE (see figure 4 , p. 205).  
They draw across the top of the screen and remain (or return after various operations are completed) 
until they are deliberately changed by picking another bar-menu symbol (in CAPITAL LETTERS).  The 
items at the outer ends of each bar show where you are in the menu structure.  The left-most item on 
each bar is its name, which indicates either its general purpose (as, Edit) or what kind of feature the 
bar operates on (as, Lines).  The right-most item on each bar, generally the name of the next higher 
bar, is the way to go back up (and out of) the hierarchy of bars (upward direction indicated by a caret, 
 ^).  Pick an item from a bar menu by clicking on it.  An example of a bar menu is the Alacarte bar, 
which is the first bar presented when you start ALACARTE:

[ Alacarte ]  |  SETUP  |  EDIT  |  PLOT  |  ANALYSIS  |  CONVERSION  |  GENERAL  |  QUIT  |

Pulldown Menus

Most of the active functions in ALACARTE are picked from menus that pull down from the menu 
bars.  Pulldown menus are opened by clicking on their menu items on the bar, which always have  
Initial Capitals.  A pulldown menu drops down on the screen below its menu item, and the bar remains 
on the screen.  The pulldown closes when an item is picked from it or from elsewhere on the bar.  Pick 
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an item from a pulldown menu by clicking on it.  An example is the Topology pulldown from the 
General bar:

[ General ]  |  Files  |  Topology  |  Symbol Editors  |  ^ALC  |
Clean
Build
Tolerances
Labelerrors

close menu

Popup Menus

A number of standard menus that pop up on the middle of the screen can be called from various parts 
of the menu structure.  The bar menu disappears temporarily when a popup menu is called.  Once a 
function is picked from a popup menu (by clicking on it), that function is carried out, the popup menu 
closes automatically, and the current bar menu reappears.  A simple example of a popup menu is the 
Choose Map menu, which appears when you go to the Edit bar from the Alacarte bar:

You must choose a map to enter the EDIT menu
help

choose map
change to new map dir

create new map

^ALC

Forms Menus

Most forms menus control functions that use variables which you specify by typing or by selecting 
from subordinate menus.  Like popups, forms menus draw in the middle of the screen at the temporary 
expense of the current bar.  The top lines of the forms menu describe the function that the menu 
controls.  Below that, the variables to be specified by the user are listed with blanks to the right in 
which to enter the information.  Ranged across the bottom are various control buttons, including the 
OK button that activates the function with the variables displayed in the form.  Default options are 
provided automatically for those variables where typical usage for geologic maps can be suggested.  A 
simple example of a forms menu is that for Build, a function that operates on an input map (coverage) 
to produce a new, output version of the map:

Build  -  build topology and feature attributes

<input coverage> /REDHOME/CWENT/TOUR/TEST.LN
{output coverage}
{POLY  |  LINE  |  POINT} POLY . . .

ok     help    cancel
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When a forms menu is opened, the blank for the first entry to be made by the user is generally 
highlighted.    Move the highlight through the items on the popup menu with the tab or arrow keys or 
click on the item to select it, enter variables in the appropriate spaces (this will override defaults or 
previous entries), and select the  OK  (highlight and <RETURN>, or click on it) when you want to 
activate the function with the specified variables.  Where an entry is one of several known alternatives, 
such as the name of an existing map file, type a  ?  in that blank or click in it with the middle mouse 
button to open a menu of the options from which you can choose.  Pick an item from such a list by 
clicking on it or by moving the highlight onto the desired option and hitting <RETURN>.  

In blanks for an input map (coverage), the current edit map may be automatically shown as a default 
that can be overridden if desired.  Similarly, the settings that you establish in the Select popup will 
remain until changed.  

Database Form

The database form can be used to view the database for selected map elements or to modify the data-
base by making entries from the keyboard.  The database items are listed in the lefthand column and 
entries or blanks appear to the right.  Open a database form by picking  forms  on the Database pull-
down (Db) from the bar for the appropriate type of feature (lines, areas, or points).  An example is a 
form for a bedding attitude in the Tour map layer CLP.ATT:

Label             Internal   9                User-ID   98

area 0.000
perimeter 0.000
clp.att# 9
CLP.ATT-ID 98
PTTYPE bedding
STRIKE 129
DIP 70

SELECT   NEXT   SAVE   WHO   CANCEL
point to label to select

There are two different versions of the form, depending on whether or not there is a currently selected 
set of map elements when you open the form.

When no elements are selected, the control buttons are as illustrated above.  While the form is open, 
you can select map elements from the screen or digitizer for inspection, change, or entry of database 
information.  To do this, pick  SELECT  on the form  (the instruction  point to [feature] to select  will 
appear below the button row) and then click on the desired element on the map.  The current data for 
that element will be displayed in the form and you can make any changes or additions by selecting the 
appropriate part of the form and entering the desired information.  Use  NEXT  to move the selection to 
an adjacent element on the map and  SAVE  to record new entries in the temporary map file.  When you 
are finished with one map element, save any changes and pick  SELECT  to begin the sequence for 
another element, or close the form with  CANCEL.  When the input form is closed, no features will 
remain selected.  You must also save your work in the usual fashion before quitting the edit session 
(see Saving, p. 80).
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If there is a selected set when the input form is opened, data for the first map element in the set will be 
displayed in the form and a different button row will appear:

NEXTREC   SAVE/NEXT   WHO   CANCEL

Scroll through the selected set by picking  NEXTREC  or, after making changes or entries that you want 
to save, pick  SAVE/NEXT  to save the displayed data to the temporary file and move to the next 
element in the set.  Save your work in the usual fashion before quitting (see Saving, p. 80).

Key Menus

Key menus offer numbered lists of options that are used in controlling certain ARC/INFO routines.  
When such a routine is started by ALACARTE, the appropriate key menu appears in the dialog area 
and ARC/INFO waits for you to proceed.   A simple key menu is used to control the Select Many 
function:

1 = Select 2 = Next 3 = Who 9 = Quit 

and a more complex key menu is used to control the Digitize Lines routine:

--------------------Options--------------------
1) Vertex             2) Node                     3) Curve
4) Delete vertex  5) Delete arc              6) Spline on/off
7) Square on/off  8) Digitizing Options  9) Quit
(Line) User-ID: 1 Points 0  

How you enter the numbers to select the available options from one of these menus depends on what 
device you are using to enter map coordinates.  If you are using the cursor as the input device for map 
coordinates, then you use the number keys on the computer keyboard to enter these numbers.  If you 
are using a 3-button mouse for coordinate input, you enter the numbers with the three mouse buttons 
and use the Shift and Control keys on the keyboard to change their meaning:

     Mouse Button: Left Middle Right

[no key] 1 2 3

Shift 4 5 6

Control 7 8 9

If you are using a 1- or 2-button mouse with a terminal emulator, consult the emulator manual or an 
experienced colleague to determine how to control these menus. 

Note that  9  is invariably used to close a key menu and terminate the function that it controls.

Popup Reports 

Some reports provided by ALACARTE pop up in menu-like form on the screen at the expense of the 
current bar menu.  An example is the report of snapping tolerances and settings produced by picking  
show  from the Snap bar in Edit Lines:

Map currently being edited is : CLP.GEOL
     in directory  /HOME/CWENT/TOUR
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Weedtolerance 0
Intersectarcs ALL
Arcsnap ON, 10
Nodesnap CLOSEST, 15
Grain 5.221496777343
Editdistance 61
Mapscale is 1:24000 (0 indicates unknown)
Mapunits are METERS

Click on QUIT to continue!
OK

Although the reports look like menus, they offer no controls except the OK (Prime) or Quit (UNIX) 
button, which will be highlighted when the report appears.  When you are finished reading the report, 
click on that button or use <Return> to close the report and return to the current bar.

CUSTOM AMLS AND MENUS

A form menu accessible from any Commands popup  (run my aml or menu)  allows you to execute 
your own AML or Menu programs from within ALACARTE.  Your program should record any en-
vironmental settings from ALACARTE that it changes (such as &severity) and then reset them before 
returning to ALACARTE.  Exceptions are &amlpath and &menupath, which this routine handles.  You 
can list and select from the form any aml or menu file located in the current directory; or specify a full 
pathname in the blank. Your aml or menu will start in the current ARC/INFO module, either 
ARCEDIT from within the Edit section of ALACARTE, or ARC from all other menus.

COMMAND LINES

The command lines for both the host computer and ARC/INFO are always available from within 
ALACARTE, and the Arcedit command line is available as well from within the Edit section of 
ALACARTE.  You can go out to any of these command lines during an ALACARTE session, enter 
appropriate commands at the prompt, and then return to ALACARTE, all within the current working 
session. 

Access to the command lines is obtained from any Commands popup menu, which is opened by 
clicking on the name (left-most item) of any bar menu (except those bars that are themselves called 
from a Commands popup, such as the Devices bar).

The relevant part of the Commands menus looks like this:

give one system command
give system commands
   list dir
give one ARC/INFO command
give ARC/INFO commands
give one ARC/EDIT command
give ARC/EDIT commands

The ARC/EDIT items are present only on Commands popups that are opened within the Edit section 
of ALACARTE.  To go out to a command line, simply pick the appropriate item from the Commands 
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menu.  If you only want to give a single command, pick a give-one-command item and you will be 
returned automatically to ALACARTE afterwards.  To return to ALACARTE after giving multiple 
commands, you will need to enter the appropriate command at the prompt:

To return from  Key 
Host system quit (Prime) or exit (UNIX)

ARC/INFO quit
Arcedit &return  (DO NOT QUIT)

Do not quit from the ArcEdit prompt:

Do not use  quit  to return to ALACARTE from the Arcedit prompt, as this will cause your current 
ALACARTE edit session to be abandoned and will return you to the Arc prompt.  Trying to return to 
Arcedit from that Arc prompt will start an entirely new Arcedit session and quitting from there will 
abandon your current ALACARTE session and return you to the system prompt. 

All is not lost, however, if you do quit from the ArcEdit prompt by mistake.  If you have made any 
changes to your map or database in the current ALACARTE session, ARC/INFO will interrupt to ask 
if you want to save.  Indicate  yes,  and you will be asked if you really want to overwrite your original 
file.  Answer  no  to that question and you will be returned to the Arcedit prompt.  Now use  &return  to 
return to your current session in ALACARTE.  The map(s) that you had opened as edit maps will still 
be open, but you will have to specify an edit map again with  choose edit map  on the Map pulldown 
from the Edit bar.

DIALOG

Various instructions and reports are printed on screen in the dialog area of terminals and terminal 
emulators.  Text printed to this area is added line by line at the bottom of the screen and previous lines 
scroll upward across the screen.  ALACARTE sets the dialog area as a default to the lower eight lines 
of the graphics area, out of the way of most menus and graphics.   The option is always available from 
any Commands popup menu to reset the dialog area to  fullscreen dialog  in order to preserve dialog 
as it scrolls up the screen or to hold longer lists on the screen.  Similarly, the eight-line  default dialog 
can always be restored from any Commands popup.  Some screen operations in ALACARTE may 
cause the dialog area to change to full screen.  To reset it, simply pick  default dialog  from any 
Commands popup.  On UNIX workstations screens, the dialog is displayed in the window from which 
ARC or ALACARTE was started and the number of dialog lines is not an issue.

EDIT MAP

The map layer that you can modify on the screen is called the edit map in ALACARTE (editcover in 
ARC/INFO terms).  The current edit map is displayed in the foreground on the screen, either alone or 
overlaid on one or more background layers (see On-Screen Backgrounds, p. 66).  The edit map is the 
active layer in which map elements (tics, lines, polygons, points, annotation) can be added (digitized) 
or selected and modified.  Control over which kinds of features in the edit map are actually displayed 
on the screen (arcs, nodes, labels, etc.) is provided by the Draw/Back Environment popup menu (see 
Draw Controls, p. 67).
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You specify the current edit map by choosing it from a Map Names popup menu (opened with  Choose 
map  on either the Choose Map popup or the Map pulldown from the Edit bar).  When you first go to 
the Edit bar in an ALACARTE session, the Choose Map popup will intervene to request that you 
choose a map.  Once in Edit you can choose other maps for editing, one at a time.  Each map chosen 
for editing during a session (as many as nine concurrent layers) will stay open in the system until you 
close that edit map or leave Edit.  The current edit map and other open edit maps can be listed with  
show edit maps  on the Map pulldown from the Edit bar and open maps can be closed with  remove 
edit map.  Be sure to save any new work before closing an edit map. 

ON-SCREEN BACKGROUNDS

While working on the screen you can display not only the foreground edit map on which you are 
working, but as many as nine separate background layers registered to the foreground layer, each 
drawn in a specified color.  Backgrounds cannot be edited, but any background layer can be moved 
into the foreground for editing simply by choosing it as the current edit map (see Edit Map, p. 65).

The features in the backgrounds that are actually displayed on the screen are controlled from the 
Draw/Back Environment menu (see Draw Controls, p. 67).  Be aware that detailed topographic maps 
can contain tens of thousands of line segments that may take many minutes to draw on the screen.  It 
is wise, therefore, to zoom in to the area of interest before turning such a background on and drawing 
it on the screen.

The display of registered backgrounds has various applications.  You can, for example, display a base 
map or its component layers (such as topography, drainage, and culture) behind the geologic line work 
while you are editing the lines, in order to fit the geology to the base as you work.  You can edit an 
imported scan in the foreground over an unedited copy of the scan displayed in the background for 
comparison, or digitize on screen by tracing a scan in the background.  Backgrounds can be used to 
display adjoining maps in the same projection in order to see relations across the boundary of the edit 
map as you work.

Backgrounds are picked from a Map Names popup of the current directory of map layers that is called 
with  choose background  on the Map pulldown from the Edit bar.  This popup is automatically 
followed by a Colors popup from which you specify a color for drawing the background.  Each further 
selection of a background adds to the current set of background layers.  All current backgrounds are 
displayed together in the specified colors according to the back environment setting (see Draw Con-
trols, p. 67).  Temporarily avoid drawing current backgrounds by turning all features off in the back 
environment.  List the current backgrounds with  show current backgnd.  Individual background layers 
can be removed from the current set with  remove background,  and all the current backgrounds can 
be removed together with  remove all backgnds.  Saving while backgrounds are chosen has no effect 
on the backgrounds.

Special backgrounds are produced by coloring polygons (see On-Screen Coloring, p. 168) and by 
displaying oriented symbols in the background (see Display Symbols in Background, p. 184).  These 
background displays cannot be controlled from the Draw/Back Environment menu, but are set and 
turned off separately from individual menu items.

66



DRAW CONTROLS

Once an edit map and any backgrounds have been chosen, they are not automatically drawn on the 
screen.  You control when the edit map is drawn on the screen, whether the backgrounds are shown, 
and which kinds of map features in the foreground and the background layers are actually drawn on 
the screen.  These controls are provided by the Draw popup menu, which is opened with  Dw  on any 
bar in Edit.  Changing the area of the map that is displayed on the screen from the Zoom popup will 
also draw that new area of the map on the screen (see Zoom Controls, p. 69).

ALACARTE sets a default draw environment in Edit that depends on the current bar.  Nothing is set 
to draw from the Edit bar, whereas going to one of the other bars below it automatically turns on the 
feature(s) in the edit map appropriate to that bar.  All elements in the map of that feature type will be 
drawn on the screen when you pick  draw map  on the Draw menu or one of the zoom items on the 
Zoom menu.  

Draw Menu

Direct user control on drawing is also available, however, which is important when working with maps 
on the screen.  The principal control is through the Draw/Back Environment popup menu (described 
below), although the Draw menu offers a variety of other controls as well.

This is the draw popup menu, with annotation and interleaved descriptions:

[ DRAW ] -  name of the menu.

The currently defined draw area can be redrawn, with or without first clearing the screen;  this will use 
the current settings for the draw and backenvironment as well as the currently defined draw area:

draw map -  clear the screen and draw the currently defined map area.

draw(noclear) -  draw currently specified map features without first clearing the screen.

Open the Draw/Back Environment menu (set draw/back envir) to specify which kinds of features in 
the foreground edit map and the background maps will actually draw on the screen (see Draw and 
Back Environment, p. 68), or to check the present settings:

 

set draw/back envir -  open Draw/Back Environment popup menu.

Reset the drawselect color used in drawing the currently selected set of elements, draw that selected 
set, or assign a session color to the selected set (such independent assignment of symbols is not avail-
able from the Digitize Planar and Linear Points bars):

select many -  select one or more map elements by clicking on them; close with a  9.

set drawsel symbol -  pick color for drawing selected set from popup; default = yellow. 

draw select -  draw the selected set in the current drawselect color; color lost on redraw.

set $symbol(S) -  pick color or other symbol from popup menu to assign to selected set.

When map elements are selected in ALACARTE they are automatically redrawn with the current 
drawselect color or symbol to show which elements are selected;  although ALACARTE runs this 
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function as the default , you can turn it on and off either here or from the Select popup menu:

auto dw sel on -  draw map elements in drawselect color (default = yellow) when selected.

auto dw sel off -  omit drawing map elements in drawselect color when selected. 

The screen can be cleared of graphics and the automatic display of graphics during ALACARTE and 
ARC/INFO routines can be turned on and off:

clear screen -  clear image from screen.

graphics on -  enable drawing of graphics.

graphics off -  disable drawing of graphics. 

You can go directly to the Zoom popup without first returning to the current bar (if, for example you 
have opened the Draw popup by mistake) or you can close the Draw popup:

Zm(zoom) -  close the Draw menu and open the Zoom menu directly.

help -  display ALACARTE description of menu.

cancel -  close the Draw menu and return directly to the current bar menu.

Draw and Back Environment

Control on which kinds of features of a map are actually drawn to the screen, such as lines, labels, and 
tics, is obtained through the draw and back environments, which are set from the Draw/Back Envi-
ronment popup menu.  The Draw environment, which controls which kinds of features in the 
foreground edit map are drawn, is reset automatically in ALACARTE to the appropriate feature types 
as you move from one bar menu to another in Edit.  These automatic settings can be modified or 
overridden and the background(s) can be controlled directly from the Draw/Back Environment popup, 
which is opened from the Draw popup with  set  draw/back  envir:

Set edit map drawing environment (drawenvironment):

    Arc: ON     <  ON OFF IDS ARROWS
 Node: OFF   <  ON OFF IDS ERRORS DANGLE   PSEUDO
Label: OFF   <  ON OFF IDS       Anno: OFF <  ON   OFF
    Tic: OFF   <  ON OFF IDS       Link: OFF <  ON   OFF

Set background drawing environment (backenvironment):

    Arc: ON     <  ON OFF IDS ARROWS
 Node: OFF   <  ON OFF IDS ERRORS DANGLE   PSEUDO
Label: OFF   <  ON OFF IDS       Anno: OFF <  ON   OFF

    Tic: OFF   <  ON OFF IDS       Link: OFF <  ON   OFF

OK    DRAW     HELP DRAWENV     HELP BACKENV       CANCEL

The features that can be controlled from the menu are listed as headings (Arc:, Node:, Label:, Tic:, 
Anno:, Link:) and the items to the right of the  <  opposite each heading are buttons to turn those 
features on or off.  The current setting is reported next to each heading.
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In brief, these features are:

Arcs -  arcs are line segments;  each segment has an identification number  (IDS)  and a direction 
 (ARROWS)  that can be displayed.

Node -  nodes are line junctions;  each node has an identification number  (IDS)  that can be 
displayed;  DANGLE  marks nodes at unconnected ends of lines;  PSEUDO  marks nodes 
at junctions along otherwise continuous lines;  ERRORS  displays dangles and pseudo-
nodes together with different symbols. 

Label -  labels are points of various kinds, including oriented structural symbols and label points 
for polygons; each label has an identification number  (IDS)   that can be displayed.

Tic -  tics are digital registration tics;  Each tic has an identification number  (IDS)  that can be 
displayed.

Anno -  annotation is text, including numbers;  no distinction is available here between the 10 
levels of annotation possible for a map layer in ARC/INFO,  ON  turns all levels on 
together.

Link -  links are tie points between two specified map layers that are used in the rubbersheeting 
function ADJUST in ARC/INFO .

In using the menu, if you want to turn the arcs on in the edit map, for example, click the  ON  button to 
the right of the  <  in the Arcs row.  The setting will appear in the blank:   Arc:  ON.  If you want the arc 
user-ID numbers ($ID) or the line directions to be shown as well, click  IDS  or  ARROWS  instead.  To 
turn the arcs off, simply click  OFF  in the arcs row.  The backgrounds are controlled in similar fashion 
(the background settings apply to all current backgrounds together).

This menu remains on the screen until you deliberately close it.  You can set several items for the 
foreground and/or for the background, and then either activate these settings and close the menu with 
the  OK  button or activate the settings and draw directly from this menu with  DRAW.  

Take care when turning arcs on for a base map in the background that you don’t unintentionally use a 
draw area that covers much of the map.  You can wait many minutes for a large area of such a base 
map to draw and then find it illegibly crowded with lines on the screen.

ZOOM CONTROLS

The Zoom menu provides control over what part of a map is drawn on the screen.  Although the entire 
area of a map can be draw on the screen at reduced scale, most maps are much larger than the screen 
at map scale and much editing is done under considerable enlargement.  The Zoom menu provides a 
means of going directly to specified parts of the map and of changing scale or position on the map 
relative to the current draw area.  All the zoom and pan functions redefine the draw area and draw that 
new area of the map on the screen according to the current settings for draw and back environment (see 
Draw Controls, p. 67).  The Zoom menu is opened from the various bar menus in Edit using  Zm.

This is the Zoom popup menu, with annotation and interleaved descriptions:

[ zoom ] -  the name of the menu.

Any rectangular part of the current draw area can be redrawn to fill the limiting screen dimension by 
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clicking the diagonally opposite corners of the rectangle (zoom box) on the screen; or, the whole map 
area can be drawn:

zoomin(box) -  draw the area of a box defined on screen by clicking opposite corners.

overview -  draw the whole area containing map elements for the current edit map.

The map area displayed can be increased (and the display scale decreased) by zooming out around the 
center of the current draw area by any specified zoom factor (enter factor or use 2X default) or, a more 
limited area can be displayed at larger scale by zooming in with any specified zoom factor around a 
new center that you click on the screen;  zoom factors less than 1.0 will reverse the effect for each 
function:

zoomout(#) -  reduce the map about its present center; enter the factor (<1 enlarges).

zoomin(#) -  enlarge the map; enter the factor (<1 reduces) and click on new center.

Two popup menus can be opened from which to pick a specific part of the map to be drawn:  zoom 
9/36  divides the map (area within the outer tics) into 9 rectangles (3 X 3) and each of these ninths into 
quarters, whereas  zoom 8/32  divides the map into 8 rectangles (4 wide, 2 high) and each of these 
eighths into quarters: 

zoom 9/36 -  select new draw area from the Zoom 9/36 popup menu.

zoom 8/32 -  select new draw area from the Zoom 8/32 popup menu.

A zoom box can be defined by entering the x,y coordinates of its lower left corner (Xmin, Ymin) and 
its upper right corner (Xmax, Ymax) from the keyboard; the coordinates can be obtained for these 
corners of a box to be redrawn later by using the Where function on any Options pulldown: 

xy box -  draw box defined by entering coordinates (xmin, ymin, xmax, ymax).

The Pan popup allows the draw area to be shifted about 70% in any of eight directions without change 
in display scale, or a new center can be specified by clicking in the current draw area on the screen: 

Pan -  shift the draw area from the Pan popup menu.

The area occupied by any selected set of map elements can be drawn without knowing where those 
elements are on the map;  the area of the map that actually contains lines or other features  (map 
boundary)  or the whole map area bounded by digital tics  (map corners) can be drawn for the current 
edit map (use  <return>  default) or for any specified map (enter name or pathname): 

draw area of:
selected features(S) -  draw area containing currently selected set of map elements.

map boundary -  draws area containing all features in any specified map (disregards tics).

map corners -  draws area defined by the outermost digital tics in any specified map .

The map can be redrawn to any specified scale on the screen (assumes a screen width of 9.25 inches) 
around a center that you click on the screen:

draw to scale -  draw the map to any specified scale around a center clicked on screen. 

The map area currently displayed on the screen (draw area, or frame) can be saved and this saved 
frame can be redrawn later, regardless of the intervening zoom history: 
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save this frame -  save coordinates of current draw area; can then  redraw saved frame.

redraw saved frame -  draw the area previously defined by  save this frame.

You can go directly to the Draw popup without first returning to the current bar (if, for example, 
you have opened the Zoom popup by mistake) or you can close the Zoom popup: 

Dw(draw menu) -  calls the Draw menu without first returning to the current bar menu.

help -  call ALACARTE description of menu.

cancel - close Zoom menu and return directly to the current bar menu.

Zoom Strategies

The Zoom functions are used constantly during editing both to select parts of the map for display and 
scrutiny and to enlarge small parts of the map for detailed work.  Skillful use of the Zoom functions 
can save much time and help assure that all parts of the map are systematically addressed.

Whole-Map Overview

Draw the entire map on the screen with  overview,  map boundary  or  map corners.  If only part of the 
map area contains map elements, or the map elements extend well beyond the outermost tics, use  
overview  or  map boundary to fill the screen with that part of the map.  Use  map corners  to draw the 
map area out to the outermost tics.  Overview operates from the current edit map, whereas Map 
Boundary and Map Corners let you specify the map layer from which the draw area will be 
determined:

Give name(s) of map(s),  <Return>  =  current map:

Typically you will simply hit  <Return> to specify the current edit map, but this prompt lets you 
specify a different map (enter map name at the prompt and <Return>) or to specify more than one map 
to define a composite draw area (enter map names in any sequence, separated by spaces).  This is 
useful particularly where you are working on screen concurrently with overlaid or adjacent maps in 
the same projection.

Drawing the whole of a busy map on the screen can take quite a while.  Be sure that Nodes and any 
detailed background maps are turned off and, if your purpose is simply to find and zoom to some 
smaller part of your map, consider displaying only the tics or using Zoom 9/36 or Zoom 8/32 instead.

Zoom to a Specified Area

Three of the Zoom functions allow you to specify a particular part of the map without first drawing the 
map on the screen.  Both  zoom 9/36  and  zoom 8/32  open popup menus from which you can specify 
various parts of the map directly.  Zoom 9/36, which  is designed particularly for 7 1/2 and 15 minute 
quadrangles, allows you to specify any of 9 parts of the map (3 high, 3 wide) or any quarter of those 
ninths.  Zoom 8/32, which is designed for 1/2 x 1 and 1 x 2 degree quadrangles, allows you to specify 
any of 8 parts of the map (2 high, 4 wide) or any quarter of those eighths.  Either function can be used 
for any map, regardless of format, but map elements located beyond the outermost tics may not be 
included.
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The third specific function,  xybox,  permits you to describe a zoom box by entering the map coordi-
nates of its lower left and upper right corners.  Use this function to display any particular part of a map 
or to return in a new edit session to an area that you left unfinished in the last.  Determine (and record) 
the coordinates of the box corners in advance while the area of interest is on the screen (use  where  on 
any Options pulldown to click first the lower left corner of the area and then upper right;  this reports 
the coordinates in the same order in which they must be entered in the Xybox form).

Pan

The Pan popup that is opened with  Pan  lets you shift the draw area from the current area about 70 
percent in any cardinal direction without changing the display scale.  Use it to adjust the position of 
the draw area or to move systematically around the map.

Zoom In or Out

The most frequently used Zoom function is  zoomin(box), at the top of the Zoom menu, which allows 
you to click in the current draw area the opposite corners of a box of any size to be redrawn to fill the 
whole screen.  Use this to zoom in on particular areas or map elements.

Where you want to control display scale, use  zoomin(#)  instead.  Specify a magnification factor at the 
prompt and then click on the center of the new display.  By specifying a factor of  1,  this function can 
also be used to reposition the draw area to a new center within the current area.

Zoom out around the center of the current draw area by picking  zoomout(#) and entering a magnifi-
cation factor at the prompt.

Draw to Scale

You can draw a map on screen at any specified display scale with  draw to scale.  This is useful in 
checking whether more smoothing of lines is needed (draw at about twice the intended cartographic 
scale), for example, or as a check in generalizing.  It is important in working with oriented symbols, 
which do not scale with changes in the size of the draw area (see Set the Symbol Environment, p. 180). 
A standard screen width of 9.25 inches is assumed for this scale calculation.  To correct for a different 
width, use:

Scale to specify = (desired scale) X (width of your screen / 9.25)
  
Save Frame

On-screen editing typically involves selecting part of the map for work and then going back and forth 
from that area to enlarged displays of the various places that require work.  The Save Frame function 
(save this frame) allows you to save a draw area, proceed through any sequence of Zoom functions, 
and then return to that area with  redraw saved frame.  By saving the current work area on a map, you 
can zoom in for detailed work and then redraw the work area to select the next problem on which to 
zoom in. 
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SELECTING MAP ELEMENTS

Editing, tagging, and other operations on map elements require first that the particular elements be 
specified (selected).  Line segments, points, polygon label points, annotation strings, and digital tics 
can be selected using the selection functions, whereas nodes can be selected only as part of the Move 
Nodes routine.  A powerful suite of functions allows precise identification of map elements by tech-
niques that range from clicking on individual elements (such as a line segment) or surrounding a group 
of target elements with a box or polygon, to searches of the map database according to specifications 
about such attributes as line type, line length, or sample number.  Selection functions operate on the 
kind of map feature represented by the current bar (such as lines from the Reshape bar).

All the selection operations either create a new set of selected map elements or modify the currently 
selected set.  Some ALACARTE - ARC/INFO functions require that only one map element be se-
lected, whereas other functions operate on a selected set of any size, including the whole map.

The basic suite of selection functions is available on the Select popup menu, a few functions that are 
used frequently are directly available on some bar and pulldown menus, and the functions that select 
according to current [line, point, area] type are located on the Select pulldowns from the various 
Digitize bars.

Select Popup Menu

The Select popup menu illustrates the several kinds of selective actions and the various ways to spec-
ify which elements are to be selected.  It is opened with  Se  or  Sel  on various bars and on the Select 
pulldowns in Edit):

Select map features by logical expression or using current
coordinate device:   MOUSE

   Type:  ASELECT :   < select aselect reselect unselect nselect

Option:  FOR :   < one many all outline dangle connect
box polygon screen <  limit: within passthru

choice: passthru

    for   expression  (enter below):
: $id  =  216

by length
Auto draw select:
:   DRAWSELECT   :   <  on  off set draw color  >      7

ok help cancel

The heading reports the current coordinate device (here  MOUSE).  Check this to remind yourself 
whether you are currently set to work from the screen or the digitizer.  Then set a selection type and 
an option, plus any further information required by the option, turn Auto Drawselect off if the draw 
time will delay you, and activate the specified selection function with the  ok  button.
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The selection types describe the principal selective actions that are used to create a new selected set or 
to modify an existing set:

select -  define a new selected set.
aselect -  add more features to the currently selected set.
reselect -  define a new selected set from within the current set.

unselect -  remove features from the currently selected set.  

A fifth kind of action operates on the whole map:

 nselect -  select all elements in the map that are not currently selected. 

The option specifies the method by which that selection type will operate; some options are specific 
to lines, whereas others apply to any kind of map feature:

one -  select one map element by clicking on it; automatic return to current bar.
many -  select multiple elements by clicking on them in sequence; close with a  9.
all -  select all elements in the whole map.
outline -  select the polygon boundary that includes the click-selected line (click   

just inside the desired polygon within an edit distance of the line).
dangle -  select all lines that have at least one unconnected (dangling) end.
connect -  select all lines that are connected to any of the lines in the currently se-

lected set.

The next three options operate by defining areas within which map elements will be selected;  for lines 
there is a choice between selecting only those lines that are completely within the defined area  (within) 
 and those lines that are at least partially within the defined area  (passthrough):

box -  select all features completely enclosed (the default) or at least intersected 
by a box clicked on screen.

polygon -  select all features completely enclosed (the default) or at least intersected 
by a polygon clicked on screen.

screen -  select all features at least partly included (the default) or completely in-
cluded in the current draw area.

The last two options require a relation of the form  $id  =  216 (see Select by Attribute, p. 76).  With  for 
expression, this relation is entered in the blank below the heading (as in the example above); with by 
length, the conditions and length are specified in a popup menu:

for expr. -  enter the expression by which to select.
by length -  specify line length and conditions from popup menu.

Select By Hand

Specifying one or numerous map elements to be selected from many elements can be done by indi-
cating their map positions with the crosshairs on the screen or digitizing puck from a digitizer.  The 
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selection technique used will depend on the number of elements to be selected, their map distribution, 
and the ease of starting one or another of the functions from your particular location in ALACARTE.  
The techniques are described here in terms of selecting a new set, but the same principles apply to the 
other types of selective actions (aselect, etc.).

Select One or Select Many 

Where only a few elements are to be selected, use Select Many.  Start the select function, click on the 
map elements, one by one, and then close the selection routine with a  9.  You can pick as many 
elements as desired before closing the routine.  Each element so identified will blink on the screen and 
be reported in the dialog area.  When the routine is closed and Autodraw select is on, ALACARTE will 
then redraw the newly selected set in the drawselect color (default = yellow) and the total number of 
elements selected will be reported in the dialog area.  Select One can be used where only one element 
is to be selected if it is convenient to use from your particular location in ALACARTE.

Select Many uses a key menu:

1 = Select    2 = Next    3 = Who    9 = Quit

Click  1  (left mouse button) to select, follow if necessary with one or more 2’s to move the selection 
through a group of closely spaced elements to the desired one, and close the selection routine with a  
9.  Each element will blink on the screen when it is identified and then, when the selection routine is 
closed, the selected set will be redrawn in the current drawselect color on the screen.

A line is selected by clicking near it anywhere along its length.  ARC/INFO will search outward from 
your clickpoint as far as the edit distance (see Snapping and Other Controls, p. 123) to find the line 
and identify it.  To avoid catching the wrong line within the search distance, avoid clicking where the 
line approaches others.  To select all the lines that join at a node, in contrast, click several times at that 
node with Select Many (or use Select Polygon Passthru).  Points and polygon label points are selected 
by clicking on them.  To select an annotation string, click at the lower left corner of its first character. 
If the elements are too crowded on the screen, zoom in.

Select Many is available on the Select popup menu, on some bar menus  (pick  sm),  and on some 
pulldowns.  Select One is available from the Select popup and the Put bar  (so).

Select Polygon

Select Polygon can be used to select all the elements in an area simply by clicking a line around the 
group, and can also be used to isolate one or more line segments in a complicated group of lines.  The 
default option choice is Within, but this can be changed to Passthru where desired.

Start the routine, and you will be instructed to:  

Define the polygon

Click  1’s to define a rough polygon around the target elements and end with a  9  (because you are not 
digitizing an arc, you don’t need to define nodes at the start and end of the polygon line).  Use as few 
points as are needed to enclose or cross the target or excluded elements and don’t bother to close the 
polygon.
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Within - Only those line segments that are completely within the polygon will be selected.  This means 
that you can deliberately exclude particular line segments from the selection by crossing them with the 
polygon boundary.

Passthru - Both those lines enclosed and those intersected by the polygon will be selected.  In contrast 
to the Within choice, this means that you can deliberately include particular line segments in the 
selection by crossing them with the polygon boundary.  There need not be any lines completely en-
closed in the polygon.

Select Polygon is available on the Select popup menu, and with the default choice of Within is avail-
able on some bar menus  (pick  sp),  and on some pulldowns.

Select Box is similar to Select Polygon, but is less flexible in its use.  It, too, involves the choice 
between Within and Passthru.  It is available only from the Select popup.

Select Screen

You can select every map element that is displayed on the screen (the current draw area), including, in 
the case of lines, either just those that are completely included on the screen or also those that are only 
partially included.  In contrast to Select Polygon and Select Box, the default choice for Select Screen 
is Passthru.  If a large number of elements are displayed on the screen, you may want to turn Auto 
Drawselect off before selecting, simply because of the time required to redraw all the elements. 

Select Outline

The outline (perimeter or boundary) of a closed polygon can be selected with Select Outline by click-
ing just inside any part of the outline.  The click must be within the select search distance and inside 
the polygon for which the outline is to be selected.  The resulting selected set will consist of all the line 
segments that form the boundary of the polygon.  Use this function to test a polygon boundary or to 
find the opening between two linked polygons (listed by Labelerrors as being one polygon with two 
labels).

Select By Attribute

Map elements can also be selected through database searches which identify all elements that meet 
specified criteria.  This can be as simple as selecting all the line segments that are tagged with a 
specified line-type, such as fault, concealed, or selecting two polygon label points by specifying their 
User ID numbers ($ID).  More complex logical expressions can be used as the selection criteria, such 
as selecting all lines having lengths within a specified range or all polygons having a perimeter/area 
ratio within specified bounds.  

Select by [feature]-type

Map elements can be selected according to the feature type with which they have been tagged (line 
type, area type, and point type, which are recorded in the database items LTYPE, PTYPE, and PT-
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TYPE, respectively).  Such selection is most easily accomplished from the Select pulldown from the 
various Digitize bars.  This is the relevant part of that pulldown for lines:

Sel by current linetype:
select
aselect
reselect
unselect

To select a set of lines tagged as  Contact,  concealed,  for example, set the current line type that way 
and then pick  select  under  Sel by current line type:  from the pulldown.  The database will be 
searched and all lines so tagged in the map will be selected.

To color the different kinds of contacts in a map with different colors, for example, first select all the 
contacts (set the linetype to  all cntcs, for select,  and select by current linetype), assign the color for 
one kind of contact to all the contacts, unselect that linetype from the selected set, assign the next 
color, unselect that linetype, etc.

These Current Type functions can be made to apply to other items in the database of a map by chang-
ing the feature item.  Do this with  change lines item  (or equivalent) on the Database pulldown from 
the Lines, Points, or Areas bar.

Select for Expression

You can specify an expression to be used in searching the database.  The new selected set will consist 
of all elements in the map that fit the expression.  The criteria can involve numeric and/or character 
items with the logical relations described using the suite of arithmetic and logical operators and con-
nectors listed in Table 6 (p. 78).  To make such a selection, Click  for  on the Select popup and enter 
the expression in the blank:

for   expression  (enter below):
   :     [type expression here]

Some examples of simple expressions illustrate the method:

$ID  =  234 -  this will select the element(s) having User ID number 234. 

$ID  =  234  or  $ID  =  235 -  this will select those elements having User ID numbers 234

   and/or 235. 

PTYPE  =  ’Qal’ -  this will select all the polygon label points having tags of Qal. 

PTYPE  =  ’Qal’  or  PTYPE  =  ’Qt’ -  this will select all the polygon label points having tags of Qal 
     and/or Qt.

NUM  <=  50  and   NUM  >=  25 -  this will select all the map elements for which the value of the 
      numeric item NUM is in the range 25 to 50.

Be sure that each part of an expression is separated from the others by spaces and that, for repetitive 
criteria, the item is repeated (such as $ID or PTYPE).  Entries in character fields must be enclosed in 
single quotes.  Numerical comparisons require that the target item be numeric.
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Select by Length

Selection by line length is automated through the Length Select popup, which is opened from the 
Select popup:  pick  by length to specify the option.  The  ok  button will open the Length Select popup, 
from which you pick the appropriate length relation and then specify the desired length in map units 
from the keyboard or by clicking a distance on the screen:

Enter length in map units (typically meters), or hit <Return> 
to pick length with CURSOR: 

Selection Strategies

Various objectives in working with a map will be best served by different selection techniques or 
combinations of techniques.  None are unique, but some of the more common possibilities are de-
scribed below.

Select One Element

To select one line, point, polygon label point, or annotation string, use Select Many (or Select One), 
click on the element (and close the routine), and then assure that the intended feature was actually 
selected by checking which element redrew in the drawselect color.   A report in the dialog area should 
indicate that one element is selected.  Where the elements are crowded, change the identified element 
with a  2  (2 = next) until the target element blinks and then close the routine.  If this doesn’t work, 
zoom in closer. 
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Table 6.  Operators and connectors for selection expressions

Place character strings in single quotes.  For more information, see Feature Selection in the 
Arcedit Users Guide, and particularly the table of Logical Expressions, p. 8-5.

+ -  plus

- -  minus

/ -  divided by

* -  multiplied by

= -  is equal to

<> -  is not equal to

>= -  is greater than or equal to

<= -  is less than or equal to

> -  is greater than

< -  is less than

CN -  contains the single character string next specified

NC -  does not contain the singe character string next specified

& -  connects expressions that must all be true

OR -  connects expressions any of which must be true

XOR -  connects expressions only one of which must be true



On the Reshape (Lines) bar, various editing functions require that a single line segment be selected 
(indicated by  (S1)  at the end of the menu items).  Here you can start the Select Many routine directly 
from the Reshape bar with  sm.  Click on the line of interest, be sure that a line was actually identified 
(line blinks and identity is reported in the dialog area), close the routine, and check that the intended 
line is the one that redrew in the drawselect color.  

If the lines are crowded and you have trouble picking the right one, you can always zoom in, but first 
try isolating the line with Select Polygon.  Pick  sp  from the Reshape bar to start the Select Polygon 
Within routine, click a polygon that encloses the target line but crosses all the adjacent lines, and close 
the routine.  Check as before that the correct line is selected.  Also, because Select Polygon can catch 
tiny lines that are too small to see except at extreme enlargement, check the report in the dialog area 
to assure that only one line is selected.  Or start Select Polygon Passthru from the Select popup menu 
and simply cross the target line with a small polygon.

Select Several Elements

To select several elements, use Select Many and click on the several elements wanted.  In some cases 
it may be faster to use Select Polygon or even Select Screen to select the group containing the target 
elements and then to remove the unwanted elements from the set with Unselect Many or Unselect 
Polygon.

Clots and Overlaid Elements

Test for the presence of local clots of elements, including tiny lines, by clicking a polygon (Select 
Polygon) around the suspected clot and then checking the dialog area to see how many elements are 
selected.  Where overlaid elements are suspected, use this polygon technique or click with Select 
Many over the suspect element until no further elements are selected, then check to see how many 
have been selected.  Overlaid elements can occur where you have mistakenly entered the same ele-
ment more than once.  Small clots of lines can occur on imported scans or where you have moved a 
node across a vertex in a connecting line.  They may be suggested by a slight bulge in a line or at an 
intersection, or by the inability to combine adjoining line segments.  Overlaid elements that are not 
identical in location may be revealed by overwide plot symbols.

Isolate a Cross-Cutting Line

Use Select Polygon to select a line that crosses other lines, such as a leader in an imported scan or a 
fault cutting layered rocks.  Clicking with Select Many is likely to catch unwanted nearby lines.

Most, But Not All Elements

Where you want to select most, but not quite all the elements in some area, the fastest method may be 
to select all the elements in the area and then unselect those not wanted.  Use Select Polygon or Select 
Screen to select all the elements in the area and then Unselect Many or Unselect Polygon to remove 
the unwanted elements.

79



Limit the Extent of a Database Search

If a selection by attribute (or For Expression) need only apply to part of a large map, it may save time 
to select all the elements in that part of the map first with select Polygon or Select Screen (you may 
want to turn Auto Drawselect off), and then reselect to conduct the database search.  Reselect operates 
only on the elements in the currently selected set.

Multiple Operations on a Selected Set

If more than one operation will be performed on a set of elements, arrange the work to permit all those 
operations to be performed while the set is selected, rather than selecting the same set several times.  
A common example  --  to select a set of elements, tag them, and then color them (session color)  --  
has been automated as  sel,tag,color  on the Select pulldowns from the various Digitize bars.  This 
routine begins by starting the Select Many routine for you to click on the wanted elements and then, 
when you close the routine with a  9,  tags the newly selected set with the current [feature]-type and 
presents the Colors popup from which you can assign a session color to the same selected set.

Progressive Selections

Where all the elements in an area are to be operated on, but with different values for some database 
item, it may be most efficient to use a progressive selection technique.  A simple example is to color 
all the lines in an area, most in red but some in green.  Start by selecting all the lines and coloring them 
green.  Then unselect the few lines intended to be green and color the rest red.  The basic principal is 
to start with the category having the fewest elements, leave them behind by unselecting them, and then 
to proceed on progressively through larger groups, reserving the largest for last.   Where the unselec-
tion is done automatically rather than by hand (as with Unselect For Expression or Unselect by Current 
[Feature]type), the particular sequence used is not as important.

SAVING

When you open an edit map and change it in ALACARTE,  the changes are not automatically recorded 
in the permanent file for that map.  Instead, the changes are recorded in a temporary file that was 
created when you opened the map.  If you want to preserve your new work, you must deliberately save 
this temporary file.

Two principal options are available when you save:  you can overwrite the existing file for the map, or 
you can leave that unchanged and save the modified map as a new version.  Because each new version 
that you save will require additional space on the storage device (typically a hard disk), you should be 
sparing in saving as a new map, but it is important to have a fairly recent version available in the rare 
event that the current working version becomes corrupted.

The basic principle to follow is always to save as a new file after radical treatment of the map, in-
cluding such bulk processes as deletion of all tiny lines in an imported scan, running Generalize on the 
whole map, or cleaning the map.  Or, save or copy as a new version before operating on the map.  In 
addition, in order to keep a fairly recent version available as one form of backup, save as a new file 
after each significant new increment of work.  After assuring that these files are in order, delete the last 
previous version to minimize your storage requirements (after archiving, if appropriate).
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A map can be saved from three places in ALACARTE:  from any Options pulldown in Edit, from the 
Save pulldown from the Edit bar, and from the ARC/INFO interrupt that appears when you leave Edit 
without having saved after changing a map.  The Save pulldown illustrates all the available save 
options:

cur map(ow) -  save current edit map by overwriting the existing file.  

cur map(new) -  save current edit map as a new file; enter new file name. 

all maps (ow) -  save all open maps by overwriting existing files. 

save-select? -  set save to include current selected set of map elements (SEL item).

save-symbol? -  set save to include current symbols assigned to elements (SYMB item).

save-audit? -  set save to include audit trail.

show settings -  report save settings.

save setup -  save current settings to setup file.

use setup -  pick existing map from which to read and use setup file for current map.

The current edit map can be saved by overwriting its permanent file (which replaces the earlier version 
of the map with the current version), the current edit map can be saved as a new file (you will be 
prompted to enter a new file name), or all the open edit maps can be saved at once by overwriting their 
permanent files.  The Options pulldowns offer only the overwrite option for the current edit map 
(save(OW)), whereas saving at the ARC/INFO interrupt saves all open edit maps by overwriting.

You must save before quitting after an edit session in order to preserve your work, but you may want 
to save during an edit session as well.  Although it is not likely, your system can crash without notice, 
and you want to avoid loosing several hours of work if it does.  Saving an edit map cancels all current 
symbol assignments (such as session colors), which requires that they be reassigned after the save.  
Frequency of saving is thus a compromise between the time required and vulnerability to loss.  An 
optimum frequency is probably every 45 minutes to an hour.  Because it is hard to remember to save 
while you are working, one useful rule is that, when you think of saving, do so. 

If ALACARTE crashes while you are editing and you cannot make anything work, you can keep your 
temporary files for later restoration by terminating communication with the host rather than perform-
ing a system break (CONTROL-P or CONTROL-C).  Breaking out of ARC and answering  yes  to  Are 
you sure (y/n):  causes the temporary files containing your current edits to be deleted.  Instead, hang up 
the data phone, turn off the terminal, quit the session window, or the equivalent to terminate commu-
nication with ARC.  Then you can use  Restore edit session  (on the Files pulldown from the General 
bar) to recreate the lost edit map.

The second set of items on the Save pulldown is designed to aid resetting your map after saves.  In any 
one session, you can include in your saves the currently selected set of map elements, the current set 
of symbol assignments (such as session colors), and/or an audit history of your work.  To do this, 
simply pick the appropriate item(s) from the Save pulldown and enter  yes  at the prompt(s).  Then each 
time you save during the session, that additional information will be saved.  During an edit session 
ALACARTE will automatically restore the selected set and assigned symbols after each save.  This 
information can also be recovered in a new edit session by picking  restore save  from any Options 
pulldown in Edit.  Do this before you begin work, or you will lose any newly established selection or 
symbols.
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The third set of items on the Save pulldown provides a way of saving the current snap settings to the 
Setup file for the edit map and of copying a setup file from another map (specify from a Map Names 
popup) for use with the current edit map.

CUSTOM TAG MENUS

You can make your own menus and open them from the appropriate digitize bars in Edit to set the 
current tag type (line type, area type, etc.) that is maintained at the digitize bars. These menus are 
specific to a particular map layer and are automatically saved and copied with that map.  Three such 
menus can be prepared for each kind of tag, and each menu can contain as many as 100 entries.  
Picking tags from such menus avoids the risk of misspelling that is present when you enter a custom 
tag from the keyboard.

You will need to learn how to use the screen editor that is opened on your system by ALACARTE (see 
System Details, p. 35, and/or consult your system administrator).

To prepare a custom menu, go to the directory for the map and then open the menu for Custom Tag 
Menus (pick  create tagging menus  on the Prepare Scans pulldown from the Setup bar):

Create or edit custom tag menu using the system editor:  vi

  Name of map for which tag menu is to be created or edited:

/REDHOME/CWENT/TOUR/CLP.GEOL

Create new tag menu  or  Edit existing tag menu    Choice :  NEW

Select tag menu to create or edit:

AREAS1 AREAS2 AREAS3
LINETYPES1 LINETYPES2 LINETYPES3
LINEMODS1 LINEMODS2 LINEMODS3
POiNTS1 POINTS2 POINTS3
ATTITUDES1 ATTITUDES2 ATTITUDES3
LINEATIONS1 LINEATIONS2 LINEATIONS3

Selected tag menu:  area1.alc

OK     editor help    CANCEL

The type of editor installed for your system will be reported at the right end of the first line in the 
menu.  Specify the name of the map for which the menu is intended (list maps with  ?  or middle 
mouseclick in blank, then pick the name).  Indicate whether you want to prepare a new menu or edit 
an existing one by picking the appropriate button  (Create new tag menu  or  Edit existing tag menu); 
your choice will be noted at the right.  Then specify the tag menu involved by picking the button that 
represents both the type and the menu number  (1,  2,  or  3).  The selected tag menu will be reported 
(including its .alc extension).

When you are ready, pick the  OK  button to open the screen editor.  If you are starting a new menu, 
ALACARTE will automatically insert the first four lines of the new file for you.  If you are editing an 
existing file, that file will be opened in the editor. 
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The first four lines of the file consist of computer instructions, menu headings, and a CANCEL button 
for the menu; for example:

1    3     area3.alc,  ALACARTE custom geologic unit tagging menu 3
2    0  0    
3    Select unit Tag:
4    CANCEL
5

Following these four lines, you should enter your custom tags, one to a line, using the procedures 
specific to your screen editor and terminal.

Organize the labels as you wish (stratigraphically or alphabetically, for example).  The items will be  
arranged in sequence, row by row, in the menu.  Short entries are best, but do not exceed 32 
characters.  If you include spaces in an entry, be sure to enclose the whole entry in single quotes.

The file should look like this (an example for unit labels):

   1   3     area3.alc,  ALACARTE custom geologic unit tagging menu 3
  2    0  0    
  3    Select unit Tag:
  4    CANCEL
  5     Qal
  6     Qls
  7     Qt
  8     Tv
  9     Ttl
10     ’unmapped area’

When you are finished, save the file from the screen editor.  ALACARTE will place it in the map 
subdirectory (the map name is actually the name of its subdirectory, which contains the AAT, PAT, 
and other files that constitute the map).  The .alc extension on the file name will cause ALACARTE 
to copy the menu file when you save or process the map to a new map name.

Edit an existing menu in the same fashion.  Note that when you save a new tag menu, it will overwrite 
any existing file of the same name for that map.
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PROCEDURES

Various procedures for use with  ALACARTE - ARC/INFO are systematically described for reference 
during planning and work with maps.  These procedures represent the principal steps involved in 
compiling a map in ALACARTE - ARC/INFO.  The particular methods described here work effec-
tively, but the system is very flexible and many operations can be carried out in more than one way.

Steps in Preparing a Digital Map

This section describes the steps and operations involved in preparing a standard ALACARTE geologic 
map and provides cross references to the more detailed discussions elsewhere in this manual. The 
general issues in compiling a geologic map with ALACARTE-ARC/INFO are discussed in Compiling 
a Digital Map (p. 6).  

PLAN THE WORK

Before you start, decide how you will prepare the map and why you are working digitally (see Com-
pilation Goals, p. 7).  Choose a map scale and a base map and projection, select your source materials, 
and decide how best to enter the line work and other data into the computer (use table 7 as a guide, p. 
89).  Will the base be digital, or will the digital geology be fitted to a photomechanical base, and how 
will you accommodate a physically mosaicked base?

If your objective is solely print production, you can be concerned only with cartographic appearance 
at map scale, whereas if the digital map is to serve as a digital database or will be released digitally, 
you may want to attend more carefully to small scanning artifacts and the details of line shapes.  There 
may be additional database fields (items) required, including one for some measure of spatial resolu-
tion, and you will want to assure that full topologic relations are established.  If you are compiling a 
map from larger scale sources, decide whether you will want to have digital versions of the source 
maps at their original resolutions or whether you can incorporate the first step in simplification for the 
smaller compilation scale into tracings that you prepare for scanning input.

Design the Map

Select the base map and the projection for the final map (see Projections, p. 101).  Separate the infor-
mation that the map will contain into appropriate layers (see Layers, p. 11) and choose distinctive file 
names for the layers.  A standard ALACARTE geologic map can consist of at least eight layers:

Base (assuming that base separations will be scanned)

culture - [map name].clt

drainage - [map name].drn

index contours - [map name].idx

intermediate contours - [map name].int

Lines   (after completion, the lines layer is used to start the Areas layer and is then abandoned)

faults, contacts, water and scratch boundaries, map boundary - [map name].ln,  .ln2, etc.

Areas  (polygons)

map units (and all information from the Lines layer) - [map name].py, .py2, etc.
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Structure

orientation data, fold axes, structural contours - [map name].sr, .sr2,  etc.

Other Points 

field stations, fossil localities, sample localities, chemical analyses

radiometric dates, wells, or other data  -  [map name].pt, .pt2, etc.       (or a more specific designation)

Annotation

unit labels (and leaders), fault names, point labels, other map-face text - [map name].an, .an2, etc.

Naming Map Layers - Your objective should be to make the names distinctive and short (typically 
no more than eight characters).  You want to be able to determine from the file name alone what the 
layer is and which is the most recent version.  One simple way to accomplish this, as illustrated in the 
list above, is to use a short abbreviation for the map name and indicate the kind of layer with a suffix. 
Leave space in the suffix for trailing numbers to indicate sequence as you edit and save new versions. 

Procedure

Plan the sequence of steps that will be required to prepare the map.  This will depend particularly on 
whether and how you obtain a digital base and whether you decide to enter the line work by hand 
digitizing or by scanning.  The typical sequence for the geologic data in a standard ALACARTE 
geologic map is shown in figure 1 (p. 87), which illustrates the contrast between line input by scanning 
or by digitizing.  Most other data in the map will require hand entry, although a scan can serve as an 
on-screen background from which points or oriented structural symbols can be traced.  The boxes in 
the figure mark the steps that involve hand work;  of those, the work with lines will take the largest 
amount of effort, just as it does in conventional work with a pen.

BASE MAP

It is strongly recommended that you obtain a digital version of your base map to work with on screen 
and to be able to include in plots (see Base Maps, p. 8).  If the base map (or base separations) will be 
scanned, you must assure that sufficient registration is present on the originals before they are 
scanned, because precise registration cannot be established later (see Map Registration, p. 115).

Obtain the files for the digital version of the base map (or layers) and convert them into arc coverages 
(see Import from Vector Source, p. 155).

Prepare a projected tic framework, adjust the tic registration, and transform the base layers into the 
projection of the original base map using the Prepare Scans sequence, as described below (see Tic 
Framework and Database, p. 88).

Mosaics - physical mosaics prepared from maps of adjacent quadrangles will not be in a single co-
herent projection, and therefore will not fit exactly with a geologic map prepared with a common, 
mathematically projected tic framework in ALACARTE - ARC/INFO.  Scan the quadrangle base 
maps separately and prepare them in their original projections.  Then reproject them into a common 
projection.  This can be done before compiling the geology or after the geology has been compiled as 
separate digital quadrangles (but remember that the projection of the tic framework must match that of 
the source map initially).  If the geology must be fitted back to a physical mosaic of the quadrangle 
bases, the best procedure is to prepare the base mosaic over a scale-stable plot of the projected tic 
framework of the digital map.  This will assure the closest fit between the two.  In any case, the 
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Prepare Source
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   Database for Lines
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Contacts, Faults, and Units
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         for Units
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Prepare Structure Layer

Enter Structural Data

Prepare Annotation Layer

Enter and Edit Annotation

Prepare Source

Add Water Boundaries

Clean for Polygons

Figure 1.  Principal steps in preparing a standard ALACARTE geologic map.  Ovals 
mark processing steps, boxes mark steps involving hand work.



disparity between quadrangle projections is small, and it may be satisfactory to force a fit between 
base and geology by transforming the geology into tics fitted precisely to the corners of the mosaic, 
using the projective option (see Projections, p. 101). 

GEOLOGIC SOURCES

Choose your source materials and decide how you will enter them.  Work from scale-stable materials 
where possible, but even good paper maps can be used because of the x,y scaling included in the 
Transform function (see Transform, p. 105).  Distortions caused by folds can be overcome if enough 
latitude/longitude tics are available by registering each section between the folds separately.  Be sure 
to include an adequate number of graphic registration marks (see Map Registration, p. 115).

Hand digitize where only a few lines are involved or a scanner is not available.  Otherwise, scan the 
source maps directly or make a tracing specifically for scanning.  Include the first round of generali-
zation in the tracing, if appropriate.

Scan a map directly where the line work is sharp and uncluttered by line ornaments (teeth, queries), 
abundant labels and leaders, or background.  Some base images can be dropped during scanning, but 
a test will be required with your specific map.  Tracing may be preferable even with a clear original if 
most of the lines are dashed or dotted.

Make a tracing where the source is not satisfactory for direct scanning.  Use a non-smear pencil on 
plastic, maintain a fine, regular line, and make all lines continuous regardless of intended line 
symbols.  Omit all thrust teeth and other ornaments.  Mark each change in line type along otherwise 
continuous lines with a small cross tic to impose a node in the line and flag the change in the scan.  Add 
graphic registration marks with stickup or fine drafting.

Import and process the scanned geology in the same fashion as a scanned base.

TIC FRAMEWORK AND DATABASE

Most work in compiling geology digitally will be done in the context of a map in a particular projec-
tion with associated databases for lines, polygons, and points that have been prepared with standard 
ALACARTE database items.  The procedure differs slightly depending on whether the input of lines 
is by hand digitizing or by scanning (see Start a New Map or Layer, p. 93).

Once a projected tic framework has been prepared for a base layer or for the lines layer, it can be 
copied to prepare other layers (by specifying the projected layer as a template for the other layers).  
Use the ALACARTE functions available from the Setup bar, and specify the appropriate kinds of map 
features to assure that the database is prepared properly.  Where lines will be entered from a digitizer, 
make the tic framework from the New Map pulldown, and prepare the database for faults, contacts, 
and units.

If you have started with a scan, be sure that the tic registration has been established (see Start a New 
Map or Layer, p. 93, Projections, p. 101, and Registering Imported Scans, p. 116), and use Step 2 
(transform)  on the Prepare Scans pulldown to make the projected tic framework and transform the 
scan into it.  Prepare the scan for lines with Step 4  (prep database),  regardless of its topical content.
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Table  7.  Worksheet for compiling a digital geologic map.

Map name - ________________________;   abbreviation for file names:  ____
Geologic source - ___________  ____________  ____________________  (medium, scale, reference)
Base map - _____________________________  (layer(s), type (scan, DLG, DEM),  source)
Registration - establish at lat.-long tics in every original:     existing     drafted     stickup

 file name       date   comments
Scans      (base layers, geology, other)

Raw vectorized scan - placed in working directory ___________ ___________ ___________
Unprojected scan - converted to ARC coverage ___________ ___________ ___________
Tic framework -  set up using projection worksheet___________ ___________ ___________
Place tics in scan - establish tics for transform;  record numbers and coordinates of tics to be used
Projected scan - ___________  (transform type) ___________ ___________ ______ (RMS error)
Check registration - compare other layers with  ________________  (master layer)

Lines Layer (contacts, faults, various kinds of boundaries)    [mapname].ln

Input Method - hand digitize    scan and edit    scan and trace    trace and scan    map on screen
Line types - make list of kinds of lines in map and line types to be assigned
Prepare layer - set up new map for faults, contacts, and units (use projection worksheet, table 8)  or prepare 

   projected scan for lines; __________ ___________ ___________
Edit Scan:  

Bulk editing ______ (Matchnode, spline, other)__________ ___________ ___________
Edit and tag (number the versions) __________ ___________ ___________

Hand digitize:
Digitize and edit (number the versions) __________ ___________ ___________

Boundaries -  ____________    (add and/or connect map, water, scratch, and any other boundaries).
__________ ___________ ___________

Areas Layer (polygons):       [mapname].py

Process or prepare  - clean lines layer for polygons or prepare edited scan for units
__________ ___________ ___________

Area types - make list of unit labels and-or make a custom tagging menu (Areas1, 2, and-or 3)
Label units - hand digitize or use Createlabels and select and tag
Edit - (build polygons as needed) __________ ___________ ___________

Structure Layer    [mapname].sr
Setup new layer - use [mapname].py as template __________ ___________ ___________      
Digitize oriented data and add fold axes

Points Layer (sample localities or other points)   [mapname].pt, .sl, or other specific name
Setup new layer - use [mapname].py as template __________ ___________ ___________      
Digitize oriented data and add fold axes

Annotation Layer (unit labels, leaders, and other map-face text)   [mapname].an
Setup new layer - use [mapname].py as template __________ ___________ ___________      
Copy unit tags -   use  create unit annotation  to  copy unit tags from PTYPEs
Edit - move, add, and delete labels; add leaders; add other map face labels and text
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In either procedure, be sure to include the Map Boundary option if you are working with geologic lines 
for a regular quadrangle; this will be needed to close polygons around the boundary of the map.  Add 
an equivalent outer boundary (such as a scratch boundary) around an irregular map outline by hand. 

Prepare base scans for lines, as this will permit you to tag lines in the base layers if occasion requires 
(such as to identify closed water boundaries in the drainage layer for later incorporation into the 
polygon layer).

LINES LAYER

The lines layer will contain all the contacts, faults, and any other lines that will bound map units 
(polygon boundaries).  Do not put any other kinds of lines in this layer (fold axes, isograds, structural 
contours), because they will unnecessarily break up the map-unit polygons.  If the lines will be edited 
from an imported scan, be sure that the scan has been processed with Step 4  (prep database)  on the 
Prepare Scans pulldown to prepare it for lines.  A map begun for faults, contacts, and units from the 
New Map pulldown will already have a database prepared for lines.

Enter lines by hand from a digitizer or by tracing on screen over a scan (see Digitize Lines, p. 129).  
Decide how you will tag the various kinds of lines (make a list) and then begin.  If you are working 
from a digitizer, choose the lines layer as the edit map, register the source map on the digitizer, su-
perimpose a transparent overlay on which to monitor progress and problems, set the line type, and start 
digitizing.  For on-screen digitizing, simply draw the scan or base map over which you will work in 
the background behind the lines layer, and begin digitizing lines.  Set the line type for the kinds of lines 
you are adding, or be sure to retag later.  Every line will be assigned the current line type at the time it 
is digitized.  Be sure to save occasionally.

If you are editing a scan for lines, work on screen to remove all extraneous material, correct scanning 
artifacts, connect and combine lines as appropriate, and tag all the lines (see Process and Edit Scans, 
p. 155, and Edit Lines, p. 135).  Consider bulk processing to close gaps (Matchnode) or smooth ir-
regular lines (Spline or Generalize), but be sure to test the effects first and to work on a copy of the 
map, as unwanted effects can be common.

Review your work on screen with Node Errors turned on to check for problems that require correction 
(see Edit Lines, p. 135) and/or make and examine an edit plot.  

 If a scanned image contains fold axes or other lines that you will want later, consider copying them 
into a temporary storage layer before deleting them from the lines layer.  The simplest method is to 
color them as you encounter them and, when you are ready to clear out a section of the map, to select 
them by their color ($symbol), use the Put function to copy them into the temporary storage layer, and 
then delete them from the lines layer.  Later you can edit and tag them in the temporary layer and 
incorporate them into the structure or other specialized layer.

If you did not include creation of a map boundary in the initial preparation of the lines layer, you will 
want to add a boundary around the line work to close map-unit polygons.  Do this by digitizing a 
scratch boundary (place a node in that boundary at the end of each dangling internal line, with 
nodesnap on, to connect the boundary) or by starting a new map to make a projected map boundary 
and then adding it to the lines layer with the Put or Get function.  Be sure to connect internal lines to 
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the boundary.  Similarly, add open water boundaries to the lines layer and connect adjoining lines to 
them.  Obtain the water boundaries from a digital base map (drainage layer) or hand digitize them from 
a copy of the base.  

POLYGON LAYER (UNITS)

Start the polygon layer by processing the lines layer for polygons (see Prepare the Polygon Layer, p. 
161).  For a map containing hand digitized lines, which should already contain a database prepared for 
polygons, simply clean the map for polygons and specify the new polygon layer for the output map. 
For a map containing scanned lines, process the layer for units (polygons) with Step 4  (prep database) 
in the Prepare Scans sequence.

Tag the polygons by geologic unit either by digitizing tagged label points or by running Createlabels 
and then selecting and tagging each label point (see Tag and Edit Areas, p. 161).  The practical dif-
ference between these two methods is in the kinds or errors that can result and the methods used to find 
and correct them (see Check Labels, p. 165).  You can set the area type from the keyboard, but be 
careful about misspellings.  If, instead, you prepare and use a custom tag menu to set the area type (see 
Custom Tag Menus, p. 82), the spellings will be constant, but be sure to pick the right item from that 
menu.  Use the methods described in Check Labels to check your work, correct polygons with in-
complete boundaries before adding labels to them or fixing PTYPEs that have been changed in 
multiple label points by a build, and take full advantage of the methods available to help you find 
errors (see Check Labels, and On-Screen Coloring, p. 168).

Createlabels - The Createlabels function applied to an untagged map will place an untagged label 
point at the centroid of each valid polygon (see Run Createlabels, p. 164). (Be sure that you are using 
ARC/INFO 5.0.1, as in earlier versions the label can be placed outside the boundary of irregularly 
shaped polygons.)  It can be difficult to find and select these label points (use the  sel,tag,color  item) 
and they may not be where you want the label point to be, particularly as its location determines where 
the unit label will be posted when you start the annotation layer (see Add and Edit Annotation, p. 187). 
 It can also be difficult to find intended polygons that have incomplete boundaries.  The only errors 
will be those imposed by erroneous tagging and by incomplete polygon boundaries. 

Hand Digitizing - Placing the label points by hand will give you more control over the locations of 
the label points and will be somewhat faster than the Createlabels approach.  Errors can include as-
signing the wrong tag to a polygon or placing a label on the wrong side of the boundary of a small 
polygon (zoom in on it).  More important is the effect of building the map with polygons that contain 
more than one label point, which will occur where polygon boundaries are incomplete.  ARC/INFO 
will arbitrarily convert the PTYPEs of all label points in a valid polygon to the same entry.  Where you 
find that multiple labels exist (with Labelerrors) because of a broken polygon boundary, be sure to 
check the PTYPEs of those labels and correct the erroneous one(s).

Note that you will probably want to build the map for polygons several times (see Topology, p. 56) as 
you enter and edit the labels and tags, in order to be able to use the on-screen coloring techniques to 
find remaining problems (see On-Screen Coloring, p. 168).  
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STRUCTURE LAYER

Start the structure layer from the New Layer pulldown and specify the polygon layer as a template (see 
Start a New Map or Layer, p. 93).  Enter and tag any structural lines (fold axes, contours) by hand 
digitizing or by copying from an edited scan with the Get or Put function.

Enter bedding attitudes and other oriented structural data from a digitizer or by tracing over a scanned 
background image (see Oriented Symbols and Data, p. 179).  Be sure to set the Symbols Environment 
properly first.  Superimposing a template over the structural symbols for graphic entry from a digitizer 
can increase the precision of specifying strike and of the calculated location of the data point.  (Make 
a transparent template on which a strike-and-dip symbol 3-4 inches long is drafted, with the dip line 
located precisely at the center of the strike line;  number the ends 1 to the left and 2 to the right, looking 
down dip, to guide the sequence of clickpoints.)  

Adjust the location of dip or plunge numbers from the Annotation bar (see Add and Edit Annotation, 
p. 187).  In doing this, be sure to specify the markerset and lookup table for the symbols and set the 
Symbols Environment to show the structural symbols and numbers on screen in proper spatial pro-
portion (see Set the Symbol Environment, p. 180).

ANNOTATION LAYER

Start the annotation layer from the New Layer pulldown by preparing a new layer for annotation and 
leaders (specify the polygon layer as the template) and then posting all the unit identities from the 
PTYPE item of the polygon label points with  create unit annotation  on the New Layer pulldown (see 
Copy Annotation from Database, p. 98).

Edit these unit labels from the Change Annotation bar.  Move, delete, and copy the unit labels and add 
short leaders (from the Digitize Lines bar) to provide appropriate graphic labels for the map units.

Be sure to display the geologic line work and the oriented symbols in the background for reference.  
Choose the polygon layer as a background and turn on background lines and labels.  Display the 
oriented symbols with  draw cov in back  after setting the markerset and lookup table properly (see 
Display Symbols in Background, p. 184).  Set the draw scale to match the size of the structural symbols 
(2X will be best) to assure that the structural symbols and numbers draw on screen in proper spatial 
proportion (see Set the Symbol Environment, p. 180).

For some purposes you may want to color selected map units instead, using a custom coloring program 
to color polygons in the background (see Custom Colorfill, p. 170). Specify the polygon layer in this 
program explicitly, rather than using the edit-cover version of the program, because the edit cover will 
be the annotation layer, not the polygon layer.  (Note that polygon coloring and displaying oriented 
symbols in the background cannot be done concurrently.)

Add any other map-face text here as well.  This might include the names of major faults and identifi-
cation of any special points in the map, such a wells or fossil localities.  These point identifiers can be 
posted from the database of the points layer in the same fashion as the unit labels (see Copy Annotation 
from Database, p. 98).
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Start a New Map or Layer

Starting a new map or layer involves two principal steps, (1) defining a framework of digital regis-
tration tics at known locations in a specified map projection, and (2) preparing the database of that 
empty map for the intended kinds of data.  An equivalent process is available to prepare imported 
scans.  The various functions available from the Setup bar make these procedures straightforward.  
Start a new projected map from one of the options on the New Map pulldown, make a projected tic 
framework for a scan there or from the Prepare Scans pulldown (Transform step), and copy the tic 
framework from an existing map for a new layer from the New Layer pulldown.  These maps will all 
be projected maps in which the dimensions are meters on the ground in the specified projection.  The 
initial projection is that of the source map, but once the map is in digital form this can be changed as 
desired.

The use of the Setup functions is described here, but also see Projections (p. 101) for a description of 
projection issues and the Transform function and Map Registration (p. 115) for discussion of estab-
lishing, checking, and improving registration of map data to the earth and between layers.  The full 
procedures for working with scans are addressed in Process and Edit Scans (p. 155).

Maps can also be started with rectangular coordinates with dimensions of inches on the map.  Unless 
such a map is later transformed into a projection, however, it will not support work with such oriented 
structural data as bedding attitudes.

It is wise to plan your map before actually starting it.  Choose a base, determine the scale and projec-
tion, decide how the data will be entered, determine what map layers you will want, and establish 
registration procedures (see Compiling a Digital Map, p. 6, and Map Registration, p. 115).  If you plan 
to compile geology on a digital base map, start by obtaining and preparing the digital base as a pro-
jected map (see, for example, Registering Imported Scans, p. 116). 

You will be asked to specify map scale.   For digital maps, the principal significance of scale is as a 
measure of the spatial resolution of the map data.  This is important because a digital map can be 
displayed or plotted at any scale, regardless of the scale from which the map was digitized.  The scale 
of a digital map is also used by ALACARTE to determine the size and placement of such annotation 
as dip values for bedding attitudes.  Where the scale of a source map is larger than that of the digital 
map being compiled, you should decide whether you want to do any necessary simplifying prior to 
digitizing or later in the computer, and therefore what the scale (resolution) of the digitized source map 
will be.

PROJECTED FRAMEWORK AND DATABASE

The Setup functions all use the same basic suite of routines, with differences depending on the data-
base features, use of an existing map as a template, and creation of a projected map boundary in the 
process.  The New Map procedures are the most complete, and their description will thus explain the 
whole suite of routines.

The several New Map options (on the New Map pulldown from the Setup bar) create an empty map 
containing digital registration tics at designated latitude/longitude positions in a specified projection.  
Tics can be placed automatically at the corners of a standard quadrangle or can be specified individ-
ually for non-standard maps.  For standard quadrangles, internal tics and a projected map boundary 
connecting the corner tics can be generated automatically.
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ALACARTE Version 1.0 supports seven projections that are commonly used in geology in the United 
States:  Lambert Conformal Conic, Transverse Mercator, Oblique Mercator, Polyconic, Universal 
Transverse Mercator (UTM), Albers Equal-Area Conic, and the special DNAG projection, as well as 
the State Plane equivalents.  Consult Projections and your source map (or the base map, or Snyder, 
1987; see reference on p. 102) for the information that will be required by the Setup routine in order 
to establish a map in the projection that you specify. 

New Map Sequence

To begin the New Map sequence, pick the option from the New Map pulldown that contains the kinds 
of map features that you want (either in terms of geologic features or of lines, points and polygons, as 
noted below).  A sequence of questions is then presented through forms menus in which you name the 
map, specify map scale, enter tic locations, define the projection, and enter values for several edit and 
topology parameters (the sequence of questions differs for standard quadrangles and non-standard 
maps).  The whole procedure requires only a few minutes (You can terminate the sequence at any time 
by picking  cancel  from any one of the forms menus).  Once the map is created, you can modify the 
database format, if necessary, by adding and/or deleting database items  (see Database Items, p. 55).

Kinds of Features 

Specify the kinds of features that you plan to enter in the map by picking the appropriate menu item 
on the New Map pulldown; ALACARTE will prepare the database for those features and add the 
standard items used in ALACARTE for them:

faults, contacts, units -  lines and polygons; LTYPE and PTYPE items.

unit boundaries only -  lines; PTYPE item (no LTYPE).

geologic structures -  fold axes and oriented structural features (lines and points); LTYPE, 
PTTYPE,  STRIKE, and DIP items.

sample localities -  points;  PTTYPE and SAMPNO items.

annotation + leaders -  lines and annotation; LTYPE item

Map Name

Specify a name for your new map that is distinctive and short enough that suffixes can be added to 
identify other layers (such as loma, followed by layers such as loma.ln for lines; see Design the Map, p. 
85).  Check the pathname indicated in the  change map dir  blank to be sure that you are in the directory 
in which the new map is to be placed and, if necessary, change directories before proceeding. 

Standard Quadrangle or Non-Standard Map

Indicate that your map is a standard quadrangle and designate its scale by picking the map scale here; 
or, for a non-standard map, pick  none  here, which will later permit you to enter the tic locations 
individually, then specify the map scale on the next menu.  To specify a scale not listed on the menu, 
click in the  Other:  blank and enter the denominator of the scale ratio (omit commas). 
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Specify Tic Locations

For a standard quadrangle, enter the latitude and longitude of the southeast corner and ALACARTE 
will calculate the location of the other corners automatically and place a digital registration tic at each. 
For non-standard maps, enter at least four tics located near the outer corners of the map.  ALACARTE 
will prompt you for these in sequence, and then offer the opportunity to add as many more as you wish, 
one at a time.  In specifying tic locations, you can enter degrees, minutes, and seconds separately, or 
use decimal degrees or minutes in any combination.

Internal Tics

For a standard quadrangle, indicate whether internal tics should be generated - Y(es) or N(o).  These 
tics will be placed automatically at the interval standard for the designated scale of quadrangle (2.5’ at 
1:24,000, 5’ at 1:62,500, 7.5’ at 1:100,000, and 15’ at 1:250,000).  See Projections (p. 101) for the 
numbering pattern used by ALACARTE For non-standard maps, specify any internal tics as part of the 
tic entry process above.

Map Projection

Pick the projection of the map.  The projection of the digital map must match that of the source map, 
at least initially.  Any change in projection is made after a digital version of the original has been 
prepared.

Projection Parameters

Various parameters will be requested, depending on the projection specified for the map (see Projec-
tions, p. 101).  Enter these as they are requested by the sequence of forms menus.  As in specifying the 
location of tics, latitude and longitude can be entered in degrees, minutes, and seconds separately, or 
in decimal degrees or minutes in any combination. 

False origin

Reposition the origin for the map coordinates (meters on the ground) by entering values for x and/or 
y.  For most maps you can leave the values at 0.  Do not use a false origin for a State Plane map (see 
Projections, p. 101, for the false easting required to convert Transverse Mercator and Lambert maps 
to the State Plane origin).

Edit and Topology Tolerances

Specify map scale and, particularly for maps to contain lines, set the various parameters that are used 
during editing (see Snapping and Other Controls, p. 123). By specifying them here while setting up 
the map, you will record them in the setup file for the map, from which they will be reset for you 
automatically every time you open the map for editing.  These stored values can be changed later if 
desired by setting new values during an edit session;  the setup file can be changed by saving such reset 
values. Only the weed tolerance and edit distance need attention for maps that will contain no lines.
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Set default edit tolerances for this map:

    meters or     inches

weed tolerance 1. . . . . . . . 0 . . . . . . . -  keep small (as, 0-1 meter).

intersectarcs ALL . . . . . . . . . . . . . -  use ALL for most work.

arcsnap distance 12 . . . . . . .02. . . . . . -  typical value: 0.01-0.03 inches.

arcsnap type ON . . . . . . . . . . . . . .

nodesnap distance 12 . . . . . . .02. . . . . . -  typical value: 0.01-0.03 inches.

nodesnap type CLOSEST . . . . . . . . -  generally use CLOSEST.

extend distance 12 . . . . . . .02. . . . . . -  as above, or set in Edit.
extend direction BOTH . . . . . . . . . . 

edit distance -1 . . . . . . -  use  -1 here; reset temporarily in Edit 

ok     help     cancel     Map scale  =  24000

Default values for the fuzzy and dangle tolerances (used by the Clean function) can be recorded here 
in the Setup file, but can be overridden from the Clean menu when appropriate.  The tic match toler-
ance can be used to prevent work on a poorly registered map by automatically rejecting any 
registration on a digitizer that does not meet the tolerance, but you may prefer to reserve control of that 
decision to the occasion.

Set default topology tolerances for this map,  in meters:

    meters or     inches

fuzzy tolerance . . . . . . . . . . . . . . . . . . -  typically use 0.001 inches.

dangle tolerance . . . . . . . . . . . . . . . . . . -  typically use 0.

tic match tolerance . . . . . . . . . . . . . . . . . . -  typically leave blank.

ok    help    cancel     Map scale  =  24000

Quadrangle Boundary

You can have a quadrangle boundary added automatically to a standard quadrangle (answer  Yes  to 
the question).  If you will ever want a boundary for the map, this is the place to create it, because 
ALACARTE will bend the boundaries properly in the map projection.  

Select and Symbol Items

Include these items (answer  Yes)  to add the items SEL and SYMB to the database if you will want to 
be able to save a selected set or the current symbol assignments (such as line colors) between map 
saves and edit sessions.  Adding these items does no harm, in any case.
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Check the Plan

Check the report to be sure that the plan for the map is as intended:  

      These are the parameters for your new map layer:

        map name: Geol.ln
quad type: ’7.5 24’ (7-1/2 minute quadrangle, 1:24,000)

map scale: 24000
map units: meters

            make quad boundary: .true.
      add symbol/select items: YES

                 click for projection info: projection
           click for edit snapping info: snapping
click for topology tolerances info: tolerances

make map now    cancel

Click on the  projection,  snapping,  or  tolerances  buttons to list those settings, respectively.  If 
everything is correct, pick  make map now   to have ALACARTE proceed to make the map, otherwise 
cancel  the procedure and start again. 

Once all the needed information is entered and you start the processing, ALACARTE proceeds to 
create the named map layer in the current directory with tics at the specified latitude/longitude posi-
tions in the designated projection.  When this process is completed, which can take several minutes, 
you will be returned to the Setup bar menu and notified with a beep.  The new map will be the selected 
map if you proceed down to the Edit bar.  

New Layer Sequence

The options for kinds of features for a new layer are the same as for a new map (except for creation of 
a unit labels layer, discussed below).   Once the process is started by picking an option from the New 
Layer pulldown, the sequence proceeds to ask for a name for the layer (and offers a place to change 
directories, if necessary), for specification of a template from the set of existing maps, and for in-
structions about adding database items for saving symbols and a selected set (SYMB and SEL).  These 
instructions are listed for inspection, and then you are given a change to cancel or proceed to make the 
map.  No opportunity is available to make a projected map boundary.  Make that separately from the 
New Map pulldown or copy one from an existing layer if it is needed.

Prepare a Scan

The procedure for scans is somewhat different, because the scan contains map elements that must be 
retained.  Once the scan has been imported and converted to ARC/INFO, follow the instructions in 
Registering Imported Scans (p. 116) to place the scan in a projected framework of tics.  The database 
is prepared as a separate step, in contrast to the New Map and New Layer sequences.  Pick  4. prep 
database from the Prepare Scans pulldown to open the Build Database menu:
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Build  database  files  needed  for  the  layer  type  specified  below
      name of map:     . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
           layer type:     . . . . . . . . . . . . . . . . . .
  add symbol and select items?:      YES          YES    NO
  ok      help      cancel

Specify in this menu the desired options for processing the projected scan.  Use a  ?  or middle mouse 
click in the Layer Type blank to list the options for selection, and click on the YES  or  NO button for 
SYMB and SEL.  Pick  ok  to start the process or quit with  cancel.

COPY ANNOTATION FROM DATABASE

Information stored in a database item of one map layer can be copied automatically into another layer 
and posted at the locations of the associated map elements.  Use this procedure, for example, to start 
an annotation layer for a geologic map by entering unit labels from the PTYPE item of the polygon 
layer for subsequent editing.  Start by preparing a new layer with  annotation + leaders,  then add the 
database information using  create unit annotation  (both are located on the New Layer pulldown from 
the Setup bar).  Entries in any database item (character or numeric) for any kind of of map feature 
(polygon label points, lines, or points) can be posted in this fashion. 

Create feature annotation - creates annotation for a specified map
layer from database values

<feature type>   . . . . . . . . . . . . . . .
<cover to receive annotation>   . . . . . . . . . . . . . . . . . . . . . . . . . . .
<source cover used for annotation>   . . . . . . . . . . . . . . . . . . . . . . . . . . .
<feature source item used for annotation>   . . . . . . . . . . . . . . . . . . . . . . . . . . .
<annolevel> 1
<mapscale>  24000 . . . . . . . .
<mapunits>  METERS . . .
<text height>  0.1 . . . . . . . .

ok    help    cancel

Enter  ?  or a middle mouse click in the blanks to list the options and pick the layer just prepared to 
receive the annotation, the map from which the annotation will be obtained, and the database item in 
that map containing the information.  Leave the annolevel at 1 unless you have good reason to change 
it, enter the presentation scale for the map, pick the units for the map (meters for ALACARTE maps), 
and specify a height for characters in inches on the map (note that the default of 0.1 is standard for unit 
symbols).  Activate the process with  ok.  The contents of the specified database item will be added to 
the receiving layer as text annotation at the locations of the associated map elements.

SIMPLE MAP FRAMEWORK

The Create Map routine can be used to make a map framework without preparing an associated 
database.  Three different options are available depending on where you are in ALACARTE:  you can 
copy an existing tic framework and its dimensions (from the Files pulldown from the General bar, the 
Choose Map menu, or the Map pulldown from the Edit bar), you can enter tics from a digitizer or on 
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screen in map inches (from the Choose Map menu or the Map pulldown from the Edit bar), or you can 
create a map with unit dimensions and no tics (from the Files pulldown from the General bar).  Use 
these procedures particularly where you do not need the database preparation or where you want the 
dimensions to be inches on the map.

Create Map from General Bar

The tics and dimensions of an existing map can be copied without any associated database preparation. 
Pick  create map  from the Files pulldown, enter the name of the new map (layer), and specify the 
template map.  The new layer will be placed in the current directory, but a template in another direc-
tory can be used by entering its full path name.  The new layer will have the tics and dimensions of the 
template, but you will have to attend to any needed database preparation separately (see Prepare Map 
Database, p. 100).

Create - create an empty map layer.  Tic locations may be copied from
another map layer.

name of new map: . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

optional:  name of map to use tics from  (tic bnd cover):

. . . . . . . . . . . . . . . . . . . . . . . . . . . . -  enter template name (or pathname).

ok    help    cancel

An empty map containing no tics and with unit dimensions (xmin=-1, ymin=-1, xmax=1, ymax=1, 
with origin at center) can be made from this menu by not specifying a template (leave the blank 
empty).  Tics can then be added on screen (from the Tics bar in Edit).

Create Map from Edit

The tics and dimensions of an existing map can also be copied from either the Choose Map popup 
menu that precedes the Edit bar or from the Map pulldown from that bar.  Pick  create map  to start 
the routine, enter the name of the new layer, and specify the template map.

Create - create an empty map layer.  Tic locations either entered with
current coordinate device (mouse, digitizer, etc.) or copied from an
existing map layer.

name of new map:  . . . . . . . . . . . . . . . . . . . . . . . . . . .

Note:  When asked to ’Enter initial boundary’ click just outside
(an inch is OK) the lower-left and upper-right margin of
your map.

optional:  name of map to copy tics from (tic bnd cover):

 . . . . . . . . . . . . . . . . . . . . . . . . . . .

ok    help    cancel
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Create Unprojected Tic Framework

An unprojected tic framework with dimensions in inches on the map can be prepared with the Create 
Map routine in Edit by not specifying a template (leave the blank empty).  You then digitize the tics 
directly from a map registered on the digitizer or on screen by tracing a background or working free-
hand (note that the tics will not be drawn on the screen as they are entered).  Map coordinates will be 
in digitizer inches or arbitrary units.  This method can be useful where you do not intend to project the 
map, or at least not until further work is done with it.

Start by mounting your source map on the digitizer or displaying a digital source on screen in the 
background.  Be sure that you are in the directory to receive the map and that the coordinate input 
device is set to match your input source (digitizer or on-screen mouse).  Then start the routine by 
picking  create map  (from the Choose Map menu or the Map pulldown).  Enter a name for the new 
map in the form, leave the template name blank, and then at the prompt in the dialog area, digitize at 
least four tics:

Creating [map name]
Digitize a minimum of 4 tics.
Signal end of tic input with Tic-ID = 0
Tic-ID: - prompt to enter a tic from digitizer or screen.

 

First type the number of the tic at the  Tic-ID:  prompt and enter it (<Return> from the keyboard or <A> 
from the digitizing puck), then click precisely on the tic location on the digitizer or the screen.  Do this 
for each tic that you want to digitize, then <Return> with no number entered to close the routine.  The 
new map will then be the current edit map at the Edit bar.

Prepare Map Database

You may need to prepare the database of a map created outside of Setup before working on it in 
ALACARTE.  Depending on the need, this can be done piecemeal or with options from the Prepare 
Scan Menu.  You may want to prepare the database for working with lines, points, or polygons in 
advance of entering map elements and/or you may want to add additional items (fields) to the 
database.  You may also want to add a setup file to the map.

In the piecemeal approach, build the map for the appropriate map features  (Build  on the topology 
pulldown from the General bar) and then add whatever database items are needed  (Add Item  on the 
Files pulldown from the General bar; see Database Items, p. 55).

Alternatively, use the options on the Prepare Scans pulldown from the Setup bar.  Here you can build 
the map for the appropriate map features (lines, points, polygons) and add any standard ALACARTE 
items to the database (such as LTYPE, PTYPE, or PTTYPE).

To add a setup file to the map, use  create setup file  on the Prepare Scans pulldown (from the Setup 
bar) or set and save the desired settings in Edit.  To set snapping in Edit, choose the map and either 
copy a setup file from an existing map  (use setup  on the Save pulldown from the Edit bar) or set new 
snapping tolerances  (set snap  on the Snap pulldown from the Lines bar).   Save these settings with  
save setup  (on the Save pulldown from the Edit bar).  
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Projections

ALACARTE is designed to work with maps in one of several standard projections using the 1927 
North American Datum (NAD27) and with locations and dimensions recorded in meters on the ground 
in the appropriate x,y coordinate system.  In these maps north is at the top, azmuthal data such as strike 
or plunge direction are properly recognized, and adjacent maps can be mosaicked in a common 
projection.  During the initial entry of map data into the computer you must work in the projection of 
the source map, but once a map is digitized, its projection can be changed.  Projections are specified 
in two circumstances in ALACARTE, when a projected map is started or a scan is transformed from 
the Setup bar, and whenever a map is changed from one projection to another.

Scanned maps that have been imported into ARC/INFO have dimensions in inches (or less commonly 
in centimeters or millimeters) referenced to the digitizer, and these must be converted into meters in 
the matching projection.  This is done with the Transform function, which places the scanned image 
into its projection coordinates according to the location of equivalent digital registration tics in the 
input scan and in the projected framework of the receiving map. Maps that are started from the Setup 
bar in ALACARTE are automatically placed in a specified projection.  In hand digitizing with 
ALACARTE, the transformation from the coordinates of the digitizer into such a projected map is 
done automatically as you enter each map element.  Details of the procedures involved in transforming 
maps are described in Start a New Map or Layer (p. 93), Map Registration (p. 115), and Process and 
Edit Scans (p. 155).

Once a map is properly recorded in its original projection, it can be converted into another projection 
with the Project function.  This might be done, for example, to overlay different maps of the same area, 
to place the geology on a different base map, or to mosaic several quandrangles together in a common 
projection (using, for example, the Append or Mapjoin function on the Boundary pulldown from the 
Analysis bar).  The Project function can also be used to convert a file of latitudes and longitudes into 
the corresponding x,y coordinates in a specified projection, or vice versa.  

Accurate placement of a map image by Transform and any subsequent changes in projection depends 
on the quality of the initial registration, which involves both the precise identification of lati-
tude/longitude registration marks in the source map and the precise placement of digital registration 
tics at those graphic marks in scans (see Map Registration, p. 115).  Good registration is important 
both for plotting and printing and for overlays, analytic work, and the preparation of derivative maps.

SUPPORTED PROJECTIONS

Version 1.0 of ALACARTE supports seven projections that are commonly used in geology in the 
United States:  Lambert Conformal Conic, Transverse Mercator, Oblique Mercator, Polyconic, Uni-
versal Transverse Mercator (UTM), Albers Equal-Area Conic, and the special DNAG projection, as 
well as the State Plane equivalents.  To prepare an empty map (a projected geographic framework of 
a map) in one of these projections from the Setup bar in ALACARTE, you need only specify the 
projection, the needed projection parameters, and the map location in latitude/longitude; ALACARTE 
does the rest of the work in ARC/INFO to create the digital map (see Setup Details, p. 102, and Start 
a New Map or Layer, p. 93).  Many other projections are available, but use of these will require 
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working in naked ARC/INFO.  More information about projections and their application to maps in 
the United States can be obtained from: 

Snyder, J.P., 1987, Map projections - a working manual: U.S. Geological Survey
Professional Paper 1395.

ALACARTE assumes the 1927 North American Datum (NAD27), which uses the Clark spheroid of 
1866.  Almost all USGS topographic quadrangles are in NAD27, although some include NAD83 
corner tics as well.  Any work directly in NAD83, which ARC/INFO also supports, will require use of 
the native PROJECT command in ARC/INFO.  Conversion from one datum to the other can be ac-
complished using the ARC/INFO CONTROLLINK and QUADLINK commands.  Maps projected 
outside ALACARTE can be used in ALACARTE with some limitations.  If a map is not in meters, the 
snapping menus in the Lines section of ALACARTE will not translate from map units to inches 
properly.

Before the late 1950’s, large-scale USGS quadrangles were prepared in the Polyconic projection, 
whereas more recent 7-1/2 and 15 minute quadrangles typically use Lambert or Transverse Mercator. 
Lambert is used for states of predominantly east-west extent and Transverse Mercator for states of 
north-south extent (Oblique Mercator is used solely for the Alaskan panhandle and the Great Lakes).

The projection reported on the more recent quadrangle maps may still be Polyconic, despite this 
change, but the practical effect of treating these maps as polyconic rather than as their actual projec-
tion is generally insignificant.  The difference in the length of the diagonal of a 7-1/2 minute 
quadrangle between Polyconic, Transverse Mercator, and Lambert projections ranges from 0.001 mm 
(0.00004 in.) to 0.05 mm (0.002 in.) (Snyder, 1987), and in the worst case is thus less than half a line 
width.  Because the coordinate origin for any polyconic map is at the center of its southern latitudinal 
boundary, regardless of location on the earth, it is necessary to convert to another projection for com-
parison or mosaicking with maps of adjacent areas.  

The State Plane projection represents the projection details of large-scale quadrangle maps that are 
actually Transverse Mercator, Lambert, or Oblique Mercator, such that the projection parameters can 
be specified simply with a single State Plane zone.  Using State Plane in ALACARTE and specifying 
the appropriate zone number (see Table 9, p. 110) is thus equivalent to using the actual projection and 
projection parameters of the map.

The UTM projection is used for many intermediate-scale maps, such as the 1:100,000 and 1:250,000 
quadrangle series, and the Albers projection is used for small-scale maps in the United States.  The 
DNAG projection, selected by the Geological Society of America for use for the Decade of North 
American Geology, is Transverse Mercator with its central meridian at 100 degrees and a scale factor 
of 0.926.

SETUP DETAILS

Starting a new map from the Setup bar (New Map pulldown) requires that you answer a series of 
questions about the map projection and the location of the map on the globe.  The information about 
projection that is needed in this process is listed in Table  8 (p. 109).  This information can usually be 
obtained from the text at the lower left corner of the source map or, where not reported on a geologic 
map, from the equivalent topographic map.  Snyder (1987) also provides a number of useful tables of 
projection data.
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For State Plane maps, do not confuse the State Plane zone with UTM zones (look for the word pro-
jection), as many maps contain UTM grids but are in a different projection.  For example, the 
following information

       Projection and 10,000-foot grid ticks: Hawaii coordinate system,
       zone 3 (transverse Mercator) Clark spheroid 1866.  etc.

indicates that the State Plane zone is Hawaii 3, which represents a Transverse Mercator projection.  
The zone number to specify in ALACARTE for this State Plane Zone (for this example, 5926) is then 
determined from Table 9 (p. 110).  To convert the origins of Transverse Mercator or Lambert projec-
tions to that equivalent to a State Plane projection, simply impose the appropriate x shift by including 
it as a false easting in the projection file.  This can be done either for maps already in those projections 
or as part of the file used to convert from some other projection.  This shift is typically

Transverse Mercator -  x shift of 152,400.3048 meters (500,000 feet)
         Lambert Conformal Conic - x shift of 609,601.2192 meters (2,000,000 ft)

See Snyder (1987, p. 51-57) for discussion of the Oblique Mercator application and more details and 
exceptions.

The location of a map is indicated by specifying the latitude and longitude location of digital regis-
tration tics in the map (typically corners).  ALACARTE menus have input fields in which latitudes and 
longitudes are entered by quadrant, degrees, minutes and seconds.  The values can be entered in any 
format, including degrees-minutes-seconds, decimal degrees, decimal minutes, decimal seconds, and 
any combination.  Latitudes are either north of the equator (positive) or south (negative).  Longitudes 
are either east of the Greenwich meridian (positive) or west (negative).  Maps in the continental United 
States therefore have north latitude and west longitude.  The longitude value and its hemisphere are 
specified in separate fields in ALACARTE when setting up a new map (a negative longitude value 
will not be accepted in the degrees field), but the negative sign for west longitude must be included in 
preparing a separate projection file.

For regular quadrangles, only the location of the southeast corner need be specified; ALACARTE 
calculates the other corners and generates digital registration tics at all four locations. Corner tics are 
numbered in a standard way for regular quadrangles in ALACARTE.  Tic 1 is at the southeast corner 
and the numbers progress clockwise:

3 _ _ _ _ _ _ 4
 |  |
 |  |
 |  |
 | _ _ _ _ _ _  |
2                   1
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Internal tics can be included automatically in regular quadrangles as an option.  They are numbered as 
follows for 7 1/2 and 15 minute quads:

  3   5   6   4

  7   8   9 10

11 12 13 14

  2 15 16   1

For 1/2 x 1 and 1 x 2 degree sheets, the internal tics correspond to the corners of the 7 1/2 or 15 minute 
quadrangles within the sheets, and are numbered as follows:

  3   5   6   7   8   9 10 11   4

12 13 14 15 16 17 18 19 20

21 22 23 24 25 26 27 28 29

30 31 32 33 34 35 36 37 38

  2 39 40 41 42 43 44 45   1

It is important to retain the history and current state of a map’s projection.  ALACARTE stores pro-
jection information for the map in the map directory in a file named projx.alc, where x is the number 
of the projection file.  The information for the first projection is in proj1.alc, and that for each subse-
quent change in projection is stored sequentially in proj2.alc, proj3.alc, etc.  The projx.alc file is 
obtained by ALACARTE from the project file for the ARC PROJECT command and records both 
input and output projections.  An example of this projx.alc file for a polyconic map is:

INPUT

PROJECTION GEOGRAPHIC

UNITS DD

PARAMETERS

OUTPUT

PROJECTION polyconic

UNITS METERS

PARAMETERS

-120 3 45

38 00 00

0

0

END
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TRANSFORM

The Transform function provides the means to change coordinate systems for a map by moving it from 
one set of registration tics into another set.  Its principal use for ALACARTE maps is to move an 
imported scan from digitizer inches into a projected tic framework with the coordinate system in 
meters on the ground.  This standard role for Transform is an automatic part of the transform step in 
the Prepare Scans sequence (see Process and Edit Scans, p. 155); Transform is also available from the 
Conversion bar (Projection pulldown), where greater control over its operation is possible.  

A prerequisite for transforming a map is the presence of digital registration tics at several known 
locations in the map and the creation of an empty receiving map with similarly numbered tics in 
equivalent locations in that map.  Transform uses the x,y locations of these equivalent tics in the input 
and receiving maps to calculate the transformation equations, and then applies these to all x,y loca-
tions in the input map to prepare the output map.  The locations of the tics in the output map are the 
reference and do not change, regardless of how poorly the tic locations in the input map match them.

Transform Operations

Two kinds of transformation are available, affine and projective.  With the affine option, a 6-parameter 
linear transformation of the form 

x’ = Ax + By + C
y’ = Dx + Ey + F

is used in which the operations can involve translation from one coordinate origin to another, relative 
x,y stretch, and a rigid or shear rotation in which parallel map elements remain parallel.  Specifying 
three equivalent registration tics will lead to an exact match of those tics in the output map, whereas 
four or more tics will be used to determine the best aggregate fit, and using only two tics will force 
proportional x and y scaling.  A single transformation for all points is involved, and where more than 
three tics are used, none will be fitted precisely unless the fit is perfect.
 

The projective option, which is specifically intended for removing tilt from data obtained from aerial 
photographs, performs all the affine operations and also permits trapezoidal distortion to be made 
rectangular, such that parallelism of map elements is not retained .  A minimum of four equivalent tics 
is required for calculation of the 8-parameter projective transformation

x’ = (Ax + By + C)/(Gx + Hy +1)
y’ = (Dx + Ey + F)/(Gx + Hy +1).

This transformation will match four tics exactly, and with more tics will determine the best aggregate 
fit.  As with the affine transformation, a single transformation for all points is involved, and where 
more than four tics are used, none will be fitted precisely unless the fit is perfect.   

Specifying Tics 

Transform associates the tics in the input and receiving maps according to their $ID numbers and uses 
all equivalently numbered tics in the two maps.  Control on which tics are used in a transformation is 
thus exerted by matching their $ID numbers.  Tic numbers are assigned when the tics are created and 
can be changed later from the Tics bar in Edit with the Calculate function.
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Transform Report

ARC/INFO presents a report of the transformation on screen during the process (run a watch file to 
capture this for later inspection or printing).  For an affine transformation, this report includes the 
scaling and translation required to change coordinate systems, the RMS error of the relative tic loca-
tions (in both input and output units), and a rotation angle that may describe a rigid rotation, but is 
more likely to include an unreported amount of shear as well (R.K. Mark, oral commun., 1991).  The 
tics used in the transformation are listed along with their locations in both the input and receiving 
(output) maps.  Errors are also reported (x error, y error in output units) that represent departures of the 
transformed tic locations from their actual locations in the output map.
:

Transforming coordinates for coverage /CWENT/TESTMAPS/SCAN

Scale (X,Y) = (609.963,610.634)   Translation = (-6173.439,-411.649)
Rotation  (degrees) = (1.543)   RMS Error (input,output) = (0.003,1.567)
Tic id   input  x  input  y

      output x        output y          x error          y error
------  --------------------  --------------------  --------------------  --------------------
     1         19.214            1.196

    5563.365            1.826           -1.561            0.129
      2           0.984            0.704

   -5563.365            1.826            1.561           -0.129
      3           0.382          23.414

   -5554.245    13873.856          -1.563            0.129
      4         18.592          23.904

    5554.245    13873.856           1.563           -0.129

The report for a projective transformation is less informative, but includes an RMS error for the tics 
and a list of the tics and their locations and transformation  errors. 

Transform Strategy

The principal decisions required in transforming an imported scan into a projected tic framework are 
which and how many tics to specify and which transform option to use.  Under ideal circumstances the 
relative tic positions in the source map and calculated tic framework will be identical and a four-tic 
affine transformation will place the map image into the projected tics precisely with an RMS error of 
zero. The task is to decide how best to accommodate the inevitable departures from this ideal.  Details 
of the procedures are described in Map Registration (p. 115) and Process and Edit Scans (p. 155).

A critical preparatory step is to assure that graphic registration marks are clear and precise in the 
source map before scanning and that digital registration tics are placed precisely at those marks in the 
imported scan (see Map Registration, p. 115).  All subsequent positioning of map elements in the map 
projection is dependent on the location of these reference points.

Good transform results can be obtained from film originals and even undamaged paper maps, for 
which any regular x,y distortion is accommodated in the transformation process.  Unless problems are 
anticipated, the simplest procedure is thus to proceed directly and then check the result.  First add (or 
move) digital tics in the scanned image to the map corners and to any well located internal registration 
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marks and assign $ID numbers equivalent to those in the projected tic framework for the tics to be used 
in the transform.  Then perform the transform with the affine option and check the RMS error in the 
Transform report.  A good fit is indicated by an error of 0.003 inches or less.  Larger error can cause 
later problems and a better transformation should be sought. 

Poor transformations result from mislocated tics, which can be due to distortion in the source map, 
poor placement of graphic registration marks before scanning, distortion during scanning, poor place-
ment of digital registration tics after scanning, or mismatch between projections.  If no problem in tic 
placement can be found and the projection of the source map was used in creating the projected tic 
framework, try eliminating or changing the specified tics (corner or other exterior tics are preferred in 
transforms, but internal tics can be used if necessary).  Omitting interior tics may improve the result.  
If there is a difference in the size of the x,y errors in the transform report, eliminate or replace the tics 
with the highest error.   

If it is essential that all the corners fit exactly, the four corner tics can be used in a projective 
transformation.  This will force an exact fit of the corners, but may produce unsatisfactory distortions 
within the map.  In all transformations, and particularly in projective transformations, check the fit 
throughout the map by comparing unused graphic tics and registration marks, drainage and geology, 
or other map elements of known relation on screen and/or in a plot.  As a last resort, consider 
rescanning.

Local improvements in registration can be made with the rubbersheeting ADJUST command (which 
is not automated in ALACARTE)), but the effect of such adjustments falls off rapidly with distance 
away from the pairs of link points used to control the distortions.

PROJECT

The Project  function converts coordinates from one projection to another for either a file of locations 
or for a map (coverage).  These functions are obtained with  Project file  and  Project coverage  on the 
Projection pulldown from the Conversion bar.  The projection of a scanned map can be changed only 
after the scan has been transformed into the projection of its source.

Projecting Files

A text file of x,y coordinates is converted to another projection with  Project file:

Project - change map projections of a file

<in file> -  name of text file of x,y locations (use full pathname if necessary).

<out file> -  name for new file of converted coordinates.

{project file} -  name of optional file with which to specify projections and parameters.

OK HELP CANCEL

The input and output projections and parameters can be specified in a text file (the project file), as 
described below.  If you don’t name a project file, ARC/INFO will ask you to specify the projections 
and parameters through a series of questions (examples of such questions and answers are provided in 
table 10, p. 112).
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An example input text file of signed longitudes and latitudes (termed geographic projection in ARC) 
is given below, followed by the output file that would be created if the Geographic to Lambert 
dialog in table 10 (p. 112) were used:

Example input file of signed x,y coordinates (here longitude and latitude):

-122 00 00 38 00 00

-122 30 00 38 00 00

-122 30 00 38 30 00

-122 00 00 38 30 00

Example output file in Lambert meters:

          87834.8581        4499891.8618

          43918.0488        4499541.8939

          43623.1895        4555044.5375

          87245.1479        4555392.1558

Projecting Maps

All the x,y coordinates in a map are converted to another projection with  Project coverage, which 
opens a menu similar to that for files.  Specify an in- and an out-coverage (map file names) and a 
project file (see table 10, p. 112), or specify the projections and parameters through the interactive 
series of questions.

Projection File

A projection file is prepared by typing a text file using the system editor or an equivalent  (you can 
start a screen editor from the Commands popup).   Sample projection files and dialogs for map pro-
jections supported by ALACARTE are given in Table 10 (p. 112).  To use a projection file, specify it 
as the PROJECT file in the Project File or Project Coverage menu.
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Table 8.  Worksheet for map projections

Name of map
Regular quadrangle? Type of quad Scale

Location of southeast corner  - Lat: Long.
Map projection and parameters:
   -  Lambert (1st standard parallel is the one closest to the equator.)

Latitude of 1st standard parallel:
Latitude of 2nd standard parallel:

  Longitude of central meridian:
Latitude of projection’s origin:

   -  Transverse Mercator
Scale factor at central meridian:

  Longitude of central meridian:
Latitude of projection’s origin:

   -  Oblique Mercator
Latitude of projection’s origin:
Longitude of projection’s origin:
Scale factor at center of projection:
Azimuth at center of projection (degrees):

   -  State Plane (covers above 3 in standard form):
State Plane zone:

   -  Polyconic   No parameters. (Latitude of projection’s origin is set to SE corner of map)
   -  UTM

UTM zone (1 through 60):
   -  Albers (1st standard parallel is the one closest to the equator.)

Latitude of 1st standard parallel:
Latitude of 2nd standard parallel:

   Longitude of central meridian:
Latitude of projection’s origin:

   -  DNAG 
Latitude of projection’s origin:

X,Y shift of origin (defaults are zero; do not use in State plane projection)
    False easting in meters:

False northing in meters:
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Table 9.  State Plane projection zones (NAD27)

State Plane Zone from base map and corresponding Zone number for ALACARTE-ARC/INFO

(from Table Project-4, ARC/INFO Users Guide, Volume 2, January 1989)
          

Alabama, East 3101 West 3126

Alaska, Zone 1 6101 Zone 5 6201 Zone 8 6276

   Zone 2 6126 Zone 6 6226 Zone 9 6301

   Zone 3 6151 Zone 7 6251 Zone 10 6326

   Zone 4 6176

Arizona, East 3151 Central 3176 West 3201

Arkansas, North 3226 South 3251

California, Zone I 3276 Zone IV 3351 Zone VI 3401

   Zone II 3301 Zone V 3376 Zone VII 3426

   Zone III 3326

Colorado, North 3451 Central 3476 South 3501

Connecticut 3526

Delaware 3551

Florida, North 3576 East 3601 West 3626

Georgia, East 3651 West 3676

Hawaii, Zone 1 5876 Zone 3  5926 Zone 5  5976

   Zone 2 5901 Zone 4  5951

Idaho, East 3701 Central 3726 West 3751

Illinois, East 3776 West 3801

Indiana, East 3826 West 3851

Iowa, North 3876 South 3901

Kansas, North 3926 South 3951

Kentucky, North 3976 South 4001

Louisiana, North 4026 South 4051 Off Shore 6426

Maine, East 4076 West 4101

Maryland 4126

Massachusetts, Mainland       4151 Island 4176

Michigan, East (Transverse, old)     4201 West (Transverse, old)     4251

    Central (Transverse, old)    4226

Michigan, North (Lambert, current)   6351 South (Lambert, current)  6401
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   Central (Lambert, current) 6376

Minnesota, North 4276 Central 4301 South 4326

Mississippi, East 4351 West 4376

Missouri, East 4401 Central 4426 West 4451

Montana, North 4476 Central 4501 South 4526

Nebraska, North 4551 South 4576

Nevada, East 4601 Central 4626 West 4651

New Hampshire 4676

New Jersey 4701

New Mexico, East 4726 Central 4751 West 4776

New York, East 4801 West 4851 Long Island 4876

New York, Central 4826

North Carolina 4901

North Dakota, North 4926 South 4951

Ohio, North 4976 South 5001

Oklahoma, North 5026 South 5051

Oregon, North 5076 South 5101

Pennsylvania, North 5126 Pennsylvania, South 5151

 Puerto Rico, (meters) 6026

Rhode Island 5176

South Carolina, North 5201 South 5226

South Dakota, North 5251 South 5276

St. Croix (meters) 6076

Tennessee 5301

Texas, North 5326 Central   5376 South 5426

   North Central 5351 South Central  5401

Utah, North 5451 Central 5476 South 5501

Vermont 5526

Virginia, North 5551 South 5576

Washington, North 5601 South 5626
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West Virginia, North 5651 South 5676

Wisconsin, North  5701 Central 5726 South 5751

Wyoming, Zone I, East 5776 Wyoming, Zone III, West Central  5826

Wyoming, Zone II, East Central 5801 Wyoming, Zone IV, West       5851

Table 10.  Sample dialogs for PROJECT

The sample PROJECT dialogs below provide examples for the projections supported by ALACARTE.  PROJECT files are 
simply lists of the dialog responses, as shown for the first example.  Prepare a PROJECT file in a screen editor or a word 
processor from which you can save an ASCII file.   Many more options and projections are available for the PROJECT 
command in naked ARC/INFO than are described below (see the entry for PROJECT in the ARC/INFO Users Guide, 
Volume 1).  

Lambert (to Albers)

 Sample dialog    Sample projection file

Project: INPUT INPUT
Project: PROJECTION LAMBERT PROJECTION LAMBERT
Project: UNITS METERS UNITS METERS
Project: PARAMETERS PARAMETERS
1st standard parallel: 37 10 00 37 10 00
2nd standard parallel: 37 50 00 37 50 00
Central meridian: -123 00 00 -123 00 00
Latitude of projection’s origin: 0 0 0 0 0 0
False easting (meters): 0.0 0.0
False northing (meters): 0.0 0.0
Project: OUTPUT OUTPUT
Project: PROJECTION ALBERS PROJECTION ALBERS
Project: UNITS METERS UNITS METERS
Project: PARAMETERS PARAMETERS
1st standard parallel: 37 10 00 37 10 00
2nd standard parallel: 37 50 00 37 50 00
Central meridian: -123 00 00 -123 00 00
Latitude of projection’s origin: 0 0 0 0 0 0
False easting (meters): 0.0 0.0
False northing (meters): 0.0                      0.0
Project: END END

Transverse Mercator (to UTM)

Project: INPUT
Project: PROJECTION TRANSVERSE
Project: UNITS METERS
Project: PARAMETERS
Scale factor at central meridian: 1
Longitude of central meridian: -123 00 00
Latitude of origin: 0 0 0
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False easting (meters): 0.0
False northing (meters): 0.0
Project: OUTPUT
Project: PROJECTION UTM
Project: UNITS METERS
Project: ZONE 10
Project: XSHIFT 500000
Project: YSHIFT 4000000
Project: PARAMETERS
Project: END

Oblique Mercator (to Geographic)

Project: INPUT
Project: PROJECTION OBLIQUE_MERCATOR
Project: UNITS METERS
Project: PARAMETERS
Enter projection type (1 or 2): 2 (Type 2 is where azimuth of central line is known)

Scale factor at center of projection: .9999
Longitude of projection’s origin: -133 40 00
Latitude of projection’s origin: 57 00 00
Azimuth at center of projection: 36.87
False easting (meters): 0.0
False northing (meters): 0.0
Project: OUTPUT                      

Project: PROJECTION GEOGRAPHIC
Project: UNITS DD
Project: PARAMETERS
Project: END

State Plane (to DNAG)

Project: INPUT
Project: PROJECTION STATEPLANE
Project: UNITS METERS
Project: ZONE 3326
Project: PARAMETERS
Project: OUTPUT
Project: PROJECTION TRANSVERSE
Project: UNITS METERS
Project: PARAMETERS
Scale factor at central meridian: .926
Longitude of central meridian: -100 00 00
Latitude of origin: 0 0 0
False easting (meters): 0.0
False northing (meters): 0.0
Project: END

113



UTM (to Transverse Mercator)

1. Where UTM zone is known: 2. Where UTM zone not known:

Project: INPUT
Project: PROJECTION UTM
Project: UNITS METERS
Project: ZONE 10 omit the zone statement

Project: XSHIFT 500000
Project: YSHIFT 4000000
Project: PARAMETERS you will be asked for the location of any point in map:

    Longitude: -122 00 00
    Latitude: 38 00 00

Project: PROJECTION TRANSVERSE
Project: UNITS METERS
Project: PARAMETERS
Scale factor at central meridian: 1
Longitude of central meridian: -123 00 00
Latitude of origin: 0 0 0
False easting (meters): 0.0
False northing (meters): 0.0
Project: END

Albers (to State Plane)

Project: INPUT
Project: PROJECTION ALBERS
Project: UNITS METERS
Project: PARAMETERS

1st standard parallel: 37 10 00
2nd standard parallel: 37 50 00
Central meridian: -123 00 00
Latitude of projection’s origin: 0 0 0
False easting (meters): 0.0
False northing (meters): 0.0                      

Project: OUTPUT
Project: PROJECTION STATEPLANE
Project: UNITS METERS
Project: ZONE 3326
Project: PARAMETERS
Project: END

DNAG (to Oblique Mercator)

Project: INPUT
Project: PROJECTION TRANSVERSE
Project: UNITS METERS
Project: PARAMETERS
Scale factor at central meridian: .926
Longitude of central meridian: -100 00 00
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Latitude of origin: 0 0 0
False easting (meters): 0.0
False northing (meters): 0.0
Project: OUTPUT
Project: PROJECTION OBLIQUE_MERCATOR
Project: UNITS METERS
Project: PARAMETERS
Enter projection type (1 or 2): 2 (Type 2 is where azimuth of central line is known)

Scale factor at center of projection: .9999
Longitude of projection’s origin: -133 40 00
Latitude of projection’s origin: 57 00 00
Azimuth at center of projection: 36.87
False easting (meters): 0.0
False northing (meters): 0.0
Project: END

Geographic (to Lambert)

Project: INPUT
Project: PROJECTION GEOGRAPHIC
Project: UNITS DMS
Project: PARAMETERS
Project: OUTPUT                      

Project: PROJECTION LAMBERT
Project: UNITS METERS
Project: PARAMETERS
1st standard parallel: 37 10 00
2nd standard parallel: 37 50 00
Central meridian: -123 00 00
Latitude of projection’s origin: 0 0 0
False easting (meters): 0.0
False northing (meters): 0.0
Project: END

Map Registration

The registration of map information involves both the relative position of map elements between map 
layers, such as geology over a topographic base, and the assignment of absolute geographic coordi-
nates to map elements.  In work with conventional geologic maps, geologic features are located 
relative to features in a topographic base map and absolute geographic locations are typically deter-
mined only for selected points by measuring from the map in latitude/longitude or another coordinate 
system portrayed on the map.

In compiling geologic maps as digital databases, in contrast, every point and every vertex of every line 
is assigned an absolute location.  The geographic coordinates of maps prepared in ALACARTE-
ARC/INFO typically represent meters on the ground in a specified projection, although imported 
scans are initially in scanner dimensions, typically inches.  Control on geographic registration and the 
registration between map layers is provided by digital registration tics (tics) that are assigned x,y ad-
dresses in a specified coordinate system.  Although represented by absolute locations of high precision 
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in the map database, the locations of geologic features in a digital map can be no better than the 
accuracy and resolution of the base on which they were compiled.  Attending carefully to registration 
issues will help maintain the accuracy of the source information.

The tics for maps started from the Setup bar in ALACARTE  are assigned latitude/longitude addresses 
that are automatically converted to meters on the ground in the specified map projection.  Maps en-
tered from the digitizer can be registered to such a projected tic framework in the computer.  Imported 
scans are registered geographically by placing digital tics at graphic registration marks of known 
location in the scanned image (typically latitude/longitude marks) and then transforming the map im-
age into an equivalent set of projected tics (see Projections, p. 101).

The precision of location required to avoid perceptible misregistration between superposed map layers 
in high-quality plotting is about half a line width (0.003 inches on the map), which is more precise than 
is generally required for geographic location of the geologic features.  Good registration between the 
geographic reference system and map images is also important if different maps are to be combined or 
if the map database will be used in analytic routines involving absolute or relative geographic 
locations.

Accomplishing good registration requires (1) precise identification of geographic references marks in 
the original map (the source for scanning or digitizing),  (2) careful placement of digital registration 
tics at those registration marks in imported scans,  (3) accurate registration of source maps on the 
digitizer,  (4) preparation of subsequent layers with registration identical to the primary digital map, 
and (5) careful tracing, digitizing, and/or editing.

Registration and its adjustment in the computer can involve several different procedures:  assigning 
registration according to graphic tics that are part of the map (generally latitude/longitude tics), trans-
forming a map recorded in digitizer inches into projected tics, creating new map layers from existing 
maps, registering maps on the digitizer, and moving or distorting one layer relative to another.

REGISTERING IMPORTED SCANS

The best method of registering imported layers in a map is to assure that clear and precisely located 
graphic registration marks exist prior to import.  These may be part of the original map image or, 
particularly for scanning, may have to be added by fine drafting or with stick-up.  Each layer requires 
at least four outer registration marks, one near each corner, but as many internal tics should be in-
cluded as possible to permit alternative use and checking of registration.  This is not a matter that can 
be deferred until after a map has been scanned, because these graphic registration marks must be part 
of the scanned image.

Once a map image has been imported into ARC/INFO, the procedure is to move or place digital reg-
istration tics precisely at each of the graphic registration marks in the image and then to transform the 
map into a framework of projected tics.  The Prepare Scan sequence of functions available from the 
Setup bar is designed to simplify this process.

Prepare a Projected Tic Framework 

An empty framework of projected tics must be prepared to receive the transformed scan.  This can be 
accomplished as part of the Transform step in the Prepare Scans sequence (2. transform  on the Prep 
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Scans pulldown from the Setup bar), or can be done separately.  The first part of the Transform step 
involves setting up a framework of projected tics with the same procedure used to start a new map.  A 
location and projection are specified and a map boundary can be included (automatically tagged as  
map boundary),  or an existing map can be specified as a template (but then a map boundary is not an 
automatic option).  Note that this procedure requires that you have already repositioned the tics in the 
scan, either using the Assign Tics step or from the Tics bar.  You can also prepare the tic framework 
by setting up a new map directly from the New Map pulldown or by preparing a new layer from an 
existing map from the New Layer pulldown from the Setup bar.  By using these ALACARTE Setup 
functions, you will concurrently prepare the map database for the kinds of data the layer will contain. 
These procedures are described in Start a New Map or Layer (p. 93).

Assign and Add Tics

You can move, add, and renumber tics from the Tics bar, or can use the Assign Tics step in the Prepare 
Scans sequence  (1. assign tics) if you only need to reposition the tics in the scan.  To work from the 
Tics bar, choose the map in which you want to move the tics and, if appropriate, a background that you 
want to consult in the process, and then go to the Tics bar.  The Assign Tics step provides forms in 
which to specify the edit map and any backgrounds.  

Most imported maps will contain four arbitrarily located digital tics.  Once the edit map is drawn on 
the screen, you should see these tics and their user ID numbers on the screen.  (If you see no tics, be 
sure that the map really lacks tics by selecting All from the Tics bar and checking the size of the 
selected set).   If there are no tics, or if you want more tics than are now displayed on the screen, you 
can add them from the Tics bar. 

Move Tics

You will need to move the existing tics in the scan, and any that you add, so that they precisely match 
the location of the graphic registration marks in the scanned image.  ALACARTE provides an efficient 
Move Tics routine that helps you reposition these tics over the graphic registration marks in the map 
image  (1. assign tics  on the Prep Scans pulldown from the Setup bar or  move many  on the Move 
pulldown from the Tics bar).  The routine leads you to zoom in on and select the tics in turn, then 
progressively move the tic and zoom in closer until you are satisfied that you have located each as 
precisely as you can.  You should seek to place each tic within 0.001 inch of the center of its equivalent 
graphic registration mark in order to avoid adding error to locations in the map. 

The routine presumes that, with only the digital tics displayed, you can define a zoom box around each 
digital tic that will include the associated graphic registration mark.  You should save any previous 
work before beginning, because if you miss including a digital tic in the zoom box, you will be stuck 
in an endless loop and will have to break out of the session.

When you move the tics, attend to the fact that the tic numbers in the scan must match the numbers of 
the equivalently located tics in the projected framework into which you will transform the scanned 
map image (see Projections, p. 101, for tic numbering pattern used by ALACARTE).  It is easier to 
move the tics across the map image to their proper locations than it is to renumber them.  This can be 
done as the first zoom box step for each tic in the Move Tics routine or by using  so  on the Tics bar 
to select each in turn and  move(S)  to move them near their target registration marks.
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Once you have started the Move tics routine, you first define some draw parameters for the routine:

Draw arcs for initial display of entire map, <Return> = yes?    -  enter no; answer yes only if you must see the

line work in the foreground map in order to fine the graphic tics;

 the time required to draw the whole map can be considerable.

Display background maps, <Return> = yes?    -  enter no; answer yes only if you want the arcs turned on in the

background. 

Set mapextent to the edit map, <Return> = yes?    -  enter yes;  answer no only if you are prepared to enter the

 name of another map that should be used instead to define the map

 area to be displayed. 

The tics will be drawn on the screen (and, if you indicated, the line work as well) and the first cycle of 
zoomin-and-move is started:

Now zoom in to area around first tic.
Be sure to include both the tic and the inked corner of the map.
Define the box -  instruction for the Zoombox function

Follow the instructions by clicking a zoom box around both the first tic and the graphic registration 
mark to which you want to move the tic.  Be sure to include the tic in the zoom box, as there is no way 
to get out of the routine gracefully if you have no tic to select in the next frame.  Once the screen is 
redrawn, select the tic by clicking on it and then move the tic onto the registration mark:

Select the tic
Point to the feature to select    -  instruction for Select One

Now move the center of the tic to the map corner
Point to the coordinate to move from   -  instructions for Move

Point to the coordinate to move to  

Now, do you want to zoom in again and place the tic more precisely?  (It will generally take three or 
four zoomin-and-move cycles to place the tic within 0.001 inch of the registration mark on the map.)  
If you do, answer yes and then click a zoom box around the tic and the registration mark:

Zoom and move again?  -  answer y(es) or n(o)

Now zoom in closer.  TIC should be within  .001 inch of the corner.
(or about 0.5 meter on a 1:24,000 scale map)
Define the box -  instruction for the Zoombox function

Now the routine offers the Distance function for you to measure the distance between the tic and the 
registration mark (click first on one, then the other); determine whether this move will place the tic 
within the needed precision, and close the Distance function with a  9:  

Now measure distance of tic from corner.
Press CONTROL-RIGHT_MOUSE_BUTTON to quit the distance command                   - enter a 9
. . . Press any pair of Alphanumeric keys . . .  (9 to quit) -  prompt for the Distance function

Coordinate      [coordinates of the click points]
Distance          [distance between the click points]
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Move the tic, repeat the cycle if necessary (usually three or four cycles will be needed) and then 
answer no when asked if you want to zoom and move again.  There may be other tics to move, and you 
will then be asked:

Do again for another tic?

Answer  y(es)  and repeat the whole sequence until you have placed all the tics over their respective 
registration marks, then answer  n(o)  to quit the Move Tics routine.

Be sure to save your work.

Add Tics

You can add tics simply by picking  add  on the Tics bar and then clicking on the screen at the intended 
locations.  The Add routine will use the User-ID number next in sequence above those of the tics 
already present in the map.  To control the new tic numbers, reset the next User-ID number or change 
the numbers later.  To reset the next User-ID  number, start the Add routine, enter a  3  to obtain the 
prompt for a new User-ID number, and enter the number with which you want to start.  When you hit 
<Return>, you will be returned to the Add prompt with the new number in place.

Match User-ID Numbers

Transforming a scanned image into a set of projected tics requires that the tics in equivalent positions 
in the input and receiving maps bear the same User ID numbers ($ID’s). It is this equivalency that 
determines how the lines in the map image are placed in the blank projected layer.  If they are not the 
same, change the numbers in the input layer (the scan) to match those of the projected tics in the 
receiving layer.  Consult Projections for the way that ALACARTE numbers tics in the Setup routines 
or draw the receiving layer on the screen with Tic ID’s on to determine the numbering.

Only the equivalently numbered tics will be used by the Transform function, and it is through the 
numbering of the tics that you determine which and how many tics will be used in the transform (see 
Projections, p. 101, for a discussion of the issues involved).  You may want to use (that is, match the 
numbers of) only the corner tics, all the tics you have available, or some other set chosen to minimize 
transform error.

To change the numbers of the tics in the Edit Map, work from the Tics bar.  Draw the map with Tic 
ID’s on  (set from the Draw/Back Environment menu).

Select each tic to be renumbered, one by one  (so  on the bar), and then change the number of the 
selected tic.  Do this with  calculate  on the Database pulldown or from the keyboard at the ArcEdit 
command line (go there from the Commands popup):

ArcEdit:   calc  $ID  =   [number]

where  number  is the User-ID to be assigned to the selected tic.

Note that, because ARC/INFO does not tolerate duplicate tic numbers, changing the number of the 
selected tic to that of another tic will cause the latter to be deleted automatically.  If this is a problem,
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consider selecting whichever tics pose the problem and renumbering them in bulk; for example, by 
adding 100 to the numbers of the selected tics:

ArcEdit:   calc  $ID  =   $ID + 100

Change all the tic numbers as necessary and be sure to save your work.

Transform the Map

Once the tics are placed, numbered properly, and the result is saved, you are ready to transform the 
scan into the projected tics.  Details of the transform function are described in Projections, which you 
should consult before proceeding.

You can use the Transform step in the Prepare Scans sequence, or you can use the Transform function 
directly  (Transform  on the Projection pulldown from the Conversion bar).  The latter requires that a 
map with the desired projection and tics has already been prepared or can be copied from an existing 
map.   Specify the scan as input and in one manner or other the map of projected tics as output, retain 
the default Affine option unless you specifically want to use the Projective option (see Projections, p. 
101), and activate the function.  If you are working outside the Prepare Scans sequence and have 
created a map boundary or have other map elements in the receiving map, be sure to save them sepa-
rately (Copy  on the Files pulldown from the General bar), because the Transform function will delete 
any preexisting elements other than digital tics in the output map.  These separate elements can be 
added to the transformed map later (see, for example, Add Lines, p. 150).

REGISTER ON THE DIGITIZER

Mount your original on the digitizer.  Place the map in a convenient position, but be sure that all of the 
map image is within the active part of the digitizer (the inactive margin can be several inches wide).  
Use the indicator light on the digitizing puck to determine where the active boundaries are. Start 
ALACARTE, specify your digitizer and tty line, and choose  digitizer  for the coordinate input device. 
Go to the Edit bar, choosing your map on the way.  When the Snap report appears, check that the snap 
settings are appropriate for your purpose (see Snapping, p. 123). 

If you are not sure how the tics in the digital map are numbered, draw the tics on the screen (turn Tic 
IDs on from the Draw/Back Environment menu and draw the map).

Start the Register Map routine (pick  register map  on the Map pulldown from the Edit bar), and enter 
the tic numbers and locations from the digitizer at the prompt: 

Digitize a minimum of 4 tics.
Signal end of tic input with Tic-ID = 0
Tic-ID:

For each tic, first enter the tic number from the digitizing puck (puck indicator light must be on;  tic 
number will appear after the  Tic-ID:  prompt on the screen), click  A  for enter (*  will appear after the 
number), and then place the crosshairs precisely over the tic location on the map and click  1  from the 
puck to specify location.  Position the crosshairs carefully before clicking the tic location, because the 
accurate location of the map elements that you are about to digitize will depend on the accuracy with 
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which you specify the registration tics.  When you click the tic location, you will be prompted for 
another tic:

Tic-ID: 1*  
Tic-ID:

Continue to enter the tics until you have specified at least four, preferably near the outer margin of the 
map or of the map area in which you plan to work.  When you are finished, close the Tic routine by 
clicking  A  (enter) without first entering a tic number.  The scaling factors and the RMS error resulting 
from this transformation between the tic locations just specified on the digitizer and those in the digital 
map will then be reported:

Scale (X,Y) = (1590.872,1583.733)  RMS Error (dig,map) = (0.002,2.577)
Hit <return> to continue:  

It is important to keep the RMS error to 0.004 inches or less for most maps.  If you get a higher error, 
reregister the map (pick  register map  from the Map pulldown again).  If the error remains high after 
several tries, don’t just proceed, get help if necessary and identify the problem (see discussion in 
Projections, p. 101).

EXAMINE THE REGISTRATION

Misregistration has two principal sources, mislocated tics (see Projections, p. 101) in the input map or 
disparity between bases. Other possibilities include misregistration in an earlier compilation step, 
operator error in numbering tics, and even use of the wrong projection.  It is important to recognize 
that materials obtained from different base maps (and particularly from maps of different scales) are 
not likely to register in detail precisely. Such disparities must be addressed in compiling or comparing 
digital maps just as they must in conventional work.  

The transform error (RMS error) provides the first test of registration, but you should also make visual 
checks wherever you have a basis for comparison.  Work in Edit with the needed features turned on, 
include backgrounds as appropriate, and zoom in on available points of comparison.  Distribute these 
throughout the map if possible, and record distance and direction of misregistration to allow later 
consideration of improving the registration.  Compare the location of graphic registration marks and 
digital tics, both for tics that were used in the transformation and for tics that were not.  Compare map 
elements of known relation between layers, such as contour crossings of drainage and the ends of 
contacts against water boundaries.  Select one layer as the standard, if appropriate, and test other layers 
against it.  The standard might be the layer with the smallest RMS error, the base to which everything 
else must be fitted, or a standard digital line graph.

Correction of misregistration can be straightforward or nearly impossible, depending on its source.  As 
discussed in Projections, the location or selection of tics can be modified, or the Projective option for 
Transform can be used to force the four corners to fit exactly (but check the resulting fit of interior 
tics).  The comparisons may suggest a systematic shift or rotation of the map relative to its tics that 
would improve registration, or improve it in a critical part of the map at the expense of less important 
parts.  Disparities between original bases may require that material be refitted to the new base, either 
by hand editing or by local distortions imposed with the  rubbersheeting function ADJUST.
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MOVE THE MAP

Any systematic disparity in registration between two layers that involves an x,y shift or simple rotation 
of the map image can be corrected.  Even if the disparity is only approximately systematic, the regis-
tration may be improved significantly by moving one layer relative to another.

Linear Shift

The various elements of a map can be shifted in x and y relative to the digital tics or to another layer.  
Work from the bar appropriate for the kind of feature involved and put the layer to be shifted in the 
foreground over the reference layer in the background.  Note that if the map contains more than one 
kind of feature (lines and polygon label points, for example), each will have to be moved separately.

Select a place in the map where the shift can be precisely defined on the screen and zoom in to permit 
the shift to be specified by clicking from and to points on the screen.  Select the whole foreground map 
(Select All, with Autodrawselect turned off) and then pick  move(S)  on the Copy pulldown.  Specify 
the from and to points carefully, and the whole map will then be moved, element by element, as just 
prescribed (for a large map, this can take a while).

Work on a copy of your map, or save the reregistered map as a new version in case you later want to 
return to the unmodified version of the layer.

Rotation

The various elements of a map can be rotated in x and y relative to the digital tics or to another layer.  
Work from the bar appropriate for the kind of feature involved and put the layer to be rotated in the 
foreground over the reference layer in the background.  Note that if the map contains more than one 
kind of feature (lines and polygon label points, for example), each will have to be moved separately.

Compute the needed angle of rotation from the size of the maximum shift and the length of the rotation 
bar (measure that length on screen with the map drawn at small scale using  distance  on the Options 
pulldown).  Note that the whole map will be rotated the specified angle around the rotation point.

Set the angle  (setangle;  positive angles rotate counterclockwise), select the whole foreground map  
(Select All, with Autodrawselect turned off), and then rotate the map (rotate(S)).  Specify the rotation 
point on the map by clicking on-screen (whole-map view or zoomed in on that spot for accuracy) or 
on the digitizer, and the whole map, element by element, will  be rotated as just prescribed (for a large 
map, this can take a while).

Work on a copy of your map or save the reregistered map as a new version in case you later want to 
return to the unmodified version of the layer.

DISTORT THE MAP

The Rubbersheeting function in ARC/INFO (ADJUST) is not automated in ALACARTE.  You will 
need to consult the ARC/INFO manual and/or an expert user for help with this.  You will find that the 
Adjust function can be used effectively to distort local parts of your map, but will not distribute dis-
tortions for large distances across the map.
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Snapping and Other Controls

Various snapping and processing controls and spacing parameters can be set for use during an edit 
session or recorded for later use with a map.  These settings bear largely on lines and determine 
whether and how various functions operate during work on a map.  Snapping is activated by such 
functions as digitizing or copying a line or moving a selected set.  To deliberately apply the current 
snap settings to a selected set of lines, use  move in place  (on the Reshape pulldown from the Reshape 
bar).

SNAPPING

Because of the high precision with which ARC/INFO records the location of map elements and their 
parts, gaps and overlaps in line work and other differences in location that are too small to see at map 
scale can be significant for map topology.  This is particularly important in working with lines that will 
form the boundaries of polygons, which must be precisely closed.  Functions are available to auto-
matically snap these mislocations and overlaps together.  Various settings under your control 
determine whether they operate and over what distances the snapping will occur.  Store the settings for 
a map in its ALACARTE setup file for automatic inclusion in each edit session and then override those 
settings where necessary for particular operations.  A setup file is created for a map when it is started 
from the Setup bar (see Start a New Map or Layer, p. 93) or can be saved with the current settings at 
any time from the Edit bar.

The selection of snapping values will depend on the requirements of each map and, in some circum-
stances, on the particular operation being performed on the map.  The snapping functions are activated 
only for particular operations such as digitizing new lines and moving existing ones, and can be de-
liberately activated by selecting the target lines and then picking  move in place  (on the Reshape 
pulldown form the Reshape bar). 

The various snapping functions operate on a newly digitized line in the following sequence:  (1) 
Nodesnap will try to snap the ends of the new line to any nearby nodes, (2) Arcsnap will try to snap 
each end of the new line to the closest existing line within the snapping distance,  (3) Intersectarcs will 
create a new intersection if the new line crosses another and extends beyond the snapping distance, 
and  (4) Nodesnap will try to snap such a new node to any nearby nodes.

It is also possible in ARC/INFO to snap elements in the edit map to specified features in other maps, 
although the functions are not automated in ALACARTE.

Intersectarcs

The Intersectarcs function determines whether a node and associated intersection will be created 
where one line is placed across another.  It can be left  OFF,  limited to newly digitized lines  (ADD),  
or applied to all lines that are digitized, moved, or otherwise manipulated in a way that requires the arc 
coordinates to be edited  (ALL).  For most work with geologic maps, the  ALL  option should be used.

Arcsnap

The Arcsnap function snaps nodes to nearby arcs where an end (node) of a line being digitized is 
placed within snapping distance of any part of an existing line.  Arcsnap can be either  ON  or  OFF  
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and requires a distance to be specified to indicate over how large a distance such snapping will occur. 
This distance is measured along the trajectory defined by the outer two vertices at each end of the new 
line.  The function, which operates only on newly digitized lines, automatically closes small gaps and 
removes small overlaps by connecting the new line precisely to an existing line within the snap 
distance.  The resulting node splits the preexisting line.

Arcsnap should be used in digitizing geologic maps to assure clean line intersections.  Use a snapping 
distance equal to two or three line widths on the original map (typically 0.02 - 0.04 inches).  Once a 
line exists (has been digitized or scanned and imported), Arcsnap has no application.  The equivalent 
operations are then more complicated (see Edit Lines, p. 135).  Note the implication for digitizing 
strategy:  enter the crosscutting line first, then the line to be snapped to it.

Nodesnap

The Nodesnap function snaps nodes together where they are placed within snapping distance on the 
map.  Nodesnap can snap to the first node found within the snapping distance  (FIRST)  or take the time 
to search for the closest node within the snapping distance  (CLOSEST),  and requires that a search 
distance be specified.  The function operates when lines are newly digitized, when they are moved, 
copied, or rotated, and when nodes are moved.  Note that Nodesnap will try to snap both ends of such 
lines; when you move a node at one end of a line, the other end may snap as well.

Use Nodesnap in digitizing and editing geologic maps to assure precise connection between lines, 
except where the closely spaced ends of lines should remain separate.  Typically, a good snapping 
distance equals two or three line widths on the original map (0.02 - 0.04 inches).

Bulk activation of Nodesnap in a map can be accomplished with the Matchnode function (see Edit 
Nodes, p. 136).

Extend

The Extend function can be used to snap the ends of existing lines to nearby lines in a fashion similar 
to Arcsnap where the end of the line falls short and leaves a gap.  (Note that Extend can lengthen a line 
to snap an intersection, but cannot shorten it.)  Extend can be applied to a selected set or to a whole 
map as part of the Clean function.  Extend can be applied to  BOTH  ends of the line(s), to the  FROM  
or the  TO  end(s) only, and requires a search distance to be specified (in map units).  These settings 
can be stored as the default for the Extend option used with the Clean function, for which a conser-
vative distance of 0.05 inches might be appropriate.  Extend can also be applied to a selected set with 
a specified snap distance from the Reshape (Lines) bar.

Set the Snapping

The settings for the various snapping functions can be set and stored in the setup file as part ofthe New 
Map and New Layer sequences and with Step 3  (create setup file)  of the Prepare Scans sequence in 
Setup (see Start a New Map or Layer, p. 93).  These settings will then be automatically established 
each time the map is opened in Edit.  Settings can also be established (or changed) from within Edit 
using the Snap forms menu  (set snap  on the Snap pulldown from the Lines bar), or by copying the 
setup file of another map  (use setup  on the Save pulldown from the Edit bar).
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Edit Tolerances Menu

This menu appears as part of the Setup sequences to allow you to store default tolerances with your 
map:

Set default edit tolerances for this map:

    meters or     inches

weed tolerance 1. . . . . . . . 0 . . . . . . . -  keep small (as, 0-1 meter).

intersectarcs ALL . . . . . . . . . . . . . -  use ALL for most work.

arcsnap distance 12 . . . . . . .02. . . . . . -  typical value: 0.01-0.03 inches.

arcsnap type ON . . . . . . . . . . . . . .

nodesnap distance 12 . . . . . . .02. . . . . . -  typical value: 0.01-0.03 inches.

nodesnap type CLOSEST . . . . . . . . -  generally use CLOSEST.

extend distance 12 . . . . . . .02. . . . . . -  as above, or set in Edit.
extend direction BOTH . . . . . . . . . . 

edit distance -1 . . . . . . -  retain  -1 here to establish the default. 

ok     help     cancel     Map scale  =  24000

Enter the distances in meters or in inches (ALACARTE will recalculate in meters).  Enter   ?  or click 
the middle mouse button in the other blanks to pick an option from a subordinate menu.

Snap Menu

Open this menu with  Snap  on the Lines bar to view or change settings during an edit session:

Set  arc  and  node  snapping  tolerances  and  related  settings  for  this  map:

  meters       or   inches       or    with
on ground   on map MOUSE

weed  tolerance 0 0       *

intersectarcs       ALL

arcsnap  type       ON
arcsnap  distance 12 0.020       *

nodesnap  type       CLOSEST
nodesnap  distance 12 0.020       *

grain 30 0.050       *
edit  distance -1 -1       *

set  all  to  ALACARTE  defaults  for  current   map  scale:   DEFAULTS
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Current  map  scale = 1:24000
Set  current  map  scale:   1:  24000                        (0 = unknown)

ok   help    cancel

This menu differs from the Edit Tolerances menu in permitting distances to be entered by clicking on 
the screen.   Set those functions and parameters of interest from the menu and then establish them for 
the edit session with the  ok  button.  Enter the distances in meters or inches (Alacarte will convert to 
meters) or click on the appropriate star (*) and click the distance on the screen.  Enter  ?  or click the 
middle mouse button in the other blanks to pick an option from a subordinate menu.  Pick the  DE-
FAULTS  button and enter a distance in inches at the prompt to set all the distances at once to the same 
value (except Edit Distance). Then change any entries that should be different.  Once activated with  
ok,  these settings will apply to the current edit session (unless changed), and can be saved in the setup 
file for the map with  save settings  (on the Save pulldown from the Edit bar). 

Copy a Setup File

The setup file for another map can be used to set the snapping for the current edit map by picking  use 
setup  (on the Save pulldown from the Edit bar) and then specifying the other map.  This can then be 
saved as a setup file for the edit map with  save settings  (on the Save pulldown from the Edit bar).

SPACING CONTROLS

Three different parameters are used to control the spacing of vertices in digitizing lines and applying 
the Density, Spline, and Generalize functions.

Weed Tolerance

Weedtolerance is the parameter by which you specify how closely points or vertices can be placed on 
the map: ARC/INFO will reject any point or vertex (other than the terminating node) that you try to 
place closer than the Weedtolerance to another.  Weedtolerance is also the default constant used by the 
Generalize function in simplifying a line.  To retain maximum control in digitizing geologic maps, set 
the Weedtolerance to a very small value (0 - 1 in map units).  Such a value will be too small a distance 
for most applications of Generalize.  

Grain

Grain is a distance parameter used to determine the spacing between vertices for the Spline and Den-
sify functions.  Set it to an intermediate value of 0.1 inches in the setup file but note that, because 
theses functions are quite sensitive to its value of Grain, you may want to experiment with it for 
specific applications. 

EDIT DISTANCE

The distance from the clickpoint over which map elements are sought in such functions as Select 
Many and when choosing nodes to be moved (the edit distance) can be specified or be left to vary with 
screen magnification (zoom).  A setting of -1 in the setup file will cause ARC/INFO to calculate the 
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edit distance from the size of the draw area (mapextent), and will thus produce an edit distance of 
constant screen dimension.  This default setting can be overridden by assigning a constant distance in 
map units that will apply regardless of screen magnification.  Once such a distance is assigned in an 
edit session, the default behavior cannot be recovered, except by reopening the map.  It will thus be 
more satisfactory in most work with geologic maps to avoid assigning an edit distance for the setup 
file, to give you the option of using the default behavoir.  Where required, a specific map distance can 
be assigned during any edit session from the Snap menu (Lines bar).  

If, for any reason, the edit distance recorded in the setup file is not -1, that default setting can be 
restored to -1 in the Snap menu  (set snap  on the Snap pulldown) and then saved to the setup file  
(save setup  on the Save pulldown from the Lines bar).  You will then need to leave Edit by going back 
up to the Alacarte bar and, then return to Edit and reopen the map, in order to activate the default 
setting for Edit Distance.

PROCESSING TOLERANCES

Limits on acceptable digitizer registration can be applied automatically where appropriate and default 
values for parameters used by the Clean function can be stored for default use.

Precision of Registration

When a map is registered on a digitizer (see Map Registration, p. 115), ARC/INFO calculates the 
precision of fit between the tic positions that you enter from the digitizer and those recorded in the 
digital map.  This fit is reported as an RMS error in both map units and digitizer inches (see Projec-
tions, p. 101).  It is important that this error be kept very small, typically 0.003 inches or less, in order 
to maintain adequate registration. The Tic MatchTolerance, when set, will prevent use of a registered 
map for which the RMS error exceeds the tolerance value.  This can be useful in some circumstances, 
but overriding this constraint is inconvenient and for most work you can avoid setting the Tic Match 
Tolerance and make the decision of whether or not to proceed yourself.  In doing so, be sure to stop 
and identify the problem if the error remains too high after repeated attempts to register your map. 

Fuzzy Tolerance

The fuzzy tolerance controls the resolution at which map elements are restored during operation of the 
Clean function.  Because repeated cleaning can cause locations of elements on the map to move, the 
fuzzy tolerance should be kept very small.  The smaller the tolerance is, however, the longer the pro-
cessing of the map will take.  An appropriate compromise is the input resolution of most digitizers of 
0.001 inches.  Do not use 0 or leave the entry blank in the menu, because the smallest value 
ARC/INFO will accept is 0.0001;  smaller values will activate a default that may be too large (see 
Clean, p. 57).

Dangle Tolerance

The Clean function contains an option to delete all dangling lines automatically that are less than a 
specified length.  Because most geologic maps properly contain numerous dangling lines, caution 
should be used in deleting dangles automatically.  Set and store an appropriate dangle tolerance (in 
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map units) as a default.  You may prefer to use 0, or a small value equal to several line widths (0.02 - 
0.04 inches).  this default value can be overridden when you fill out the Clean forms menu for use. 

Topology Tolerance Menu

This menu appears as part of the New Map routine to allow you to store default tolerances with your 
map.

Set default topology tolerances for this map,  in meters:

    meters or     inches

fuzzy tolerance . . . . . . . . . . . . . . . . . . -  typically use 0.001 inches.

dangle tolerance . . . . . . . . . . . . . . . . . . -  typically use 0.

tic match tolerance . . . . . . . . . . . . . . . . . . -  typically leave blank.

ok    help    cancel     Map scale  =  24000

Enter the distances in meters or inches (ALACARTE will recalculate in meters).  Enter  ?  or click the 
middle mouse button in the other blanks to pick an option from a subordinate menu.
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Digitize Lines

Tracing lines by hand on a digitizer is the most direct method of entering line work.  It  has the 
advantage of producing clean line work that will require little additional editing and can be tagged 
during digitizing.  It has the disadvantage of being a tedious and demanding process that, unless the 
tracing is precise, is likely to introduce small errors in line shapes and positions.  Where a scanner is 
available, line entry by scanning and on-screen editing is an alternative that should be considered, 
particularly for large maps (see Process and Edit Scans, p. 155).  Hand digitizing can also be done on 
screen, either by tracing a scanned image displayed in the background or by mapping directly onto a 
digital base in the background.

The digitizing procedure involves preparing the original, attaching it to a digitizer, registering the map 
from the digitizer for ARC/INFO, and tracing the lines by clicking control points (vertices) with the 
digitizing puck (ARC/INFO does not accept stream-mode input).  Tracing a scan on screen will re-
quire an imported scan that can be properly registered.  While the lines are being traced they can be 
assigned line types concurrently, simply by setting the current line type (such as  Contact, certain).  
Clean connections between lines can be created automatically through effective use of the snapping 
functions.

If you are just beginning the map, you will need a tic framework into which to digitize the lines (see 
Start a New Map or Layer, p. 93).  Attend carefully to registration between the source map on the 
digitizer (or as a scanned background) and the digital version (see Map Registration, p. 115).  Set up 
the digital map for lines (such as  faults, contacts, units), or otherwise assure that it has been built for 
lines (has an AAT) and that this has had the item LTYPE added to it (automatic for maps started in 
Setup for lines, otherwise use  Add ALC items  on the Files pulldown from the General bar).

For digitizer input, mount your original on the digitizer, identify the digitizer in ALACARTE and set 
the input device to digitizer, and register you map ( see Register on the Digitizer, p. 120).

CHECK THE SNAPPING

You should assure that the snapping is set properly.  During digitizing you want ARC/INFO to rec-
ognize line intersections automatically and to make the small snapping adjustments that will close tiny 
gaps and remove tiny overlaps between adjoining lines.  Correcting these small but critical departures 
from precise junctions is more difficult later.  The Setup file created when the digital map was begun 
from the Setup bar recorded the snap settings that you specified, and these will be reset and reported 
when you choose the map for editing (which includes new input as well as modification of existing 
map elements).

Check the Snap report to assure that you have chosen the right map and that the snapping is set prop-
erly for digitizing.  You can check or change the snap settings at any time in the forms menu obtained 
with  set snap  (on the Snap pulldown from the Lines bar), and can check them with  show snap.  For 
hand digitizing, the snapping tolerances should be approximately: 

Weedtolerance very small, to give you control over tight places (0 - 0.001 inch)
Intersectarcs ALL

Arcsnap, type ON
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Arcsnap, distance 2 or 3 line widths, 0.02 - 0.04 inches
Nodesnap, type CLOSEST

Nodesnap, distance 2 or 3 line widths, 0.02 - 0.04 inches
Grain select by experimentation if you plan to spline the lines.

If the snapping is not set properly, reset it, and if your map does not have a setup file, set the snapping 
as desired and then save those settings to a setup file (see Snapping and Other Controls, p. 123).

SET LINE TYPE

Before you begin entering lines, decide how you want to tag them.  ALACARTE maintains a current 
line type with which each new line is automatically tagged as it is digitized.  These line types are 
recorded in the map database (in the LTYPE item) and can be used later to characterize the lines for 
analysis or assignment of line symbols in plotting.  Line types can be changed at any time, either 
individually or as sets, simply by selecting and retagging them. 

The Digitize Lines bar provides standard geologic line types in menu form and allows any character-
ization to be entered from the keyboard or from custom tagging menus that have been previously 
prepared.  The central five items on the Digitize bar  (C,  F,  A,  O,  and  Mod)  open pulldowns that 
control the setting of the current line type:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

C: Contacts F: Faults A: Fold axes O: Other lines Mod: Modifiers

contact fault fold axis no attribute certain
normal syncline map boundary approx. located
attenuation synform water boundary inferred
thrust anticline glacier bndry inferred ?
 reverse antiform scratch bndry concealed
strike-slip monocline concealed ?
"   dextral gradational
"   sinistral

other contact other fault other other fold axis other
none

custom menu 1 custom menu 1
custom menu 2 custom menu 2
custom menu 3 custom menu 3

The default line type is  Contact, certain,  which is set when you first go to the Digitize Lines bar.  
Determine the current line type at any time by picking  ?  on the bar.  The line type consists of two 
parts, the principal line type and a modifier, which are set separately.  Set the principal part first by 
picking the appropriate menu item, and then set the modifier.  Where the standard types are not satis-
factory, enter any string of characters from the keyboard (up to 35 characters) with  other,  or prepare 
one or more custom menus (see Custom Tag Menus, p. 82) and open them with  custom tag menu 1, 
etc.  The default modifier  certain  is applied automatically (except to custom types) whenever the 
principal type is reset.  The new line type is reported after each change.  Where you want to use 
non-standard types, it may be more efficient to use standard types initially and then change them later. 
 This can be done by selecting by line type and then retagging the selected sets with the custom types. 
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ENTER LINES

With the line type set for the first suite of lines to be entered, start the Digitize Lines routine (pick  dig 
on the Digitize bar).  A key menu will be presented, preceded by a report of the current line type 
(attribute) and followed by the prompt to enter a line: 

Adding lines with attribute: contact, certain
--------------------Options--------------------
1) Vertex             2) Node                     3) Curve
4) Delete vertex  5) Delete arc              6) Spline on/off
7) Square on/off  8) Digitizing Options  9) Quit
(Line) User-ID: 1 Points 0  -  prompt for new line.

ARC/INFO uses the next User-ID number ($ID) in sequence for the next line (the line about to be 
entered), and reports the present number of vertices in that line (Points).

To enter a line, place the crosshairs of the digitizer puck over one end of the line on the digitizer and 
click a  2  (node), move the crosshairs along the line and click vertices  (1’s)  as appropriate to define 
the line, and click another  2  at the far end to complete the line.  The number of points reported will 
increase as you click the vertices, and entering the final node will cause the line and its line type to be 
recorded and the line to be drawn on the screen.  The prompt for entering the next line will appear 
automatically with the User-ID increased by 1.  Enter as many lines as you choose in sequence, and 
then close the Digitize routine by entering  9.

When the routine is closed, all the newly entered lines will remain selected.  Be sure to make a new 
selection if your next step is not to apply to all these lines.  Typically, however, your purpose in 
returning to the Digitize bar will be to change the current line type, after which you will restart the 
Digitize routine and enter more lines.

Remember to save your work at regular intervals.

The key menu offers several options in addition to entering nodes (2) and vertices (1) and closing the 
Digitize routine (9).  You can delete the last vertex entered with a  4,  but be careful not to lose your 
place on the digitizer.  Similarly, you can cancel the current line with a  5.  Once you have ended a line 
with a node, however, it can be deleted only by closing the Digitize routine and separately selecting 
and deleting the line.  The square and curve options are not particularly useful for the basic line work 
of geologic maps and are not discussed.  The Spline function may be used to advantage in producing 
smoothly curved lines, but will require experimentation for effective use (see Reshape Lines, p. 149).

A key menu of digitizing options can be opened from the Digitize key menu by entering an  8:

-------------------------DIGITIZING OPTIONS-------------------------
1) New User-ID       2) New Symbol         3) Autoincrement OFF
4) Autoincrement ON  5) Arctype line       6) Arctype box
7) Arctype circle    8) Arctype centerline 9) Quit
----------------- Enter Option 

The principal use of this menu with geologic maps is to reset the next User-ID number.  You might 
want to do this where you are using that number as a record of some kind (this application of User-ID 
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is more common for points).  Once reset, the User-ID will increase progressively from the new number 
as you add lines, unless you turn Autoincrement off (3).  To reset the User-ID, open the Digitizer 
Options menu, enter a  1,  then enter the new number.  You will be placed back at the prompt to enter 
a line with the new User-ID in place.

DIGITIZING TECHNIQUES

It will pay to plan ahead.  Make a transparent overlay on which to plan and monitor your work.  
Examine the map, decide what types of lines to distinguish, and list them on the overlay.  Plan to enter 
the long continuous lines, such as alluvium boundaries, first, and then add the connecting and cross-
cutting lines.  Plan to enter a series of lines of the same type before changing line type to minimize the 
time spent changing line types.

Overlay

Prepare a transparent overlay registered to your map on which you can write with a pencil.  Make an 
informal explanation on this overlay of the different line symbols on the map and how you plan to tag 
them (such as Contact, certain for a thin, solid line).  Mark on the overlay precisely where you will place 
the breaks to change line type (such as a change from solid to dashed fault) and where you will start 
and end lines that close on themselves (island polygons).  This can be done all at once or progressively 
as you work.  You will use these marks as you digitize to control where you start and end line 
segments.

Mark up the overlay as you work.  Mark each line on the overlay after you enter it to avoid digitizing 
lines twice and to help assure that you digitize all the lines in the map.  It can be useful to do this in 
color and to change the color after each save, particularly to aid recovery in the unlikely event that a 
malfunction causes you to lose the lines entered since your last save.  Make note here of questions 
about the map that arise during digitizing to help you find and resolve them later.  You will find that 
digitizing a map leads to a scrutiny of its fine detail that may exceed even that given by its author.

Sequence

The sequence in which you enter the lines can make quite a difference both in your efficiency and in 
the amount of later editing required to assure closed line junctions.  Plan your work to enter as many 
lines of one type as possible before returning to the Digitize bar to change line type.  You can limit the 
lines you digitize in one group to lines of the current line type, or digitize all the lines in an area 
together with that line type and then change those that should be other types later (be sure to note these 
on the overlay as you work).

A new line will snap to a preexisting line only if the new line is ended within snapping distance of the 
other.  The stem of a T-shaped line junction, for example, will snap to the cross bar only if the crossbar 
is present when the stem is entered.  It is important, therefore, to enter the long, continuous lines, such 
as alluvium boundaries, before entering those lines that join and terminate at the continuous lines.  
Lines that don’t snap together properly during digitizing can be fixed later during editing, but it is 
easier to organize the initial entry of lines to accomplish the snapping while digitizing.
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Overlap for Snapping

Snapping of line junctions is best assured where the lines to be joined are overlapped or crossed 
slightly, but less than the snapping distance.  Even where the snapping distance is exceeded and small 
tails (dangles) are created, it is easier to remove them during editing than it is to extend and join 
unconnected lines.  Place the node that defines a line end slightly across the node or line to which it 
should snap.  Where a line terminates at the end of another line (as for a change in line type), cross that 
end node onto the adjoining line about a line width;  where the line ends at another line (as in a 
T-shaped intersection), cross to the far edge of that line with the final node.

Placing Vertices

The key to good hand digitizing is skillful placing of the vertices that define the lines.  This is just as 
much an art as is inking or scribing lines, except that slowing the rate of entry does no damage and can 
greatly improve results for the unskilled operator.  The goal is to place a sequence of vertices down the 
precise center of the original line with the spacing between the points an appropriate function of the 
varying curvature of the line.  

Take the time to arrange that you are comfortable at the digitizer and that lighting is satisfactory.  Hold 
the digitizing puck and attached wire to allow smooth and uninterrupted movement over the map.  
Assure that you can click the necessary buttons easily while moving the puck along the lines.  Practice 
to decide whether you will vary the spacing of vertices by changing the speed of the puck or the rate 
of clicking points.

Because a vector line consists of a sequence of points connected by straight line segments, unless you 
want some part of a line to be straight, you must place one or more vertices to shape it.  The more 
tightly curved a line, the more vertices you will need to define a smooth curve.  Placing too many 
vertices will do no harm, whereas too few will produce an angular shape.  The actual spacing that you 
use will be a compromise between speed and ease of input and assuring smooth line shapes, and will 
require a bit of experimentation.  Digitize a few test lines of different curvatures and then look at them 
on the screen at a magnification of about twice the intended scale (use  draw to scale  on the Zoom 
menu). 

On-Screen Display

It can be helpful to display on the screen the area of the map on which you are working, in order to see 
the lines you are entering.  Use the Zoom Box function (Zoom menu) with the coordinate device set 
to digitizer to specify an area from the digitizer for display.  It can also be useful to color all the 
previously entered lines, perhaps according to line type.  

Immediate Editing

There will be occasions where you make mistakes in digitizing that should be corrected.  The best time 
to do that may be immediately, while you know what and where the problem is.  It is easy to close the 
Digitize routine (enter a 9) and return to the Digitize bar, go to the Reshape bar, change the coordinate 
device to mouse (open the Options pulldown, pick  change coord device,  and then pick  mouse).  Save 
the current draw area (save this frame  on the Zoom popup) and then zoom in on the problem 
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(zoomin(box))  and fix it (see Edit Lines, p. 135, for techniques).  When you have finished correcting 
the error, redraw saved frame  from the Zoom popup, change the coordinate device back to digitizer, 
and go back to the Digitize bar to continue entering lines.  If the easiest way to fix the problem is to 
delete one or more lines and reenter them, you need not go to the Reshape bar:  select many  and  sel 
polygon  are available on the Select pulldown from the Digitize bar and  delete(S)  is on the Options 
pulldown.
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Edit Lines

Various functions are available for editing lines that support both the detailed modification of line 
shapes and connections and the manipulation of intact lines.  These functions can be used to clean up 
imported scans, to repair problems in hand-digitized maps, or to modify, revise, or simplify line work. 
Most editing is handwork carried out interactively on screen.  Some bulk processes are available that 
are typically applied before hand editing, if at all (see Bulk Processing, p. 157); be sure to operate on 
a copy of your map and examine the results carefully for unwanted effects.

The functions for modifying lines are located largely on the Reshape bar and the subordinate Nodes 
bar.  Work on the screen with a continuous line symbol (the default in Edit) except when editing for 
graphic effect.  Be sure to save your work frequently.  Computers and computer programs do fail 
occasionally, and it is far less onerous to stop and save every 45 minutes or so than it is to redo a whole 
morning’s work.  

TRACKING PROGRESS

It is easy to lose track of what has and has not been done when you are editing a map.  You can work 
systematically around the map using the zoom functions, or make an edit plot and check off items as 
you work.  More directly, you can color map elements according to their status in the editing sequence. 
If the line work is tagged, the colors can be assigned according to line type.  In editing a scan, where 
lines are being tagged as they are edited, coloring the lines by line type will both indicate which have 
been edited and tagged and aid in reading the lines as a geologic map.

Color Lines

Color a line by selecting it and then assigning a session color to the selected set (pick  $Symbol(S)  
from the Draw menu and then pick from the Colors popup that follows).  In working on a scan, com-
plete the editing on a group of lines, then set the current line-type appropriately and use  sel,tag,color  
(on the Select pulldown from the Digitize bar) to select the lines, tag them with the current line type, 
and then color them by picking from the Colors popup that automatically follows.

Save and Restore Symbols

Session colors must be deliberately saved or they will be lost when you save the map or close an edit 
session.  Similarly, they must be reassigned at the beginning of each edit session or they will be lost 
the next time you save with Save Symbols on.  With maps for which you are saving color symbols, 
start each edit session with two essential steps:  (1) turn Save Symbols on and  (2)  reassign the colors 
saved at the end of the last session.

Turn Save Symbols on by picking  save symbol?  on the Save pulldown from the Edit bar and entering 
 yes  at the prompt.  Then, every time you save your work during that session, the colors will be saved 
and then automatically restored after the save.  Reassign the saved colors before starting work in a new 
edit session by picking  restore save  from the bottom of any Options pulldown.  Note that if, in a new 
edit session, you assign some new colors and then remember to restore the previously saved ones, the 
new assignments will be lost.
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The colors are saved in the database item SYMB, which must be in the database before you can begin 
saving colors for the map.  Include the addition of symbol and select items when you first set up the 
map, or add the items to an existing map  (Add save items  on the Files pulldown from the General 
bar).

EDIT NODES

Nodes form the ends and interconnections of lines and can be moved, snapped together, disconnected, 
and added to lines.  They can be displayed on screen or in edit plots to aid the identification of prob-
lems that require correction.  Nodes are addressed largely from the Nodes bar, which is reached by 
picking  N at left center on the Reshape bar:

[ Nodes ] |  move  |  Snap  |  Symb  |  Op |  Dw  |  Zm  |  ^RSH  |  

Snap pulldown: Symbols pulldown:

nodesnap first * Nodecolor: 
nodesnap first distance    show
nodesnap closest *    node
nodesnap closest distance    dangle

   pseudo

Nodesize:
   show
   node
   dangle
   pseudo

Nodes are parts of lines, rather than independent database features, and can be selected only during the 
Move Nodes routine or as the end vertices of a selected line.  No information can be attached to nodes 
in the database in version 5.0.1 of ARC/INFO.

Display Nodes

All nodes can be displayed on-screen simply by turning Nodes on from the Draw/Back Environment 
popup and redrawing the screen with any Draw or Zoom function. Those nodes at the unconnected 
ends of lines can be selectively displayed by turning Dangles on.  Similarly, those nodes that connect 
adjacent segments in otherwise continuous lines (a connection between two line segments) can be 
displayed separately by turning Pseudonodes on.  Pseudonodes and dangles can be displayed together 
with different symbols with Node Errors.  Although they are not necessarily errors in geologic maps, 
checking pseudonodes and dangles is an effective way to find line interruptions that should, or for 
polygon definition must, be repaired. 

It is helpful while editing to use Node Errors routinely to show where connections are broken and 
where lines have gaps or are split by pseudonodes.  Be aware, however, that drawing maps with many 
lines at small scale with Node Errors on can nearly double the draw time and largely obscure the lines 
with node symbols.
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Dangling nodes and pseudonodes can also be displayed with different symbols on edit plots (answer  
yes  to the Node Error question;  see Edit Plots, p. 193).

Node Symbols

The size and color of the symbols used to display all nodes, dangles, and pseudonodes can be con-
trolled from the Node Symbols pulldown.  Change the symbol from the default of white by picking the 
appropriate node type under  Nodecolor:  and then specifying a color from the subsequent Colors 
popup.  Similarly, change the symbol size from the default of 0.1 inch by picking a node type under  
Nodesize:  and then entering the desired size at the prompt (specify in inches on the screen).

Nodesnap

Nodesnap can be set (or reset) either from the Snap pulldown (Lines bar) or from the Snap pulldown 
from the Nodes bar.  Unless Nodesnap is set, nodes will not snap together when you try to join them.  
When you choose maps that have setup files, Nodesnap will be set automatically to the function 
(Nodesnap First or Nodesnap Closest) and distance specified in the setup file.  Set these properly there 
and you will generally not have to reset Nodesnap in Edit.  The principal exception is when you need 
to prevent snapping of closely spaced line ends that should not be joined. 

You should generally use Nodesnap Closest, in which a node will be snapped to its nearest neighbor 
within the snapping distance.  Nodesnap First, which causes a node to snap to the first node encoun-
tered within the snapping distance, does not seem particularly useful for geologic work.

Use  distance  where you want to enter the snapping distance numerically (in map units) and use  *  
where you want to click the distance on the screen.  Set a distance that is small relative to the spacing 
of elements in the map but large enough to snap nodes moved when the map is displayed at your 
smallest working scale.  Typically this is about 0.01 to 0.03 inches on the map at map scale.  

Move Nodes

Nodes can be moved, and thus line intersections can be moved.  The ends of all the lines connected to 
the node move with it.  A node that is moved to a point within snapping distance of another while 
Nodesnap is on will snap to that node.

To move a node, go to the Nodes bar and pick  move  to start the Move Nodes routine.  You will be 
instructed to:

Point to the node to move  <9 to Quit>

Click  1  on the node (at the intersection) and watch closely to be sure that the correct node blinks or 
becomes highlighted.  The location of the selected node will be reported and then a key menu is 
presented:

Node  (9.446,14.462)  selected
1  =  Select      2  =  Next     3  =  Who     4  =  Move     9  =  Quit

If the wrong node was selected, move the selection to the correct node by entering one or more  2’s 

137



until the selection moves to the target node.  Once the correct node is selected, confirm with a  4.  You 
will be instructed to:

Point to where to move the node  <4 - Restart,  9 - Quit>

Now simply click at the point to which you want the node to be moved.  (Note that in contrast to the 
Move routines for lines, points, and annotation, no from point is specified when moving nodes.)  The 
node and its connecting lines will be redrawn with the node at the new location.  If a line is left behind 
(not redrawn), it was not connected to the node.  This situation is easily recognized if dangles and 
pseudonodes are displayed.

You can move as many nodes as you choose in this fashion before closing the Move Nodes routine 
with a  9.  Be aware, however, that to remove the effect of one erroneous move with  oops  you must 
remove the effects of all the moves made while the routine was running.  It is wise, therefore, to close 
the routine frequently, even if your next step is to move some more nodes.    

A small group of extra lines (a clot) can be formed where you move a node across an internal vertex 
in a line with Intersectarcs on.  These clots generally show on the screen as a slight thickening of the 
intersection.  You can test for them by returning to the Reshape bar and clicking around the node with 
Select Polygon (sp).  If any lines are selected, simply delete them (delete(S) on the Options pulldown). 
This generally leaves the intersecting lines connected, but if any dangles remain, snap the nodes to-
gether (see below).

If the nodes defining the ends of a short line are snapped together by moving one end onto the other, 
that line will be automatically deleted if it has no internal vertices.  When you have snapped the nodes 
of such a line, the line will be deleted automatically and you will be warned:

WARNING  Arc deleted due to size of snap distance.

If you have deliberately tried to remove such a line in this fashion, while repairing a line intersection, 
for example, be sure to check for this report.  If it does not appear, then a clot of small lines has been 
formed.  This can be selected and deleted, or it can be prevented in the first place by selecting and 
deleting the connecting line before moving the nodes.

Activate Nodesnap

Unconnected lines with dangling nodes within the snapping distance of any other node can be con-
nected by selecting the lines and then moving them in place.  To do this, select all the unconnected 
lines with  sm  on the Reshape bar, then use  move in place  (on the Reshape pulldown from the 
Reshape bar) to activate the snapping.  All dangling nodes within snapping distance of each other will 
be snapped.  Be sure to check the result by drawing again with Node Errors on, and note that you have 
no control over which node actually moves to the location of the other.

Matchnode

All dangling nodes in the whole map can be snapped within any specified distance using the Match-
node function.  Use this where many tiny breaks are present in scanned line work, for example, but 
note that such bulk processing can have unpredictable results in some places.  Some nodes may snap 
that should not be joined, and it will be uncertain whether the dangles will snap to each other or to a 
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nearby connected node.  Dangling lines shorter than the snap distance will snap back on themselves, a 
circumstance that will pose problems in later editing (you can select for lines with lengths less than or 
equal to the intended snapping distance to test for this problem).  Always specify a new output map 
when using Matchnode, because unsatisfactory effects imposed on your working copy cannot be re-
moved except by hand editing.

To run Matchnode, open the Matchnode forms menu (pick  Match nodes  on the Files pulldown from 
the general bar):

Matchnode  -  match nodes within a coverage

<in coverage> . . . . . . . . . . . . . . . . . . . . . . . . .

<out coverage> . . . . . . . . . . . . . . . . . . . . . . . . .

<match tolerance> . . . . . . . . . .

{point coverage} . . . . . . . . . . . . . . . . . . . . . . . . .

{NOEXTEND  |  EXTEND} NOEXTEND

OK        HELP     CANCEL

Specify your working map as the  in coverage,  a new file for the  out coverage,  and enter the snapping 
distance  (match tolerance) that you want to use in map units.  Two options are also available.  You can 
specify a second map containing points to which nodes within the snap distance should be snapped 
(this will operate on all nodes, not just dangles), and you can have all dangles extended to adjacent 
lines within the snap distance.  Be careful in applying such functions in bulk, however, to assure that 
the results are constructive and that any unacceptable changes are identified and corrected.  

Extend Lines

The ends of selected lines can be extended automatically to intersect adjacent lines using the Extend 
functions on the Extend pulldown (E on the Reshape bar).  The functions extend each selected line 
along the trajectory of the last pair of vertices from either or both ends of the line and snaps that line 
to another that is encountered within the specified extend distance.  Typically  both ends  can be used, 
because only one end of a line will be unattached or dangling within reach of another line.  Use  *  to 
click the extend distance on the screen and  distance  to enter it from the keyboard.  Keep the distance 
small enough that unexpected connections won’t be made.

Disconnect Lines

Disconnecting a line from a node intersection requires that it be treated as a line.  Working from the 
Reshape bar, select the line and then either move it bodily away from its node connection(s) or select 
and move the end vertex off the node (see Edit Vertices, p. 140).  Both methods require that you either 
reset Nodesnap to 0 or place the line end(s) out of snapping distance of any nearby nodes. 

Split and Combine Lines

Pseudonodes, which form connected breaks in otherwise continuous lines, are needed in geologic 
maps to permit assignment of different line types to different parts of a line (such as fault, certain  and 
fault, inferred).  They should thus be retained or added (split the line) wherever needed.  Pseudonodes 
that are not needed, however, should be removed, both to simplify the database and to minimize 
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problems with cyclic line symbols in plotting.  Lines must also be split where new intersections are to 
be made with other lines, either automatically with Intersectarcs or the Extend function or manually 
where fine control is needed.

Split

To split a line, select it and then split it with  split(S1)  or  split at vertex(S1)  on the Split pulldown.  
The Split function places a node in the selected line at the point where you click, whereas Split at 
Vertex highlights a vertex where you click, reports that vertex, and presents a key menu:

1 = Select     2  =  Next     3  =  Who     4  =  Restart     9  =  Quit

Once a vertex has been selected by clicking on it with  a  1  or by moving the selection onto it (enter  
2),  click a  1  anywhere on the screen to split the line at that vertex.

Combine

Combine line segments that are connected by pseudonodes by selecting them and picking  combine 
arcs(S)  (on the Split/Combine pulldown opened with  Sp  on the Reshape bar).  The Combine Arcs 
function removes all pseudonodes in the selected set of lines, regardless of how many different com-
bined lines result.  It can be applied to any selected set of lines, including all the lines in a map (beware 
of removing needed pseudonodes).  It is thus most efficient in editing to operate on all appropriate 
lines in a draw area at once, rather than combining one line at a time.

You can monitor the function by drawing the selected set first to color it.  All lines that are combined 
will lose their drawselect color and the pseudonode symbols will disappear.

Lines can be broken and yet look continuous if, rather than a pseudonode, they are interrupted by 
either a tiny polygon or a short branch stub that was folded back on itself by an earlier bulk snapping  
operation.  Recognize this circumstance by drawing with Nodes on (rather than Node Errors) or by 
finding that you cannot select the whole of an apparently continuous line with one mouse click.  Cor-
rect it by selecting the interrupting lines (use  sp), deleting them, and then closing any resulting gap 
and combining the lines.

Note that line-type attributes can be lost or changed when you combine lines where their line types are 
different.  You have no control over which line type ARC/INFO chooses to retain for any given 
combined line.  Either select by line type first to avoid disparate line types, or check or retag (and 
recolor) after combining.

EDIT VERTICES

Lines can be modified in detail by manipulating the vertices that define them.  This is done for one line 
at a time.  Work from the Reshape bar by zooming in to an adequate enlargement, selecting individual 
line segments (typically with  sm  or  sp),  and then using the functions on the Vertices pulldown (open 
with  V  on the bar):

add vertex(S1)
delete  vertex(S1)
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move vertex(S1)
draw vertex(S1)
   in red
   in other color

Display Vertices

The vertices of the selected line can be displayed for review or guidance in editing.  In contrast to 
nodes, vertices can be displayed for only one line at a time.   Draw the vertices   in red  to mark the 
vertices with red pluses on the yellow drawselect color, or use   in other color  to pick a different vertex 
color from the Colors popup that follows automatically.  If the vertices are too closely spaced for 
convenience, zoom in farther and redraw the vertices.

Move Vertices

Move vertices on a selected line by drawing them first (if necessary) and then picking  move vertex(S1) 
to start the Move Vertex routine.  You will be instructed to:

Point at vertex to move  <9 to Quit>

Click on the desired vertex.  A vertex will be highlighted, the identity of that vertex reported, and then 
a key menu is presented:

Vertex 22 Arc 1099  (-3071.369,21374.939) selected
1  =  Select     2  =  Next     3  =  Who     4  =  Move     9  =  Quit

Check to be sure that the correct vertex was selected.  If not, enter  2’s until the highlight moves onto 
the target vertex.  Then confirm with a  4  and you will be instructed to:

Point to where to move it

Now simply click at the point to which you want the vertex to be moved.  (Note that, like nodes, no 
from point is specified when moving vertices.)  The vertex will be placed at the clickpoint and the line 
changed to fit.  The Move routine stays open and the prompt to point at a vertex is repeated.  Move as 
many vertices on the selected line as you choose and then close the routine with a  9. The new line 
shape is recorded and the line remains selected.  Because a single  oops  will remove all the changes 
made while the Move routine was running, consider closing the routine frequently where many verti-
ces are to be moved.  

Note that moving the end vertices of lines is equivalent to moving nodes, and Nodesnap will operate 
if it is turned on.

Delete Vertices

The Delete Vertex routine works in much the same fashion as the Move routine.  Select the line and 
start the routine by picking  delete(S1)  and you will be instructed:

Point at vertex to delete  <9 to Quit>

Click on the desired vertex.  A vertex will be highlighted, the identity of that vertex reported, and then 
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a key menu is presented:

Vertex 22 Arc 1099  (-3071.369,21374.939) selected
1  =  Select     2  =  Next     3  =  Who     4  =  Delete     9  =  Quit

Check to be sure that the correct vertex was selected.  If not, enter  2’s until the highlight moves onto 
the target vertex.  Then confirm with a  4  and the vertex will be deleted, the line changed, and the 
deleted vertex reported:

Vertex (-2710.299,21625.816) deleted from arc 1099 User-ID:  1539

The Delete routine stays open and the prompt to point at a vertex is repeated.  Delete as many vertices 
on the selected line as you choose and then close the routine with a  9.  The new line shape is recorded 
and the line remains selected.  Backing up with  oops  will remove all changes made while the Delete 
routine was running.

Note that deleting the end vertices of lines is equivalent to moving nodes and, if Nodesnap is turned 
on, it will operate on the next vertex inward along the line.

Add Vertices

To add vertices, select the line, draw vertices if necessary, and  pick  add vertex(S1)  to start the Add 
routine.  You will be instructed:

Enter new vertex  <9 to quit>

Click in as many new vertices as you choose, one at a time, by clicking on screen where you want the 
vertex to be placed.  After each new vertex is added, the line will snap to it on the screen and its 
identity will be reported:

Vertex (-3176.106,21523.264) added to arc 1787 User-ID:  15639

The Add prompt will be repeated.  Add as many vertices as you choose and then close the routine with 
a  9.  The line will remain selected.   Backing up with  oops  will remove all vertices added while the 
Add routine was running.

The Add routine offers a powerful way to shape a line carefully, because it allows you to add vertices 
in any order.  If you start with a straight line pinned with vertices only at its ends, you can shape it 
gradually by setting the gross shape first and then going back and putting in the fine structure.  The 
initial straight line can be added by digitizing or by stretching out an existing line by moving a vertex. 
You will want to experiment a bit to see how ARC/INFO decides where to fit the new vertex into the 
line. 

Densify

The Densify functions (on the Reshape pulldown from the Reshape bar) add vertices to selected lines 
(not limited to one selected line) at a specified spacing.  No change in shape is involved.  The principal 
use for Densify in ALACARTE is to provide vertex control on straight lines before their projection is 
changed. Use  densify default(S)  to apply vertices at a spacing equal to the current value of Grain,  
densify *(S)  to click the spacing on the screen, and  densify distance(S)  to enter the spacing from the 
keyboard in map units.
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Align Vertices

Irregularly positioned vertices within a given search distance on one or more lines can all be moved 
onto a specified linear alignment using the Align function on the Align/Rotate pulldown (from the 
Reshape bar).  This can be used effectively to straighten lines or parts of lines, but can also create 
complications where parts of several lines are all brought together.  Align does not require selection of 
lines or vertices,  it operates on all vertices within the rectangle defined by the center line specified for 
alignment and the perpendicular search distance on either side of that line.  You will want to experi-
ment a bit to decide whether and how to use the function.

Align requires that you specify the perpendicular search distance and then the alignment to which 
vertices (including nodes) are to be moved.  Use  align *  to click the search distance anywhere on the 
screen and  align distance  to enter a distance in map units from the keyboard .  Once the distance has 
been specified, you will be asked to: 

Enter 2 points defining the line segment to align features along
1  =  Enter points     2  =  Show line     9  =  Quit

Enter the two ends of a line to which you want the vertices to be moved.  If you click  1 at both ends, 
the function will be activated for the specified line.  If you use a  2  for the second click, a tentative line 
will be shown that you can change with another 2.  When you are ready, click  1  at the desired point 
and the function will be activated. 

MANIPULATE LINES

Entire lines, or selected sets of lines, can be moved, copied, enlarged (or reduced), and rotated.  Nodes 
will snap within the snapping distance when their lines are operated on.  Lines can thus be manipulated 
within the map relative to adjacent lines or the rest of the map, or the whole map can be manipulated 
relative to its tics or a reference background.  Work from the Reshape bar.

Copy and Move

One or more lines can be copied or moved as a selected set using functions on the Copy/Move 
pulldown.  Move the line(s) to a new position on the map with  move(S)  and, at the prompts, click a 
from and a to point.  The line(s) will be moved parallel to themselves in the direction and distance 
specified by the clicks.  The line(s) will remain selected.

Make one copy of a line (or lines) in the same fashion, using  copy(S).  The copy will become the 
selected set.  Make several copies of the same line(s) with copy many(S).  A prompt for a from point 
will begin the sequence, but thereafter the from point for the next copy will be the to point of the last 
copy.  Close the sequence with a  9; the last copy made will remain selected.

Enlarge

The Parallel options in Copy and Move (on the Copy/Move pulldown) can be used to change the size 
of one or more lines while retaining their relative positions and proportions.  This is not a zoom 
function; the  lines are made longer or shorter relative to the rest of the map.    Each straight component 
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(vertex to vertex segment) of a line is moved (copied) parallel to itself and lengthened (or shortened) 
appropriately.  Some modification of line shape and number of vertices may take place.  You will want 
to experiment with this function to determine whether and how you can use it.

Specify the distance the line(s) should be moved (or copied to) on screen  with  *(S1)  (one arc only) 
by clicking at the appropriate perpendicular distance from the line.  Use  distance(S)  to enter the 
distance in map units from the keyboard for one or more arcs  (positive values move line(s) to the left, 
negative to the right, relative to line direction).

Rotate

Lines can be rotated a given angle around a specified rotation point on the map using functions on the 
Align/Rotate pulldown.  This function can be applied to a single line or a larger selected set, including 
the whole map.

With the line(s) selected, pick   rotate(S).  You will be asked first to  Point to the pivot point,  which you 
should do with a mouse click.  The next step depends on the current angle.  If it is 0 (the default), a 
circle will appear on the screen around the pivot point with a from radius pointing north, and you are 
instructed to  Point to the coordinate defining the angle.  Do this by clicking a to point on the circle to 
define the rotation angle (you are defining an angle, not an orientation). The line will be rotated about 
the pivot point by the specified angle and the angle and pivot point will be reported:

1 arc rotated 263.157 degrees around (5278.220,13217.724)

You can also specify the rotation angle from the keyboard by picking  setangle  and entering the angle 
at the prompt (positive values rotate counterclockwise).  This current angle will be used by the Rotate 
function until you change it.  Use  setangle 0  to reset it to 0.  Where you have rotated a line in the 
wrong direction, use  oops  to restore it, and reset the angle with the opposite sign with  setangle last  
(which multiplies the last angle used by -1).  Check the current angle settings by entering  status  misc 
 at the Arcedit prompt.

DELETE UNWANTED LINES

Imported scans are likely to contain unwanted lines.  For scans of existing geologic maps, these are 
likely to include lines representing structural symbols, numbers, unit labels and leaders, line orna-
ments (such as thrust teeth), and text.  In addition, some scanners place lines around incompletely 
thinned parts of the original line work (particularly common at intersections).  A first step in convert-
ing a scan into a lines layer in a map database is thus to select and delete the unwanted material either 
throughout the map or in each part of the map as it is addressed.  Hand-digitized maps may contain 
dangles needing removal, or the goal may be to modify an existing lines layer for a new purpose by 
selectively removing lines.  Be sure to retain an unmodified version of the scan or other map for use 
later as a background layer for comparison during hand editing.

Select by Attribute

It is faster to select the lines for deletion in bulk rather than by hand, if new problems won’t result.  
This would apply, for example, where lines can be selected according to LTYPE (as, all faults), or 
where length and/or a dangling end is the criterion.  Some scans have a myriad of tiny lines that may 
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best be removed before hand editing begins (but check some test areas on the map first).  You may 
want to color and examine a decreasing progression of line lengths in the map before choosing a length 
criterion for deletion.

Another class of lines that can be deleted in bulk is dangles.  You can leave small dangles untouched 
during hand editing and then select and remove them all at once, or use the dangle option in the Clean 
function to delete them when you clean the lines map for polygons.  This will delete all dangling lines 
less than the dangle length that you specify in the Clean forms menu.

Select by Hand

Most deletion of extraneous lines must be done by hand.  This is sufficiently time consuming that it 
pays to remove as much of the extraneous material from the original as possible before scanning, or to 
make a tracing of the source map for scanning.   

To select unwanted lines, work from the Reshape bar using whichever selection function is most ap-
propriate (see Selecting Map Elements, p. 73); Select Polygon  (sp  on the Reshape bar) is particularly 
useful for many situations.  Try to capture a large group of lines in each selection step, check the lines 
that redraw in yellow (default color) to be sure that no wanted lines are included, and delete the 
selected set  (delete(S)  on the Options pulldown).  It can be useful to draw with Nodes on in order to 
see and avoid selecting parts of broken lines that should be retained.  Where the representation of 
wanted lines is complex because of ornaments or interference with other material, it may be easiest to 
delete the lines and then replace them by tracing on screen over an unmodified version of the scan.

Duplicate Arcs

Some circumstances can leave duplicate arcs where one line is intended, including hand digitizing the 
same line twice and automatic insertion of boundaries around incompletely thinned lines in scans.  
Duplicate arcs are pairs of lines that share common end nodes and therefore form closed polygons (of 
any shape).  One of each pair can be deleted by selecting the lines, picking  no duplicate arcs  on the 
Options pulldown from the Digitize Lines bar, and then activating the Duplicate Arcs function with  
move in place  on the Reshape pulldown.

Draw the map with Nodes on to be sure you can see which wanted lines may also be duplicates.  Then 
select the candidate lines, move them in place, and one of each duplicate pair will be automatically 
deleted.  Select all the lines in a work area that are candidates, avoiding only those wanted lines that 
may be duplicates.  The function operates on the whole selected set and has no effect on non-duplicate 
lines.  Be sure to turn Duplicate Arcs back on  (duplicate arcs ok)  if you plan to move other lines or 
do any digitizing during the session.

REPAIR LINE INTERSECTIONS

Most intersections in imported scans will be deformed in varying degree as a result of the raster line  
thinning that precedes conversion to vectors.  The need for correction will depend on your application 
and perhaps a test plot to determine their graphic effect, but at least the more extreme examples may 
have to be fixed.  Intersections in hand-digitized line work will pose far fewer problems, but may 
require some attention because of digitizing error, snapping effects, or other causes.  Fitting the geol-
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ogy to a base or simplifying the line work may require moving or changing intersections, as may 
editing for graphic appearance in plots. 

Distorted Intersections

The most common problem with intersections in imported scans is mislocation of the node that joins 
the intersecting lines as a result of the line thinning that must be applied to the raster scan before it is 
converted to vectors.  In that process, pixels are stripped off the outer boundaries of the lines until only 
one pixel remains or the procedure is terminated.  The junctions and resulting nodes at low-angle 
intersections are moved toward the acute angle of the intersection by thinning of the wedge-shaped 
junction of the two lines.  At T-shaped intersections, the junctions are moved down the stem of the T 
by asymmetric thinning that views the intersection from above the crossbar as a very wide line.  The 
size of the distortions is small, typically 0.005 to 0.05 inches, but the more severe distortions can 
greatly exceed a line width and be quite evident on plots.

Move the Node

Most of these distortions can be corrected simply by moving the common node.  Its proper location 
can generally be determined by eye directly on the screen without consulting the original map.  Pull 
the node at a blunted intersection out to straighten the joining lines.  Move the node at a T-shaped 
intersection out to straighten the cross bar.  If you move a node across a vertex in one of the connecting 
lines, you will create one or more tiny lines and polygons around the new intersection that must be 
removed.

The distortion at X-shaped intersections can involve separation of the top and bottom of the X into two 
opposed V’s connected by a short line.  Combine the two nodes by moving the node in one V onto the 
other node (be sure that Nodesnap is on), and then move the combined node to its correct position.  
Watch for the report that an arc has been deleted to assure that the connecting line actually was deleted 
or, if internal vertices are evident, delete the connector first.  If a clot does form, select and delete it 
and then check that the remaining lines are properly connected.

The most efficient method of moving nodes at distorted intersections is to zoom in on one or more 
intersections, move them, go to the Reshape bar to check for and delete clots if necessary, and then 
return to the larger draw area with Node Errors on, check for and correct any unconnected lines, and 
then zoom in on the next group of nodes to be moved.  Beware the temptation to fix inconsequential 
distortions that are exaggerated at high magnification. 

Unconnected Intersections

One or more lines at an intersection may be unconnected, or an X-shaped intersection may be repre-
sented by two opposed V’s without a connecting line.  Most unconnected lines will be revealed by 
their dangling ends (draw with Node Errors on), and opposed, unconnected V’s will probably be 
marked by pseudonodes.  These pseudonodes must be joined, regardless of the size of the distortion, 
if the lines are to serve later as polygon boundaries.
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Connect the V’s

Join the opposed V’s by moving nodes, as described above.  If the V apex is not marked by a node, 
select the line and split it to add a node there.

Connect Lines

Unconnected lines at an intended intersection can be connected by selecting them and then activating 
the Nodesnap function by moving them in place or by moving nodes at low magnification.  If details 
of the connection are important, zoom in and move each dangling node separately.  Work from the 
Nodes bar, and be sure that Nodesnap is on.  If necessary, split a line to create a pseudonode to which 
to join the dangling end(s).

CLOSE BROKEN LINES

Maps being edited, particularly imported scans, may have numerous gaps that must be closed.  Many 
geologic maps contain dashed lines that produce lines with regular gaps when scanned, and the line 
work in some scans may contain many irregular gaps.  Several techniques are available to meet the 
particular circumstances, including bulk processes and detailed hand operations.

Dash-to-Solid Conversion

Incomplete lines that contain gaps shorter than the line segments can be closed using the Dash-to-Solid 
routine.  This ALACARTE function lets you temporarily reset the Nodesnap distance to the maximum 
gap length and select the lines to be snapped.  It then snaps the lines and offers the option of deleting 
the resulting pseudonodes (combining the selected segments).  Dash-to-Solid works well on regularly 
dashed lines and lines with various small gaps, but will not be satisfactory for dotted lines or lines with 
ornaments (such as thrust teeth).  Nearby extraneous material that might divert the snapping should be 
deleted first, and nearby lines with superfluous pseudonodes should be combined.

To use the function, work at moderate magnification from the Reshape bar.  Draw with Nodes on to 
let you recognize any complicating factors.  Start the routine (pick  dash to solid  from the Reshape 
pulldown) and you will be instructed to reset the Nodesnap distance:

Click on two points on the screen which are slightly farther apart than
                     the longest space between dashes - ALACARTE instruction.

Enter 2 points defining the distance -  ARC/INFO prompt.

Click a distance representing the longest gap that you want closed along the broken line, but keep it 
short enough to avoid snapping to other nearby nodes.  Then use the Select Polygon (Within) function 
to specify the lines to be joined:

Select the lines (dashes) to connect by drawing a polygon around them 
Click the 1 key to define the polygon vertices, click the 9 key to end  
A line must be entirely inside the polygon to be selected.

Define the polygon -  ARC/INFO prompt.

Click a polygon on the screen around the dashes or the line segments that you want to have snapped. 
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When you close the selection with a 9, the selected lines will be drawn in yellow and the gaps will be 
closed as the nodes snap across the gaps.  When the snapping is completed, ALACARTE will instruct:

Now may remove pseudo-nodes in order to merge snapped line segments. . .
Remove pseudo-nodes,  <Return> = yes?

Check the result on the screen, and if everything has gone as intended, hit <return> and the selected 
line segments will be converted to a single line.  If you see problems or are uncertain, enter  n  and 
combine the segments separately.  ALACARTE will reset the nodesnap distance to its previous value 
before returning control to the bar.  

Check to see that the line is now continuous.  The simplest way is to select the line with one click  (sm) 
 to see if the whole line redraws.  If it does not, or if other errors were introduced, you will want to 
redraw the screen to clear away remnants of deleted node symbols and examine the situation. 

Problems can sometimes arise with the Dash-to-Solid routine.  Some nodes may remain on the line 
where relations are complex.  Any line segments (arcs) shorter than the gap length you have defined 
will either be deleted (no internal vertices) or folded back on themselves.  If a node on some nearby 
feature is closer than the intended end of the next dash, the snapping will diverge from the dashed line. 
Fix these problems individually  (Save the frame and zoom in on each one),  or start over by backing 
up through the routine with  oops  (on the Options pulldown) 2 or 3 times, depending on whether or 
not you deleted pseudonodes).  Where dashes snapped to nodes off the line, pick them up (as end 
vertices) and put them back where you want them to be.  Sometimes you can use Dash-to-Solid se-
quentially to snap and combine short dashes with a small gap length first and then reapply the routine 
to close larger gaps. 

Bulk Snapping of Nodes

The dangling ends of any set of lines can be snapped by selecting the lines, setting Nodesnap to the 
appropriate distance, and moving the lines in place.  Where possible, use the Dash-to-Solid function, 
which allows you to do exactly this.  In some cases it may be more convenient to perform the steps 
separately by hand.

For some maps, an early editing step may be to use Matchnode to snap dangling nodes in the whole 
map (see Matchnode, p. 138).  In doing this, consider working progressively, snapping first with a 
relatively small snap distance, then examining the result before increasing the snap distance and run-
ning Matchnode again.  It may be important, before rerunning Matchnode, to apply the Combine Arcs 
function (on the Split/Combine pulldown from the Reshape bar) to the whole map (select all the lines 
first) to avoid folding lines shorter than the new snap distance back on themselves.

Individual Treatment

Some interrupted lines may be simple enough or, conversely, so complex, that moving nodes indi-
vidually is the best solution.  This approach may also be preferable where you are already working 
from the Nodes bar for other reasons.  Be sure that you have Nodesnap set properly.
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Another approach is to enter short line segments from the Digitize bar to fill gaps, particularly where 
they are relatively large, and then combine the resulting connected line segments.  If the lines are 
tagged, be sure to check the resulting line type or simply retag.

Where nodes are moved or snapped across a relatively large distance, it may be desirable to go back 
and add some vertices to smooth the line.  One good place to add a vertex is at the original position of 
the moved node.  If you combine the line segments first, you will be able to work with the whole line 
at once.

RESHAPE LINES

Lines may need to be reshaped to correct scanning artifacts, to improve appearance or fit the the base, 
to simplify, or to incorporate changes (where major changes are involved, consider adding new lines). 
Such reshaping can be done by hand, either by editing vertices or drawing a new shape, or by applying 
the Spline or Generalize function to a selected set of lines.

Reshape by Hand

Most scanning artifacts that are large enough to matter, as well as various misplaced vertices in hand-
work, can be corrected by moving or deleting vertices, although some lines may be improved by 
adding vertices as well.  Where lines have many fine irregularities, Spline or Generalize may be use-
ful, but experiment first.

Larger changes in the shape of line segments can be made by using Add Vertex to shape a skeleton 
line prepared by deleting preexisting vertices or moving vertices.  Or, use the Reshape function, which 
permits you to redraw part of an existing line segment.

To apply the Reshape function, select the line and then pick reshape(S1)  from the Reshape pulldown. 
You will be instructed to:

Enter the new segment  <3  -  Curve,  9  -  Quit)

You then can enter a new shape or addition for the line by clicking vertices with  1’s, being sure to 
cross the selected line either at the beginning or end of an addition or at both ends of a new shape (the 
dangles will not be retained).  Close the routine with a  9  and the line will be redrawn with the new 
shape incorporated.  If you cross the selected line twice the new shape will replace the old between the 
intersections.  If you cross only once, the new line will be a composite of the longest parts of both the 
original line and the addition.  Remember that you are not digitizing a new line, you are modifying the 
selected line, and must attach the change to that line by crossing it.

Spline

The Spline function can be applied to a selected set of lines either to smooth the lines or to simplify 
them.  The difference depends on the relative size of the Grain parameter and the spacing between 
vertices on the lines.  The Spline function places or removes vertices on the selected lines to the grain 
interval but, in contrast to Densify, it can build curves at the angles in the line.  Use it to add curves to 
an angular line by using a Grain value smaller than the existing vertex spacing.  Where the Grain value 
is larger, the vertices will be weeded to the Grain spacing and the remaining vertices will define the 
line.  This method of simplifying a line can distort its original shape (but see Generalize, p. 150). 
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To use Spline, select the line(s), set Grain, and then apply the function.  Set Grain from the Reshape 
pulldown either with  grain *  (click the distance on the screen) or with  grain distance  (enter the value 
from the keyboard in map units).  Then pick  spline(S)  (also from the Reshape pulldown) to apply the 
function to the selected set of lines.  Be sure to check the result.  Be cautious about applying Spine to 
large parts of your map, as some line relations will be distorted.  Check particularly at intersections, 
tight bends, and abrupt steps in the lines.  If you do operate on large areas, work on a copy of your map.

Generalize

Generalize, like Spline applied with a relatively large Grain value, weeds vertices, but it does so with 
some attention to the shape of the line (using the Douglas-Peucker algorithm).  Although the new line 
will be a simplified version of the old, there will be shape changes and the result should be checked 
carefully.  Like Spline, a spacing parameter should be set to control the function.  In contrast to Spline, 
the final spacing of vertices will be much larger than that parameter.  The function is sensitive to small 
changes in the control parameter and satisfactory results will require experimentation.

To use Generalize, select the line(s) and apply the function from the Reshape pulldown.  Pick  gen *(S) 
to click a distance for the control parameter on screen and  gen distance(S)  to enter it in map units 
from the keyboard (gen default(S) uses the current Weedtolerance value, which is typically set auto-
matically from the setup file for the map).  Be sure to check the result.  Be cautious in applying 
Generalize to large parts of your map without first testing its effect, and be sure to work on a copy.

ADD LINES

Most maps will require the addition of various lines during editing, including lines that were over-
looked during original input or were deleted during earlier editing.  A scratch boundary may need to 
be added around the mapped area to close polygons, or a map boundary may be needed if not included 
in the original setup of the map.

Hand Digitize

Some lines may have been overlooked during the initial digitizing or tracing, may not have been 
effectively captured in scanning, or may have been deleted during editing as too complex to repair.  To 
replace them, simply digitize them by hand from the original registered on a digitizer or over a scan 
displayed in the background on screen.  Be sure that the lines have snapped properly to existing lines, 
that they are properly located in the map, and that they are tagged properly.

Map and Scratch Boundaries

A boundary is needed around the map area to close the open sides of polygons left by dangling faults 
and contacts.  This can be the latitude/longitude boundary of a regular quadrangle or a scratch bound-
ary around an irregular map area.  

A scratch boundary can be digitized on screen or from a digitizer and concurrently snapped to the ends 
of dangling lines.  Register your original on the digitizer or zoom to the part of the map in which you 
want to add the boundary on screen.  Set Nodesnap to a value that will let you place nodes within 
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snapping distance of the dangling line ends.  Then, from the Digitize bar, set the line type to  scratch 
boundary,  start the digitize routine, and enter the line.  Place a node at the end of each dangling line to 
cause the scratch boundary to snap to the dangling nodes.  Once the line has been entered, draw with 
Node Errors on to be sure that all the appropriate snapping did occur and that you have not created new 
dangles outside the boundary by intersecting some of the dangling lines.

The best way to obtain a projected map boundary is to include it when you start the map or transform 
a scan from the Setup bar (see Start a New Map or Layer, p. 93).   Adding a regular map boundary to 
an existing map is a bit more complicated.  To make a map boundary for an existing map, go to the 
Setup bar and make a new layer for your map (any kind of lines) and  include creation of a map 
boundary.  A boundary will be created, snapped to the corner tics, densified, and projected into your 
map projection.

Next, move the boundary from the new layer into your working map layer with the Get function.  Go 
back to Edit, rechoose your working map (otherwise the new layer will be the edit map) and go down 
to the Reshape (Lines) bar.  Pick  get  from the Options pulldown and then specify the new layer from 
the map names popup.  The boundary will be added to your working map and will be the selected set. 
While it is still selected, assign it a session color  (set $symbol(S)  on the Draw popup) to allow you to 
see and select it later in the session if necessary (Select For Expression  $symbol  =  [color number]) 
and/or tag the line as  map boundary.  

The remaining step is to attach connecting line work to the boundary.  From the Reshape bar with 
Intersectarcs on, move the boundary in place to create intersections with any overlapping lines and 
then draw with Node Errors on.  It will be difficult to distinguish unattached lines within the map from 
small dangles at the ends of intersected lines.  Go systematically around the map boundary and use 
Select Polygon to find and delete small dangles and use the Extend function to lengthen the other lines 
to attach them to the boundary.

Get and Put

The Get function allows you to copy all the lines from one map layer into the current edit map.  Put, 
in contrast, allows you to copy selected lines from the edit map into another layer.  In both cases, all 
ALACARTE attributes (such as LTYPE) will be lost unless the structures of the lines databases 
(AAT) in the two layers are identical.  Be sure, if you don’t want the current snap settings to operate, 
that you change them before proceeding.  Addition of lines with Get is an edit change that must be 
saved.

Get lines from another layer by opening the forms menu with  get  (on the Options pulldown from the 
Reshape bar) and entering (or picking) the name of the map containing the lines.  All the lines in the 
specified map will be added to the edit map, any in the current draw area will appear on the screen, and 
the newly added lines will form the selected set.  You may want to assign these lines a session color 
while they are selected.  If it is important that the line types or other attributes are copied as well, you 
will need to attend to correspondence between the two lines databases. 

Put selected lines from the edit map into another layer from the Put bar, which is reached with  PUT  
on the Options pulldown from the Reshape bar.  Select the target lines with the various select (so, sm, 
sp) and aselect (aso, asm, asp) functions on the bar.  Open the forms menu with  put  on the bar: enter 
(or pick) the name of the map into which the lines should be put, and click the  ok  button.  If the 
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specified layer does not exist, it will be created by copying the tic framework and database format of 
the Edit Map and the selected lines copied into it.  If the receiving layer already exists, ARC/INFO will 
interrupt to ask:

Coverage  [pathname of specified layer]
  already exists.  Do you want to append  <Y/N>  :

Confirm with a  Y, and the line(s) will be added to that layer.  In contrast to Get, the addition is to the 
permanent file of the receiving map unless you are displaying that map in the background, in which 
case you may need to save it.  If you are putting numerous lines into another layer, you may want to 
color or delete them from the edit map in order to keep track of which lines you have already put.  

TAG LINES

Existing lines can be selected and assigned line types (tagged) in bulk or by hand from the Digitize bar. 
The most efficient technique will depend on the specific problem.  ALACARTE maintains a current 
line type that you can set as desired (see Digitize Lines, p. 129).  In addition to tagging lines as they 
are digitized, that line type can be used to tag any selected set of lines or to select lines already tagged 
with that line type.

In the basic tagging operation, a selected set is tagged with the current line type by picking  tag  on the 
Digitize bar.  That line type will be recorded in the LTYPE database item for each of the selected lines 
and the operation will be reported:

12 lines tagged with LINETYPE:  contact,  LINEMODIFIER:  certain 

While the lines are still selected, you may want to use  $Symbol(S)  on the Draw menu to assign them 
 a session color.

This sequence is combined in the ALACARTE function  sel,tag,color  on the Select pulldown (Sel) 
from the Digitize bar.  This starts Select Many, with which you can select the desired lines.  When you 
close the selection (enter  9),  the selected lines are redrawn in the drawselect color and you are asked 
in the dialog area if you want to continue.  If the line selection is good, hit <Return> to tag them, if not, 
enter  n  to cancel the process.  Once the lines have been tagged with the current line type, the Colors 
popup is presented for you to assign a session color to the lines.

You can tag lines one-by-one as you edit, or wait to finish the lines in a work area on the map and then 
tag and color all the lines appropriately.  Selecting finished lines by clicking with Select Many will 
help you find overlooked editing problems and avoid tagging any tiny lines not evident at normal 
screen magnifications.  That absence of tags can be used to find these lines later.

Tag lines only with their proper line types, or, where more convenient, tag an easily selected group, 
even though some are wrong, and then change the incorrect ones later.

At any time, the line tags can be checked by selecting the lines by line type, coloring each type dif-
ferently, and checking visually on the screen.  Ultimately, you will want to make a test plot using 
proper line symbols.  Check that plot particularly for misoriented asymmetric symbols.  Correct them 
by reversing the line direction.
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LINE DIRECTION

All lines in ARC/INFO have a direction that is recorded in terms of the from and to nodes in the 
database.  Line direction is of principal interest here because of its influence on asymmetric line 
symbols.  The direction that thrust teeth, queries, and other asymmetric elements face is a function of 
line direction.  If you find that such elements face the wrong way, simply reverse the line direction.

To display line direction on the screen, turn Arrows on in the Draw Environment and redraw.  To 
reverse the direction of lines, select them and pick  flip line dir’n(S)  (on the Options pulldown from the 
Digitize and Reshape bars).
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Process and Edit Scans

Maps that have been scanned and converted to vectors can be imported into ARC/INFO for conversion 
into the line work of a map database.  The scanning and vector conversion can introduce a variety of 
defects and artifacts in the lines and their intersections, many of which must be corrected before the 
lines can serve as the database line work and polygon boundaries.

Once the vector file has been converted into an ARC/INFO map, that map is transformed into its 
projection, prepared as an ALACARTE map, and then edited and tagged.  Editing involves removal 
of extraneous material, repair of line continuity, shape, and intersections, and replacement of lines lost 
in scanning or deleted during earlier editing.  This work is done largely by hand on screen.  Boundaries 
of open water and a map or scratch boundary around the map area are incorporated into the map as 
appropriate.  The lines are tagged and the map searched for small untagged lines that signal minor 
problems that are best corrected before polygons are built.

Once any bulk operations are completed, it is most efficient in hand editing to work systematically 
over the map.  Start in one corner at an appropriate zoom magnification, do all the editing and tagging 
needed in that work area, and then shift the work area and edit and tag progressively through the map. 
Coloring lines as they are completed (edited and tagged) will help you find remaining problems and 
keep track of progress.  You will want to take full advantage of the various Zoom functions as you 
work (see Zoom Controls, p. 69).

PROCESS THE SCAN

Prepare and scan your original to obtain the cleanest line work possible.  Take the time to prepare the 
original to eliminate as much extraneous material as possible.  For many originals, it may be more 
efficient to prepare a tracing in non-smear pencil specifically designed for scanning (that is, all lines 
continuous and without teeth or other ornaments).  Be sure to include precise registration marks (see 
Map Registration, p. 115). At least four graphic marks should be located near the outer corners of the 
map at known positions and where other line work will not distort them in the scanning.  It will also 
be more efficient to take the time to set the scanner up carefully than to edit unnecessarily severe 
scanning artifacts later.

Import from Vector Source

With your map scanned and converted to vectors in an acceptable file format, load the file onto your 
ARC/INFO system (consult a colleague or your system administrator and, on Unix systems, avoid 
capital letters in the file name).  Convert this into an ARC/INFO map (coverage) using the appropriate 
ARC routine.  Name the converted map something like  [quad name].scn.

IGES  -  for files in IGES format, go to the Arc prompt and use the IGESARC command:

Arc:   igesarc  [input iges file]  [output map name]   {out error log file}

The option is available to name an error file, which will then record any unrecognized 
characters in the input IGES file.

DXF  -  for files in DXF format, go to the Arc prompt and use the DXFARC command:

Arc:  dxfarc  [input dxf file]  [output map name] 
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There are text-width and attribute-width options for this command that have no signif-
icance for scans.

SCITEX  -  for files in SCITEX format, open the Scitexline forms menu (pick  Scitexline  on the 
Scitex pulldown from the Conversion bar) and specify the Scitex file name and the output 
map name.

Transform into Projection

The dimensions and locations of map elements in the imported scan will be in scanner inches.  You 
can edit the line work in this form but, particularly if you will be using a digital base, it is better to get 
the map into the proper projection first.  This procedure is described under Map Registration 9p. 115). 
Be sure to include a map boundary in the Transform step if one will ever be needed, and call the 
projected scan something like [quad name].pr.

Prepare the Lines Layer

Make a copy of the projected scan ([quad name].pr) to be prepared as the lines layer, either by saving 
the projected scan as a new file from Edit or using   Copy  on the Files pulldown from the General bar. 
Call the copy something like  [quad name].ln. You will want to preserve the unmodified projected scan 
for use as a background during editing.

Prepare this lines layer for work with lines.  Working from the Prepare Scans pulldown from the Setup 
bar, use  3. create setup file  to record the map scale and the snapping and other values that you will 
want to use while editing (see Snapping and Other Controls, p. 123).  The resultant Setup file, which 
can be changed at any time, will then accompany the map and any derivatives as long as you work 
within ALACARTE.  Then use  4. Prep database, specifying a map layer of  contacts_faults, to prepare 
the database for lines.  This routine will build the map for lines and add an LTYPE item to the database 
in which to store the line types.  You should also include addition of the SYMB and SEL items for 
saving session colors and a selected set.  (Be consistent in the items that you include when you start 
layers to allow Get and Put transfer of lines to include database information.)  When these steps are 
completed, the layer is ready for editing and tagging lines. 

REMOVE EXTRANEOUS MATERIAL

Most scanned maps will contain various amounts of extraneous material.  A typical first step in editing 
a scan for lines is to remove this material by selecting and deleting it on screen (see Delete Unwanted 
Lines, p. 144).  You can do this as a first step in working on each part of the map, or you can clear out 
the whole map before beginning to edit the lines.  Editing on large maps will be speeded considerably 
if all extraneous lines are removed from the database first (reduces database search times), and any 
bulk processing will require it.

Use of Test Plots

A plot of the line work, although not necessary, can help you judge which scanning artifacts are 
significant.  Edit plots, which can include symbols for Node Errors (see Edit Nodes, p. 136), will show 
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where dangling ends and pseudonode breaks in lines are located.  The most useful times to make edit 
plots are after the extraneous material is cleared away, in order to examine the effects of scanning 
artifacts, and then after most of the editing is completed, to help find any remaining broken lines.

Edit plots are prepared in a routine started from the Edit Plot forms menu (see Edit Plots, p. 193).  For 
the first plot, specify a scale denominator that will plot the map at scale, use a window only if the full 
map is too big for the plotter, and answer  yes  to only the   Plot tics?  and  Plot arcs?  questions.  Make 
a hard-copy plot on a pen plotter, or on a high-resolution electrostatic plotter with all the lines assigned 
a very fine line symbol, such as contact weight in the ALACARTE lineset (ALCWRG.LIN, line symbol 
25).

In the second edit plot, be sure to include node errors.  Neither plot will contain any polygon infor-
mation, because polygons have yet to be built and recognized in the map.

EDIT AND TAG LINES

The principal task in editing a scan is to clean up the lines:  to repair line intersections, close broken 
lines, and reshape distorted lines.  The techniques involved are described in Edit Lines.  Consider 
starting with bulk procedures to delete tiny lines, snap dangling nodes, and smooth the lines, as ap-
propriate, and then work through the map systematically by hand to fix all the lines.  Tag the lines as 
you finish them, or as you finish all the lines in each work area, and color them to show that they are 
finished.  Be sure to save these session colors and restore them at the beginning of each edit session.

Bulk Processing

It may be useful to apply some operations to the whole map before proceeding to hand editing.  The 
principal criterion is whether the operations will increase or decrease the difficulty of later editing.  
Thus, if there are many short gaps in the lines, or many exceedingly short lines, or some fine-scale 
irregularity in line shape, bulk processing may be profitably applied.  Be sure that the extraneous 
material has been removed first.

Delete Short Lines

Consider selecting and deleting all the lines shorter than a line width or so (0.01 inches, for example). 
You can test the effect by selecting and coloring all the lines less than such a value (expressed in map 
units)  --  or, better, by selecting and coloring a sequence of progressively shorter lines   --  and then 
inspecting the map in several places at high magnification to see what the effect of deleting a set of 
short lines would be.  The principal damage that this can do is to remove tiny connecting lines pro-
duced by the line thinning at crossed-line intersections.  These situations can be flagged with Node 
Errors as long as you do not combine arcs in bulk.

Snap Dangling Nodes

It may be useful to snap together all closely spaced dangling nodes to simplify later editing.  Draw 
various parts of the map at intermediate magnification with Node Errors on to see whether this will do 
more harm or good.  One useful procedure where such snapping looks promising is to snap all dan-
gling nodes at some very short distance, examine the result, combine arcs in the whole map, and then 
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progressively increase the snap distance and repeat the process until damage starts to appear.  Make a 
new copy of the map for each stage to allow later selection of the best version.

Nodes can be snapped on screen by setting Nodesnap to the desired distance, selecting the lines (in-
dividually or, for example, by the screenful), and then activating the snapping with  move in place  (on 
the Reshape pulldown from the Reshape bar).  If you want to operate on the whole may, use Match-
node (see p. 138).

Smooth the Lines

Some scans may contain systematic fine-scale distortion of the lines that can be effectively removed 
by smoothing the lines with the Generalize or Spline functions (see p. 149-150.  Try out some repre-
sentative lines first, and be sure to check the effect on intersections and tight bends in the lines.

Hand Editing

Once the extraneous material has been removed and any bulk processing has been applied, the re-
maining lines will probably require hand editing.  Check the snapping, turn Node Errors on, and 
proceed systematically through the map.  Adjust those intersections that are distorted beyond the limits 
of map resolution, close broken lines and unconnected intersections, and fix misshapen lines.  Add any 
lines missed by the scanner or deleted during earlier editing, either from the digitizer or by tracing 
from the unmodified, projected scan.

Tag and color the lines by line type as you finish them to record your progress and help you read the 
map on the screen.  Test line integrity while tagging by selecting with Select Many to help check for 
remaining problems.  Beware the temptation to fix artifacts that are too small to be significant at map 
scale.  Test line type assignments occasionally by selecting and coloring by line type, rather than just 
restoring the colors saved in the last edit session.

Your goals are to produce line work that properly represents the lines in the original map and that can 
serve as polygon boundaries in the polygon layer.  If appropriate, work with a digital base map in the 
background to assure that the lines are properly fitted to the base.

Map, Scratch, and Water Boundaries

If the map is a regular quadrangle , you probably included a projected map boundary when you pre-
pared the scan from the Setup bar.  If you did not, and now want such a boundary, prepare it separately 
by starting a new map in the same projection (see Start a New Map or Layer, p. 93).  Get the map 
boundary from its separate map layer and add it to the lines layer you are working on.  You will want 
to tag it to distinguish it from the other lines, and will need to attach to it all those lines that reach the 
boundary in the original.  If the map area is irregular, add a scratch boundary to bound the mapped area 
and attach it to the dangling lines in the map.  Similarly, if there are open bodies of water that should 
be distinguished from the geologic map units on the map, add their boundaries to the map, and then 
tag the boundaries and connect other lines to them as appropriate.  These water boundaries can be 
traced on a digitizer from a base map or selected in a digital base and added to the lines layer with the 
Put function.

158



REMAINING PROBLEMS

When you think you are finished with the lines, there will almost certainly be more problems to 
correct.  Check the map by selecting and coloring the lines by Line type and then drawing its various 
sections on the screen with Node Errors on to check for mistagged lines, unnecessary pseudonodes, 
and unwanted gaps in lines.  Make a second edit plot to check particularly for breaks in lines that are 
to serve as polygon boundaries.  Any that are not corrected now, however, will become clearly evident 
later.

You can find and correct untagged lines by selecting them (Select for Expression: LTYPE = ’ ’), listing 
them, and recording their $ID numbers.  Then select each of the lines, one by one (Select for expres-
sion: $ID = [number]), draw the area of the selected features to find it on the screen, and delete, tag, or 
otherwise correct the problem that it represents.

159



160



Tag and Edit Areas

The various units in a geologic map are represented by polygons whose boundaries are composed of 
the contacts, faults, and other kinds of lines in the map.  The polygons are organized by ARC/INFO in 
a topologic processing step (the Clean and Build functions) that organizes valid polygons and lists 
them in the areas database (the PAT).  Prepare a polygon layer from the completed lines layer of the 
map.  You then can specify the identity of each polygon by placing a label point in it (by hand or in 
bulk process) and tagging the label point according to map unit.  Subsequent editing will probably be 
needed to find and correct breaks in some of the intended polygon boundaries and any errors in la-
beling and tagging.

Digitizing and editing the identifying label points is done principally from the Digitize (Areas) bar and 
repair of broken polygon boundaries is done from the Reshape (Lines) bar.  The symbols representing 
the label points can be colored or changed on screen, polygons of given identities can be filled with 
color to aid editing, and missing and multiple label points can be listed.

PREPARE THE POLYGON LAYER

Process the lines layer to build polygon topology for a new polygon layer (name it something like  
[map name].py1).  The procedure for this depends on how you have processed the map to this point:

Edited Scan - a lines layer that has been processed for contacts and faults with Step 4 from the 
Prepare Scans pulldown will not yet have an areas database (PAT).  Such layers should now be 
processed at Step 4 again for units:  pick  4. prep database  (on the Prepare Scans pulldown from 
the Setup bar) and specify  units  for layer type.  Generally you will want to include the SYMB and 
SEL items for the PAT as well.

New Map or Layer - a lines layer that was started from the New Map or New Layer pulldowns 
for contacts, faults, and units will already have a PAT and probably will have SYMB and SEL 
items in the PAT as well.  Do not use the Prepare Scans procedure here.  Instead, simply clean the 
map for polygons  (Clean  on the Topology pulldown from the General bar).

Non-Standard Map - any ARC/INFO map, regardless of its history, can be prepared for work 
with polygons in ALACARTE as long as it does not contain point information (in ARC/INFO 
5.0.1, points and polygons are incompatible because they use the same PAT database).  First, clean 
the map for polygons  (Clean  on the Topology pulldown from the General bar; and see Topology, 
p. 56).  Then add the PTYPE, SYMB, and SEL items to the PAT database with  Add ALC items  
(on the Files pulldown from the General bar). The remaining step is to add a Setup file.  This can 
be done with Step 3 in the Prepare Scans sequence or by establishing settings in Edit and then 
saving them (see Snapping and Other Controls, p. 123). 

Completion of this step for any ALACARTE map should produce a database prepared both for lines 
(AAT) and polygons (PAT) that probably contains SYMB and SEL items for each feature type.  The 
structure of the database for a map can always be checked by describing the map  (describe map  on 
the Map pulldown from the Edit bar) and/or going to the Lines and Areas bars and listing the items in 
the database for each type of feature  (items  on the Database pulldowns).
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TAG POLYGONS

The principal task in preparing the polygon layer for a map is to place an identifying label point that 
is tagged by map unit in each polygon.  This is done from the Digitize (Areas) bar which, like the 
Digitize (Lines) bar, supports digitizing, tagging, and selection by area type:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  key  |  m1  |  m2  |  m3  |  Op  |  Dw  |  Zm  |  ^AREAS  |

A current area type is maintained at the bar for use in tagging label points automatically as they are 
digitized, in tagging a selected set of label points, and in selecting label points according to their tags 
(PTYPE).  Pick  ?  to report the current area type, and reset it either by entering from the keyboard 
(pick  key  and enter at the prompt) or by picking from a user-prepared custom menu opened with  m1, 
m2, or m3  (see Custom Tag Menus, p. 82).  In contrast to lines, there are no standard area types and 
no modifiers for area types.  Labels and arcs will be turned on in the Draw Environment automatically 
when you go to the Digitize bar.

To digitize label points, pick  dig  on the bar -  a key menu is presented, preceded by a report of the 
current area type that will be assigned to the PTYPE item for the point and followed by the prompt to 
enter a label:

Adding polygons labels with attribute:  Qal

--------------------------Options----------------------------
1)  Add Label                   5)  Delete last label
8)  Digitizing options        9)  Quit
(Label)  User-ID: 20

Click  1  on the screen or digitizer to enter a point; the coordinates of the clickpoint will be reported 
and the point displayed on the screen:

(Label)  User-ID: 20  Coordinate = -3181.966,6025.430

The simplest way to identify polygons on a map is to digitize label points and tag them concurrently.  
Do this from the screen or, particularly for complex maps, from a full-scale colored map or annotated 
map or edit plot registered on a digitizer.  An alternative method is to create untagged label points for 
all valid polygons automatically and then to find, select, and tag each of these points, working either 
on screen or from the digitizer with an edit plot on which all polygons and their label points are shown. 

Digitize and Tag

Labelling polygons by hand from the digitizer or on screen mimics the familiar labeling of an inked 
map and provides the greatest control over the location of the labels in the map.  If you place more than 
one label point in a polygon, however, or any polygon boundaries are incomplete, then some PTYPEs 
may be changed when you build the map and later editing will be required.

Work on screen with one section of the map at a time, tagging the larger polygons first and then the 
smaller ones progressively.  Set the area type for the first unit to be tagged, start the digitize routine, 
and enter the label points, one to each polygon (position the crosshairs and click  1  to digitize a point). 
The label points will be tagged automatically with the current area type.  Tag as many polygons of that 
area type as is convenient, then change to the next area type and proceed. Save the current frame and 
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zoom in on small polygons as necessary to assure that the label points are actually placed within the 
polygon boundaries.

The label points will draw on the screen as you enter them.  You can include display of the PTYPE 
tags at the label points to help you read the map (see Display Tags On Screen, p. 163).  As you 
progress, build the map and color the remaining unlabeled polygons on screen to help guide the work.

Working from the digitizer, in contrast, and particularly with a full-scale, colored original, allows you 
to digitize tagged label points for many polygons of the same map unit throughout the map before the 
area type has to be changed.  Start by registering your map on the digitizer, and keep track of your 
progress by checking off the digitized points on a transparent overlay as you go.  Display the map on 
the screen in the fashion described above to help keep track of the work.   If you have difficulty placing 
labels within small polygons or finding remaining untagged polygons, move your work to the screen.

It can be useful, particularly as you begin to run out of unlabeled polygons, to highlight the remaining 
ones by coloring them on screen.  There will be a number that you have overlooked, particularly small 
ones, and perhaps some that result from line problems that should be fixed. Alternatively, you may 
want to color labeled polygons of specified PTYPEs to aid work on screen.  Such on-screen coloring 
may make it easier, even where the initial polygon tagging is done from a digitizer, to finish the job on 
screen.  Build the map first, and then specify the kind of polygon from the Color Units menu opened 
with  color units in backgnd  (see Color Selected Polygons, p. 169).

Determine that you have labeled all the polygons by building the map and running Labelerrors (see 
List Label Errors, p. 167).  Or, if you are coloring unlabeled polygons, check the report in the dialog 
area that indicates the number of polygons that have been selected for coloring.  A report of 1 polygon 
selected (the background polygon) indicates that there are no unlabeled polygons in the map.

If any unlabeled polygons are particularly resistant to being found, use the Createlabels function to add 
labels to them (see Create and Tag, p. 164).  These untagged labels can then be selected directly (see 
Find Untagged Label Points, p. 166).

Display Tags On Screen

You can display on screen the tags associated with each label point as you digitize or tag it, or as a 
means of checking the tags of existing labels.  This is useful at relatively large draw scales, but will 
illegibly clutter the screen at small scales.

Turn the display of PTYPE attributes on with  post attribute: on  (on the Options pulldown from the 
Digitize bar).  Now, each time that you digitize or tag a label, the tag (PTYPE) will be displayed next 
to the label point.  The tags will be displayed for all existing label points whenever you draw or zoom, 
although the text does not scale with zoom and it cannot be manipulated as annotation.  

Turn off the display of tags with  post attribute: off  (on the Options pulldown).

163



Create and Tag

You can automatically assign untagged label points to the centroid of every valid polygon in a map 
and then select and tag them. This approach avoids the multiple-label problem of hand digitizing, but 
requires that you find and select the label points before you can tag them.  Editing will still be required 
to correct incomplete polygon boundaries and remove labels and lines for unintended polygons.

Assign the label points with the Createlabels function.  It can be applied to add label points to all the 
polygons in a new polygon layer, if you prefer to select and tag existing label points.  It can also be 
used after hand digitizing to add untagged label points to the remaining unlabeled polygons.  Once the 
labels have been created, you then select and tag them.

Run Createlabels

Createlabels is run from a forms menu opened with  Create labels  (on the Files pulldown from the 
General bar).  Build the map for polygons first if it has been edited  (Build  on the Topology pulldown 
from the General bar), open the Createlabels forms menu, and enter the map name.  

If you use the default user-id base (#, which here represents 0), new labels will be created in every 
valid polygon in the map.  If the map already contains label points, those points will all be replaced by 
new ones placed at the polygon centroids.  PTYPE attributes of those existing labels will be assigned 
to the equivalent new labels, but you must build the map again for polygons to assure that the 
user-ID numbers are reset properly.

This procedure will cause multiple labels to be replaced by single labels, which will leave you unable 
to find those places where building with multiple labels has reassigned erroneous PTYPEs across 
incomplete polygon boundaries  To avoid changing existing labels, limit the procedure to unlabeled 
polygons by specifying a new user-id base that exceeds the highest user-ID number for the existing 
labels.  Determine the next higher user ID in a map by starting the digitize routine; the next higher 
number will be posted as the user ID at the prompt.

Tag Existing Labels

Tag existing label points on screen or from an edit plot of the map on which you have included tics 
(for registration on the digitizer) and all arcs and label points.  Set the area type for the first unit to be 
tagged, select all the label points of that type within reach, and tag them.  The selection, tagging, and 
on-screen coloring of the label points are combined in the ALACARTE function  sel,tag,color  (on the 
Select pulldown from the Digitize bar).  This begins with Select Many, with which you select the 
labels to be tagged.  When you close the Select routine, the selected set is redrawn with the drawselect 
symbol.  Check that the redrawn points are correct, confirm with <Return> (or cancel with  n(o)), and 
the selected set will be tagged automatically with the current area type.  The Color popup will then 
appear, from which you can assign a symbol to the newly tagged label points in order to distinguish 
them.   You can also post the tags on the screen as you go (see Display Tags On Screen, p. 163). To 
find polygons with untagged label points, select them directly or color the polygons  (see Find Un-
tagged Label Points, p. 166).

If you are working on a digitizer, keep track of progress by checking off the label points as you go.
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CHECK LABELS 

It is important, once you have labeled the polygons in a map, to check them.  At least some of the 
following kinds of error are almost certain in all but the simplest maps.  Polygons may have:

1.  No labels:
a.  polygons missed during hand labeling, most common with very small polygons;
b.  polygon not recognized by Createlabels because of an incomplete boundary;

2.  Untagged label points:  points from Createlabels missed during tagging;  
3.  Multiple labels:

a. more than one label placed by hand in a single polygon, most common with intricate poly-
gons such as alluvium;

b.  label points placed by hand in separate polygons, but a break in line work caused 
ARC/INFO to consider them a single (composite) polygon with more than one label.

3.  Wrong PTYPE:
a.  polygon tagged incorrectly;
b.  PTYPEs of multiple labels reassigned during a build. 

Correcting these errors is straightforward, but first they must be identified and located on the map.  
There are several ways to do this.  Polygons with multiple or missing labels can be listed or can be 
plotted in map form.  The errors can be located on the map using hard-copy plots or by on-screen 
selection of erroneous label points or coloring of unlabeled polygons.  Mistags can be identified 
through scrutiny of hard-copy or on-screen plots in which the tags for each label are distinguished or 
the polygons are colored according to PTYPE.

You can work on-screen work or from hard-copy edit plots registered on a digitizer.  Complex maps 
may warrant repetition of some of the steps more than once.  Your choice of method and sequence will 
depend on convenience, the abilities of your system, and the size and complexity of the map.

Checking Procedure
 

Build the Map  -  The first step in checking a polygon layer for errors is to assure full polygon 
topology by building the map  (Build  on the Topology pulldown from the General bar; and see To-
pology, p. 56).

Tag or Label Remaining Polygons  -  If you have entered label points by hand, test for unlabeled 
polygons.  Do this by checking the selection report when you color unlabeled polygons (see Color 
Selected Polygons, p. 169) or by listing errors (see List Label Errors, p. 167).  If some remain unla-
beled, find and label them.  To find unlabeled polygons, color them on screen (see Color Selected 
Polygons, p. 169), post their centroids on an edit plot (see Plot the Errors, p. 168), or add untagged 
label points and select them (see Create and Tag, p. 164).  If you have used Createlabels, check for 
untagged label points (see Find Untagged Label Points, p. 166) and tag any that you find.

Fix and Label Incomplete Polygons  -  If you have used Createlabels, check that there are no in-
tended polygons without labels (due to incomplete polygon boundaries) by inspection of the map on 
screen or on an edit plot (see Plot the Errors, p. 168), fix the boundaries, and tag.
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Correct Multiple Labels  -  If you have done any hand labeling, list label errors (see List Label 
Errors, p. 167) and record the list of any multiple label points, or make an edit plot to display multiple 
label points and node errors (see Plot the Errors, p. 168).  Find the multiple labels by polygon, deter-
mine whether the problem is a broken boundary or multiple labeling, and fix the boundary or delete 
excess labels (see Edit Polygons, p. 171).  Building with broken boundaries will have reset the PTYPE 
tags of the multiple labels.  While they are at hand, find and correct the erroneous tag(s).

Check Tags  - Once all the label errors are corrected in a map, it is wise to check that all the polygons 
are tagged correctly.  This can be done on screen by including the tags when you draw (see Display 
Tags On Screen, p. 163) or by coloring the label points or the polygons.  Label points can be colored 
by PTYPE (see Distinguish Label Points, p. 168).  Map units can be colored throughout the map one 
by one on screen (see Color Selected Polygons, p. 169), or numerous units can be colored at once (see 
Custom Colorfill, p. 170).  Check the tags throughout the map and correct erroneous tags.  Ultimately, 
you will want to make a full-color plot to check the whole map.   

Find Unlabeled Polygons

Unlabeled polygons can be listed (see List Label Errors, p. 167), but that list provides no basis for 
finding the polygons on the map.  To find them you can either color the unlabeled polygons on the 
screen (see Color Selected Polygons, p. 169) or make an edit plot showing polygons with label errors 
(see Plot the Errors, p. 168).  If you include tics in the edit plot, you can register it on a digitizer and 
either tag the polygons directly or, particularly for tight areas, zoom in from the digitizer and then 
work on screen.

Find Untagged Label Points

Label points added to a polygon layer with the Createlabels function will need to be selected and 
tagged.  If all the labels in a map are untagged, draw from the Digitize (Areas) bar and select and tag 
the labels.  Or, make an edit plot showing all arcs, label points, and tics (see Edit Plots, p. 193), register 
the plot on a digitizer, and select and tag the label points.  When working on the screen, you can color 
those polygons that have untagged label points to help guide the work (see Color Selected Polygons, 
p. 169). 

Where only a few label points are untagged, select them with Select For Expression  (Select popup):

selection expression:   PTYPE  =  ’ ’ -  two single quotes.

Then color the labels ($symbol(S)) and draw the area of the selected features.  If the distribution of the 
labels draws too large a part of the map, you may have to list their User-ID numbers (show sel’d 
features  on an Options pulldown), record those numbers, and then select them one by one:

selection expression:   $ID  =  [ID number]

Once a single label is selected, draw the area of the selected feature.  If you need to enlarge the draw 
area, first use  zoomin(box)  to reset a finite draw area and then zoom out.
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List Label Errors

The Labelerrors function will list all the valid polygons in a map that have no labels or that have 
multiple labels.  The list of unlabeled polygons serves to indicate their presence, but other means must 
be used to find them on the map.  The multiple labels, in contrast, are listed by User-ID number for 
each polygon, and this number can be used to select the label points.

Run Labelerrors from the General bar.  Pick  Labelerrors  on the Topology pulldown, specify the map, 
and activate the function.  Use  ok  unless you want to send the resulting list to the system printer, in 
which case use  print.  You can also run a watch file to record the list and print that separately.  To do 
this, go to the Devices bar (pick the bar name to open the Commands menu, then pick  DEVICES), and 
pick  watch on  from the Watch pulldown.  Enter a name for the watch file at the prompt (such as 
erlist.1) and then go back and start Labelerrors.  Be sure to turn the watch file off again afterwards 
(watch off).  This watch file can then be displayed on the screen  (page list  on the Commands menu) 
or sent to a printer.

If you are working from a terminal, you may want to reset the screen dialog to full screen  (fullscreen 
dialog  on a Commands popup) in order to preserve as much of the list as possible on the screen.

If there are no errors in the polygon labels on the map, the list will simply report the background 
polygon, which surrounds your map and needs no label:

Polygon 1  has 0  label points

Otherwise, a list of errors will be reported in the following form:

Polygon 1  has 0  label points

Polygon 3  has 2  label points

Label User ID: 5 -  one label in polygon 3.

Label User ID: 6 -  another label in polygon 3.

Polygon 4  has 2  label points

Label User ID: 4
Label User ID: 8

Polygon 7  has 0  label points

This list of label errors indicates the presence of unlabeled polygons and specifies the User-ID num-
bers of the label points in each polygon that has multiple labels.  Use these ID numbers to select the 
label points (see Locate Multiple Labels, below).

Locate Multiple Labels
  

The Labelerrors function lists multiple labels according to their enclosing polygon, and you should 
locate them on the map in the same polygon groups to facilitate correction.  Select the labels using 
Select Many from an edit plot on a digitizer or by user ID-numbers on screen.  To select a group of 
labels by user ID, use Select For Expression on the Select popup and enter the User ID (call it $ID) for 
each label in the group, separating each with  or :

select expression:    $ID  =  3  or  $ID  =  4  or  $ID  =  5  
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This example would select the three label points that have User ID numbers 3, 4, and 5.  The first 
time you do this in a session, ARC/INFO will warn you:

WARNING  User-IDs between LAB and PAT do not agree.

Exit and re-build the coverage

Do not rebuild.  The disagreements in the database that produce this warning result from the errors that 
you are working to correct. 

With the labels selected, draw the area of  selected features(S)  from the Zoom popup to see the 
selected label points on the screen.  Draw the selected labels or, better, assign them a session color to 
distinguish them ($symbol(S)).   Zoom out if necessary to see whether the problem is more than one 
label in a single polygon or a broken boundary that has produced a composite polygon.  To check this, 
you will probably want to draw the whole perimeter of the enclosing polygon.  You can do this by 
zooming out several times.  It may be faster to go to the Reshape bar (which you must do anyway to 
repair a boundary), select the polygon boundary with Select Outline on the Select popup, and then 
draw the area of the selected feature from the Zoom menu.  The selecting mouseclick should lie just 
inside the polygon at the boundary.  

Plot the Errors

Two complementary kinds of edit plots can be made that will help to identify and find errors for 
correction (see instructions in Edit Plots, p. 193).  A plot of polygon errors will show the information 
in the error list graphically (multiple labels and polygons without labels).  A plot of line-work errors 
will aid in finding broken polygon boundaries by showing the line work and marking all pseudonodes 
and dangling nodes .  If tics are included in the plot, the error plots can be registered on a digitizer and 
used directly.  Complex parts of these plots will be difficult to read clearly.  Plot these areas at an 
expanded scale or reserve them for on-screen work.

Make a polygon error plot by limiting the edit plot to polygons with label errors (include tics to register 
the plot on a digitizer).  This will mark the centroids of unlabeled polygons with a star, indicate mul-
tiple label points and their User-ID numbers, and show the boundaries of those polygons that have 
label errors.  Make a line work error plot by including all arcs and node errors (and tics for registering 
the plot).  This will show all the arcs and then superimpose (with pen 2) small rectangles for dangling 
nodes and diamonds for pseudonodes.

ON-SCREEN COLORING

Coloring the label points of tagged polygons or filling polygons with color on screen can be very 
useful in viewing and editing your work.  Some coloring operations are automated in ALACARTE, 
whereas others require the preparation of simple text files that are then run as ArcPlot programs 
whenever the screen is redrawn with any Draw or Zoom function.  

Distinguish Label Points

The polygon tags can be displayed on the screen at their label points (see Display Tags On Screen, p. 
163) or the label points can be assigned session colors or symbols according to polygon type.  These 
label colors can be saved between edit sessions.
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Select the label points by area type from the Digitize bar and assign each type a session color 
($symbol(S)  on the Draw popup).  Save these symbols, if desired, by assuring that the needed items 
have been added to the database (SEL and SYMB in the PAT) and turning Save Symbols on from the 
Save pulldown from the Edit bar.

Session colors 1-15 on the Colors popup will assign a small rectangular spot of the specified color to 
the label point.  Because only five or six screen colors are really distinguishable on screen for such 
small symbols, such coloring must be done in groups of five or six map units at a time.  Larger sym-
bols can also be assigned in the same range of colors by picking  other  from the Colors popup and 
entering a number at the prompt:  17-31:  rectangles:  33-47:  pluses;  49-63:  rectangles containing an 
X;  65-79:  rectangles contain a plus; and 81-95:  diamonds.

Color Selected Polygons

You can color any single kind of polygon in the edit map with the Color Unit function  (color units in 
backgnd  on the Options pulldown from the Digitize bar).  This is particularly useful in finding un-
tagged polygons or label points, but can also be used to color polygons of any PTYPE.  You specify 
the type of polygon and the color, and then every time you draw or zoom the polygons are selected and 
colored.  The routine that colors the polygons consults the permanent file of the edit map and requires 
that no editing has been saved since it was last built for polygons.  

Color unlabeled polygons, or those with any single specified tag (including untagged label points) 
with  color units in backgnd, which opens a forms menu:

1.  Specify shadeset
        local shadeset:       /ARCEXE50/SYMBOLS/COLOR.SHD
                 OR
        arc shadeset:          /ARCEXE50/SYMBOLS/COLOR.SHD

2.  Unit to be colored       selected geologic unit:   Qal
                  OR
     color unlabeled polygons

3.  select color for unit     selected color number:  7

Accept the default shadeset or specify another (?  or middle mouse click to list options from your local 
directory or the ARC symbols directory).  Use the PTYPE of existing label points to specify the 
polygons to color by picking the  Unit to be colored  button and then choosing from the resulting list 
of unit labels in the map  (Qal  in the example;  pick  *none*  from that list to color polygons with 
untagged label points).  Color polygons with no label point by picking the  color unlabeled polygons  
button.  Specify the color to be used by opening the Colors menu with the  select color  button and 
picking a color.  Numbers greater than 16 will produce various patterns in white, red, green, and blue 
(pick  other  and enter number from the keyboard).  Activate the routine with  ok, and then every time 
you draw or zoom, the specified kind of polygon will be colored on screen.  

Change the unit or color assignments by repeating the process.  Accumulate colors on the screen for 
different units by changing the settings and drawing sequentially without clearing the screen (use  
draw(noclear)  on the Draw menu).
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Turn the coloring routine off with  color unit:  off  on the Options pulldown.  Be sure to do this before 
leaving the Areas bar to work on lines or points or errors will result on every zoom and draw.

This function operates on the permanent file of the current edit map.  You can color from a different 
version of the map, or color several units at once, by using a custom colorfill program (see Custom 
Colorfill, below).

Custom Colorfill 

A colorfill program can be written that will color one or more map units on screen as part of the Draw 
and Zoom functions in ALACARTE.  This works in the same fashion as the routine used to color 
selected polygons from the Color Unit menu, except that you invoke it from the Arcedit command 
line.  You must have built the map for polygons since last saving any editing. The limit on the number 
of units that can be colored concurrently is the number of distinctive colors and patterns available on 
your system.  For large maps this routine may exceed available memory in your terminal unless only 
part of the map is drawn at a time.

Prepare the Program

Go to the directory that contains your map and start a screen editor from the system prompt or the 
Commands menu.  Use a short file name of the form  c.[mapname].ap. (Or use the extension .alc, which 
will inform ALCARTE to copy the coloring file when you save to a new file name.)

Enter the program in the screen editor:

/* explanatory heading for the program  (optional)

shadeset  color.shd (specify the shadeset for the program)

Repeat the following four lines for each unit to be colored:

resel  [map name]  poly  mapextent (save time by limiting to draw area)

resel  [map name]  poly  PTYPE  =  ’Qal’ (single quotes around entry)

polygonshades  [map name]   7 (7 is yellow)

Clearselect (clear this selection)

In this form the program is specific for a particular map file.  Save the program as a file in the current 
directory for the map.

This basic form can be modified to color unlabeled polygons (those lacking label points) and post the 
polygon numbers on screen (those reported by Labelerrors):

shadeset color.shd
resel  [map name]  poly  mapextent (save time by limiting to draw area)

resel  [map name]  poly  PTYPE  =  ’’ (two single quotes, no space between)

polygonshades  [map name]   7 (7 is yellow, 13 is magenta)

textcolor 13 (specify a color for polygon numbers)

polygontext  [map name] [map name]# (post polygon numbers)
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To make the general program apply to the current edit map, regardless of its name, change the file 
name references:

/* explanatory heading for the program  
shadeset  color.shd

resel  %.alc$cover%  poly  mapextent
resel  %.alc$cover%  poly  PTYPE  =  ’Qal’
polygonshades %.alc$cover%   7
Clearselect 

To post the polygon number for the selected polygons (as for unlabeled polygons), insert the following 
into the program just before  Clearselect:

&s apcover  [entryname %.alc$cover%] (generalize map name for other directories)

textcolor 13 (color the text magenta)

polygontext  %.alc$cover%  %apcover%# (post the poygon number)

Run the Program

Activate the colorfill program by going out to the ArcEdit prompt (pick  give one ARC/EDIT command 
 from a Commands popup in Edit)  and entering  ap   [name of colorfill program]:

Arcedit:   ap   colormap.alc

Now, every time that you draw or zoom in ALACARTE, the colorfill program will color the polygons 
on the screen.  Turn the colorfill routine off by picking  color units:  off  (on the Options pulldown from 
the Digitize bar).  To restart the colorfill routine, go out to the Arcedit prompt and activate it again.

EDIT POLYGONS

Polygons can be edited by repairing or modifying their boundaries or by adding, deleting, moving, or 
tagging their label points.  Work with the label points from the Digitize and Move (Areas) bars and 
change polygons boundaries from the Reshape (Lines) bar.  Any changes in boundaries or in the 
presence or location of label points will require that the map be rebuilt for polygons to assure complete 
polygon topology.  Be sure to save any changes before leaving Edit, and then rebuild the map to 
incorporate the edit changes into the polygon topology.

Once problems in a polygon layer have been identified (see Check Labels, p. 165), the principal issue 
is to locate them on the map in order to correct them.  Some problems are located as they are identified, 
as with coloring unlabeled polygons or noting problems on an edit plot, whereas others must be lo-
cated once they have been identified.  This applies particularly to multiple labels listed with 
Labelerrors.

Most polygon editing will be facilitated by drawing with Node Dangles on and displaying the tags at 
their label points (see Display Tags On screen, p. 163).
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Move Labels

There are occasions, particularly with very small polygons, in which you may have placed a label on 
the wrong side of a boundary.  This leads to one polygon with no label and an adjacent one with two.  
If, in checking labels, you recognize that this has happened, simply select one of the labels and move 
it across the boundary (work from the Move bar).  You will then need to check (and correct) the tags 
of both labels, because the previous build will have reassigned them in common.  

Delete Extraneous Labels

Some errors in polygon labels may be multiple labels in individual polygons.  This is most likely in 
large or intricate polygons that you labelled more than once in different places.  Multiple labels within 
discrete polygons can be found on a polygon error plot, except where the plot is illegible in tight or 
complex areas.  They can also be found on screen through the selection of groups of multiple label 
points or by inspection of a screen plot showing lines and label points (draw from the Areas bar).

Select and delete the extraneous label points and then check the tag of the remaining label and correct 
it if necessary.

Change Tags

The tag recorded for a label point (PTYPE) may be wrong either because you entered it incorrectly or 
because it was reset during a build where the polygon contained multiple labels.  Change a tag either 
by retagging or by correcting it in the database form.

To retag, set the correct area type at the Digitize bar, select the label, and tag it.

To check or correct the tag from the database form, select the label, open the form (forms(S) on the 
Database pulldown from the Areas bar) and, if necessary, enter the correct tag in the PTYPE blank.  
Or, open the form with no label selected and then select from within the form (click on  SELECT  in 
the form and then click on the label on the map).

To change the PTYPE entry for a set of labels (for example, to change numerous entries from  Tv  to  
Ta), set the current area type to the current entry (Tv),  select by current area type, reset the area type 
(Ta),  and tag the selected set. Be sure to save your work.

Broken Boundaries

Some polygons with multiple labels may actually be composite polygons made of adjacent, labeled 
polygons for which the common boundary is not closed.  These composite polygons can be found 
either by on-screen inspection of the line work surrounding the multiple label points or by comparison 
of a polygon error plot and a line work error plot. 

Work from the Reshape (Lines) bar and be sure that the snapping functions are set properly.  Examine 
the map and determine the source of the error.  If gaps in a polygon boundary are tiny, you may need  
to zoom in on the various junctions to find where the continuity is broken (use  save this frame  before 
zooming in to permit easy return to your view of the whole polygon).  In extreme cases you can use 
Select Outline on the Select popup to check the integrity of a polygon boundary.  Once you have 
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located the break, fix it (typically by moving and snapping nodes).

The tags of multiple label points within each polygon will have been reassigned in common during the 
preceding build.  Thus you will also want to check and correct the tags while the affected labels are 
identified.  Select the mistagged label and correct it (see Change Tags, p. 172).
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Points and Point Data

Geologic maps can contain a variety of kinds of information assigned to particular points in the map, 
including field or sample localities,  fossil localities, wells, and earthquake epicenters.  (Structural data 
and such oriented elements as strike-slip arrows and bar-and-ball on faults are also recorded at points, 
but are separately treated under Oriented Data and Symbols.)  Point data in a digital map can be much 
more extensive than on a single cartographic presentation, because the digital map is a database.  
Different kinds of points can be distinguished by different primary tags (PTTYPE in a standard 
ALACARTE map) or can be separated in different map layers.  

Points and point data are entered by hand or by import of tabular files;  scans can only provide loca-
tions for on-screen tracing.  Imported files that contain location of the points can be used to generate 
point maps automatically;  those without locations can be be used to assign information to existing 
points carrying equivalent identifications.  All the information about a point can be recorded in the 
primary INFO database, or an entry in that database can be used to relate the point location and iden-
tity with additional information in another database containing additional information (such as fossil 
lists, major-element chemistry, or field notes).  

Different kinds of point information are supported by different digitize bars in ALACARTE.  Work 
with information that requires a point location but has no azmuthal content from the Digitize (Points) 
bar (pick  POINT  from the Digitize/Tag pulldown from the Points bar).

BASIC POINTS BAR

The points bar (reached with  PTS  on the ALACARTE bar) provides basic functions about points and 
a Digitize/Tag pulldown from which you proceed to the digitize bars for the different kinds of points:

[ Points ]  |  Dig/tag  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

POINT 

PLANAR
LINEAR
MAP SYMBOLS
no attribute

Use the items on the Digitize/Tag pulldown to go to the digitize bar appropriate for the kind of point 
data with which you want to work.  Move or copy points from the Move bar.  Change markerset or 
lookup table for the symbols displayed on the screen from the Symbols bar (pick  SYMB).  The Data-
base pulldown contains a number of functions for working with the database, including the Database 
forms menu from which you can view and change database entries.

Points Item

The database item that ALACARTE uses to record the point type and to select by type is the PTTYPE 
field by default, but this can be changed for more specialized applications from any of the points 
digitizing bars.  If you have established an additional character item in the database for some purpose 
(with  Additem  on the Files pulldown from the General bar), you can reset it as the points item that 
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ALACARTE will use in tagging and selecting.  Pick  set points item  (on the Database pulldown from 
the Points bar), which causes the report:

Current points item is PTTYPE.  Select a new character item.

and opens a menu of available character items in the points database of the current edit map from 
which you can pick an alternative to PTTYPE.  ALACARTE will report the new points item, which 
will be maintained throughout the various points bars until you change it or start a new work session.

PREPARE A POINTS LAYER

Start a Points map from the Setup bar as a new map or a layer for an existing map by picking  sample 
localities  from the appropriate pulldown (see Start a New Map or Layer, p. 93).  Use this menu item 
regardless of whether the intended points will actually be sample localities or some other kind of point. 
ALACARTE will prepare the map for points and add items (database fields) called PTTYPE and 
SAMPNO, which are addressed automatically in some of the ALACARTE points functions.  You will 
probably want to include the save items SYMB and SEL as well.  If you will need additional database 
items, add them from the General bar:  add item  on the Files pulldown (see Database Items, p. 55). 

 
DIGITIZE POINTS

Digitizing points can be as simple as setting the PTTYPE, positioning the crosshairs or digitizing 
puck, and clicking on the location.   An option is available to follow the entry of each point with a 
prompt at which to enter an identifying number or name for the point from the keyboard (generically 
called Sample Number in ALACARTE).  To begin, go to the Digitize Points bar (click  POINT  on the 
Digitize/Tag pulldown from the Points bar):

[ Dig ]  |  dig  |  Tag  |  Sel  |  ?  |  Point Tags  |  SYMB  |  Op  |  Dw  |  Zm  |  ^POINTS  |

point tag key-in
sample nbr tag
point & samp tag Custom tag menu 1

Custom tag menu 2
Custom tag menu 3

Sample nbr:
  help
  set field
  on
  off

A current point type is maintained at the bar for use in tagging points automatically as they are digi-
tized, in tagging a selected set of points, and in selecting points according to their tags (point item of 
PTTYPE, unless changed).  Pick  ?  to determine the current point type and reset it either by entering 
from the keyboard (pick  key  and enter at the prompt) or by picking from a user-prepared custom 
menu opened with  Custom tag menu 1  (or  2  or  3)  on the Point Tags pulldown (see Custom Tag 
Menus, p. 82).  There are no standard types for these simple points and no modifiers.
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The process of digitizing points is identical to that of digitizing label points for polygons.  Pick  dig  
on the bar -  a key menu is presented, preceded by a report of the current point type that will be 
assigned to the PTYPE item for the point, and followed by the prompt to enter a label (in this case 
meaning a point):

Adding points with attribute:  bedding

--------------------------Options----------------------------
1)  Add Label                   5)  Delete last label
8)  Digitizing options        9)  Quit
(Label)  User-ID: 20

Click  1  on the screen or digitizer to enter a point; the coordinates of the clickpoint will be reported 
and the point will be displayed on the screen:

(Label)  User-ID: 20  Coordinate = -3181.966,6025.430

Unique Point Identifier

The point type will probably be used to identity a class of points, such as sample localities or wells.  
Two options are available for assigning unique identifiers to the points as they are entered, the User-ID 
number and/or the Sample Number.

User-ID Number

The simplest way to assign a unique identifier is to control the User-ID number that is automatically 
assigned to each point when it is digitized.  This number, typically referred to as the $ID, is recorded 
in the [map name]-ID item in the points database (PAT).  Use the number that ARC/INFO assigns 
(posted at the prompt when you digitize), or reset that number as you wish.  ARC/INFO will start a 
new round of digitizing with a $ID number one greater than the highest number already in the data-
base, and will automatically increase the count as you digitize (this Autoincrement can be turned off 
from the Digitzing Options key menu if you wish).  The User-ID item is a numeric field, which will 
permit selection of ranges of numbers with Select For Expression on the Select menu. 

Reset the base from which the $ID number is counted from the Digitizing Options key menu.  This 
menu can only be reached from the Points bar:  pick  no attributes  on the Digitize/Tag pulldown and 
then, at the digitizing prompt, enter an  8  to obtain the Digitize Options key menu:

----------------------------------------Digitizing Options-------------------------------------
1)  New User-ID              2)  New Symbol    3)  Autoincrement  OFF
4)  Autoincrement  ON    5)  New Angle       6)  New Scale
9)  Quit
-------------------Enter Option

To reset the User-ID,  enter a  1  here, then enter the new number.  You will be placed back at the 
prompt to enter a new point with the new user ID-in place.  Even if you want to work from the Digitize 
(Points) bar, you must digitize one point here to implement the new User-ID number (you can always 
delete it later, if necessary).  The number will progressively increase from this new base as you enter 
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more points.  You can post the $ID numbers adjacent to their points on the screen to provide a means 
of checking the numbers as you proceed (see Display Point Attributes On Screen, p. 179).

Sample Number

A number or other unique identifier (any sequence of alphanumeric characters) can be recorded for 
each point at a prompt that appears after each point is entered.  This is in addition to recording the 
current point type in the PTTYPE item and is placed in a separate character field in the database. 
Controls for this option are on the Point Tags pulldown (see p. 176).  Use  set field  to change the 
database item in which the identifier will be recorded from the default of SAMPNO to any other 
character field that is available.  Include the Sample Number prompt in the digitizing sequence  with  
on  and remove it with  off.  After each point that you enter with the prompt turned on, you will be 
asked to:

enter a sample number on keyboard: 

Do so and upon your <Return>) the prompt to digitize another point will appear.  You can post these 
entries with the points on the screen to provide  a means of checking them as you proceed (see Display 
Point Attributes On Screen, p. 179).

Changing Points Attributes

The point tag and/or the sample number can be reassigned or changed from the Tag pulldown (see p. 
176).  Use  point tag  to assign the current point type to the selected set.  Use  sample nbr tag  to obtain 
the sample number prompt from which to enter a different sample number.  (The function  point & 
samp tag  to do both steps together is not implemented in version 1.0; use the separate items instead.) 
 If more than one point is selected, the retagging will be done on the whole set together, but the sample 
number prompt will cycle through the set, one point at a time. 

When you pick  sample nbr tag  with a set of four points selected, for example, a report will indicate

Tagging 4 points with individual sample number
1 element (s) now selected -  selected the first point in the set.

Existing sample number for point 1 of selected set
  (ID = 22) is:  444 -  reports the current entry in SAMPNO.

Enter new sample number on keyboard or
   <Return> = No Change,  Q to Quit:  1 -  1 entered as new sample number.

Point 1 of 4 tagged with SAMPLE NUMBER:  1 -  reports change in sample number.

The routine cycles through the whole selected set in this fashion, and then asks

Reset selected set,  <Return> = yes?

Hit <Return> to have ALACARTE reestablish the original selected set before returning control to the 
bar, or enter n(o) to leave only the last point in the list selected. 
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Display Point Attributes On Screen

You can display on screen next to the point symbol any of the attributes associated with the point as 
you digitize, tag, or draw.  This is useful at relatively large draw scales, but will illegibly clutter the 
screen at small scales.  Go out to the Arcedit prompt (pick  give one ARC/EDIT command  from the 
Commands menu) and enter:

Arcedit:   textitem  label  [item name]

where  item name  is the item (database field) in which the attribute is located (PTTYPE, $ID, SAMP-
NO, or others).  Then, each time you digitize or tag a label, the attribute will be displayed next to the 
point.  The attribute will be displayed for all existing points whenever you draw or zoom, although the 
text does not scale with zoom and it cannot be manipulated as annotation.  

Turn off the display of attributes by going out to the Arcedit prompt and entering:

Arcedit:   textitem  label  none

Oriented Symbols and Data 

Oriented symbols are used on geologic maps to represent such information as bedding attitudes, lin-
eations, and strike-slip arrows on a fault.  In an ALACARTE map, the type of feature and orientation 
information are recorded in the database and the symbols representing that data are posted on the map 
in the proper orientation at the time of plotting or on-screen display.  The data are associated with a 
specific location in the map and database and are posted at that point. Such data are recorded by 
ALACARTE as points with associated attributes in a map layer devoted to structural information.  
Different kinds of orientation data are distinguished by different primary tags (PTTYPE) assigned to 
the points, with the strike or bearing stored in the STRIKE item and the dip or plunge in DIP.

Oriented point data are typically entered by hand from the digitizer or on screen with the strikes (or 
bearings) specified graphically or from the keyboard and the dips (or plunges) entered from the 
keyboard.  Data in tabular files can be imported and associated with existing points or, if x,y locations 
are included, can be used to generate a map automatically.  Scans can be useful as backgrounds from 
which to trace orientations on screen.  

The basic Points bar is described in Points and Point Data (p. 175).  Work with all orientation data 
from the appropriate digitize bar - the Planar bar for features such as bedding and joints, the Linear bar 
for features such as lineations and the axes of minor folds, or the Map Symbols bar for features such 
as strike-slip arrows on a fault (the Map Symbols bar is not implemented in version 1.0 of 
ALACARTE). 

PREPARE A STRUCTURE LAYER

Start a structure layer from the Setup bar as a new map or a layer for an existing map by picking  
geologic structures  from the appropriate pulldown menu (see Start a New Map or Layer, p. 93).  
ALACARTE will prepare the map for points and attributed lines (such as fold axes or structural con-
tours) with the items LTYPE, PTTYPE, STRIKE, and DIP in the appropriate attribute tables.  You 
will probably want to include the save items SYMB and SEL for both lines and points as well.  
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PLANAR AND LINEAR ELEMENTS

Although different bars are used because of the different point types and digitizing routines, the pro-
cedures related to planar and linear features are essentially the same and data for planar and linear 
elements are normally stored in the same structure layer.  Start by specifying the markerset to be used 
for posting symbols, and set the point type, which identifies the kind of structural feature (bedding, 
vertical joint, minor anticline).  For each graphic entry, click the ends of the strike line or lineation on 
the screen or digitizer and enter the dip or plunge from the keyboard.  ALACARTE calculates the 
azimuth and records it in the STRIKE item, places the point at the midpoint of the strike line or the 
origin of the lineation, records the dip or plunge value in the DIP item, and posts the value as annota-
tion an appropriate distance from the end of the symbol as a function of map scale.  (Keyboard entry 
of direction, either by azimuth or by quadrant, is not supported in version 1.0 of ALACARTE.)

To begin, go to the appropriate bar from the Digitize/Tag pulldown from the Points bar by picking  
PLANAR  for planar structural elements and  LINEAR  for linear structural elements; the only difference 
in the appearance of the bars will be the bar name:

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |
[ Linear ]       "          "          "      "           "             "         "       "         "            "   

ALACARTE will automatically select the existing points in the layer, assign symbols from the 
standard map-scale symbol set, and draw the map.

SET THE SYMBOL ENVIRONMENT

Before you work with oriented structural symbols on the screen, you will probably need to define 
some of the settings that control the method of entering data and the way that symbols are selected and 
drawn on the screen.  In particular, this involves changing to the lookup table for double-sized symbols 
if desired, and setting the draw scale to permit you to read symbols and dip or plunge values in pro-
portion to the other map features.  The draw scale is important because, although the spatial relations 
of map elements and the dip and plunge numbers all scale when you zoom in or out, the size of the 
structural symbols themselves does not.

Most of these factors are set from the Set Symbols pulldown, which is identical for both planar and 
linear features (except for dip/plunge):

draw first time w/ current
show current settings

Choose markerset
Choose lookup table
Select db items

set dip numeral height
or   "  plunge   "         "

set attitude entry format
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Set the Symbols

Check the Settings - List the current settings for symbols by picking  show current settings.  

Markerset - The standard structural symbols that are drawn on the screen in ALACARTE are con-
tained in a markerset called ALCGEOL.ALC, which is located in the ARC Symbols directory.  This is 
specified automatically by ALACARTE, but can be changed for specialized work.  To specify a 
markerset, pick  Choose markerset,  list the options from the Symbols directory or the local directory  
(?  or middle mouseclick in the blank), and pick one. 

Lookup Table - Two standard lookup tables for structural symbols were attached to the structure layer 
when you started it from the Setup bar.  One of these, called [map name].LUT, assigns symbols of a size 
appropriate for geologic maps and is automatically selected by ALACARTE.  The other ([map 
name].LUT2X), assigns symbols twice as large.  Because these symbols do not change size as you zoom 
in and out on the map, you will want to select the proper lookup table for your on-screen work.  For 
most digitizing and editing, you will probably want to use the double-size symbols (the 2X lookup 
table).  To specify a lookup table, pick  Choose lookup table, list the options (?  or middle mouseclick 
in the blank), and pick one. 

Size of Numbers - The dip and plunge numbers are placed as annotation in the structural layer with a 
default height of 0.05 inches on the map.  The height is actually specified in map units (meters on the 
ground) by automatically converting as a function of recorded map scale.  Change from this default 
height by picking  set dip numeral height  and entering a height in map units from the keyboard.  This 
height will apply only to dip or plunge values entered while it is in effect.  The height of existing 
numbers was established when they were entered.  Change that from the Change Annotation bar with 
annosize(S)  after selecting the numbers (see Edit Annotation, p. 190). 

Set the Draw Scale 

The structural symbols have a fixed size on the screen, regardless of the scale at which you draw the 
map, whereas the dip and plunge values and the spatial relations of map elements rescale as you zoom 
in and out.  If you want to see the symbols, numbers, and other map elements in the same proportion 
as on a plot at map scale, you will want to establish the appropriate draw scale.  Use  draw to scale  on 
the Zoom menu, and specify a scale chosen to match the lookup table (1X or 2X map scale) and the 
relation of your graphic screen to the standard screen width of 9.25 inches used by ALACARTE:

draw scale  =  (map scale or map scale / 2)  X  (width of your screen / 9.25)

To retain this scale on the screen, avoid using Zoombox and keep track of any temporary scale changes 
imposed with Zoomin and Zoomout, or rescale the display after changing scale or location.

Change Database Items

The default items in the database that are used to record the point type, strike or bearing, and dip or 
plunge can be changed from the default settings (PTTYPE, STRIKE, and DIP) for specialized work.  
Pick  Select db items,  then list the available character fields  (?  or middle mouseclick in the blank) 
and choose an item for each data type.
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Set the Entry Format

Three different methods of entering strike or bearing are offered on the Entry Methods menu:  Quad-
rant, Azimuth (left hand), and Digitize (the only entry format available in version 1.0 of ALACARTE 
is Digitize).  Change from the default Digitize method by picking  set attitude entry format  and then 
picking the desired method from the popup menu:

Quadrant - digitize the location of the data point on screen or from the digitizer and then enter both 
strike and dip (or bearing and plunge) from the keyboard, with the direction in quadrant format (such 
as N30E45SE). (Not included in Version 1.0.)

Azimuth - digitize the location of the data point on screen or from the digitizer and then enter both 
strike and dip (or bearing and plunge) from the keyboard, with the direction in azimuth format.  For 
planar features the down-dip direction will be the left hand side of a viewer looking along the azimuth 
direction (180° dips E, 360° dips W).  (Not included in Version 1.0.)

Digitize - Digitize the direction and location concurrently by clicking on each end of the strike or 
bearing line, then enter the dip or plunge from keyboard.  For planar features, the location will be the 
calculated midpoint of the line specified, the azimuth will be the direction from the second toward the 
first clickpoint, and the dip direction will be to the right hand side of the azimuth.  For linear features, 
the origin will be the first clickpoint and the azimuth from the first toward the second clickpoint.

SET THE POINT TYPE

Specify the kind of structural feature that a point represents with the PTTYPE, in which ALACARTE 
records the current point type when a point is digitized.  A current point type is maintained at the 
Planar and Linear bars.  Set this by picking from the standard types listed in the Point Tags menus 
(open with  Pt Tags  on the bar):

Planar Features: Linear Features:

bedding lineations:
approx bedding    inclined
ot bedding    "  at attitude
bedding w/ tops   horizontal
ot bedding w/ tops    vertical
flat bedding
vert bedding slickenside:
vert bedding w/ tops    inclined, normal
crumpled bedding    inclined, reverse
foliation    inclined, unknown
foliation and bedding bd-clvg inters. lin.
vert foliation and bedding
horz foliation minor anticline
inclined cleavage minor syncline
inclined cleavage w/ tops minor f.a., inclined
joint minor f.a., horiz.
horz joint
vert joint paleocurrent
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joint unmineralized dip of fault sfc
air photo attitude

key-in key-in

Custom tag menu 1 Custom tag menu 1
Custom tag menu 2 Custom tag menu 2
Custom tag menu 3 Custom tag menu 3

You can also enter a point type from the keyboard (pick  key-in)  or pick from a user-defined custom 
menu (open with  Custom tag menu 1  or  2  or  3).  Note that only the standard types on the Point Tags 
menus will correlate properly with the standard lookup tables and markerset;  use of custom types will 
therefore require a custom markerset and lookup table.

ENTER STRUCTURAL DATA

Draw the map area on the screen at an appropriate scale and set the point type for the kind of structural 
feature to be digitized.  If you are working from a digitizer, register your source map (see Map Reg-
istration, p. 115).  Start the digitizing routine by picking  dig  on the bar.  The procedure then depends 
on the entry format that you have chosen.  Follow the instructions in the dialog area after checking the 
point type that is reported.

Graphic Entry (Digitize)

When you start the digitize routine, the point type is reported.  (Note that the raw form of linear types 
is reported, rather than that indicated on the Tag Menu.  The correlation between the two will be clear 
if you set two or three types and check the report for each by starting the digitize routine.)

You are instructed to click on one end of the strike or bearing line (click  1).  For strikes, this first click 
should be to the left of an observer looking down dip at the attitude, which is the end of the line farthest 
from an observer looking along strike with the down dip direction on the right.  For bearings, Click-
point 1 should be at the data point marked by the origin of the linear feature.  

Click on endpoint  1  of attitude template using CURSOR, or press 9 to exit

Click on origin of linear symbol using CURSOR, or press 9 to exit

The template for attitudes is an oversized strike-and-dip symbol (3-4 inches long) that you can prepare 
and use to increase the precision of strikes entered from the digitizer.  Alternatively, click on the ends 
of a drafted symbol or a scanned equivalent displayed on the screen.  Remember that ALACARTE 
will calculate the midpoint of the strike line to determine its location.

The second click (also a  1)  marks the other end of the strike or bearing line;  the second click for a 
bearing is used simply to specify direction (no length is involved):

Click on endpoint  2  of attitude template using CURSOR

Click on end of linear symbol (arrow) using CURSOR

The symbol will be drawn on the screen at the point in the specified orientation, the calculated azimuth 
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of the strike or bearing will be reported, and you will be asked to enter the dip or plunge from the 
keyboard:

strike  =  313
Enter dip value (0  to  90) on keyboard:   45
Bearing  =  82
Enter Plunge value (0  to  90) on keyboard:  45

The examples show values of 45 degrees entered.  When you <Return> after typing the value, 
ALACARTE records the data and starts the instruction sequence over again.  Enter another data point, 
or terminate the digitize routine with a  9  and return control to the menu bar.

Note that, once begun, the entry sequence cannot be interrupted.  If you make an error, carry on 
through the sequence and then correct the problem.  Do this by deleting an entry (see below) or, if the 
error is in the last point entered, by backing up with  oops.  Repeat the  oops  seven times to back up 
through one entry cycle (watch on the screen and in the dialog area to see the steps that ALACARTE 
uses to enter an oriented symbol and dip number). 

EDIT STRUCTURAL DATA

The database for oriented structural data cannot be edited with the same ease as for other kinds of map 
features.  Correcting an azimuth is not as simple as changing the recorded azimuth, because the ori-
entation of the symbol on the map is controlled by a separate angle that is calculated from the azimuth 
at the time of digitizing and is stored in an internal ARC/INFO file.  Similarly, the dip is not only 
recorded in the DIP item in the database, but is posted as annotation as well.

The recorded PTTYPE and resultant kind of symbol can be changed directly, by selecting the attitude, 
setting the point type, and picking  current point type(S)  on the Change pulldown.  The other items on 
the Change pulldown are not implemented in version 1.0 of ALACARTE.

If either the strike (bearing) or dip (plunge) of an entry must be changed, the present procedure is to 
delete the entry and reenter it.  Select the symbol as a point and delete it, then go to the Annotation bar 
and select the dip (plunge) value and delete that.   Then return to Points and redigitize with the correct 
information. 

SELECT STRUCTURAL DATA

Oriented structural entries can be selected by all the standard techniques for selecting points that are 
available on the Select popup menu and with the Select-By-Current-Point-Type items on the Select 
pulldown.  The Select pulldown also supports selection by strike (bearing) and dip (plunge) values as 
well.  Pick the appropriate menu item, click on a button to specify the kind of relation desired, and 
enter a value in the blank (gt = greater than, ge = greater than or equal, eq = equals, le = less than or 
equal, lt = less than, and ne = not equal to).

DISPLAY SYMBOLS IN BACKGROUND

The oriented symbols and dip/plunge numbers in a structure layer can be displayed in the background 
behind any map layer for reference.  This is not done in the usual way by choosing a background and 
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turning on the points (labels), but is done instead from the Symbols bar.  Go to the Symbols bar from 
any feature bar (Lines, Points,  Areas, or Annotation) by picking  SYMB:

[SYMB]  |  Lines  |  Pts  |  Areas  |  Anno  |  Dw  |  Zm  |  ^PREV  |

Points (Pts):

Oriented symbols:
  markerset
  lookup table
  draw cov in back
  draw in back off

Non-oriented:
  markerset
  reset symbols
  lookup table

The Points pulldown from this bar offers items with which to set the markerset and lookup table for 
oriented symbols (see Set the Symbol Environment, p. 180), and then to turn the background on  (draw 
cov in back)  and off  (draw in back off).  When turned on, the oriented symbols will draw in the 
background in white with every draw and zoom.
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Add and Edit Annotation

Annotation can be added to any map layer, but for geologic maps it may be better to create a separate 
map layer for unit labels and other text.  Such an annotation layer is strictly for graphic purposes, as 
database information must be assigned to valid map elements (individual lines, points, or polygon 
label points).  Annotation can be added to any map layer from the digitizer or on screen, can be gen-
erated automatically from any database entry, and existing annotation can be selected, deleted, moved, 
rotated and otherwise modified (Change bar).

  
PREPARE THE LAYER

Start an annotation layer at the New Layer pulldown from the Setup bar by making a layer into which 
you can enter annotation and leaders (pick  annotation + leaders, and call the layer something like  
[map name].an).  This layer will be prepared to receive tagged leaders and other lines as well as text. 
Then, consider adding to it the unit labels recorded by PTYPE in the polygon layer of your map (see 
Copy Annotation from Database, p. 98).  These can be placed automatically as annotation at their 
label-point locations in a specified map layer with  add unit text labels  (New Layer pulldown from the 
Setup bar). Although not directly satisfactory for graphic unit labels (too few in large and too many in 
small polygons), they will provide an excellent starting point for editing.

DIGITIZING CONTROLS

The Annotation Environment forms menu provides control on several factors involved in digitizing  
annotation:  (1) the level in which the annotation is recorded,  (2) the size and style used for the 
alphanumeric characters added to the map,  (3) the method by which the text is specified, and  (4) the 
method by which the text string is placed on the map.  This menu appears automatically when you first 
go to the Annotation bar in an edit session and can be called at any time from the Digitize bar (Anno-
environment  on the Add Options pulldown):

Annotation Environment

      Annolevel: 1
       Annosize: 0.000
  Annosymbol: 1
    Annooffset: 0.000
           Annofit: OFF ON   OFF
Annoposition: LL LL    LC    LR    CL    CC    CR    UL    UC    UR

        Annotype: POINT1 POINT1    POINT2     LINE      AUTO
       Annoitem: KEYBOARD POLY       POINT       LINE      KEYBOARD
             {item]:
          {AUTO}: OFF ON   OFF

OK   HELP   CANCEL   DEFAULT

The settings in this menu control subsequent digitizing of annotation:

Annolevel  -  ALACARTE typically uses level 1 for all annotation in a map, although any of the 10 
levels (1-10) supported by ARC/INFO for a map layer can be specified here.  Use the default 
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level of 1 for standard ALACARTE maps.  Separation of annotation into different levels permits 
independent manipulation of the separate levels, such as selective inclusion in plots or change in 
size or symbol (font, etc.).  The control of annotation by ALACARTE in the Draw and Back 
Environments turns all levels on and off together. Annotation can be selected by level (see Select 
Annotation, p. 190) and selected annotation can be assigned session symbols.  The level of 
selected annotation can be changed from the Change bar.

Annosize  -  defines the height of the alphanumeric characters that are entered.  Two modes are 
available.  Where Annosize is left at the default value of 0, characters are entered with a screen 
height of 0.1 inch, regardless of the zoom magnification of the display, and are then rescaled as 
the zoom is changed.  Text entered at different screen magnifications will therefore have dif-
ferent sizes on the map.  Specify a height in map units (numerically in the forms menu or by 
clicking on screen from  Annosize *  on the Add Options pulldown) where you want the text to 
be entered with that constant map height. The size of existing annotation can be changed from 
the Change bar.

Annosymbol  -  a positive integer that designates a suite of alphanumeric characters in the current 
textset that has a particular combination of font, color, slant, and character spacing (the default 
textset is PLOTTER.TXT, which contains 100 symbol suites;  see Appendix B, Fonts, in 
ARC/INFO Symbols of the ARC/INFO Users Guide).   Because many types of symbols draw 
slowly on the screen, it is more efficient to use the default symbol (1) for most on screen work, 
and then change to the desired symbol for final editing and plotting (and see Draw Selected 
Annotation, p. 191).  The Annosymbol of existing annotation can be changed from the Change 
bar or as part of preparing a plot file.

Annooffset  -  distance in map units by which text is offset from its associated line when placed on the 
map using Annotype  AUTO.  The default distance is 0.

Annofit  -  use  ON  when you want to place text by stretching it between two clickpoints.  This 
overrides the character spacing inherent in the Annotation symbol.  The default is  OFF.

Annoposition  -  specifies which part of an annotation string is placed at the positioning clickpoint:  
considering the text string as an elongate rectangle, the Annoposition can be at the lower left of 
the rectangle  (LL),  the lower center  (LC),  lower right  (LR),  center left  (CL),  center center  
(CC),  center right  (CR),  upper left  (UL),  upper center  (UC),  or upper right  (UR).  The default 
is lower left, which is the point from which a string of annotation is selected (regardless of the 
Annoposition setting.

Annotype  -  specifies the method by which a text string is placed on the map.  Place it horizontally 
with one click using  Point1  and at any angle by specifying an orientation with a second click 
using  Point2.  Specify a curved alignment with 3 or 4 clickpoints using  LINE,  and align it with 
an existing line in the map using  AUTO.

Annoitem  -  enter the text string from the KEYBOARD, or extract it from the database item of a speci-
fied kind of map feature (POLY, POINT, LINE) that will be selected during the Digitize routine.

item  -  the database item from which the text string will be extracted with Annoitem set to a map 
feature.
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AUTO  -  places the text automatically along the same line from which the text is extracted where 
Annotype is set to a map feature; uses the identifying clickpoint as the position point.

ENTER AND PLACE ANNOTATION 

The basic procedure used to add text to a map uses Annotype  =  Point1.  Start the Add routine (pick  
add  from the Digitize bar) and enter the text string at the prompt::

Text:  [this is an example text string]

Hit <Return> when the text has been typed and you will be instructed to:

Enter position (1)

Click once on the screen (indicated by the  1  in the prompt) to place the text on your map.  The current 
Annoposition setting will be used (default of lower left).  The text will be plotted horizontally on the 
screen (in the current Annosize and Annosymbol) and you will be prompted for another text entry.  
Close the Add routine with a <Return> at the Text: prompt.

Specify an orientation for the text line with two mouseclicks by setting the Annotype to  Point2  and 
then, at the position prompt  (Enter position (2)),  click twice on the screen to define a direction.  The 
first click positions the text and the direction to the second click defines the orientation of the text.  
Stretch the text between two such clicks by turning Annofit on as well.

Place the text along a curved line smoothed automatically between 3 or 4 clickpoints by setting the 
Annotype to Line.  The prompt then becomes:

Enter position (Up to 4, 9 to stop)

Click 3 or 4 points to define a line along which the text is to be placed (if only 3, close with a  9).  The 
actual line used will be a splined version of the angular line that you enter.  You can also make the 
Annotype Line function work like Point1 (close after one click) or like Point2 (close after two clicks), 
although Annofit will not operate here as it does with Point2. 

Place the text along an existing arc in the map by setting the Annotype to AUTO.  The position prompt 
then becomes:

Point to the arc to receive annotation
1 = Select     2 = Next     3 = Keep     9 = Quit

Use a single mouseclick to accomplish three steps at once:  to select the line used for orientation, 
specify a position, and indicate on which side of the line the text should go.  The text will be placed 
along the line with its base toward the side of the line indicated (for positive offset values).  Offset the 
text from the selected line by specifying a distance in map units for Annooffset (positive values place 
text above the line, negative below).

Create stacked lines in a single entry by separating the lines with \, as:

Text:  this is the first line and\this is the second and\this is the third.

Determine how the digitizing controls are currently set either by opening the Annotation Environment 
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menu or by picking  status - add  from the Add Options pulldown to obtain a report:

Annotation  Level   1    Symbol  1   Size  158.000
Annotation  Fit  OFF    Position  UR   Type ONE POINT
Annotation  Offset  -100.000     Item  KEYBOARD

Hit <return> when finished viewing 

 EDIT ANNOTATION

Annotation can be modified from the Change bar.  The changes can involve modifying the entries 
themselves, such as size or symbol, or manipulating a text string as a whole, such as moving or rotat-
ing it.  Before annotation can be changed, it must be selected.

Show Characteristics

Show the characteristics of individual text strings with  show(S1)  on either the Add Options pulldown 
(Digitize bar) or the Change pulldown (Change bar).  This produces a report about the selected entry:

Shows characteristics of a selected annotation string.

  Arrow1:
  Arrow2:
  Arrow3:
       Gap: -100
     Level: 1
Narrows: 0
  Nchars: 12
      Npts: 1
   Point1: 2493.932387835,21305.80971419
   Point2:
   Point3:
   Point4:
      Size: 124.8238980423
      Text: Example Text
  Status: ADDED
Symbol: 1

             OK     HELP

Select Annotation

Select individual entries using Select One or Select Many by clicking at lower left (regardless of where 
Annoposition was at the time of digitizing) or using Select Polygon to surround the lower left corner.  
Select multiple entries with Select Many or Select Polygon.  Note that all levels of annotation in a map 
are active at once, regardless of what is actually drawn on the screen.  
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Select all the annotation in a particular level with Select For Expression (Select popup), by entering 
the level at the prompt:

selection expression:   $level = [number]

Select all the entries with a particular text string using  select $text =  on the Change pulldown.  At the 
prompt, enter the text string to be used in the search:

Enter annotation string to be selected:    [text to be used in search]

All annotation entries in the map (in all levels) that precisely match the search string will be selected.

Draw Selected Annotation

Text symbol 1 is a clear type that draw quickly on the screen in white, but the standard Drawselect 
symbol of 7 uses slightly larger characters in green.  This leads to changes in apparent size when you 
select and the annotation redraws, and prevents complete removal of the green when the string redraws 
again in white.  If this poses a problem, change to another Annosymbol and set the Drawselect color 
appropriately as well.  For example, Annosymbol 9 (Drawselect symbol 11) is a simple type, but is 
smaller than 1;  Annosymbols 21, 41, 49, and 85 (and their respective Drawselect symbols 23, 43, 51, 
and 87) are similar in size to 1, but all require more than single strokes to draw them.

Modify Entries

Several of the characteristics of annotation established at the time it is digitized can be changed later 
from the Change pulldown.  Some of these changes can be applied to many entries at once, whereas 
others require working with one entry at a time.  Any changes are made in the temporary file and must 
be saved. 

Change Annolevel  -  Select the entries for which the level is to be changed, pick  annolevel(S), and 
enter the new level in the resulting forms menu.  

Change Annosize  -  Select the entries for which the size is to be changed, pick  annosize(S), and enter 
the new size in map units into the resulting forms menu.  

Change Annosymbol  -  Select the entries for which the symbol is to be changed, pick  annosymbol(S), 
and enter the new symbol number into the resulting forms menu.  

Change Text String  -  Change the selected text string(s) in one of four ways.  Pick  change(S) $text, 
to open the Change Options menu:  

Change options  -  Please select an editing method:

  APPEND       CHANGE       OVERLAY      REPLACE

   HELP     CANCEL

Pick one of the change options and provide the needed information:

APPEND   -  enter a new string to be added to the end of the existing string(s).
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CHANGE  -  change part of existing string(s) by entering the partial string to be changed, the new 
string with which the old should be replaced, and under  Globally,  indicate whether 
the replacement should  YES  apply to all repeats of the search string in each selected 
string, or  NO  apply only to the first encountered from the left.

OVERLAY  -  enter a new string that will be overlaid (characters and spaces) on the existing 
string(s), starting from the left. 

REPLACE  -  enter a new string to be substituted for the existing string(s).

Replace Text String  -   pick  replace text string  from the Change pulldown and enter a new text string 
to be substituted for the selected string(s).  This function is identical with the Replace option in the 
Change Text String function, except it cannot be canceled once started.  Remove unintended effects 
with  oops.

Manipulate Text Strings

The location, orientation, or method of placement of annotation on the map can be manipulated for 
existing text strings.

Copy and Move Text

One or more text entries can be copied or moved as a selected set using functions on the Move/Copy 
pulldown.  Select and move the text string(s) to a new position on the map with  move(S)  by clicking 
a from and to point at the prompts.  The string(s) will be moved parallel to itself in the direction and 
distance specified by the clicks.  The string(s) will remain selected.  Use  select and move  to select 
and move several string(s) in sequence by selecting (Select One) and clicking from and to points for 
each one.  Close the routine with a  9;  the last string moved will remain selected. 

Make one copy of a text string (or strings) in the same fashion, using  copy(S).  The copy will become 
the selected string(s).  Make several copies of the same string(s) with copy many(S).  A prompt for a 
from point will begin the sequence, but thereafter the from point for the next copy will be the to point 
of the last copy.  Close the sequence with a  9; the last copy made will remain selected.

Reposition Text

Reposition one selected text string according to the current Annotype setting.  Select the entry, set the 
Annotype if necessary, pick  reposition(S1)  on the Move pulldown, and then follow the instructions 
as if placing a new string.

Dragging and Rotating Text from Terminals

Individual text strings can be selected and dragged to a new position and/or rotated easily using  
smartanno(Tek)  and  position(Tek).  As implied by their names, these functions will work only from 
Tektronix terminals, which contain the needed segment memory required by the functions.  Turn 
Smartanno on and off with  smartanno(Tek)  (pick  ON  or  OFF from the resulting menu).  With 
Smartanno on, you can select and drag annotation with  move(S)  by holding the left mouse button 
down.  Similarly, drag and rotate selected annotation with  position(Tek):  drag with the left mouse 
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button and rotate in increments of the current Setangle by entering 1’s from the keyboard (see the 
Rotate pulldown; uses 5 degrees if Setangle is 0).

Rotate Text

Text strings can be rotated a specified angle around a specified rotation point on the map using func-
tions on the Rotate pulldown.  This function can be applied to a single string or to a larger selected set, 
including the whole map.

With the string(s) selected, pick  rotate(S).  You will be asked first to  Point to the pivot point,  which you 
should do with a mouseclick.  The next step depends on the current angle.  If it is 0 (the default), a 
circle will appear on the screen around the pivot point with a from radius pointing north, and you are 
instructed to  Point to the coordinate defining the angle.  Do this by clicking a to point on the circle to 
define the rotation angle (you are defining an angle, not an orientation). The text string will be rotated 
about the pivot point by the specified angle and the angle and pivot point will be reported:

1 annotation rotated 263.157 degrees around (5278.220,13217.724)

You can also specify the rotation angle from the keyboard by picking  setangle  and entering the angle 
at the prompt (positive values rotate counterclockwise).  This current angle will be used by the Rotate 
function until you change it.  Use  setangle 0  to reset it to 0.  Where you have rotated a string in the 
wrong direction, use  oops  to restore it, and reset the angle with the opposite sign with  setangle last  
(which multiplies the last angle used by -1).  Check the current angle settings by entering  status  misc 
 at the Arcedit prompt.

Plots

Making plots of digital map files is important as a means of checking the digital compilations and to 
obtain hard copy for use in revision, continued field work, display, and study and analysis.  Various 
kind of plots can be made that range from simple pen plots and page-sized line drawings to page-sized 
and large-format color plots.  High-quality color plots that rival published maps in appearance can be 
made with large-format color electrostatic plotters.

There are two distinct steps in making a plot:  (1) preparing the plot file from the digital map files, 
lookup tables, and various symbol sets, and then  (2) loading that plot file into a plotter to obtain 
output.  Version 1.0 of ALACARTE supports preparation of plot files for simple edit plots and for 
full-color maps that are in standard ALACARTE format, and the on-screen display of such plot files.  
Separate expertise will be needed, however, both in preparing the lookup tables for the color plots and 
in making hard-copy plots. 

EDIT PLOTS

Hard-copy line plots can be prepared easily to help find errors in line work, polygons, and polygon 
labels.  A plot file is first created according to your specifications and then this file is plotted (a pen 
plotter is sufficient).  Edit plots are useful to gain a first look at line work and to identify and find 
dangling nodes and pseudonodes and errors in polygon labeling that result from missing or multiple 
label points or incomplete polygon boundaries.
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To make an Edit plot file:

If you want to include polygon features, be sure that the map has been cleaned or built for polygons 
since it was last edited.  Use  describe map  (on the Map pulldown from the Edit bar) to determine this.

Open the Editplot forms menu (pick  Make edit plot  on the Plotfiles pulldown from the Plot bar menu: 

Editplot  -  create error plot of coverage

<coverage> . . . . . . . . . . . . . . . . . . . . . . . . . . . .
<plot file> . . . . . . . . . . . . . . . . . . . . . . . . . . . .
<scale denominator> 1

OK      HELP      CANCEL

Fill in the blanks in the form with the map name, a name for the plot file (such as  [map name].ep),  and 
a plot scale (called scale denominator).  This scale parameter is defined as the number of map units 
equal to 1 inch on the plot:

scale denominator = (denominator of map scale) / (inches per map unit)  

or, for a map with map units in meters (typical for ALACARTE maps)  to be plotted at 1:24,000 :

 scale denominator = (24000) / 39.37) = 609.6

A series of questions is then posed on screen, the answers to which (largely Y(es) or N(o)) specify the 
content of the plot.

Window plot?

Y  -  use to limit the plot to a specified rectangular part of the map.  Prompts will then ask for the  
 x,y coordinates of the lower left and upper right corners of the rectangle.  This is useful 
particularly to plot a map in page-sized pieces or to enlarge complex parts of the map.

N  -  the outer map boundary will be used to define the limits of the plot.

Enter legend Text:

<Return>  -  use the default text:  EDIT PLOT of  [map name].

Key-in  -  specify a text line of up to 70 characters to describe the plot.

Plot Tics?

Y  -  tics will be shown by a plus enclosed by a square, together with the Tic-ID number.
N  -  omits tics.

Plot ONLY Polygons with label errors?

Y  -  limits plot to polygons with label errors and their boundaries (shows multiple label points and 
 their User-ID numbers and marks unlabeled polygons at  their centroids with a star).  Ques-
tion sequence is terminated.

N  -  continues the questions.
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Plot arcs?

Y  -  all arcs in the map will be shown.

N  -  no arcs will be shown.

Plot arc IDs?

Y  -  places the User-ID number of each arc at its center.
N  -  no arc IDs will be shown.

Plot label points?

Y  -  the label point and its User-ID number will be plotted at the centroid of each polygon; prompt 
follows to specify the size of the plus symbol in inches. 

N  -  no label points will be shown.

Plot Node Errors?

Y  -  shows dangling nodes with squares and pseudonodes with diamonds.
N  -  nodes will not be shown.

Once the questions are answered, the plot file is automatically created and placed in the current 
directory.  Check the plot file by displaying it on screen (see Screen Plots, below).

SCREEN PLOTS

Plot files can be drawn on the screen using the Draw Plotfile menu (pick  Draw plotfile to screen  on 
the Plotfiles pulldown from the Plot bar):

Draw  -  display an ARC/INFO plot file on the screen

<plot file name>   . . . . . . . . . . . . . . . . . . . . . . .

OK    HELP    CANCEL

Enter the name of the plot file (use  ?  or middle mouseclick in blank to list, then pick).  When you pick 
the  OK  button, the plot will be drawn on the screen and it will be reported:

Plotting  [name of plot file]
Hit  <CR>  to continue:

The ALACARTE menus will not reappear until after the <Return> and thus the ALACARTE zoom 
functions are not accessible while the plot is on the screen;  use machine zoom and pan instead on 
terminals and emulators to examine the plot.
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FULL-COLOR PLOTS

A plot file for a single, full-color map can be prepared with the Standard Plot routine, once the nec-
essary parts have been prepared or determined.  These parts are:

1.  Geologic map - polygon layer, with 
lines attributed in LTYPE  (required)
polygons attributed in PTYPE  (required)
a geologic lookup table  (optional)

2.  Map units for all layers in meters  (required)
3.  Input scale to specify  (required)
4.  Structural attitudes (structural layer - optional)
5.  fold axes (can be a separate layer - optional)
6.  Base map (optional) with line symbols (color) assigned from CCA.LIN

index contours
intermediate contours
culture layer
drainage layer (hydro)

 Open the Standard Plot menu with  Make standard plot  on the Plotfiles pulldown from the Plot bar):

Makes a plot file of a geologic map constructed with Alacarte

<geologic map> . . . . . . . . . . . . . . . . . . . . . . . .
{geologic lookup table} . . . . . . . . . . . . . . . . . . . . . . . .
<scale> . . . . . . . . . . .
{keyfile} . . . . . . . . . . . . . . . . . . . . . . . .

{structural attitudes} . . . . . . . . . . . . . . . . . . . . . . . .
{fold axes} . . . . . . . . . . . . . . . . . . . . . . . .

Color Base Layer . . . . . . . . . . . . . . . . . . . . . . . .
. . . . . {index contours} . . . . . . . . . . . . . . . . . . . . . . . .
. . . . . {intermediate contours} . . . . . . . . . . . . . . . . . . . . . . . .
. . . . . {culture layer} . . . . . . . . . . . . . . . . . . . . . . . .
. . . . . {hydro} . . . . . . . . . . . . . . . . . . . . . . . .

OK   HELP   CANCEL

Enter the name of the completed polygon layer as the geologic map.  This must not have been edited 
after last being built for polygons, and the attributes must be in ALACARTE format.

Specify a lookup table in which the attribute fields are defined:
PTYPE  35  35  C
SYMBOL  3  3  I

If no lookup table is specified, the program will not attempt to color polygons.
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The program assumes that you want standard geologic symbols assigned to the lines and uses the line 
symbol set ALCWRG.LIN.  This cannot be changed.

Enter a scale denominator for the plot (no commas).

The keyfile is an optional ASCII system file that is used to produce an explanation of the map units 
down the right hand side of the plot:  The file specifies in sequence the color for filling the box (in 
shadeset CCA.SHD, which is located in the arcexe50 symbols directory) and the unit label to be placed 
in the box.  For example:

.16 (color number)

Qal (unit label)

.24
Qls

Specify the structural layer for oriented structural symbols.  This must have attributes recorded in the 
PTTYPE, STRIKE, and DIP fields.  The program uses the lookup table CCPTPL.LUT (located in the 
ALACARTE symbols directory), which is formulated for Calcomp pen color 3 (black), and uses the 
ALCGEOL.MRK structural symbol set (located in the arcexe50 symbols directory).  If no structural layer 
is specified, the program does not plot oriented symbols.

Specify the structural layer for fold axes.  Line attributes must be recorded in the LTYPE field.  The 
program uses the lookup table CCSTRUCTURE.LUT to plot anticline and syncline symbols on the fold 
axes. This entry can be the same as that for oriented symbols. 

Enter colors and layer names for the base layers.  The program uses line symbols from CCA.LIN and 
the color numbers to plot the base layers.  All are optional and any combination will work, including 
a composite base specified in any one of the blanks.

The program creates a plot file and names it by appending  .PLT to the input geologic name (plot file 
for LP.GEOL thus is named LP.GEOL.PLT).  A box is drawn around the map with a 3-inch margin in the 
x dimension and a 5-inch margin in the y dimension.  The name of the geologic map, the map scale, 
and the date and time are placed in the lower left corner of the plot.

Note that the program changes annotation in structural attitudes to symbol 21 for plotting, and then 
changes it back to symbol 1.  If the symbol in the original was not 1 to start with, it will be 1 on 
completion of the program.

SYMBOLS

Symbols are used in ARC/INFO to portray the various elements in a map to aid editing, composition, 
and interpretation, and to support cartographic output.  They are assigned to map elements as a func-
tion of the attributes stored in the database and can be flexibly applied both to on-screen displays and 
hardcopy plots.  Examples of symbols include contact- and fault-weight lines, thrust-fault symbols for 
faults, oriented dip-and-strike symbols for bedding attitudes, a light yellow shade for aluvium (Qal), 
and an appropriate font for map-face text.  Symbols are displayed during editing on screen in both the 
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edit map and background layers (ARCEDIT) and are specified  for inclusion in plot files and on-screen 
display and query in ARCPLOT.

Several standard symbol sets are provided in ARC/INFO and symbol editors are available for modi-
fying symbol sets and creating new ones.  ALACARTE adds custom symbol sets for geologic lines 
and points and implements a subset of the ARC/INFO symbolization capabilities.

Symbol Sets

The symbol sets store pattern definitions for symbols.  The four types of symbol sets correspond to the 
four principal feature types: markersets for labels (points and polygon label points), linesets for arcs, 
shadesets for area-fill of polygons, and textsets for annotation.  Some symbol sets are device-specific. 
Shadesets for pen plotters, for instance, are designed for stroked color fill, whereas shadesets for 
electrostatic plotters specify solid color fill.  Standard ARC/INFO symbol sets are stored in the ARC 
symbols directory and are accessible to all users.  Custom symbol sets can reside in map workspaces 
or can be copied to the ARC symbols directory for general use.  Some details about text sets are 
described in Annotation (p. 55).

A group of symbol sets - one each for points, lines, areas, and text - can be combined as a 
SYMBOLSET.  SYMBOLSET PLOTTER, for example, consists of PLOTTER.MRK, PLOTTER.LIN, 
PLOTTER.SHD, and PLOTTER.TXT.  The standard ARC SYMBOLSETS are:

PLOTTER  -  for 4-color pen plotters (see Appendix C, Default symbols, in the ARC/INFO Symbols Users Guide)

COLOR -  a 16-color symbolset optimized for fast hardware drawing speed

BW -  for monochrome monitors

The default symbol sets in Arcedit are PLOTTER.TXT, COLOR.LIN, and COLOR.MRK; because Arcedit 
does not manipulate polygons, it does not support shadesets (except as backgrounds, see below).  The 
default SYMBOLSET in Arcplot is PLOTTER.  ARC/INFO provides several additional special symbol 
sets (described in the ARC/INFO Symbols Users Guide, Appendix D, Special Symbols) that are de-
signed for 4-pen plotters:

MINERAL.MRK -  USGS mineral locality symbols.

MUNICIPAL.MRK -  point symbols for municipal mapping.

OILGAS.MRK -  standard oil and gas well symbols.
USGS.MRK -  subset of USGS topographic map symbols.

WATER.MRK -  subset of USGS geohydrologic point symbols.

OILGAS.LIN -  lines for subsurface structures.

CARTO.LIN -  a variety of dashed and dotted lines.

CARTO.TXT -  several styles of text.

CARTO.SHD -  useful stroked area fill patterns.
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 20  atten. fault, approx. located
 19  atten. fault, certain
 23  atten. fault, concealed
 24  atten. fault, concealed, queried
 58  atten. fault, concealed, queried_
 21  atten. fault, inferred
 22  atten. fault, inferred, queried
 57  atten. fault, inferred, queried_
 48  conglomeratic, marker
 26  contact, approx. located
 25  contact, certain
 29  contact, concealed
 30  contact, concealed, queried
 27  contact, inferred
 28  contact, inferred, queried
 61  detatchment fault, certain
 62  detatchment fault, queried
 39  dike
 38  dikelet
 31  f.a., anticline, certain
 35  f.a., anticline, concealed
 33  f.a., anticline, inferred
 34  f.a., anticline, inferred, queried
 31  f.a., syncline, certain
 35  f.a., syncline, concealed
 33  f.a., syncline, inferred
 34  f.a., syncline, inferred, queried
   2  fault, approx. located
   1  fault, certain
   5  fault, concealed
   6  fault, concealed, queried
   3  fault, inferred
   4  fault, inferred, queried
 46  glacial moraine
 47  glauconitic, marker
 60  intruded fault, certain
 42  marker bed
 63  named fault
   1  normal fault, certain
   5  normal fault, concealed
   3  normal fault, inferred
   4  normal fault, inferred, queried
 14  o.t. thrust fault, approx. located
 13  o.t. thrust fault, certain
 17  o.t. thrust fault, concealed
 56  o.t. thrust fault, concealed, quer_
 18  o.t. thrust fault, concealed, queri
 15  o.t. thrust fault, inferred
 55  o.t. thrust fault, inferred, queri_
 16  o.t. thrust fault, inferred, querie
 37  photo lineament
   1  s.s. fault, r.l., certain
   5  s.s. fault, r.l., concealed
   3  s.s. fault, r.l., inferred
   4  s.s. fault, r.l., inferred, queried
 41  sag pond
   8  thrust fault, approx. located
   7  thrust fault, certain
 11  thrust fault, concealed
 12  thrust fault, concealed, queried
 54  thrust fault, concealed, queried_
   9  thrust fault, inferred
 10  thrust fault, inferred, queried
 53  thrust fault, inferred, queried_
 40  topographic escarpment
 25  water boundary, certain

Figure 2.  Line symbols in line set ALCWRG.LIN (symbol, symbol number, and standard line type).



ALACARTE provides several additional symbol sets:

ALCWRG.LIN -  geologic lines (see fig. 2).

ALCGEOL.MRK -  oriented geologic structural symbols (see fig. 3).

CCA.SHD -  shadeset for Calcomp electrostatic plotters, hardware shades 1 through 999.

CCB.SHD -  shadeset for Calcomp electrostatic plotters, hardware shades 1000 through 1024.

CCA.LIN -  lineset for Calcomp electrostatic plotters, hardware lines 1 through 999.

CCB.LIN -  lineset for Calcomp electrostatic plotters, hardware lines 1000 through 1024.

Under normal ALACARTE installation procedures, these will be located in the ARC/INFO symbols 
directory, where they are available to all users.

Using Symbols

Simple, distinctive symbols are automatically assigned to the various kinds of map features (lines, 
points, nodes, etc.) for on-screen editing in ARCEDIT, but these can be changed as desired in one of 
three ways.  The simplest way to control symbol assignments in ALACARTE is by selecting one or 
more features and setting their symbol number to the desired symbol with  set $symbol(S)  on the 
Draw popup.  In this way, for example, you can color lines as a function of line type or editing status 
and can mark newly added label points in polygons with a distinctive symbol.

A second method involves using a lookup table to assign symbols systematically as a function of 
database attributes.  ALACARTE provides standard lookup tables in the ALACARTE symbols di-
rectory with which to assign standard geologic symbols for lines, points, and oriented structural 
symbols.  Lookup table ALCLINE.LUT assigns line symbols from lineset ALCWRG.LIN as a function of 
standard LTYPEs picked from the linetype menus (Digitize Lines bar), and PTPL.LUT assigns point  
and oriented symbols from markerset ALCGEOL.MRK as a function of PTTYPEs picked from the point 
type menus (Digitize Planar and Linear Points bars).

When a structure layer is prepared in ALACARTE from the Setup bar, two copies of PTPL.LUT are 
attached to it that will assign symbols of two different sizes (see Set the Symbol Environment, p. 180). 
These lookup tables, which are directed particularly at oriented symbols, are named [map name].LUT 
and [map name].LUT2X, where [map name] is the name of the map.

Specific assignment of custom symbols for lines, polygon labels, and non-oriented point is less auto-
mated in ALACARTE and requires use of the lookup command from the Database pulldown  (Db)  on 
the Points, Lines, and Areas bars.

Finally, map elements can be symbolized as AP (ARCPLOT) backgrounds to ARCEDIT edit maps.  
ALACARTE supports the coloring of selected polygons in the background with  color units in back-
grnd on the Options pulldown from the Digitize Areas bar.  Oriented structural symbols can be 
displayed in the background by selecting the   draw cov in back  item on the Points pulldown from the 
Symbols bar.  AP backgrounds are separate from normal ARCEDIT backgrounds (backcoverages) 
and the backenvironment.  Refer to the ARCEDIT Users Guide, Chapter 6, Drawing Coverage Fea-
tures, for more information on symbolization.
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  1  bedding

  2  ot bedding

  3  vert bedding

  4  flat bedding

  5  foliation

  6  bedding w/tops

  7  approx bedding

  8  foliation and bedding

  9  crumpled bedding

10  ot bedding w/tops

11  vert bedding w/tops

12  vert foliation and bedding

13  inclined cleavage

14  horz foliation

15  joint

16  -

17  -

18  -

19  -

20  unmineralized horz joint

21  horz joint

22  -

23  -

24  vert joint

25  -

26  -

27  -

28  -

29  -

30  -

31  inclined cleavage w/tops

32  air photo attitude

33  -

34  -

35  -

36  joint unmineralized

Figure 3.  Point symbols in marker set ALCGEOL.MRK  (symbol, symbol number, and 
standard point type). 



ARCPLOT has a rich set of commands for symbolizing and drawing features.  The simplest procedure 
draws all features with a single symbol.  A symbolset is specified, then the symbol to be used, then  a 
command that draws the features from a specified map layer.  Symbolizing features based on attributes 
requires a different drawing command that takes a lookup table as one argument.  ALACARTE im-
plements a basic plotting capability with  Make standard plot  (on the Plotfiles pulldown from the Plot 
bar).  Otherwise, the ARCPLOT command line must be used to prepare plotfiles.  Refer to Chapter 3, 
Specifying Symbols, in the ARCPLOT Users Guide for more information.

Creating and Modifying Symbolsets

Symbol sets can be modified and new symbol sets created using the ARC/INFO symbol editors.  The 
four symbol editors markeredit, lineedit, shadeedit, and textedit, are opened in ALACARTE with  
marker editor,  line editor,  shade editor,  and  text editor,  respectively (on the Symbol Editors pull-
down from the General bar).  Individual pattern elements for markers, text, and certain lines (for 
example, teeth on thrust faults) are created in ARCEDIT and grouped as fonts.  Instructions for using 
the symbol editors and creating fonts can be found in the ARC/INFO Symbols Users Guide.
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STRUCTURE AND FUNCTIONS

This section of the manual shows how the menu items in ALACARTE are organized into a hierar-
chical structure of bar menus and subordinate pulldown, popup, and forms menus and briefly 
describes the function of each menu item on the bars and pulldowns (the individual popup menus are 
described as part of the discussion of their use in ALACARTE Basics and Procedures).  The menus are 
shown much as they appear on the screen, except that pulldown menus are listed near the left margin 
under their bars rather than being aligned beneath their call symbols on the bar.  The different kinds of 
menus are described in Using the Menus (p. 59) and the application of the various ALACARTE func-
tions in working with maps is described in ALACARTE Basics and Procedures.

Although not necessary for normal use of ALACARTE, further information about the ARC/INFO 
commands employed by the various ALACARTE functions can be obtained from the ALACARTE 
Installation and System Manual and directly from the AML and MENU routines in ALACARTE, and 
description of the ARC/INFO commands themselves can be obtained from on-line ARC/INFO help 
and the ARC/INFO manuals.

ALACARTE is divided into six principal sections that support different kinds of activities with maps:

Setup  -  begin new maps and adjust imported maps to ALACARTE.
Edit  -  enter and modify digital map elements and data.
Plot  -  make plot files and on-screen and hard-copy plots.
Analysis  -  query, manipulate, and analyze maps.
Conversion  -  import, export, and convert formats and projections of maps.
General  -  various whole-map operations and housekeeping functions.

The main framework of the ALACARTE menu structure is the hierarchical series of bar menus (fig. 
4, p. 205), in which each bar supports a different set of related functions.  The six bars just below the 
Alacarte bar at the top of the menu tree represent the six principal sections of ALACARTE.  These 
higher level bars provide routes down to bars lower in the menu structure. Working-level bars offer 
standard popup menus, direct access to frequently used functions, and various pulldown and forms 
menus tailored to the  purpose of each bar.  Procedures initiated from a particular bar return the user 
to that bar, which serves as home base until it is deliberately changed.  Your choice of a bar menu from 
which to work thus determines which suite of ALACARTE functions is directly available.

Alacarte Bar Menu

The Alacarte bar menu appears automatically once the startup phase of ALACARTE is completed.  It 
serves principally as the switch place between the six major subdivisions of ALACARTE, which are 
called from the six central items on the Alacarte bar.  As on all of the bar menus, the bar name on the 
left (here, [ Alacarte ]) is used to gain access to the command lines and other system functions from the 
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Commands popup menu, and the right-most item (here, QUIT) is used to move up and out of the menu 
structure.  The Devices and Show bar menus are accessible from this and all other Commands menus.

[ Alacarte ]  |  SETUP  |  EDIT  |  PLOT  |  ANALYSIS  |  CONVERSION  |  GENERAL  |  QUIT  |

[ Alacarte ] -  name of bar menu; open commands menu.

SETUP -  go to Setup bar menu.

EDIT -  go to Edit bar menu.

PLOT -  go to Plot bar menu.

ANALYSIS -  go to Analysis bar menu.

CONVERSION -  go to Conversion bar menu.

GENERAL -  go to General bar menu.

QUIT -  close ALACARTE-ARC/INFO and return to the system prompt.

COMMANDS POPUP MENU

A Commands popup menu can be opened from any of the bar menus in ALACARTE (click on the bar 
name, at the left end of the bar) except the Devices and Show bars (which are themselves reached from 
the Commands menus).  The Commands menus provide various basic controls, particularly access to 
the Devices bar and to the command lines of the host computer and ARC/INFO.  The Commands 
menus called from within the Edit section also provide access to the Arcedit command line (see Edit 
Section, p. 210).  

[Cmds]

alacarte info -  display the information panel, which provides an update summary.

alacarte demo -  start the automated demonstration of ALACARTE-ARC/INFO.

arcshell -  start Arcshell.

 Go out to a command line and then return to current ALACARTE bar:

give one system command -  enter one command and return automatically to the current bar.

give system commands -  enter commands; enter quit or exit to return to current bar.

  list dir -  list files in current directory.

give one ARC/INFO command -  enter one command and return automatically to the current bar.

give ARC/INFO commands -  enter commands; when done, enter  quit  to return to the current bar.

 change workspace -  enter name of map directory (full pathname where not subordinate).  
 show workspace -  report the current map directory.

run my aml or menu -  run custom AML or menu program (pick from list or give pathname).

screen editor -  select a file or name a new file and start the screen editor.
page list -  select file from current directory popup and list it, page by page.

   default dialog -  limit dialog to the bottom 8 lines of the screen (terminals only).

   fullscreen dialog -  use whole screen for dialog (terminals only).

DEVICES -  go to the Devices bar menu.

SHOW -  go to the Show bar menu.

<Cancel> -  return to the current bar menu.
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205

        Figure 4.     The hierarchical framework of menus in ALACARTE.  Bar menus are
        shown in capital letters and selected pulldown menus and access to command lines
        are shown with initial capitals.  Every bar provides access to the Devices bar, to the
        system and ARC command lines and, in Edit, to the Arcedit command line as well.
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Devices Bar Menu

The Devices menu lets you reset and save device settings, increase the responsiveness of screen 
crosshairs to mouse movement (terminals only), change the content and location of messages reported 
on screen, and start and stop watch files, which record all map operations for later scrutiny.

[ DEVICES ]  |  Devices  |  Settings  |  Watch  |  ^PREV  |

[ Devices ] -  name of bar menu; no Commands menu available here.
Devices -  open the Devices pulldown menu.

Settings -  open the Settings pulldown menu.

Watch -  open the Watch pulldown menu. 
^PREV -  return to the previous bar menu.

Devices pulldown:

[ DEVICES ]  |  Devices  |  Settings  |  Watch  |  ^PREV  |

show devices -  list the current device settings.

station -  reset devices to those previously saved as a station file. 
save station -  save current device settings as a station file in current directory.

terminal -  specify a terminal type and method of picking menu items. 

display:
  set to term - set display device to match the presently specified terminal.

  other display -  specify a display device name and a display option if desired.

digitizer -  specify digitizer from popup menu (or enter from other). 
coord device -  pick method of entering map coordinates from popup menu. 

fastmouse -  make crosshairs more responsive to mouse movements (terminals only).

fastdisk -  make crosshairs more responsive to joydisk movements (terminals only). 
help " -  explain fastmouse and fastdisk functions. 

close menu -  close Devices pulldown menu and return to Devices bar menu.

Settings pulldown:

[ DEVICES ]  |  Devices  |  Settings  |  Watch  |  ^PREV  |

messages on -  all messages on and printed in dialog area (the ALACARTE default).

messages popup -  all messages on and displayed in popups (rather than in dialog area). 
messages info off -  limit messages to errors and ALACARTE prompts; printed in dialog area.

messages all off -  no messages except from operating system. 
current setting -  show current setting for messages.

echo on -  list all ALACARTE program statements as they are executed.

echo off -  program statements not listed (the ALACARTE default). 
current setting -  show current setting for echo. 

default dialog -  limit dialog to the bottom 8 lines of the screen (terminals only).

fullscreen dialog -  use whole screen for dialog (terminals only). 
set dialog lines -  specify number of dialog lines at bottom of screen (terminals only). 
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show dialog lines -  show present number of dialog lines being displayed. 
help - dialog -  describe dialog settings.

close menu -  close Settings pulldown menu and return to Devices bar menu.

Watch pulldown:

[ DEVICES ]  |  Devices  |  Settings  |  Watch  |  ^PREV  |

watch on -  start a watch file to record ARC/INFO commands as they are executed.

watch append -  start adding to an existing watch file. 
watch off -  close the running watch file.

display file -  report the name of the running watch file. 
help - watch -  describe watch file.

close menu -  close Watch pulldown menu and return to Devices bar menu.

Show Bar Menu

The functions on this bar are used largely in debugging and related work on the ALACARTE AML 
code itself.  The Help pulldown in Edit includes help for Arcedit as well as ARC/INFO commands.

[ Show ]  |  Show   |  List  |  Help  |  time  |  ^PREV  |

[ Show ] -  name of bar menu: no Commands menu available here.

Show -  open Show pulldown menu.

List -  open List pulldown menu.

Help -  open Help pulldown menu.

time -  report time and date.

^PREV -  return to the previous bar menu.

Show pulldown:

[ Show ]  |  Show   |  List  |  Help  |  time  |  ^PREV  |

show -  enter show topic at prompt.

&show -  enter &show topic at prompt.

close menu -  close Show pulldown menu and return to Show bar menu.

List pulldown:

[ Show ]  |  Show   |  List  |  Help  |  time  |  ^PREV  |

list all vars -  report values of all AML variables in ALACARTE.

list one var -  report value of a specified variable in ALACARTE.

set variable -  set the value of an ALACARTE variable.

list files -  list open user files.

trace back -  show AML program sequence from the Alacarte bar to present location.

close menu -  close List pulldown menu and return to Show bar menu.
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Help pulldown:

[ Show ]  |  Show  |  status  |  List  |  Help  |  time  |  ^PREV  |

help ARCEDIT cmds -  enter help subject at prompt or list help topics with <Return> (Edit only).

list ARCEDIT cmds -  list ARCEDIT commands page by page (only in the Edit section).

help ARC/INFO cmds -  enter help subject at prompt or list help topics with <Return>.

list ARC/INFO cmds -  list ARC/INFO commands page by page.

help AML commands -  enter name of AML directive or function at prompt for help.

list AML commands -  list AML commands page by page.

show aml usage -  enter name of AML directive or function at prompt.

close menu -  close Help pulldown menu and return to Show bar menu.

Setup Section

The Setup section supports starting a new map or or map layer or preparing an imported scan for use 
in ALACARTE.   A map that is started here will automatically be provided with the database structure 
and items (fields) required for the specified kinds of map features in ALACARTE.  A Setup file is 
created in which basic information about the map is stored, including the tolerances used by 
ALACARTE to set the snapping functions each time the map is opened.  

SETUP BAR MENU

The Setup bar provides access to suites of functions to start various kinds of new maps, to start various 
kinds of new layers from an existing map, and to carry out the several steps involved in preparing an 
imported scan for use in ALACARTE.  The Setup bar is reached from the Alacarte bar (click  SETUP).

[ Setup ]  |  New Map  |  New Layer  |  Prep scans  |  Options  |  ^ALC  |

[ Setup ] -  name of bar menu; open Commands popup menu.

New Map -  open New Map pulldown menu.

New Layer -  open New Layer pulldown menu.

Prep scans -  open Prepare Scans pulldown menu.

Options -  open Options pulldown menu.

^ALC -  return to Alacarte bar menu.

New Map pulldown:

[ Setup ]  |  New Map  |  New Layer  |  Prep scans  |  Options  |  ^ALC  |

Make new map:

faults, contacts, units -  start new map to contain faults, contacts, and units.

unit boundaries only -  start new map to contain only unit boundaries.

geologic structures -  start new map to contain oriented structural data and fold axes.

sample localities -  start new map to contain sample localities or other points.
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annotation + leaders -  start new map to contain annotation and leaders.

help -  display help for New Map menu.

Close menu -  Close New Map pulldown menu and return to Setup bar menu.

New Layer pulldown:

[ Setup ]  |  New Map  |  New Layer  |  Prep scans  |  Options  |  ^ALC  |

Make new layer:

faults, contacts, units -  start new layer to contain faults, contacts, and units.

unit boundaries only -  start new layer to contain unit boundaries.

geologic structures -  start new layer to contain oriented structural data and fold axes.

sample localities -  start new layer to contain sample localities or other points.

annotation + leaders -  start new layer to contain annotation and leaders.

create unit annotation -  create annotation from entries in a database item.

help -  display help for New Layer menu.

Close menu -  close New Layer pulldown menu and return to Setup bar menu.

Prepare Scans pulldown :

[ Setup ]  |  New Map  |  New Layer  |  Prep scans  |  Options  |  ^ALC  |    

faults, contacts, units: 

  1.  assign tics -  move digital tics to graphic registration points in scan.

  2.  transform -  convert scan to projected dimensions on the ground.

  3.  create setup file -  store tolerances, scale, etc. in a setup file for the map.

  4.  prep database -  prepare map database for desired kinds of map features.

  5.  create tagging menus -  enter items for custom menu(s) from which tag types can be set.

help -  display help for Prepare Scans menu.

Close menu -  close Prepare Scans pulldown menu and return to Setup bar menu.

Setup Options pulldown :

[ Setup ]  |  New Map  |  New Layer  |  Prep scans  |  Options  |  ^ALC  |

create map -  create a new, empty map; can copy tics from an existing map.

setup file present? -  check for the presence of a setup file for a specified map.

show or change setup -  examine setup for specified map, change as desired, and save.

copy setup file -  copy setup file from one map to another.

view projection file -  view the projection file for a specified map.

change workspace -  enter name of map directory (full pathname where not subordinate).

show workspace -  report current  map directory.

help -  display help for Setup Options menu.

Close menu -  Close Options pulldown menu and return to Setup bar menu.
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Edit Section

The Edit section supports compilation of maps, including entering digital elements into a map (lines, 
points, the identity of areas, and map-face annotation), tagging or identifying those features, editing 
(modifying) them, and entering and modifying database information.  Before the Edit menu can be 
reached from the Alacarte bar menu, a map must be chosen on which to work.  This chosen map 
becomes the edit map (foreground) for the working session and is the map layer that can be modified 
and queried.  Once in Edit, background maps can be chosen for display as underlays on the screen. 

CHOOSE MAP MENU

The Choose Map menu pops up automatically the first time in an edit session that you go to the Edit 
bar from the Alacarte bar (click  EDIT):

You must choose a map to enter the EDIT menu
help -  display help for menu.

Choose map -  pick edit map from popup list of maps in the current directory.

change to new map dir -  enter name of map directory (full pathname where not subordinate).

create new map -  make empty map layer; can copy tics and projection from existing map.

^ALC -  return to the ALACARTE bar menu.

EDIT BAR MENU

Once an edit map is chosen, the Edit bar menu appears.  This bar is the switch point between the four 
bar menus that support work with the different graphic elements of a map (lines, points, areas, and 
text annotation) and the Tics bar for work with digital registration tics:

[ Edit ]  |  Map  |  LINES  |  PTS  |  AREAS  |  ANNO  |  TICS  |  Save  |  Dw  |  Zm  |  ^ALC  |

[ Edit ] -  name of bar; open the Commands popup menu.

Map -  open Map pulldown menu.

LINES -  go to the Lines bar menu.

PTS -  go to the Points bar menu.

AREAS -  go to the Areas bar menu.

ANNO -  go to the Annotation bar menu.

TICS -  go to the Tics bar menu.

Save -  open the Save pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^ALC -  return to the Alacarte bar.

Commands popup (Edit):

The Commands popup menu available in Edit does not provide access to the ALACARTE demon-
stration or to Arcshell, but does provide access to the ARCEDIT command line and to the Audit Trail 
bar menu.  The menu can be opened from any of the bar menus in the Edit section  (click on the bar 
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name, at the left end of the bar) except the Devices, Audit Trail, and Show bars (which are themselves 
reached from the Commands menus).  The Help pulldown from the Show bar here in Edit includes 
help for Arcedit as well as ARC/INFO commands.

[Cmds]

 Go out to a command line and then return to current ALACARTE bar.

give one system command -  enter one command and return automatically to current bar.

give system commands -  enter commands; enter quit or exit to return to current bar.

  list dir -  list files in current directory.

give one ARC/INFO command -  enter one command and return automatically to the current bar.

give ARC/INFO commands -  enter commands; enter  quit  to return to current bar.

   give one ARC/EDIT command -  enter one command and return automatically to the current bar.

   give ARC/EDIT commands -  enter commands; enter  &return  to return to the current bar.

change workspace -  enter name of map directory (full pathname where not subordinate).  
show workspace -  report current map directory.

  run my aml or menu -  run custom AML or menu program (pick from list or give pathname).

screen editor -  select a file or name a new file and start the screen editor.
page list -  select file from current directory popup and list it, page by page.

   default dialog -  limit dialog to the bottom 8 lines of the screen (terminals only).

   fullscreen dialog -  use whole screen for dialog (terminals only).

DEVICES -  go to the Devices bar menu.

AUDIT TRAIL -  go to the Audit Trail bar menu.

SHOW -  go to the Show bar menu.

<Cancel> -  return to the current bar menu.

Map pulldown:

[ Edit ]  |  Map  |  LINES  |  PTS  |  AREAS  |  ANNO  |  TICS  |  Save  |  Dw  |  Zm  |  ^ALC  |

choose edit map -  choose new edit map (foreground) by picking from popup menu.

show current edit map -  report the identity of the current edit map.

show all open edit maps -  list the current edit map and any other open maps.

remove edit map(s) -  pick map to remove from popup menu of open maps.

create new map -  make empty map layer; can copy tics and projection from existing map.

choose background -  choose background layer and color from popup menus.

show current backgrnds -  list current background layer(s).

remove background -  remove one background layer by picking from popup menu.

remove all backgnds -  remove all background layers.

change workspace -  enter name of map directory (full pathname where not subordinate).

show workspace -  report the current map directory.

list dir -  list the contents of the current map directory.

register map -  register map on digitizer by specifying tic numbers and locations.

describe map -  list data about content and state of current edit map.

record mapscale -  enter map scale for edit map from popup menu and record in setup file.
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record mapunits -  enter map units (meters or inches) from popup menu and record.

show scale, units -  report scale and map units for the edit map that are recorded in setup file.

change coord device -  pick coordinate device from popup menu.

close menu -  close the Map pulldown menu and return to the Edit bar menu.

Save pulldown:

[ Edit ]  |  Map  |  LINES  |  PTS  |  AREAS  |  ANNO  |  TICS  |  Save  |  Dw  |  Zm  |  ^ALC  |

cur map(ow) -  save current edit map by overwriting the existing file.  

cur map(new) -  save current edit map as a new file; enter new file name. 

all maps (ow) -  save all open maps by overwriting existing files. 

save-select? -  set save to include current selected set of map elements (SEL item).

save-symbol? -  set save to include current symbols assigned to elements (SYMB item).

save-audit? -  set save to include audit trail.

show settings -  report save settings.

save setup -  save current settings to setup file.

use setup -  pick existing map from which to read and use setup file for current map.

close menu -  close Save pulldown menu and return to Edit bar menu.

Audit Trail Bar Menu

[ Audit trail ] | Show audit trail |  ^PREV |

[ Audit trail ] -  name of bar menu; no Commands menu available here.

Show audit trail -  open the Show Audit Trail pulldown menu.

^PREV -  return to the previous bar menu.

Audit Trail pulldown:

[ Audit trail ] | Show audit trail |  ^PREV |
brief -  list  summary of changes made to edit map.

full -  list in detail all changes made to edit map.

LINES BAR MENU

The Lines bar supports work with lines by providing access to the Digitize and Reshape bars, to the 
supporting Snap pulldown and Symbols bar, and to the Database pulldown.  It is reached from the Edit 
bar (click  LINES).

[ Lines ] | DIG |  RSH  |  Snap  |  SYMB  |  Db |  Sel |  Op  |  Dw  |  Zm  | ^EDIT |

[ Lines ] -  name of bar menu; open the Commands popup menu.

DIG -  go to the Digitize menu bar.

RSH -  go to the Reshape bar menu.

Snap -  open the Snap pulldown menu.
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SYMB -  go to the Symbols bar menu.

Db -  open the Database pulldown menu.

Sel -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^EDIT -  return to the Edit bar.

Snap Pulldown:

[ Lines ] | DIG |  RSH  |  Snap  |  SYMB  |  Db |  Sel |  Op  |  Dw  |  Zm  | ^EDIT |

show snap -  report current snap and other settings from setup file of edit map.  

set snap -  open forms menu in which to enter changes in snap and other settings. 

Database pulldown:

[ Lines ] | DIG |  RSH  |  Snap  |  SYMB  |  Db |  Sel |  Op  |  Dw  |  Zm  | ^EDIT |

database:  help -  menu name; display help about menu.

set lines item -  specify item for automatic line tagging and other ALACARTE functions.  
list unique values -  list unique values of current (or specified) lines item. 

list attributes(S) -  list attributes of selected set of lines.

list lines item attributes(S) -  list current lines item and entries in that item for selected set of lines.

items -  list items (and their definitions) in lines database of edit map (AAT).

calculate -  enter value to be placed in specified numeric item for selected lines.

moveitem -  enter character string to be placed in specified item for selected lines.

update -  change entry in specified item using ARCEDIT Update function.

change -  change entry in specified item with editor string using Change function.

lookup -  assign screen symbols from a lookup table using Lookup function.

forms -  open forms menu to view or change data entries for selected elements.

oops -  remove the effect of the last ARC/INFO action.

statistics -  make statistical queries using ARCEDIT Statistics function.

columns -  access other databases using ARCEDIT Columns function.

connect to RDBMS -  access other databases using ARCEDIT Connect function.

RELATE -  go to Relate bar to access other data tables using Relate function.

close menu -  close Database pulldown menu and return to the current bar menu. 

Options pulldown:

[ Lines ] | DIG |  RSH  |  Snap  |  SYMB  |  Db |  Sel |  Op  |  Dw  |  Zm  | ^EDIT |

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore lines deleted in the current edit session:

   last -  restore the last line that was deleted in the current session.

   all -  restore all lines that were deleted in the current session.

   for expression -  restore deleted lines according to expression typed at the prompt.

delete(S) -  delete the selected set of lines.  
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select many -  select many lines by clicking on them; close selection with 9.  

draw sel’d features -  redraw selected lines in current drawselect color (default = yellow).  

show sel’d features -  redraw selected lines and report their identities.  

draw w/ default colors -  make all faults red, all contacts light blue, and all other lines white.

auto dw sel on -  redraw lines in drawsel color (default = yellow) when selected.  

auto dw sel off -  turn auto drawselect off (default is on).

list attributes(S) -  list attributes of selected lines.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save the current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for the current edit session.

close menu -  close Options pulldown menu and return to the Lines bar.

Digitize (Lines) Bar Menu

The Digitize bar for lines supports digitizing and concurrent tagging of lines, assigning line types to 
existing lines (tagging), and selecting lines according to their line types.  The Digitize bar is reached 
from the Lines bar (click  DIG).

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

[ Dig ] -  name of the bar menu; open the Commands popup menu.

dig -  start the Digitize Lines routine and the key menu to control it.

tag -  tag the selected set of lines with the current line type.

Sel -  open the Select popup menu.

? -  report the current line type.

C -  open the Contacts pulldown menu.

F -  open the Faults pulldown menu.

A -  open the Axes pulldown menu.

O -  open the Other Lines pulldown menu.

Mod -  open the Line Type Modifier pulldown menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^LINES -  return to the Lines bar.

Select pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

help select

sel by current linetype:
   select -  select all lines tagged with the current line type.

   aselect -  add to the selected set all lines tagged with the current line type.

   reselect -  reselect from the selected set all lines tagged with the current line type.
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   unselect -  remove from the selected set all lines tagged with the current line type. 
nselect -  select all lines in the map that are not currently selected.

Sel -  open the Select popup menu.

select many -  select many lines by clicking on them; close selection with a 9.  

sel polygon -  select all features completely enclosed in a polygon clicked on screen.

sel,tag,color -  start routine to select many lines, tag with current line type, assign color.

show sel’d features -  redraw selected lines and report their identities.

close menu -  close Select pulldown menu and return to the Digitize bar.

Contacts pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

help contacts -  name of menu; display help for menu.

contact -  set current line type to  contact  with modifier  certain.

other contact -  enter a qualifier:  contact, [your qualifier]  with modifier  certain.

all cntcs, for select -  set line type to  contact  with modifier  all  for selecting all contacts. 

close menu -  close Contacts pulldown menu and return to the Digitize  bar.

Faults pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

help faults

fault -  set current line type to  fault  with modifier  certain.

normal -  set current line type to  normal fault  with modifier  certain.

attenuation -  set current line type to  attenuation fault  with modifier  certain.

thrust -  set current line type to  thrust fault  with modifier  certain.

reverse -  set current line type to  reverse fault  with modifier  certain.

strike-slip -  set current line type to  strike-slip fault  with modifier  certain.

"   dextral -  set current line type to  strike-slip fault, r.l.  with modifier  certain.

"   sinistral -  set current line type to  strike-slip fault, l.l.  with modifier  certain.

other fault -  enter a qualifier:  fault, [your qualifier]  with modifier  certain.

all flts, for select -  set line type to  fault  with modifier  all  for selecting all faults. 

close menu -  close Faults pulldown menu and return to the Digitize bar.

Axes pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

help fold axes -  name of menu; display help for menu.

fold axis -  set current line type to  f.a., fold axis  with modifier  certain.

syncline -  set current line type to  f.a., syncline  with modifier  certain.

synform -  set current line type to  f.a., synform  with modifier  certain.
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anticline -  set current line type to  f.a., anticline  with modifier  certain.

antiform -  set current line type to  f.a., antiform  with modifier  certain.

monocline -  set current line type to  f.a., monocline with modifier certain.

other fold axis -  enter a qualifier:  f.a., [your qualifier]  with modifier  certain.

all fa’s, for select -  set line type to  f.a.  with modifier  all  for selecting all contacts. 

close menu -  close the Axes pulldown menu and return to the Digitize bar menu.

Other Types pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

help other lines -  name of menu; display help for menu.

no attribute -  clear current line type; digitizing or tagging will record a blank. 

map boundary -  set current line type to  map boundary  with the modifier blank.

water boundary -  set current line type to  water boundary  with the modifier blank.

glacier bndry -  set current line type to  glacier boundary  with the modifier blank.

scratch bndry -  set current line type to  scratch boundary  with the modifier blank.

other -  enter line type from the keyboard at the prompt;  modifier will be blank.

Custom tag menu 1 -  open custom menu LINETYPES1.

Custom tag menu 2 -  open custom menu LINETYPES2.

Custom tag menu 3 -  open custom menu LINETYPES3.

close menu -  close Other Types pulldown menu and return to the Digitize bar menu.

Modifiers pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

help modifiers -  name of menu; display help for menu.

certain -  set current linetype modifier to  certain.

approx. located -  set current linetype modifier to  approx. located.

inferred -  set current linetype modifier to  inferred.

inferred ? -  set current linetype modifier to   inferred ?.

concealed -  set current linetype modifier to  concealed..

concealed ? -  set current linetype modifier to  concealed ?.

gradational -  set current linetype modifier to  gradational.
other -  enter modifier from the keyboard at the prompt.

none -  clear current modifier; digitizing or tagging will not record a modifier.

Custom tag menu 1 -  open custom menu LINEMODS1.

Custom tag menu 2 -  open custom menu LINEMODS2.

Custom tag menu 3 -  open custom menu LINEMODS3.

close menu -  close the Modifiers pulldown menu and return to the Digitize bar menu.
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Options Pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  C  |  F  |  A  |  O  |  Mod  |  Op  |  Dw  |  Zm  |  ^LINES  |

options: help -  name of menu; display help for menu.

oops -  remove the effect of the last ARC/INFO action.

Undelete(S):  Restore lines deleted in the current edit session:

   last -  restore the last line that was deleted in the current session.

   all -  restore all lines that were deleted in the current session.

   for expression -  restore deleted lines according to expression entered at the prompt.

delete(S) -  delete the selected set of lines.

select many -  select many lines by clicking on them; close selection with a  9. 

draw sel’d features -  redraw selected lines in current drawselect color (default = yellow).

show sel’d features -  make selected lines blink on screen and report their identities.

list attributes(S) -  list attributes of selected set of lines.  

distance -  report distance in map units between pairs of clicks; close with a  9.

where -  report x,y coordinates of click points; close with a  9. 

duplicate arcs ok -  permit more than one line between the same pair of nodes.  

no duplicate arcs -  deny duplicate arcs. 

flip line dir’n(S) -  reverse the recorded direction of the selected lines. 

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current session.

close menu -  close the Options pulldown menu and return to the Lines bar.

Reshape (Lines) Bar Menu

The Reshape bar supports modification of existing lines:  reshape and adjust line segments in various 
ways, connect and combine broken lines, correct scanning artifacts and delete unwanted features, re-
pair intersections, and move nodes.  The Reshape bar is reached from the Lines bar (click  RSH).

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

[ Rsh ] -  name of the bar menu; open the Commands popup menu.

C -  open the Copy/Move pulldown menu.

E -  open the Extend pulldown menu.

Rsh -  open the Reshape pulldown menu.

A -  open the Align pulldown menu.

Sp -  open the Split/Combine pulldown menu.

V -  open the Vertices pulldown menu.

N -  go to the Nodes bar menu.

sm -  select one or more lines by clicking on them; close with a  9.

sp -  select all lines completely within polygon clicked on screen; 9 to close.

Se -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^LINES -  return to the Lines bar.
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Copy/Move pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

copy: help -  display help for Copy.

copy(S) -  copy selected line set (click from and to points to place the copy).

copy many(S) -  click from and to points at prompts to place each copy; type  9  to close. 

copy parallel(S): Copy selected lines making each arc segment parallel to original segment.

   * -  click distance on screen (select only one arc).

   distance -  enter distance in map units (positive = place to right, negative = to left).
 

move:  help -  display help for Move.

move(S) -  move selected line(s) (click from and to points to place on screen).

move parallel(S): Move selected line making each arc segment parallel to original segment.

   * -  click distance on screen (select only one arc).

   distance -  enter distance in map units (positive = move to right, negative = to left).

close menu -  close the Copy/Move pulldown menu and return to the Reshape bar.

Extend pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dq  |  Zm  |  ^LINES |

extend: -  name of menu.

both ends   * -  extend ends of line(s) to intersect any other lines within clicked distance.

both ends distance -  extend ends of selected line(s) to intersect within typed distance.

from-end   * -  extend the from end of line(s) to intersect within clicked distance.

from-end  distance -  extend the from end of selected line(s) to intersect within typed distance.

to-end  * -  extend the to end of lines to intersect line(s) within clicked distance.

to-end  distance -  extend the to end of lines to intersect line(s) within typed distance.

close menu - close Extend pulldown menu and return to the Reshape bar.

Reshape pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

reshape:  help -  name of menu; display help for menu.

reshape(S1) -  click a new shape for selected line; cross that line at start and finish (9).
dash to solid -  convert a dashed or broken line to a single line segment (arc).

move in place -  activate snapping, intersecting, or similar function for selected lines.

Grain: Grain is a numeric variable used in the Spline and Densify functions.

   grain  * -  set grain value by clicking distance on screen.

   grain  distance -  set grain value by entering distance in map units.

Spline: Spline smooths or simplifies lines, depending on grain and vertex spacing:

   help -  display help for Spline.

   spline(S) -  apply spline function with current grain value to selected set of lines.

Densify: Densify adds vertices to the selected line(s) at the specified spacing.

   help -  display help for Densify.
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   densify default(S) -  add vertices at grain spacing to the selected set of lines.

   densify  *(S) -  click distance at which vertices are added to selected set of lines.

   densify distance(S) -  enter distance in map units at which vertices are added to selected set.

Generalize: Generalize simplifies lines using the weedtolerance or specified distance.

   gen default(S) -  generalize selected lines using current weedtolerance.

   gen *(S) -  click distance at which to generalize selected lines.

   gen distance(S) -  enter distance at which to generalize selected lines.

close menu -  close the Reshape pulldown and return to the Reshape bar. 

Align/Rotate pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

align/rotate:  help -  name of menu; display help for menu.

Align: Align moves vertices into a straight line between points clicked on screen

   align  *     after specifying perpendicular search distance by clicking (*) or entering 

   align  distance     (distance).  All vertices on all lines within specified distance are aligned. 

rotate(S) Rotate selected lines about a pivot point (click at prompt);  specify

setangle:     rotation angle with click on circle around pivot point or enter with

   setangle     setangle  (positive = counterclockwise);  clear current angle with

   setangle  0     setangle  0,  restore last angle entered with  setangle  last.  Uses

   setangle  last    last angle set unless that = 0, then requires angle to be clicked on screen.

Split/Combine pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

split:  help -  name of menu; display help for menu.

split(S1) -  split a selected arc into two at clickpoint; same $ID for both.

split  at  vertex(S1) -  split selected arc; click to specify vertex and enter 1 to verify; same $ID.

combine arcs(S) -  join abutting arcs (at pseudonodes); unique $ID for each resulting line.

close menu -  close the Split/Combine pulldown menu and return to the Reshape bar.

Vertices pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

vertices:  help -  name of menu; display help for menu.

add vertex(S1) -  add with click on or near selected line; can reshape line; close with  9.

delete  vertex(S1) -  click to pick vertex on selected line, delete with  4;  close with  9.

move vertex -  click to pick vertex;  confirm with  4;  click on new position;  9  to close.

draw vertex(S1)
   in red -  draw vertices of selected line in red.

   in other color -  pick color from Color popup to draw vertices of selected line.

close menu -  close the Vertices pulldown menu and return to the Reshape bar.
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Options pulldown:

[ Rsh ] |  C  |  E  |  Rsh  |  A  |  Sp  |  V  |  N  | sm | sp |  Se  |  Op  |  Dw  |  Zm  |  ^LINES |

options:  help -  name of menu; display help for menu.

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore lines deleted in the current edit session:

   last -  restore the last line that was deleted in the current session.

   all -  restore all lines that were deleted in the current session.

   for expression -  restore deleted lines according to expression entered at the prompt.

delete(S) -  delete the selected set of lines.

select many -  select one or more lines by clicking on them; close with a 9. 

draw sel’d features -  redraw selected lines in current drawselect color (default = yellow).

show sel’d features -  blink selected lines on screen and report their identities.  

list  attributes(S) -  list attributes of selected set, line by line. 

PUT -  go to the Put bar menu.

get -  incorporate all lines from specified map into edit map; snapping applies.

distance -  report distance in map units between pairs of clicks; close with a  9.

where -  report x,y coordinates of click points; close with a 9.  

flip line dir’n(S) -  reverse the recorded direction of the selected lines.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current edit session.

close menu -  close the Options pulldown menu and return to the Reshape bar.

Nodes Bar Menu

The Nodes bar supports moving nodes as a part of editing lines.  It is reached from the Reshape bar 
(click  N).

[ Nodes ] |  move  |  Snap  |  Symb  |  Op |  Dw  |  Zm  |  ^RSH  |  

[ Nodes ] -  name of bar menu; open the Commands popup menu.

move -  click to pick node,  4  to confirm, click on new location,  9  to close.

Snap -  open the snap pulldown menu to set/change nodesnap.

Symb -  open Symbols pulldown menu to set/change symbol color and size.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^RSH -  return to the Reshape bar.

Snap pulldown:

[ Nodes ] |  move  |  Snap  |  Symb  |  Op  |  Dw  |  Zm  |  ^RSH  |

nodesnap:  help -  name of menu; display help for menu.

nodesnap first * -  set nodesnap to first listed; click snap distance on screen. 

nodesnap first distance -  set nodesnap to first listed; enter snap distance in map units.
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nodesnap closest * -  set nodesnap to closest on map; click snap distance on screen.

nodesnap closest distance-  set nodesnap to closest on map; enter snap distance in map units.

close menu  -  close the Snap pulldown menu and return to the Nodes bar.

Symbols pulldown:

[ Nodes ] |  move  |  Snap  |  Symb  |  Op |  Dw  |  Zm  |  ^RSH  |  

Nodecolor: Set the color of the node symbols from the Colors popup.

   show -  report the current color settings (color number).

   node -  set color of node symbol.

   dangle -  set color of dangle symbol.

   pseudo -  set color of pseudonode symbol.

Nodesize: Set the size of the node symbols (enter at the prompt, in inches on screen).

   show -  report the current size settings.

   node -  set size of node symbol.

   dangle -  set size of dangle symbol.

   pseudo -  set size of pseudonode symbol.

close menu -  close the Symbols pulldown menu and return to the Nodes bar.

Options pulldown:

[ Nodes ] |  move  |  Snap  |  Symb  |  Op  |  Dw  |  Zm  |  ^RSH  |

options:  help -  name of menu; display help for menu.

oops -  remove the effect of the last ARC/INFO action.

distance -  report distance in map units between pairs of clicks; close with a  9.

where -  report x,y coordinates of click points; close with a  9.

Change coord device -  pick coordinate devince from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

close menu   -  close the Options pulldown menu and return to the Nodes bar.     

SYMBOLS BAR MENU

The Symbols bar menu provides a place to change the current symbol sets and assignments for the 
current feature type and edit map and a means of displaying oriented symbols in the background.

[ SYMB ]  |   Symbolset  |  Lines  |  Pts  |  Areas  |  Anno  |  DW  |  Zm  |  ^PREV  |

[ SYMB ] -  name of the bar menu; open the Commands popup menu.

Symbolset -  open the Symbolset pulldown menu.

Lines -  open the Lines Symbols pulldown menu.

Pts -  open the Points Symbols pulldown menu.

Areas -  open the Areas Symbols pulldown menu.

Anno -  open the Annotation pulldown menu.

Dw -  open the Draw popup menu.
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Zm -  open the Zoom popup menu.

^PREV -  return to the home bar from which the Symbols bar was reached.  

Symbolset pulldown:

[ SYMB ]  |   Symbolset  |  Lines  |  Pts  |  Areas  |  Anno  |  DW  |  Zm  |  ^PREV  |

show current -  list the current markerset, lineset, and textset.

symbolset -  specify a markerset, lineset, and textset together with a SYMBOLSET.

close menu -  close the Symbolset pulldown and return to the Symbols bar menu.

 
Lines Symbols pulldown:

[ SYMB ]  |  Symbolset  |   Lines  |  Pts  |  Areas  |  Anno  |  DW  |  Zm  |  ^PREV  |

lineset -  specify a lineset.

close menu -  close the Lines Symbols pulldown and return to the Symbols bar menu.

 
Points Symbols pulldown:

[ SYMB ]  |  Symbolset  |   Lines  |  Pts  |  Areas  |  Anno  |  DW  |  Zm  |  ^PREV  |

Oriented symbols:
  markerset -  specify a markerset for oriented symbols by picking from list.

  lookup table -  specify a lookup table for oriented symbols by picking from list.

  draw cov in back -  specify a map layer to draw in background using oriented symbols.

  draw in back off -  turn off the drawing of oriented symbols in the background.

Non-oriented:
  markerset -  specify a markerset for points by picking from list opened from menu.

  reset symbols -  reassign symbol 1 of current markerset to all points in edit map.

  lookup table -  specify a lookup table for points by picking from list opened from menu.
  

close menu -  close the Points Symbols pulldown and return to the Symbols bar menu.

 
Areas Symbols pulldown:

[ SYMB ]  |  Symbolset  |   Lines  |  Pts  |  Areas  |  Anno  |  DW  |  Zm  |  ^PREV  |

markerset -  specify a markerset for label points.

close menu -  close the Areas Symbols pulldown menu and return to the Symbols bar.

 
Annotation Symbols pulldown:

[ SYMB ]  |   Lines  |  Pts  |  Areas  |  Anno  |  DW  |  Zm  |  ^PREV  |

textset -  specify a textset for annotation.

close menu -  close the Annotation Symbols pulldown and return to Symbols bar menu.
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RELATE BAR MENU

The Relate menu provides functions with which to relate or associate other database tables with the 
feature attribute table (AAT or PAT) of a specified map.

[ Relate ]  |  add  |  list  |  drop  |  save  |  restore  |  help  |  ^PREV  |

[ Relate ] -  name of bar menu; open commands menu.

add -  add related table to existing relate environment.

list -  list tables in the existing relate environment.

drop -  remove a related table from the existing relate environment.

save -  save the set of current relates to an INFO file.

restore -  restore a set of relates from an INFO file.

help -  display help for the Relate command.

^PREV -  return to the previous bar menu.

PUT BAR MENU

The Put bar supports selecting map elements from the current edit map and placing copies of these 
elements into another, specified map.  The Put bar is identical for lines, points, and areas and is 
reached from the  Options pulldowns from the Reshape or Move bars (click  PUT).  The receiving map 
can be created from the edit map or chosen from a popup list of the map directory.  Attributes are 
transferred with the selected elements only if the databases for the feature type are identical in the 
source and receiving layers. 

[ PUT ] | so | sm | sp | aso | asm | asp | Sel | put | Op | Dw | Zm | ^PREV |

[ Put ] -  name of menu; open the Commands popup menu.

so -  select one map element by clicking on it; automatic return to current bar.

sm -  select one or more elements by clicking on them; close with a 9.

sp -  selects all elements completely enclosed in a polygon clicked on screen.

aso -  add one element to selected set by clicking; automatic return.

asm -  add multiple elements to selected set by clicking; close with a 9.

asp -  add to selected set all elements enclosed by clicked polygon;  9 to close.

Sel -  open the Select popup menu.

put -  put a copy of the selected set of map elements into a specified map layer.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^PREV -  return to the home bar from which the Put bar was reached.

Options pulldown:

[ PUT ] | so | sm | sp | aso | asm | asp | Sel | put | Op | Dw | Zm | ^PREV |

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore elements deleted in the current edit session:

   last -  restore the last element that was deleted in the current session.
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   all -  restore all elements that were deleted in the current session.

   for expression -  restore deleted elements according to expression typed at the prompt.

delete(S) -  delete the selected set.

select many -  select many elements by clicking on them; close with a  9. 

draw map -  redraw the currently defined map area.

draw sell’d features -  redraw selected elements in current drawselect color (default = yellow).

show sel’d features -  redraw selected elements and reports their identities.  

list attributes(S) -  list attributes of selected set.  

distance -  report distance in map units between pairs of clicks; close with a  9. 

where -  report x,y coordinates of click points; close with a  9.    

change coord device -  pick coordinate device from puopup menu.

save(OW) -  save the edit map by overwriting the existing file.

close menu - close the Options pulldown menu and return to the Put bar. 

POINTS BAR MENU

The Points bar supports work with various kinds of points, including attitudes, lineations, sample lo-
calities and any other data assigned to points on a map (except the label points that are used to identify 
polygons, which are treated under Areas).  The Points bar is reached from the Edit bar (click  PTS)  and 
provides access to the Database pulldown and to separate bars to digitize, tag, or change points, planar 
features, linear features, and map symbols, and to a bar to move and copy points.

[ Points ]  |  Dig/tag  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

[ Points ] -  name of the bar menu; open the Commands popup menu.

Dig/tag -  open the Digitize/Tag pulldown menu.

MOVE -  go to the Move bar menu.

SYMB  -  go to the Symbols bar menu.

Db -  open the Database pulldown menu.

Sel -  open the Select popup menu.

Op  -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^EDIT  -  return to the Edit bar menu.

Digitize/Tag pulldown:

[ Points ]  |  Dig/tag  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

POINT -  go to the Digitize bar menu for point features.

PLANAR -  go to the Planar bar menu to work with planar features.

LINEAR -  go to Linear bar menu to work with linear features.

MAP SYMBOLS  -  not implemented in Version 1.0 of ALACARTE.

no attribute -  start digitize routine for points with no attributes.

help  -  display help for the Digitize/tag pulldown menu.

close menu -  close the Digitize/tag pyulldown menu and return to the Points bar.
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Database pulldown:

[ Points ]  |  Dig/tag  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

database:  help -  name of menu; display help for Database menu.

set points item -  specify item for automatic tagging and other ALACARTE functions.  

list unique values -  list unique values of current (or specified) points item. 

list attributes(S) -  list attributes of selected set of points.

items -  list items (and their definitions) in points database of edit map (PAT).

calculate -  enter value to be placed in specified numeric item for selected points.

moveitem -  enter character string to be placed in specified item for selected points.

update -  change entry in specified item using ARCEDIT Update function.

change -  change entry in specified item with editor string using Change function.

lookup -  assign screen symbols from a lookup table using Lookup function.

forms -  open forms menu to view or change data entries for selected points.

oops -  remove the effect of the last ARC/INFO action.

statistics -  make statistical queries using ARCEDIT Statistics function.

columns -  access other databases using ARCEDIT Columns function.

connect to RDBMS -  access other databases using ARCEDIT Connect function.

RELATE -  go to Relate bar to access other data tables using Relate function.

close menu -  close Database pulldown menu and return to the Edit bar menu. 

Options pulldown:

[ Points ]  |  Dig/tag  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points in current drawselect symbol.  

show sel’d features -  redraw selected points and reports their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current edit session.

close menu -  close the Options pulldown menu and return to the Edit bar.
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Digitize (Points) Bar Menu

The Digitize bar for points supports digitizing points and concurrent tagging and assigning of sample 
numbers (if desired), assigning point types to existing points (tagging), and selecting points according 
to point type or sample number.  The Digitize bar is reached from the Points bar (Click  POINT  on the 
Dig/tag pulldown).

[ Dig ]  |  dig  |  Tag  |  Sel  |  ?  |  Point Tags  |  Op  |  Dw  |  Zm  |  ^POINTS  |

[ Dig ] -  name of the bar menu; open the Command popup menu.

dig -  digitize points (and assign sample numbers if included).

Tag  -  open the Tag Points pulldown menu.

Sel -  open the Select pulldown menu.

? -  report the current point type.

Point Tags -  open the Point Tags pulldown menu.

Op  -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^POINTS  -  return to the Points bar menu.

Tag Pulldown:

[ Dig ]  |  dig  |  Tag  |  Sel  |  ?  |  Point Tags  |  Op  |  Dw  |  Zm  |  ^POINTS  |

point tag -  tag selected set with current point type.

sample nbr tag -  enter new sample number(s) for selected set of points (one by one).

point & samp tag -  not installed in Version 1.0 of ALACARTE.

close menu -  close the Tag pulldown menu and return to the Digitize bar.

Select Pulldown:

[ Dig ]  |  dig  |  Tag  |  Sel  |  ?  |  Point Tags  |  Op  |  Dw  |  Zm  |  ^POINTS  |

help select -  menu name; display help for menu.

sel by current point type:
   select -  select all points tagged with the current point type.

   aselect -  add to the selected set all points tagged with the current point type.

   reselect -  reselect from the selected set all points tagged with the current point type.

   unselect -  remove from the selected set all points tagged with the current point type. 
nselect -  select all points in the map that are not currently selected.

Sel -  open the Select popup menu.

select many -  select many points by clicking on them; close selection with a 9.  

show sel’d features -  redraw selected points and report their identities.

close menu -  close the Select pulldown menu and return to the Points bar.
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Point Tags Pulldown:

[ Dig ]  |  dig  |  Tag  |  Sel  |  ?  |  Point Tags  |  Op  |  Dw  |  Zm  |  ^POINTS  |

key-in -  enter point type from the keyboard at the prompt.

Custom tag menu 1 -  open custom menu POINTS1.

Custom tag menu 2 -  open custom menu POINTS2.

Custom tag menu 3 -  open custom menu POINTS3.

Sample nbr:
  help -  display help for Sample Number.

  set field -  pick database item (field) for sample number (default=SAMPNO).

  on -  include prompt to enter sample number in digitize routine (default=off).

  off -  turn prompt off for sample number in digitize routine (default).

close menu -  close Point Tags pulldown menu and return to the Digitize bar.

Options pulldown:

[ Dig ]  |  dig  |  Tag  |  Sel  |  ?  |  Point Tags  |  Symb  |  Op  |  Dw  |  Zm  |  ^POINTS  |

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points with current drawselect symbol.  

show sel’d features -  redraw selected points and report their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current session.

close menu -  close Options pulldown menu and return to the Edit bar.

Digitize Planar Features (Points) Bar Menu

The Digitize bar for planar features supports digitizing attitudes, joints, foliations, and other planar 
features, changing data entries for these elements, and selecting planar features according to type, 
strike, and/or dip.  The Planar bar is reached from the Points bar (click  PLANAR  on the Dig/tag 
pulldown).

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

[ Planar ] -  name of the bar menu; open the Command popup menu.
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dig -  enter planar features according to current entry format (default=Digitize).

Chg -  open the Change pulldown menu.

Sel -  open the Select pulldown menu.

? -  report the current point type.

Pt Tags -  open the Point Tags pulldown menu.

Set -  open the Set Symbols pulldown menu.

Op  -  open the Options pulldown menu.

Dw -  open the Draw popup menu (assignment of symbols not available).

Zm -  open the Zoom popup menu.

^PTS  -  return to the Points bar menu.

Change pulldown:

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

current point type(S) -  tag selected set with current point type.

strike & dip(S) -  not installed in Version 1.0 of ALACARTE.

strike only(S)  -  not installed in Version 1.0 of ALACARTE.

dip only(S) -  not installed in Version 1.0 of ALACARTE.

close menu -  close Change pulldown menu and return to Planar Features bar.

Select pulldown:

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

sel by current point type:
   select -  select all points tagged with the current point type.

   aselect -  add to the selected set all points tagged with the current point type.

   reselect -  reselect from the selected set all points tagged with the current point type.

   unselect -  remove from the selected set all points tagged with the current point type. 
   nselect -  select all points in the map that are not currently selected.

select by strike value -  select (reselect, etc.) according to strike value(s).

select by dip value -  select (reselect, etc.) according to dip value(s).

Select -  open the Select popup menu.

select many -  select many points by clicking on them; close selection with a 9.  

show sel’d features -  redraw selected points and report their identities.

close menu -  close the Select pulldown menu and return to the Planar bar.

Point Tags pulldown:

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

bedding -  set current point type to  bedding.

approx bedding -  set current point type to  approx bedding.

ot bedding -  set current point type to  ot bedding.

bedding w/ tops -  set current point type to  bedding w/ tops.

ot bedding w/ tops -  set current point type to  ot bedding w/ tops.
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flat bedding -  set current point type to  flat bedding. 

vert bedding -  set current point type to  vert bedding.

vert bedding w/ tops -  set current point type to  vert bedding w/ tops.

crumpled bedding -  set current point type to  crumpled bedding.

foliation -  set current point type to  foliation.

foliation and bedding -  set current point type to  foliation and bedding.

vert foliation and bedding -  set current point type to  vert foliation and bedding.

horz foliation -  set current point type to  horz foliation.

inclined cleavage -  set current point type to  inclined cleavage.  

inclined cleavage w/ tops -  set current point type to  inclined cleavage w/ tops.

joint -  set current point type to  joint.
horz joint -  set current point type to  horz joint.
vert joint -  set current point type to  vert joint.
joint unmineralized -  set current point type to  joint unmineralized.

air photo attitude -  set current point type to  air photo attitude.

key-in -  enter point type from keyboard at prompt.

Custom tag menu 1 -  open custom menu ATTITUDES1.

Custom tag menu 2 -  open custom menu ATTITUDES2.

Custom tag menu 3 -  open custom menu ATTITUDES3.

close menu -  close the Point Tags pulldown menu and return to the Planar bar.

Set Symbols pulldown:

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

draw first time w/ current -  draw screen to display symbols from current markerset and lookup table.

show current settings -  report current settings for items, entry method, and symbols.

Choose markerset -  pick markerset for oriented point symbols (default = ALCGEOL.MRK).

Choose lookup table -  pick lookup table to relate point types to markerset (default=[mapname].LUT).

Select db items -  change database items for point tag, strike, and/or dip from defaults. 

set dip numeral height -  change size of type (in map units) from .05 inches at recorded map scale.

set attitude entry format -  Digitize (=default) (Quadrant and Azimuth not installed in Version 1.0).  

close menu -  close the Set Symbols pulldown menu and return to the Points bar.

Options pulldown:

[ Planar ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  
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select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points with current drawselect symbol.  

show sel’d features -  redraw selected points and report their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current session.

close menu -  close Options pulldown menu and return to the Planar bar.

Digitize Linear Features (Points) Bar Menu

The Digitize bar for linear features supports digitizing lineations and other linear features, changing 
data entries for these features, and selection of linear features according to type, bearing, and/or 
plunge.  The Linear bar is reached from the Points bar (click  LINEAR  on the Dig/tag pulldown).

[ Linear ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

[ Linear ] -  name of the bar menu; open the Commands popup menu.

dig -  enter linear features according to current entry format (default=Digitize).

Chg -  open the Change pulldown menu.

Sel -  open the Select pulldown menu.

? -  report the current point type.

Pt Tags -  open the Point Tags pulldown menu.

Set -  open the Set Symbols pulldown menu.

Op  -  open the Options pulldown menu.

Dw -  open the Draw popup menu (assignment of symbols not available).

Zm -  open the Zoom popup menu.

^PTS  -  return to the Points bar menu.

Change pulldown:

[ Linear ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

current point type(S) -  tag selected set with current point type.

bearing & plunge(S) -  not installed in Version 1.0.

bearing only(S)  -  not installed in Version 1.0.

plunge only(S) -  not installed in Version 1.0.

close menu -  close the Change pulldown menu and return to the Linear bar.

Select pulldown 

[ Linear ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

sel by current point type:
   select -  select all points tagged with the current point type.

   aselect -  add to the selected set all points tagged with the current point type.

   reselect -  reselect from the selected set all points tagged with the current point type.
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   unselect -  remove from the selected set all points tagged with the current point type. 
   nselect -  select all points in the map that are not currently selected.

select by bearing value -  select (reselect, etc.) according to curent bearing value(s).

select by plunge value -  select (reselect, etc.) according to current plunge value(s).

Select -  open the Select popup menu.

select many -  select many points by clicking on them; close selection with a 9.  

show sel’d features -  redraw selected points and report their identities.

close menu -  close the Select pulldown menu and return to the Linear bar.

Point Tags pulldown:

[ LInear ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

lineations:
   inclined -  set current point type to  inclined lineation.

   "  at attitide -  set current point type to  inclined lineation at attitude.

   horizontal -  set current point type to  horizontal lineation.

   vertical -  set current point type to  vertical lineation.

slickenside:
   inclined, normal -  set current point type to  inclined slickenside, normal slip sense.

   inclined, reverse -  set current point type to  inclined slickenside, reverse slip sense.

   inclined, unknown -  set current point type to  inclined slickenside, unknown slip sense.

bd-clvg inters. lin. -  set current point type to  bedding-cleavage intersection lineation.

minor anticline -  set current point type to  minor anticline. 

minor syncline -  set current point type to  minor syncline.

minor f.a., inclined -  set current point type to  minor inclined fold axis.

minor f.a., horiz. -  set current point type to  minor horizontal fold axis.

paleocurrent -  set current point type to  inclined paleocurrent.
dip of fault sfc -  set current point type to  dip of fault surface.

key-in -  enter point type from keyboard at prompt.

Custom tag menu 1 -  open custom menu LINEATIONS1.

Custom tag menu 2 -  open custom menu LINEATIONS2.

Custom tag menu 3 -  open custom menu LINEATIONS3.

close menu -  close the Point Tags pulldown menu and return to the Linear bar.

Set Symbols pulldown:

[ Linear ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

draw first time w/ current -  draw screen to display symbols from current markerset and lookup table.

show current settings -  report current settings for items, entry method, and symbols.
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Choose markerset -  pick markerset for oriented point symbols (default = alcgeol.mrk).

Choose lookup table -  pick lookup table to relate point types to markerset (default=[mapname].lut).

Select db items -  change database items for point tag, bearing, and/or plunge from defaults. 

set plunge numeral height -  change size of type (in map units) from .05 inches at recorded map scale.

set attitude entry format -  Digitize (=default) (Quadrant and Azimuth not installed in Version 1.0).  

close menu -  close the Set Symbols pulldown menu and return to the Linear bar.

Options pulldown:

[ Linear ]  |  dig  |  Chg  |  Sel  |  ?  |  Pt Tags  |  Set  |  Op  |  Dw  |  Zm  |  ^PTS  |

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points with current drawselect symbol.  

show sel’d features -  redraw selected points and report their identities.  

list attributes(S) -  list attributes of selected points.

change coord device -  pick coordinate device from popup menu.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current session.

close menu -  close Options pulldown menu and return to the Edit bar.

Move (Points) Bar Menu

The Move bar for points supports moving existing points and making copies of points and their asso-
ciated data.  The Move bar is reached from the Points bar (click  MOVE). 

[ Move ]  |  move  |  Copy  |  sm  |  sp  |  Sel  |  Op  |  Dw  |  Zm  |  ^POINTS  |

[ Move ] -  name of bar menu; open Commands popup menu.  

move -  move selected point(s) (click from and to points to place on screen).  

Copy -  open Copy pulldown menu.  

sm -  redraw selected points and report their identities.  

sp -  select points within polygon clicked on screen; close with a  9.

Sel -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^POINTS -  return to the Points bar.
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Copy pulldown:

[ Move ]  |  move  |  Copy  |  sm  |  sp  |  Sel  |  Op  |  Dw  |  Zm  |  ^POINTS  |

copy:  help -  menu name; display help for Copy.

copy(S) -  copy select points set (click from and to points to place copy.

copy many(S) -  click from and to points at prompts to place each copy: close with a  9.

close menu -  close Copy pulldown menu and return to the Move bar.

Options pulldown:

[ Move ]  |  move  |  Copy  |  sm  |  sp  |  Sel  |  Op  |  Dw  |  Zm  |  ^POINTS  |

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points with current drawselect symbol.  

show sel’d features -  redraw selected points and report their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current session.

close menu -  close Options pulldown menu and return to the Edit bar.

AREAS BAR MENU

The Areas bar supports work with the label points that identify areas (polygons) by providing access 
to the Digitize and Move bars and to the Database pulldown.  The bar is reached from the Edit bar 
(click  AREAS).

[ Areas ]  |  DIG  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

[ Areas ] -  name of the bar menu; open the Commands popup menu.

MOVE -  go to the Move (Areas) bar.

SYMB  -  go to the Symbols bar menu.

Db -  open the Database pulldown menu.

Sel -  open the Select popup menu.

Op  -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^EDIT  -  return to the Edit bar menu.
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Database pulldown:

[ Areas ]  |  DIG  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

database:  help -  name of menu; display help for Database menu.

set points item -  specify item for automatic tagging and other ALACARTE functions.  

list unique values -  list unique values of current (or specified) points item. 

list attributes(S) -  list attributes of selected set of points.

items -  list items (and their definitions) in polygon database of edit map (PAT).

calculate -  enter value to be placed in specified numeric item for selected points.

moveitem -  enter character string to be placed in specified item for selected points.

update -  change entry in specified item using ARCEDIT Update function.

change -  change entry in specified item with editor string using Change function.

lookup -  assign screen symbols from a lookup table using Lookup function.

forms -  open forms menu to view or change data entries for selected points.

oops -  remove the effect of the last ARC/INFO action.

statistics -  make statistical queries using ARCEDIT Statistics function.

columns -  access other databases using ARCEDIT Columns function.

connect to RDBMS -  access other databases using ARCEDIT Connect function.

RELATE -  go to Relate bar to access other data tables using Relate function.

close menu -  close Database pulldown menu and return to the Edit bar menu. 

Options pulldown:

[ Areas ]  |  DIG  |  MOVE  |  SYMB  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points in current drawselect symbol.  

show sel’d features -  redraw selected points and reports their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current edit session..

close menu -  close the Options pulldown menu and return to the Edit bar.
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Digitize (Areas) Bar Menu

The Digitize bar for areas supports digitizing and concurrent tagging of label points for polygons, the 
assignment of area types to existing label points, and the selection of polygon label points according 
to their area types.  The Digitize bar is reached from the Areas bar (click  DIG).

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  key  |  m1  |  m2  |  m3  |  Op  |  Dw  |  Zm  |  ^AREAS  |

[ Dig ] -  name of the bar menu; open the Commands popup menu.

dig -  digitize polygon label points tagged with the current area type.

tag -  tag the selected set of label points with the current area type.

Sel  -  open the Select pulldown menu.

? -  report the curent area type.

key -  enter area type from the keyboard at the prompt.

m1 -  open custom menu AREAS1.

m2 -  open custom menu AREAS2.

m3 -  open custom menu AREAS3.

Op -  open the Options pulldown menu.

Dw  -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^AREAS -  return to the Areas bar menu.

Select pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  key  |  m1  |  m2  |  m3  |  Op  |  Dw  |  Zm  |  ^AREAS  |

help select -  menu name; display help for Select.

sel by current area type:
   select -  select all label points tagged with the current area type.

   aselect -  add to the selected set all label points tagged with the current area type.

   reselect -  reselect from the selected set all points tagged with the current area type.

   unselect -  remove from the selected set all points tagged with the current area type. 
nselect -  select all label points in the map thjat are not currently selected.

Sel -  calls the Select popup menu.

select many -  select many label points by clicking on them; close selection with a 9.  

select polygon -  select label points within polygon clicked on the screen; close with  9.

sel,tag,color -  select many points, tag with current area type, and assign color.

show sel’d features -  redraw selected label points and report their identities.

close menu -  close Select pulldown menu and return to the Digitize bar.

Options pulldown:

[ Dig ]  |  dig  |  tag  |  Sel  |  ?  |  key  |  m1  |  m2  |  m3  |  Op  |  Dw  |  Zm  |  ^AREAS  |

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.
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   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points in current drawselect color (default = yellow).  

autodig on -  start digitize routine when change ptype from key-in or custom menu.

autodig off -  turn off automatic start of digitize routine when change ptype (default).

color units in backgnd -  specify color & ptype (or untagged) to color polygons on draw and zoom.

color units:  off -  turn off the coloring of specified poygons in the background.

post attribute:  on -  post ptype (or current areas item) at label points on draw and zoom.

post attribute:  off -  turn off the automatic posting of ptype (default).

show sel’d features -  redraw selected points and repors their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current edit session.

close menu -  close Options pulldown menu and return to the Edit bar menu.

Move (Areas) Bar Menu

The Move bar for areas supports moving existing label points and making copies of label points and 

their associated data.  The Move bar is reached from the Areas bar (click  MOVE).

[ Move ]  |  move  |  Copy  |  sm  |  sp  |  Sel  |  Op  |  Dw  |  Zm  |  ^AREAS  |

[ Move ] -  name of bar menu; open Commands popup menu.  

move -  move selected point(s) (click from and to points to place on screen).  

Copy -  open Copy pulldown menu.  

sm -  redraw selected label points and report their identities.  

sp -  select label points within polygon clicked on screen; close with a  9.

Sel -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^POINTS -  return to the Points bar.

Copy pulldown:

[ Move ]  |  move  |  Copy  |  sm  |  sp  |  Sel  |  Op  |  Dw  |  Zm  |  ^POINTS  |

copy:  help -  menu name; display help for Copy.

copy(S) -  copy selected label points set (click from and to points to place copy).

copy many(S) -  click from and to points at prompts to place each copy: close with a  9.

close menu -  close Copy pulldown menu and return to the Move bar.
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Options pulldown:

[ Move ]  |  move  |  Copy  |  sm  |  sp  |  Sel  |  Op  |  Dw  |  Zm  |  ^POINTS

options: help -  name of menu; display help for menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore points deleted in the current edit session:

   last -  restore the last point that was deleted in the current session.

   all -  restore all points that were deleted in the current session.

   for expression -  restore deleted points according to expression entered at the prompt.

delete(S) -  delete the selected set of points.  

select many -  select many points by clicking on them; close selection with a 9.  

draw sel’d features -  redraw selected points with current drawselect symbol.  

show sel’d features -  redraw selected points and report their identities.  

list attributes(S) -  list attributes of selected points.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current session.

close menu -  close Options pulldown menu and return to the Edit bar.

ANNOTATION BAR MENU

The Annotation bar supports work with map-face text by providing access to the bars from which 
annotation can be added or changed.  The bar is reached from the Edit bar (click  ANNO).  The first 
time that you go to the Annotation bar in an Edit session, the Annotation Environment popup menu 
appears to report current annotation settings and offer a chance to change them, although the settings 
can also be changed from the Digitize annotation bar.

[ Anno ]  |  DIG  |  CHANGE  |  SYMB  | Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

[ Anno ] -  name of the bar menu; open the Commands popup menu.

DIG -  go to the Digitize Annotation bar menu.

CHANGE -  go to the Change Annotation bar menu.

SYMB -  go to  the Symbols bar menu.

Sel -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

EDIT -  return to the Edit bar menu.

Options pulldown:

[ Anno ]  |  DIG  |  CHANGE  |  SYMB  | Sel  |  Op  |  Dw  |  Zm  |  ^EDIT  |

options: help -  name of menu; display help for Options.

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore annotation deleted in the current edit session:
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   last -  restore the last annotation that was deleted in the current session.
   all -  restore all annotation that was deleted in the current session.
   for expression -  restore deleted annotation according to specified expression.
delete(S) -  delete the selected annotation.  

select many -  select annotation by clicking (at lower left); close selection with a  9.  

draw sel’d features -  redraw selected annotation in current drawselect color (default = green). 
show sel’d features -  redraw selected annotation and report identities.  
auto dw sel on -  draw annotation in drawsel color (default = green) when selected.

auto sw sel off -  annotation not automatically drawn in drawsel color when selected.

list attributes(S) -  list record number of selected annotation.

distance -  report distance in map units between pairs of clicks; close with a 9.

where -  report x,y coordinates of click points; close with a 9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

close menu -  close the Options pulldown menu and return to the Annotation bar.

Digitize (Annotation) Bar Menu

The Digitize bar for annotation supports entry of map-face text in different fonts and sizes either from 
the keyboard or by extraction from the map database.  Various methods of placement provide flexi-
bility in fitting the text into the map.  The Digitize bar is reached from the Annotation bar (click  DIG).

[ Dig ]  |  add  |  Add options  | Sel  |  Op  |  Dw  |  Zm  |  ^ANNO  |

[ Dig ] -  name of bar menu; open Commands popup menu.

add -  start add annotation routine; enter text at prompt; place with click.

Add options -  open the Add Options pulldown menu.

Sel -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^ANNO -  return to the Annotation bar menu.

Add Options pulldown:

[ Dig ]  |  add  |  Add options  | Sel  |  Op  |  Dw  |  Zm  |  ^ANNO  |

status  -  add -  report settings for Add Annotation routine.

Annoenvironment -  open Annotation Environment forms menu to view or change settings.

annosize * -  set size of annotation with clickpoints on screen.

new -  reset size and symbol for new annotation to be those of selected string.

show(S1) -  report attributes of the selected string of annotation.

close menu -  close the Add Options pulldown menu and return to the Digitize bar.

238



Options pulldown:

[ Dig ]  |  add  |  Add options  | Sel  |  Op  |  Dw  |  Zm  |  ^ANNO  |

options: help -  name of menu; display help for Options menu.  

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore annotation deleted in the current edit session:

   last -  restore the last annotation that was deleted in the current session.

   all -  restore all annotation that was deleted in the current session.

   for expression -  restore deleted annotation according to expression entered at the prompt.

delete(S) -  delete the selected annotation.  

select many -  select annotation by clicking (at lower left); close selection with a  9.

draw sel’d features -  redraw selected annotation in current drawselect color (default = green).  

show sel’d features -  redraw selected annotation and report identities.  
list attributes(S) -  list attributes of selected annotation.

distance -  report distance in map units between pairs of clicks; close with  9.

where -  report x,y coordinates of click points; close with  9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

close menu -  close the Options pulldown menu and return to the Digitize bar.

Change (Annotation) Bar Menu

The Change bar for annotation supports moving and rotating text and changing content, size, and font. 
The bar is reached from the Annotation bar (click  CHANGE).

[ Change ]  |  Change  |  Move  |  Rot  | sm  | sp  | Se  |  Op  |  Dw  |  Zm  |  ^ANNO  |

[ Change ] -  name of bar menu; open the Commands popup menu.

Change -  open the Change Annotation pulldown menu.

Move -  open the Move Annotation pulldown menu.

Rot -  open the Rotate Annotation pulldown menu.

sm -  select one or more annotation strings by clicking lower left corners.

sp -  select all annotation strings enclosed in a polygon clicked on screen.

Se -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

^ANNO -  return to the Annotation bar menu.

Change Annotation pulldown:

[ Change ]  |  Change  |  Move  |  Rot  | sm  | sp  | Se  |  Op  |  Dw  |  Zm  |  ^ANNO  |

annolevel(S) -  change level to which selected annotation is assigned.

annosize(S) -  change size of selected annotation by entering new size.

annosymbol(S) -  change symbol in current textset assigned to selected annotation.
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setarrow(S1) -  draw arrow for seleted text by clicking from and to ends (9  to close).

Select and Setarrow -  select text and draw arrow ; repeat or close with  9.

deletearrows(S) -  delete arrows from selected annotation.

select &text = -  select all annotation matching entered string.

change(S) $text -  append, change, overlay, or replace all or parts of selected annotation.

Replace text string -  replace selected strings with entered string.

show(S1) -  report attributes of the selected string of annotation.

close menu -  close the Change pulldown menu and return to the Change bar.

Move Annotation pulldown:

[ Change ]  |  Change  |  Move  |  Rot  | sm  | sp  | Se  |  Op  |  Dw  |  Zm  |  ^ANNO  |

move(S) -  move selected annotation (click from and to points to place).

Select and Move -  select strings one by one and move by clicking from and to points..

reposition(S1) -  relocate selected string using current placement method.

smartanno(Tek) -  turn on to drag and place selected string with  move(S).
position(Tek) -  drag selected string with mouse, rotate on pivot with 1 (Smartanno on).

help -  display help for Smartanno.

copy(S) -  copy selected annotation (click from and to points to place).

copy many(S) -  click a from point and then as many to points as copies; close with a  9. 

close menu - close the Move Annotation pulldown menu and return to the Change bar.

Rotate Annotation pulldown:

[ Change ]  |  Change  |  Move  |  Rot  | sm  | sp  | Se  |  Op  |  Dw  |  Zm  |  ^ANNO  |

rotate:  help -  name of menu; display help for Rotate menu.

rotate(S)    rotate selected annotation about a pivot point (click at prompt); specify

Setangle:    rotation angle with click on circle around pivot point or enter with 

  setangle    setangle  (positive=counterclockwise); clear current angle with

  setangle 0    setangle 0,  restore last angle entered with  setangle  last.  Uses

  setangle last    last angle set unless that = 0, then requires angle to be clicked on screen.

Options pulldown:

[ Change ]  |  Change  |  Move  |  Rot  | sm  | sp  | Se  |  Op  |  Dw  |  Zm  |  ^ANNO  |

options: help -  name of menu; display help for Options menu. 

oops -  remove the effect of the last ARC/INFO action.

Undelete(S): Restore annotation deleted in the current edit session:

   last -  restore the last annotation that was deleted in the current session.

   all -  restore all annotation that was deleted in the current session.

   for expression -  restore deleted annotation according to expression entered at the prompt.
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delete(S) -  delete the selected annotation.  

select many -  select annotation by clicking (at lower left); close selection with a  9.

draw sel’d features -  redraw selected annotation in current drawselect color (default = green).  

show sel’d features -  redraw selected annotation and report identities.  
list attributes(S) -  lists attributes of selected annotation.

PUT -  go to the PUT bar (see description under Lines, p. 223).

get -  incorporate all annotation from specified map into edit map.

distance -  report distance in map units between pairs of clicks; close with  9.

where -  report x,y coordinates of click points; close with  9.

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

close menu -  close the Options pulldown menu and return to the Change bar.

TICS BAR MENU

The Tics bar supports digitizing, placing, and numbering digital registration tics in a map.  It is reached 
from the Edit bar (click TICS).

[ Tics ]  |  add  |  Move  |  so  |  sm  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  [ ^EDIT ]  |

[ Tics ] -  name of bar menu; call the Commands popup menu.

add -  start digitize tics routine and the key menu that controls it.

Move -  open the Move pulldown menu.

so -  select one tic by clicking on on it.

sm -  select several tics by clicking; close selection with a  9.

Db -  open the Database pulldown menu.

Sel -  open the Select popup menu.

Op -  open the Options pulldown menu.

Dw -  open the Draw popup menu.

Zm -  open the Zoom popup menu.

[ ^EDIT ] -  return to the Edit bar.

Move Tics pulldown:

[ Tics ]  |  add  |  Move  |  so  |  sm  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  [ ^EDIT ]  |

move(S) -  move selected tic(s); click from and to points at prompts.

move many -  cycles through the steps to locate, select, and place tics individually.

Database pulldown:

[ Tics ]  |  add  |  Move  |  so  |  sm  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  [ ^EDIT ]  |

database:  help -  name of menu; display help for Database menu.

list attributes(S) -  report identity and x,y location of selected tics.

items -  list items (and their definitions) in database of edit map.
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calculate -  enter item name and value to be recorded in it for selected tic(s).

close menu -  close the Database pulldown menu and return to the Tics bar menu. 

Options pulldown:

[ Tics ]  |  add  |  Move  |  so  |  sm  |  Db  |  Sel  |  Op  |  Dw  |  Zm  |  [ ^EDIT ]  |

options:  help -  name of menu;  display help for Options menu.

oops -  remove the effect of the last ARC/INFO action. 

Undelete(S): Restore tics deleted in the current edit session:  

   last -  restore the last tic that was deleted in the current session.   

   all -  restore all tics that were deleted in the current session.

   for expression -  restore deleted tics according to expression typed at the prompt.
delete(S) -  delete the selected set of tics. 

select many -  select many tics by clicking on them; close selection with a  9.    

draw sel’d features -  redraw selected tics in current drawselect color (default = yellow).  

show sel’d features -  redraw selected tics on screen and report their identities. 

list attributes(S) -  report identity and x,y location of selected tics.

get -  incorporate all tics from specified map into edit map.

distance -  report distance in map units between pairs of clicks; close with a  9. 

where -  report x,y coordinates of click points; close with a  9.    

change coord device -  pick coordinate device from popup menu.

save(OW) -  save current edit map by overwriting the existing file.

restore save -  reassign saved symbols and selected set for current edit session.

close menu -  close the Options pulldown menu and return to the Tics bar. 

Plot Section

The Plot section in Version 1.0 of ALACARTE supports the preparation of plot files for on-screen and 
hard-copy plotting.  You will need to consult the system administrator concerning available output 
devices and probably will need to consult an expert user, the ARC/INFO manual, and/or the manual 
for MAPX to make sucessful plots with the present level of support for plotting in ALACARTE.

PLOT BAR MENU

The Plot bar provides access to  (1) the Arcplot command line,  (2) a connection to MAPX for pre-
paring a parameter file for plotting (A.C. Tarr, unpub.; MAPX must be separately obtained and 
installed), and  (3) procedures to make error plots, to prepare plot files for single colored maps, and to 
display plot files on the screen.  The Plot bar is reached from the Alacarte bar (click  PLOT).

[ Plot ]  |  arcplot cmd line  |  mapx  |  Plotfiles  |  ^ALC  |

[ Plot ] -  name of bar menu; open Commands popup menu.

arcplot cmd line -  go to Arcplot command line; enter  quit  to return to Plot bar.

mapx -  go to MAPX to prepare a parameter file for plotting (if MAPX installed).

Plotfiles -  open Plotfiles pulldown menu.

^ALC -  return to the Alacarte bar.
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Plotfiles pulldown:

[ Plot ]  |  arcplot cmd line  |  mapx  |  Plotfiles  |  ^ALC  |

Make standard plot -  prepare ARC/INFO plotfile for a standard ALACARTE geologic map.

Make edit plot -  prepare an error plot of a map.

Draw plotfile to screen -  display an ARC/INFO plot file on the screen.

close menu -  close the Plotfiles pulldown menu and return to the Plot bar.

Analysis Section

The Analysis section in Version 1.0 of ALACARTE provides some basic tools to manipulate digital 
maps to produce derivative extractions and combinations.  These tools and their controlling variables 
are not recast from their original ARC/INFO teminology and function.  Many other analysis and query 
functions that are available in ARC and ARCPLOT are not incorporated in Version 1.0.

ANALYSIS BAR

The Analysis bar provides access to the INFO command line and to a limited suite of ARC analysis 
functions in menu form.  It is reached from the Alacarte bar (click  ANALYSIS).

[ Analysis ]  |  info  |  Proximity  |  Boundary  |  Logical  |  Spatial  |  ^ALC  |

[ Analysis ] -  name of bar menu; open Commands menu.

info -  go to the INFO command line; enter  stop  or  q stop  to return to Analysis bar.

Proximity -  open Proximity Functions pulldown menu.

Boundary -  open Boundary Functions pulldown menu.

Logical -  open Logical Functions pulldown menu.

Spatial -  open Spatial Functions pulldown menu

Proximity Functions pulldown:

[ Analysis ]  |  info  |  Proximity  |  Boundary  |  Logical  |  Spatial  |  ^ALC  |

Buffer -  create lines (and polygons) at specific distances around specific map elements.

Near -  find distances from points in one layer to nearest map elements in another layer.

Pointdistance -  find distances from points in one layer to points in another layer.

Boundary Functions pulldown:

[ Analysis ]  |  info  |  Proximity  |  Boundary  |  Logical  |  Spatial  |  ^ALC  |

append -  combine separate maps or layers with identical databases into a single layer.

Clip -  copy a specified area from one map to produce another map.

Erase -  blank out specified area(s) in a map.

Mapjoin -  combine separate maps into one layer (as with Append) and recreate topology.

Split -  subdivide a map into specified areas as separate maps.

Update -  ’cut and paste’ new lines and polygons from one layer into another.
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Logical Functions pulldown:

[ Analysis ]  |  info  |  Proximity  |  Boundary  |  Logical  |  Spatial  |  ^ALC  |

Dissolve -  merge adjacent polygons that have the same entry in a specified database item.

Eliminate -  combine selected lines or polygons along or across longest length or boundary.

Reselect -  extract elements from a map according to specified database attributes.

Spatial Functions pulldown:

[ Analysis ]  |  info  |  Proximity  |  Boundary  |  Logical  |  Spatial  |  ^ALC  |

Identity -  combine one map with the overlapping area of another map.

Intersect -  combine two maps only for their jointly overlapping area.

Union -  combine two maps and produce a composite database for overlapping polygons.

The Conversion Section

The Conversion section provides access to various conversion routines to be applied to maps and map 
data already in ARC/INFO or that are being imported into the system or exported to another system. 

CONVERSION BAR MENU

The Conversion bar supports the projection and transform of maps, various file format, import, and 
export functions, and various conversions between ARC and the Scitex system.  It is reached from the 
Alacarte bar (click  CONVERSION). 

[ Conversion ]  | Projection  |  Export  |  Scitex  |  ^ALC  |

[ Conversion ] -  name of the ar menu; open the Commands popup menu.
Projection -  open the Projection pulldown menu.
Export -  open the Export forms menu.
Scitex -  open the Scitex pulldown menu.
^ALC -  return to the Alacarte bar.

Projection pulldown:

[ Conversion ]  | Projection  |  Export  |  Scitex  |  ^ALC  |

Projection:  help -  name of menu; display help for Projection menu.

Transform -  transform one map into another.
Project:
  Project file -  change the projection of coordinates in a file.
  Project coverage -  change the projection of a map.

close menu -  Close the Projection pulldown menu and return to the Conversion bar.

244



Export pulldown:

[ Conversion ]  | Projection  |  Export  |  Scitex  |  ^ALC  |

Export -  convert ARC/INFO file for transfer to a different ARC/INFO host.
Import -  convert ARC/INFO export file to ARC/INFO working format.

Tapewrite -  write file to 9-track tape in universal ARC/INFO format.
Taperead -  read from 9-track tape in universal ARC/INFO format.

  Assign tape(Prime) -  allocate Prime tape drive for use.

  Unassign tape(Prime) -  release Prime tape drive after use.

close menu -  close the Export pulldown menu and return to the Conversion bar.

Scitex pulldown:

[ Conversion ]  | Projection  |  Export  |  Scitex  |  ^ALC  |

Scitex:  help -  name of menu; display help for Scitex menu.

Scitex to ARC/INFO
  Scitexline -  convert a Scitex DIGIT file to a line coverage in ARC.

  Scitexpoint -  convert s Scitex DIGIT file to a point coverage in ARC.

  Scitexpoly -  convert a Scitex DIGIT file to a polygon coverage in ARC.

Arc/Info to Scitex
  Arc cover to Scitex -  convert an ARC coverage to a set of SCITEX files.
  Arc cov to Sci-poly -  convert an ARC polygon layer to a set of Scitex files (automated).

  Plotfile to Scitex -  convert an ARC/INFO plotfile to SCITEX format.

Scitex tape:
  Read a Scitex tape -  load Scitex files in TCOPY tape format.

  Write a Scitex tape -  write Scitex files in TCOPY tape format.

close menu -  close the Scitex pulldown menu and return to the Conversion bar.

General Section

The General section supports a variety of whole-map operations as well as housekeeping functions for 
map files and directories.

GENERAL BAR MENU

 The General bar supports file handling, modification of map databases, and such bulk map processes 
as Createlabels and Clean, and provides access to various symbols editors.  It is reached from the 
Alacarte bar (click  GENERAL).

[ General ]  | Files  |  Topology  |  Symbol editors  |  ^ALC  |

[ General ] -  name of the bar; open the Commands popup menu.
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Files -  open the Files pulldown menu.

Topology -  open the Topology pulldown menu.

Symbol editors -  open the Symbol Editors pulldown menu.

^ALC -  return to the Alacarte bar.

Files pulldown:

[ General ]  | Files  |  Topology  |  Symbols Editor  |  ^ALC  |

Copy -  copy an existing map as a new map.

rename -  enter old-name and new-name.

Kill -  delete an existing map (with ALL its associated files).

Create map -  make empty map layer; can copy tics and projection from existing map.

create workspace -  make new directory in current directory; specify name at prompt.

Change workspace -  enter name of map directory (full pathname where not subordinate).

externalall -  apply to map files that have been moved to make attributes accessible.

generate -  make empty layer or new map elements from specified coordinate data.

Add item -  add an item (field and its definition) to a map database. 
Drop item -  remove an item from a map database. 
Create labels -  create labels for every valid polygon in a map.

Match nodes -  snap nodes throughout a map with specified snap distance (extend opt.).

Add save items -  add the items to a map database needed to save symbols and selected set.

Add ALC items -  add standard ALACARTE database items for [line, point, area] types.

copy ALC files -  open menu to copy all ALC files from one map to another.

Restore edit session -  restore edits lost when an edit session is terminated by system failure.

close menu -  close the Files pulldown menu and return to the General bar.

Topology pulldown:

[ General ]  | Files  |  Topology  |  Symbols Editor  |  ^ALC  |

Clean -  find intersections, trim dangles, and build or rebuild topology in a map.

Build -  build or rebuild topology in a map.

Tolerances -  change or list tolerances for a map layer.

Labelerrors -  report any polygon label errors in a map (unedited since last built).

close menu -  close the Topology pulldown menu and return to the General bar.

Symbol Editors pulldown:

[ General ]  | Files  |  Topology  |  Symbols Editor  |  ^ALC  |

marker editor -  go to the marker editor; enter  quit  to return to the General bar.

line editor -  go to the line editor; enter  quit  to return to the General bar.

shade editor -  go to the shade editor; enter  quit  to return to the General bar.

text editor -  go to the text editor; enter  quit  to return to the General bar.

close menu -  close Symbols Editor pulldown menu and return to the General bar.
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Analysis Bar Menu, 243
ANNO

/EDIT, 210

Anno
/SYMBOLS, 221

Annoenvironment
/Add Options/ANNOTATION, 328

Annofit
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

Annoitem
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

Annolevel
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

Annolevel(S)
/Change/CHANGE Annotation, 239

annooffset
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

annoposition
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

annosize
/Add Options/ANNOTATION, 238

/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

annosize(S)
/Change/CHANGE Annotation, 239

annosymbol
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

Annosymbol(S)
/Change/CHANGE Annotation, 239

A
A (Align)

/RESHAPE Lines, 217

A (Axes)

/Digitize/LINES, 214

add
/DIGITIZE Annotation, 238

/RELATE/Options pulldowns, 223

/TICS, 241

Add ALC items
/Files/GENERAL, 246

Add item
/Files/GENERAL, 246

Add options
/DIGITIZE Annotation, 238

Add Options pulldown, Annotation, 238
add vertex(S1)

/Vertices/RESHAPE Lines, 219

Alacarte Bar Menu, 203
alacarte demo

/Commands/[non-Edit bars], 204

alacarte info
/Commands/[non-Edit bars], 204

Align/Rotate pulldown, 219
align

/Align/RESHAPE Lines, 219

all
Select popup/Sel/ most Edit bars, 73

all maps (ow)
/Save/EDIT, 212

ANALYSIS
/ALACARTE, 204

INDEX TO MENUS

The listing of the menu items shows their position in the menu hierarchy using sequence from the item 
upward and applies the ALACARTE captialization code.  Thus:

add vertex(S1)
/Vertices/RESHAPE Lines, 219

represents the menu item  add vertex(S1), which is on the Vertices pulldown from the Reshape bar.  

The menus themselves are listed in the form:

Alacarte Bar Menu, 203

Page numbers refer to descriptions of the menus in the manual.  

--------------------------------------------------------------------
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auto dw sel off
Draw popup/Dw/ all Edit bars, 68

/Options/LINES, 214

auto dw sel on
Draw popup/Dw/ all Edit bars, 68

/Options/LINES, 214

autodig off
/Options/DIGITIZE Areas, 236

autodig on
/Options/DIGITIZE Areas, 236

Axes pulldown, 215

B
bearing only(S)

/Change/LINEAR Points, 230

bearing & plunge(S)
/Change/LINEAR Points, 230

Boundary
/ANALYSIS, 243

Boundary Functions pulldown, 243
Box

Select popup/Sel/ most Edit bars, 73

brief
/Show Audit Trail/AUDIT TRAIL, 212

Buffer
/Proximity/ANALYSIS, 243

Build
/Topology/GENERAL, 246

By length
Select popup/Sel/ most Edit bars

C
C (Contacts)

/Digitize/LINES, 214

C (Copy/Move)

/RESHAPE Lines, 217

calculate
/Database/ all feature bars

CHANGE
/ANNO, 237

change
/CHANGE Annotation, 239

/Database/ all feature bars

Change Annotation pulldown, 239

Change Bar Menu, Annotation, 239
change coord device

/Map/EDIT, 212

/Options/ all Edit bars

Change pulldown, Linear Points, 230

Change pulldown, Planar Points, 228
change to new map dir

/Choose Map popup, 210

Annotation Bar Menu, 237

Annotation Environment popup, 187

Annotation Symbols pulldown, 222
annotation + leaders

/New Layer/SETUP, 209

/New Map/SETUP, 209

annotype
/Annoenvironment/Add Options/DIGITIZE Annota-
tion, 187

Append
/Boundary/ANALYSIS, 243

Arc cov to Sci-poly
/Scitex/CONVERSION, 245

Arc cover to Scitex
/Scitex/CONVERSION, 245

arcplot cmd line
/PLOT, 242

arcshell
/Commands/ non-Edit bars, 204

Arcsnap distance
Edit Tolerances popup/Setup sequences/SETUP, 96

Snap popup/Set snap/Snap/LINES, 125

Arcsnap type
Edit Tolerances popup/Setup sequences/SETUP, 96

Snap popup/Set snap/Snap/LINES, 125

ARC/EDIT commands
/Commands/ all Edit bars, 211

ARC/INFO commands
/Commands/ all Edit bars, 211

/Commands/ non-Edit bars, 204

AREAS
/EDIT, 210

Areas
/SYMBOLS, 221

Areas Bar Menu, 233

Areas Symbols pulldown, 222
aselect

Select popup/Sel/ most Edit bars

/Select/ all Digitize bars

asm (aselect many)

/PUT, 223

aso (aselect one)

/PUT, 223

asp (aselect polygon)

/PUT, 223

Assign tape(Prime)
/Export/CONVERSION, 245

Assign tics
/Prepare Scans/SETUP, 209

AUDIT TRAIL
/Commands/ all Edit bars

Audit Trail Bar Menu, 212

Audit Trail pulldown, 212



copy
/Files/GENERAL, 246

/MOVE Areas, 236

/Move/POINTS, 232

Copy ALC files
/Files/GENERAL, 246

copy many(S)
/Copy/MOVE Points, 233

/Copy/RESHAPE Lines, 218

/MOVE Areas, 236

/Move/CHANGE Annotation, 240

copy parallel(S):
/Copy/RESHAPE Lines, 218

Copy pulldown, Move Areas, 236

Copy pulldown, Move Points, 233
copy setup file

/Options/SETUP, 209

copy(S)
/Copy/MOVE Points, 233

/Copy/RESHAPE Lins, 218

/MOVE Areas, 236

/Move/CHANGE Annotation, 240

Copy/Move pulldown,  Reshape Lines, 218
Create labels

/Files/GENERAL, 246

create map
/Files/GENERAL, 246

/Options/SETUP, 209

create new map
/Choose Map popup, 210

/Map/EDIT, 211

Create setup file
/Prepare Scans/SETUP, 209

Create tagging menus
/Prepare Scans/SETUP, 209

Create unit annotation
/New Layer/SETUP, 209

create workspace
/Files/GENERAL, 246

cur map(new)
/Save/EDIT, 212

cur map(ow)
/Save/EDIT, 212

current point type(S)
/Change/LINEAR Points, 230

/Change/PLANAR Points, 228

current setting
/Settings/DEVICES/Commands, 206

cursor
Coordinate Input popup/coord device/DEVICES, 49

change workspace
/Commands/ all Edit bars

/Commands/ non-Edit bars

/Files/GENERAL, 246

/Map/EDIT, 211

/Options/SETUP, 209

change(S) $text
/Change/CHANGE Annotation, 240

Chg
/LINEAR Points, 230

/PLANAR, 228

choose background
/Map/EDIT, 211

choose edit map
/Map/EDIT, 211

Choose lookup table
/Set/LINEAR Points, 232

/Set/PLANAR Points, 229

choose map
/Choose Map popup, 210

Choose Map popup, 210
Choose markerset

/Set/LINEAR Points, 232

/Set/PLANAR Points, 229

Clean
/Topology/GENERAL, 246

clear screen
Draw popup/Dw/ all Edit bars, 68

Clip
/Boundary/ANALYSIS, 243

color units in backgnd
/Options/DIGITIZE Areas, 236

color units:  off
/Options/DIGITIZE Areas, 236

columns
/Database/ all feature bars

combine arcs(S)
/Split/RESHAPE Lines, 219

Commands popup, Edit, 210

Commands popup, non-Edit, 204
connect

Select popup/Sel/ most Edit bars

connect to RDBMS
/Database/ all feature bars

Contacts pulldown, 215
CONVERSION

/ALACARTE, 204

Conversion Bar Menu, 244
coord device

/Devices/DEVICES/Commands, 206

Coordinate Input popup, 49
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Lines, 214

Planar Points, 227

Points, 226
digitizer

Coordinate Input popup/coord device/DEVICES, 49

/Devices/DEVICES/Commands, 206

Digitizer popup, 48

Digitize/Tag pulldown, Points, 224
Dig/tag

/POINTS, 224

dip only(S)
/Change/PLANAR Points, 228

display file
/Watch/DEVICES/Commands, 207

display: other display
/Devices/DEVICES/Commands, 206

display: set to term
/Devices/DEVICES/Commands, 206

Dissolve
/Logical/ANALYSIS, 244

distance
/Options/ all Edit bars

draw area of: map boundary
Zoom popup/Zm/ all Edit bars

draw area of: map corners
Zoom popup/Zm/ all Edit bars

draw area of: selected features(S)
Zoom popup/Zm/ all Edit bars

draw cov in back
Oriented/Points/SYMBOLS, 222

draw first time w/ current
/Set/LINEAR Points, 231

/Set/PLANAR Points, 229

Draw in back off
Oriented/Points/SYMBOLS, 222

draw map
Draw popup/Dw/ all Edit bars

Draw plotfile to screen
/Plotfiles/PLOT, 243

Draw popup, 67
Draw sel’d features

/Options/ all Edit bars

draw select
Draw popup/Dw/ all Edit bars

Draw to scale
Zoom popup/Zm/ all Edit bars

draw vertex(S1)
/Vertices/RESHAPE Lines, 219

draw w/ default colors
/Options/LINES, 214

draw(noclear)
Draw popup/Dw/ all Edit bars

D
dangle

Select popup/Sel/ most Edit bars

dangle tolerance
Topology Tolerances popup/Setup sequences/SETUP, 
96

dash to solid
/Reshape/RESHAPE Lines, 218

Database pulldown

Areas, 234

Lines, 213

Points, 225

Tics, 241
Db (Database)

/AREAS, 233

/LINES, 213

/POINTS, 224

/TICS, 241

Default dialog
/Commands/ all Edit bars

/Commands/ non-Edit bars

/Settings/DEVICES/Commands, 206

delete  vertex(S1)
/Vertices/RESHAPE Lines, 219

deletearrows(S)
/Change/CHANGE Annotation, 240

delete(S)
/Options/ all Edit bars

densify
/Reshape/RESHAPE Lines, 218

describe map
/Map/EDIT, 211

DEVICES
/Commands/ all Edit bars

/Commands/ non-Edit bars

Devices
/DEVICES, 206

Devices Bar Menu, 206

Devices pulldown, 206
DIG

/ANNO, 237

/LINES, 212

dig
/DIGITIZE Areas, 235

/DIGITIZE Points, 226

/DIGITIZE Lines, 214

/LINEAR Points, 230

/PLANAR Points, 228

Digitize Bar Menu

Annotation, 238

Areas, 235

Linear Points, 230
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astdisk
/Devices/DEVICES/Commands, 206

fastmouse
/Devices/DEVICES/Commands, 206

Faults pulldown, 215
faults, contacts, units

/New Layer/SETUP, 224

/New Map/SETUP, 208

Files
/GENERAL, 246

Files pulldown, 246
flip line dir’n(S)

/Options/DIGITIZE Lines, 217

/Options/RESHAPE Lines, 220

for  expression
Select popup/Sel/ most Edit bars, 73

forms
/Database/ all feature bars

full
/Show Audit Trail/AUDIT TRAIL, 212

fullscreen dialog
/Commands/ all Edit bars, 211

/Commands/[non-Edit bars], 204

/Settings/DEVICES/Commands, 206

fuzzy tolerance
Topology Tolerances popup/Setup sequences/SETUP, 
96

G
GENERAL

/ALACARTE, 204

General Bar Menu, 245
generalize

/Reshape/RESHAPE Lines, 219

Generate
/Files/GENERAL, 246

geologic structures
/New Layer/SETUP, 209

/New Map/SETUP, 208

get
/Options/RESHAPE Lines, 220

give ARC/EDIT commands
/Commands/ all Edit bars

give ARC/INFO commands
/Commands/ all Edit bars

/Commands/ non-Edit bars

give one ARC/EDIT command
/Commands/ all Edit bars

give one ARC/INFO command
/Commands/ all Edit bars

/Commands/ non-Edit bars

drop
/RELATE/Options pulldowns, 223

Drop item
/Files/GENERAL, 246

duplicate arcs ok
/Options/DIGITIZE Lines, 217

Dw (draw)

Draw popup, all Edit bars

E
E (Extend)

/RESHAPE Lines, 217

echo off
/Settings/DEVICES/Commands, 206

echo on
/Settings/DEVICES/Commands, 206

EDIT
/ALACARTE, 204

edit  distance
Snap popup/Set snap/Snap/LINES, 96

Edit Bar Menu, 210
Edit distance

Edit Tolerances popup/Setup sequences/SETUP, 96

Edit Tolerances, 95

Edit Tolerances popup, 125
Eliminate

/Logical/ANALYSIS, 244

Erase
/Boundary/ANALYSIS, 243

Export
/CONVERSION, 244

/Export/CONVERSION, 245

Export pulldown, 245

extend direction
Edit Tolerances popup/Setup sequences/SETUP, 96

extend distance
Edit Tolerances popup/Setup sequences/SETUP, 96

Extend pulldown, 218
extend: both ends

/Extend/RESHAPE Lines, 218

extend: from end
/Extend/RESHAPE Lines, 218

extend: to end
/Extend/RESHAPE Lines, 218

externalall
/Files/GENERAL, 246

F
F (Faults)

/Digitize/LINES, 214
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/Symbol editors/GENERAL, 246

LINEAR
/DigTag/POINTS, 244

LINES
/EDIT, 210

Lines
/SYMBOLS, 221

Lines Bar Menu, 212

Lines Symbols pulldown, 222
lineset

/Lines/SYMBOLS, 222

list
/RELATE/Options pulldowns, 223

/SHOW/Commands, 207

list all vars
/List/SHOW/Commands, 207

list AML commands
/Help/SHOW/Commands, 208

list ARCEDIT cmds
/Help/SHOW/Commands, 208

list ARC/INFO cmds
/Help/SHOW/Commands, 208

list attributes(S)
/Database/ all feature bars

/Options/ all Edit bars

List dir
/Commands/ all Edit bars

/Commands/ non-Edit bars

/Map/EDIT, 211

list files
/List/SHOW/Commands, 207

list lines item attributes(S)
/Database/LINES, 213

list one var
/List/SHOW/Commands, 207

List pulldown, 207
list unique values

/Database/ all feature bars

Logical
/ANALYSIS, 243

Logical Functions pulldown, 244
lookup

/Database/ all feature bars

lookup table
non-Oriented/Points/SYMBOLS, 222

Oriented/Points/SYMBOLS, 222

M
make edit plot

/Plotfiles/PLOT, 243

give one system command
/Commands/ all Edit bars

/Commands/non-Edit bars

give system commands
/Commands/ all Edit bars

/Commands/ non-Edit bars

grain
/Reshape/RESHAPE Lines, 218

Snap popup/Set snap/Snap/LINES, 125

graphics off
Draw popup/Dw/ all Edit bars, 68

graphics on
Draw popup/Dw/ all Edit bars, 68

H
Help

/RELATE/Options pulldowns, 223

/SHOW/Commands, 207

help AML commands
/Help/SHOW/Commands, 208

help ARCEDIT cmds
/Help/SHOW/Commands, 208

help ARC/INFO cmds
/Help/SHOW/Commands, 208

Help pulldown, 208

I
Identity

/Spatial/ANALYSIS, 244

Import
/Export/CONVERSION, 245

info
/ANALYSIS, 243

Intersect
/Spatial/ANALYSIS, 244

intersectarcs
Edit Tolerances popup/Setup sequences/SETUP, 96

Snap popup/Set snap/Snap/LINES, 125

items
/Database/ all feature bars

K
keyboard

Coordinate Input popup/coord device/DEVICES, 49

Kill
/Files/GENERAL, 246

L
Labelerrors

/Topology/GENERAL, 246

line editor
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Move pulldown, Tics, 241
move vertex

/Vertices/RESHAPE Lines, 219

moveitem
/Database/ all feature bars

move(S)
/Copy/RESHAPE Lines, 218

/Move/CHANGE Annotation, 240

/Move/TICS, 241

N
N (NODES)

/RESHAPE Lines, 217

Near
/Proximity/ANALYSIS, 243

New
/Add Options/ANNOTATION, 238

New Layer
/SETUP, 208

New Layer pulldown, 209
New Map

/SETUP, 208

New Map pulldown, 208
no attribute

/DigTag/POINTS, 224

no duplicate arcs
/Options/DIGITIZE Lines, 217

nodecolor
/Symbols/NODES, 221

Nodes Bar Menu, 220
nodesize

/Symbols/NODES, 221

nodesnap closest
/NODES/RESHAPE, 221

nodesnap distance
Edit Tolerances popup/Setup sequences/SETUP, 96

Snap popup/Set snap/Snap/LINES, 125

nodesnap first
/NODES/RESHAPE, 220

Nodesnap type
Edit Tolerances popup/Setup sequences/SETUP, 96

Snap popup/Set snap/Snap/LINES, 125

nselect
Select popup/Sel/ most Edit bars

O
O (Other types)

/Digitize/LINES, 214

one
Select popup/Sel/ most Edit bars, 73

Make standard plot
/Plotfiles/PLOT, 243

many
Select popup/Sel/ most Edit bars

Map
/EDIT, 210

Map pulldown, 211
MAP SYMBOLS

/DigTag/POINTS, 224

Mapjoin
/Boundary/ANALYSIS, 243

mapx
/PLOT, 242

marker editor
/Symbol editors/GENERAL, 246

markerset
non-Oriented/Points/SYMBOLS, 222

Oriented/Points/SYMBOLS, 222

/Areas/SYMBOLS, 222

Match nodes
/Files/GENERAL, 246

messages all off
/Settings/DEVICES/Commands, 206

messages info off
/Settings/DEVICES/Commands, 206

messages on
/Settings/DEVICES/Commands, 206

messages popup
/Settings/DEVICES/Commands, 206

Mod (Modifiers)

/Digitize/LINES, 214

Modifiers pulldown, 21
mouse

Coordinate Input popup/coord device/DEVICES, 49

MOVE
/AREAS, 233

/POINTS, 224

move
/CHANGE Annotation, 239

/MOVE Areas, 236

/Move/POINTS, 232

/NODES/RESHAPE, 220

/TICS, 241

Move Annotation pulldown, 240

Move Bar Menu, Areas, 236

Move Bar menu, Points, 232
move in place

/Reshape/RESHAPE Lines, 218

move many
/Move/TICS, 241

move parallel(S):
/Copy/RESHAPE Lines, 218
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Plotfiles pulldown, 243
plunge only(S)

/Change/LINEAR Points, 230

POINT
/DigTag/POINTS, 224

point tag
/Tag/DIGITIZE Points, 226

Point Tags
/DIGITIZE Points, 226

Point Tags pulldown

Digitize Points, 227

Linear Points, 231

Planar Points, 228
point & samp tag

/Tag/DIGITIZE Points, 226

Pointdistance
/Proximity/ANALYSIS, 243

Points Bar Menu, 224

Points Symbols pulldown, 222
polygon

Select popup/Sel/ most Edit bars, 73

position(Tek)
/Move/CHANGE Annotation, 240

post attribute:  off
/Options/DIGITIZE Areas, 236

post attribute:  on
/Options/DIGITIZE Areas, 236

Prep database
/Prepare Scans/SETUP, 209

Prep scans
/SETUP, 208

Prepare Scans pulldown, 209
Project coverage

/Projection/CONVERSION, 244

Project file
/Projection/CONVERSION, 244

Projection
/CONVERSION, 244

projection file
/Options/SETUP, 209

Projection pulldown, 244
Proximity

/ANALYSIS, 243

Proximity Functions pulldown, 243
Pt Tags

/LINEAR Points, 230

/PLANAR, 228

PTS
/EDIT, 210

Pts
/SYMBOLS, 221

oops
/Database/ all feature bars

/Options/ all Edit bars

Op (Options)

Options pulldown, most Edit bars

Options
/SETUP, 208

Options Pulldown, Digitize Lines, 217

Options pulldown

Annotation, 237

Areas, 234

Change Annotation, 240

Digitize Annotation, 239

Digitize Areas, 235

Digitize Points, 227

Linear Points, 232

Lines, 213

Move Areas, 237

Move Points, 233

Nodes, 221

Planar Points, 229

Points, 225

Put, 223

Reshape Liines, 220

Setup, 209

Tics, 242

Other Types pulldown, 216
outline

Select popup/Sel/ most Edit bars

overview
Zoom popup/Zm/ all Edit bars

P
page list

/Commands/ all Edit bars

/Commands/ non-Edit bars

Pan
Zoom popup/Zm/ all Edit bars, 70

passthru
Select popup/Sel/ most Edit bars, 73

PLANAR
/DigTag/POINTS, 224

PLOT
/ALACARTE, 204

Plot Bar Menu, 242
Plotfile to Scitex

/Scitex/CONVERSION, 245

Plotfiles
/PLOT, 242
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Rotate Annotation pulldown, 240
rotate(S)

/Align/RESHAPE Lins, 219

/Rotate/CHANGE Annotation, 240

RSH
/LINES, 212

Rsh (Reshape)

/RESHAPE Lines, 217

Run my aml or menu
/Commands/ all Edit bars

/Commands/ non-Edit bars

S
sample localities

/New Layer/SETUP, 209

/New Map/SETUP, 208

sample nbr tag
/Tag/DIGITIZE Points, 226

sample nbr: off
/Point Tags/DIGITIZE Points, 227

sample nbr: on
/Point Tags/DIGITIZE Points, 227

sample nbr: set field
/Point Tags/DIGITIZE Points, 227

Save
/EDIT, 210

save
/RELATE/Options pulldowns, 223

Save pulldown, 212
save setup

/Save/EDIT, 212

save station
/Devices/DEVICES/Commands, 206

save this frame
Zoom popup/Zm/ all Edit bars, 71

save-audit?
/Save/EDIT, 212

save-select?
/Save/EDIT, 212

save-symbol?
/Save/EDIT, 212

save(OW)
/Options/ all Edit bars

Scitex
/CONVERSION, 244

Scitex pulldown, 245
Scitexline

/Scitex/CONVERSION, 245

Scitexpoint
/Scitex/CONVERSION, 245

Scitexpoly
/Scitex/CONVERSION, 245

PUT
/Options/CHANGE Annotation, 241

/Options/RESHAPE Lines, 220

put
/PUT, 223

Put Bar Menu, 223

R
Read a Scitex tape

/Scitex/CONVERSION, 245

record mapscale
/Map/EDIT, 211

record mapunits
/Map/EDIT, 212

redraw saved frame
Zoom popup/Zm/ all Edit bars, 71

register map
/Map/EDIT, 211

RELATE
/Database/ all feature bars

Relate Bar Menu, 223
remove all backgnds

/Map/EDIT, 211

remove background
/Map/EDIT, 211

remove edit map(s)
/Map/EDIT, 211

Rename
/Files/GENERAL, 246

Replace text string
/Change/CHANGE Annotation, 240

Reposition(S1)
/Move/CHANGE Annotation, 240

Reselect
/Logical/ANALYSIS, 244

reselect
Select popup/Sel/ most Edit bars

/Select/ all Digitize bars

Reset symbols
non-Oriented/Points/SYMBOLS, 222

Reshape Bar Menu, 217

Reshape pulldown, 218
reshape(S1)

/Reshape/RESHAPE Lines, 218

Restore
/RELATE/Options pulldowns, 223

Restore edit session
/Files/GENERAL, 246

Restore save
/Options/ all Edit bars

Rot (Rotate)

/CHANGE Annotation, 239
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Set attitude entry format
/Set/LINEAR Points, 232

/Set/PLANAR Points, 229

set dialog lines
/Settings/DEVICES/Commands, 206

Set dip numeral height
/Set/PLANAR Points, 229

set drawsel symbol
Draw popup/Dw/ all Edit bars

set draw/back envir
Draw popup/Dw/ all Edit bars

set lines item
/Database/LINES, 213

Set plunge numeral height
/Set/LINEAR Points, 232

set points item
/Database/AREAS, 234

/Database/POINTS, 225

set snap
/Snap/LINES, 213

Set Symbols pulldown

Linear Points, 231

Planar Points, 229
set variable

/List/SHOW/Commands, 207

set $symbol(S)
Draw popup/Dw/ all Edit bars, 67

setangle
/Align/RESHAPE Lines, 219

/Rotate/CHANGE Annotation, 240

setarrow(S1)
/Change/CHANGE Annotation, 240

Settings
/DEVICES, 206

Settings pulldown, 206
SETUP

/ALACARTE, 204

Setup Bar Menu, 208

setup file present?
/Options/SETUP, 209

shade editor
/Symbol editors/GENERAL, 246

SHOW
/Commands/ all Edit bars

/Commands/ non-Edit bars

Show
/SHOW/Commands, 207

/Show/SHOW/Commands, 207

show all open edit maps
/Map/EDIT, 211

show aml usage
/Help/SHOW/Commands, 208

screen
Select popup/Sel/ most Edit bars

screen editor
/Commands/ all Edit bars

/Commands/ non-Edit bars

Sel (Select popup)

most Edit bars

/Select/ all Digitize bars

sel by current area type
/Select/DIGITIZE Areas, 235

sel by current linetype:
/Select/DIGITIZE Lines, 214

sel by current point type
/Select/DIGITIZE Points, 226

/Select/LINEAR Points, 230

/Select/PLANAR Points, 228

sel polygon
/Select/ all Digitize bars

Select and Move
/Move/CHANGE Annotation, 240

Select and Setarrow
/Change/CHANGE Annotation, 240

select by bearing value
/Select/LINEAR Points, 231

select by dip value
/Select/PLANAR Points, 228

select by plunge value
/Select/LINEAR Points, 231

select by strike value
/Select/PLANAR Points, 228

Select db items
/Set/LINEAR Points, 232

/Set/PLANAR Points, 229

select many
Draw popup/Dw/ all Edit bars

/Options/ all Edit bars

/Select/ all Digitize bars

Select Popup, 73

Select pulldown

Digitize Areas, 235

Digitize Lines, 214

Digitize Points, 226 

Linear Points, 230

Planar Points, 228
Select &text =

/Change/CHANGE Annotation, 240

sel,tag,color
/Select/DIGITIZE Areas, 235

/Select/DIGITIZE Lines, 215

Set
/LINEAR Points, 230

/PLANAR, 228
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so (select one)

/PUT, 223

/TICS, 241

sp (select polygon)

/CHANGE Annotation, 239

/MOVE Areas, 236

/Move/POINTS, 232

/PUT, 223

/RESHAPE Lines, 217

Sp (Split/Combine)

/RESHAPE Lines, 217

Spatial
/ANALYSIS, 217

Spatial Functions pulldown, 244
spline(S)

/Reshape/RESHAPE Lines, 218

Split
/Boundary/ANALYSIS, 243

split  at  vertex(S1)
/Split/RESHAPE Lines, 219

split(S1)
/Split/RESHAPE Lines, 219

Split/Combine pulldown, 219
station

/Devices/DEVICES/Commands, 206

statistics
/Database/ all feature bars

Status  -  add
/Add Options/ANNOTATION, 238

strike only(S)
/Change/PLANAR Points, 228

strike & dip(S)
/Change/PLANAR Points, 228

SYMB
/ANNO, 237

/AREAS, 233

/LINES, 213

/POINTS, 224

Symb
/NODES/RESHAPE, 220

Symbol editors
/GENERAL, 246

Symbol Editors pulldown, 246

Symbols Bar Menu, 221

Symbols pulldown, Nodes, 221
Symbolset

/SYMBOLS, 221

/Symbolset/SYMBOLS, 222

Symbolset pulldown, 222

Show audit trail
/AUDIT TRAIL, 212

Show Bar Menu, 207
Show current

/Symbolset/SYMBOLS, 222

show current backgrnds
/Map/EDIT, 211

show current edit map
/Map/EDIT, 211

show current settings
/Set/LINEAR Points, 231

/Set/PLANAR Points, 229

show devices
/Devices/DEVICES/Commands, 206

show dialog lines
/Settings/DEVICES/Commands, 207

Show or change setup
/Options/SETUP, 209

Show pulldown, 207
show scale, units

/Map/EDIT, 212

show sel’d features
/Options/ all Edit bars

/Select/ all digitize bars

show settings
/Save/EDIT, 212

show snap
/Snap/LINES, 213

show workspace
/Commands/ all Edit bars

/Commands/ non-Edit bars

/Map/EDIT, 211

/Options/SETUP, 209

show(S1)
/Add Options/ANNOTATION, 238

/Change/CHANGE Annotation, 240

sm (select many)

/CHANGE Annotation, 239

/MOVE Areas, 236

/Move/POINTS, 232

/PUT, 233

/RESHAPE Lines, 217

/TICS, 241

smartanno(Tek)
/Move/CHANGE Annotation, 240

Snap
/LINES, 212

/NODES/RESHAPE, 220

Snap popup, 125

Snap pulldown

Lines, 213

Nodes, 220
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Union
/Spatial/ANALYSIS, 244

Unit boundaries only
/New Layer/SETUP, 209

/New Map/SETUP, 208

unselect
Select popup/Sel/ most Edit bars

/Select/ all Digitize bars

update
/Boundary/ANALYSIS, 243

/Database/ all feature bars

use setup
/Save/EDIT, 212

V
V (Vertices)

/RESHAPE Lines, 217

Vertices pulldown, 219
view projection file

/Options/SETUP, 209

W
Watch

/DEVICES, 206

Watch append
/Watch/DEVICES/Commands, 207

Watch off
/Watch/DEVICES/Commands, 207

Watch on
/Watch/DEVICES/Commands, 207

Watch pulldown, 207
Weed tolerance

Edit Tolerances popup/Setup sequences/SETUP, 96

Snap popup/Set snap/Snap/LINES, 125

where
/Options/ all Edit bars

within
Select popup/Sel/ most Edit bars

Write a Scitex tape
/Scitex/CONVERSION, 245

X
xy box

Zoom popup/Zm/ all Edit bars

Z
Zm (zoom)

Zoom popup, all Edit bars

Zoom popup, 69
zoom 8/32

Zoom popup/Zm/ all Edit bars

System commands
/Commands/ all Edit bars

/Commands/ non-Edit bars

T
Tablet

Coordinate Input popup/coord device/DEVICES, 49

tag
/DIGITIZE Areas, 214

/DIGITIZE/Lines, 214

/DIGITIZE Points, 226

Tag Pulldown, Digitize Points, 226
Taperead

/Export/CONVERSION, 245

Tapewrite
/Export/CONVERSION, 245

terminal
/Devices/DEVICES/Commands, 206

text editor
/Symbol editors/GENERAL, 246

textset
/Anno/SYMBOLS, 222

tic match tolerance
Topology Tolerances popup/Setup sequences/SETUP, 
96

TICS
/EDIT, 210

Tics Bar Menu, 241
time

/SHOW/Commands, 207

Tolerances
/Topology/GENERAL, 246

Topology
/GENERAL, 246

Topology pulldown, 246

Topology Tolerance popup, 128

Topology Tolerances, 95
trace back

/List/SHOW/Commands, 207

Transform
/Prepare Scans/SETUP, 209

/Projection/CONVERSION, 244

U
Unassign tape(Prime)

/Export/CONVERSION, 245

undelete(S) all
/Options/ all Edit bars

undelete(S) for expression
/Options/ all Edit bars

undelete(S) last
/Options/ all Edit bars
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Zoom popup/Zm/ all Edit bars

zoomout(#)
Zoom popup/Zm/ all Edit bars

&show
/Show/SHOW/Commands, 207

zoom 9/36
Zoom popup/Zm/ all Edit bars

zoomin(box)
Zoom popup/Zm/ all Edit bars

zoomin(#)
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ARC/INFO

description, 3

revision 6.0, 39

Areas. See Polygons

tag and edit, 161

working with, 25

B
Back Environment, 68

Backgrounds

description and picking, 66

oriented symbols, 184

using on screen, 21

Bar Menus, 60

Base Map

digital, 7

discussion of, 8, 86

layer(s), 11

mosaics, 86

Blanks

for entry in menus, 60

highlight, 60

Boundary

map, 96, 150

scratch, 150

water, 158

Breaks, 16

Broken Polygon Boundaries, 172

Build, 57

polygons, 163, 164, 165

Bulk Editing of Lines, 157

C
Change

annotation, 191

devices, 49

items for oriented symbols, 181

line tags, 152

oriented symbols, 184

point attributes, 178

polygon tags, 164

station file, 49

tic numbers, 119

A
Accessing

ARC/INFO, 35

command lines, 64

multi-user host, 36

workstation, 35

Add. See Digitizing

Add Lines, 150

ALACARTE

demonstration, 16

development of, 2

getting started, 12

learning, 13

scope of version 1.0, 3

Align Vertices, 143

AMLs, run custom, 64

Annotation

add, 187

annofit, 188

annoitem, 188

annolevel, 187

annooffset, 188

annoposition, 188

annosize, 188

annosymbol, 188

annotype, 188

copy and move, 192

copy from database, 98

digitize, 187

edit, 190

enter and place, 189

environment, 187

layer, 12, 92

map feature, 11, 55

modify, 191

reposition, 192

rotate, 193

select, 190

show characteristics, 190

smartanno, 192

working with, 28

Arcsnap. See also Extend

discussion, 123
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lines, 144

oriented symbols, 184

points. See polygon labels

polygon labels, 172

vertices, 141

Demonstration, ALACARTE, 16

Densify Lines, 142

Derivative Maps, 5

Design the Map, 85

Devices

changing, 49

setting, 46

Dialog, 65

Digitize

annotation, 189

label points, 91

lines, 129

oriented symbols, 183

overlay for record, 132

points, 176

techniques for lines, 132

Digitizers, 38

register map on, 120

Dimensions in Digital Maps, 9

Direction of Lines, 153

Directories, 40

Disconnect Lines, 139

Display on screen

oriented symbols in background, 184

point attributes, 179

polygon tags, 163

Draw. See also zoom

controls, 19, 67

menu, 67

saved frame, 72

whole map, 71

Draw and Back Environment, 68

Draw Scale, 72, 181

Duplicate Arcs, 145

E
Edit

annotation, 190

areas, 161

lines, 135, 157

nodes, 136

oriented symbols, 184

polygons, 171

structural data, 184

vertices, 140

Edit Distance, 126

Clean, 57

polygons, 161

Color, on screen

lines, 135

nodes, 137

points. See polygon labels

polygon labels, 168

polygons, 168

polygons, custom coloring, 170

selected polygons, 169

unlabeled polygons, 169

Combine Lines, 139

Command Lines, 64

INFO. See Analysis bar, 243

Commands 

Arcedit, See Help pulldown, 208

ARC/INFO, See Help pulldown, 208

Primos, 42

UNIX, 44

Comparison of Data Sets, 5

Compilation

digital map, 6

goals, 7

new work, 4

small-scale, 4

Connect Lines, 147

Copy

annotation, 192

annotation from database, 98

lines, 143

Create Map, 98

from General bar, 99

in Edit, 99

unprojected tic framework, 100

Createlabels, 91, 164

Custom

AMLs, run, 64

menus, run, 64

symbol sets, 202

tag menus, make, 82

D
Dangle Tolerance, 127

Dash-to-Solid Conversion, 147

Database

form (menu), 62

function, 11

tems, 55

prepare, 88, 93, 100

Delete

annotation, 190
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I
Import from Vector Source, 155

Intersectarcs, 123

Intersections, repair, 145

Items, database fields, 55

K
Key Menus, 63

Kinds of Digital Maps, 5

L
Label Points. See Polygon Labels

Labelerrors, 167

Layer

annotation, 12, 92, 187

areas, 161

base map, 11

lines, 11, 90

map units, 91

points, 176

polygons, 91, 161

prepare for lines, 156

start new, 93

stations, 12

structure, 12, 92, 179

Layers

in digital maps, 11

names  for, 85

Lines

add, 150

color, 135

connect, 147

copy, 143

delete, 144

densify, 142

digitize, 129

direction, 153

disconnect, 139

edit, 135

edit and tag, 157

enlarge, 143

enter, 7, 131

extend, 139

layer, 11, 90

manipulate, 143

map feature, 10, 52

move, 143

move intersections, 137

repair intersections, 145

reshape, 149

Edit Map, 65

Edit Plots, 193

Edit Tolerances Menu, 125

Editor

Primos Emacs, 43

UNIX vi, 45

Emacs editor, 43

Emulators

supported by ALACARTE, 47

terminal, 36

x-windows, 36

Enlarge Lines, 143

Enter. See digitize

in menu blanks, 60

Environment

annotation, 187

draw and back, 68

symbol, 180

Equipment and Software, 12

Experiment with ALACARTE, 17

Extend Lines, 124, 139

F
Features of Maps, 10, 51

Files, managing, 40

Find. See also select by attribute

multiple polygon labels, 167

unlabeled polygons, 166

untagged polygon labels, 166

Forms Menus, 61

Framework

geographic, 8

projected, 93

projected tics, 116

simple map, 98

tics, prepare, 88

Fuzzy Tolerance, 127

G
Generalize Lines, 150

Get, 151

Grain, 126

H
Help 

from menus, 60

see also Show Bar, 207

Highlight

menu items, 60
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Number(s)

renumber tics, 119

tics, 119

tics, standard, 104

O
Oriented Symbols

digitize, 183

entry format, 182

set point type, 182

Oriented Symbols and Data, 179

Overlay, to track digitizing, 132

P
Pan. See zoom

Pick Menu Items, 59

Plan the Map, 85

Planar and Linear Elements, 180

Plots, 193

edit plots, 193

for editing lines, 156

full color, 196

on screen, 195

polygon errors, 168

Plotters, 37

Points, 175

bar menu, 175

change items, 181

changing attributes, 178

digitize, 176

display attributes, 179

draw scale, 181

item (database field), 175

layer, 176

map feature, 11, 54

oriented symbols, 181

planar and linear elements, 180

sample number, 178

symbols, 201

unique identifier, 177

user-ID, 177

working with, 26

Points and Point Data, 175

Polygon Labels

change tags, 172

check, 165

create and tag, 164

delete, 172

digitize and tag, 162

find untagged, 166

Lines (cont.)

rotate, 144

split and combine, 139

symbols, 199

tag, 152

type, 130

working with, 21

List Label Errors, 167

Locate Multiple Labels, 167

M
Make. See Prepare

Make a Simple Map, 29

Manipulate Lines, 143

Map Analysis, 5

Map Boundary, 96, 158

Map Registration, 9, 115

Matchnode

bulk snapping, 148

discussion, 138

menu, 139

Menus, 59

bar, 60

entry blanks, 60

forms, 61

key, 63

operation, 59

popup, 61

pulldown, 60

Mosaicked Base Maps, 86

Move

annotation, 192

lines, 143

nodes, 137

polygon labels, 172

tics, 117

vertices, 141

N
Naming Map Layers, 86

New Layer Sequence, 97

New Map Sequence, 94

Nodes

display, 136

edit, 136

move, 137

symbols, 137

Nodesnap, 124

activate, 138

while digitizing lines, 137
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Q
Quitting

emergency, 16

from menus, 15

R
Registration, 115

digitizer, 120

distort map, 122

examine, 121

move map, 122

precision, 127

scans, 116

Reports

popup, 63

transform, 106

Reshape Lines, 149

Resolution, map, 7

Revision of Maps, 4

Rotate

annotation, 193

lines, 144

Rubbersheeting, 122

S
Sample Number, 178

Save

frame (draw area), 72

station file, 50

Saving, 80

symbols, 135

Scale in Digital Maps, 9

Scanners, 37

Scans

database and projection, 97

prepare original, 155

process and edit, 155

registration, 116

Scratch Boundaries, 158

Screen Plots, 195

Select

annotation, 190

by attribute, 76

by hand, 74

map elements, 73

operators for expressions, 78

popup menu, 73

strategies, 78

structural data, 184

Setup Details, 102

Polygon Labels (cont.)

list errors, 167

move, 172

plot errors, 168

tag, 164

Polygons

color on screen, 169, 170

display tags, 163

edit, 171

find unlabeled, 166

find untagged labels, 166

fix boundaries, 172

layer, 91

map feature, 10, 53

tag, 162

Popup

menus, 61

reports, 63

Prepare

annotation layer, 187

areas layer, 161

database, 88, 100

lines layer, 156

points layer, 176

sample numbers layer, 176

scan, 97

scanning original, 155

structure layer, 179

Primos, 42

Print Publication, 4

Printing On Demand, 5

Process and Edit Scans, 155

Project

description of function, 107

files, 107

maps, 108

sample dialogs, 112

Projected Tic Framework, 116

Projection File, 108

Projections, 101

of digital maps, 9

setup details, 102

state plane zones, 110

supported in ALACARTE, 101

worksheet, 109

Publication

digital, 5

print, 7

Pulldown Menus, 60

Put, 151
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T
Tag

areas, 161

existing polygon labels, 164

lines, 152, 157

polygons, 162

Tag Menus, Custom, 82

Terminal Emulators

access from, 36

supported by ALACARTE, 47

use of, 38

Terminals

access from, 36

supported by ALACARTE, 47

Test Plots for Lines, 156

Tics

add, 119

assign and add, 117

map feature, 51

move, 117

number, 119

renumber, 119

standard numbering, 103

used in transform, 105

Tolerance

arcsnap, 123

dangle, 127

edit distance, 126

edit tolerances menu, 125

extend, 124

fuzzy, 127

grain, 126

nodesnap, 124

registration, 127

snap menu, 125

topology tolerances menu, 128

weed, 126

Topology, 56

Topology Tolerance Menu, 128

Tour, Self-Guided, 15

Transform, 105

map, 120

operations, 105

renumber tics, 119

report, 106

scan, 156

specifying tics, 105

strategy, 106

Tutorial, 15

Setup File

change, 95

copy, 126

make, 95

report, 18

Simple Map, Make a, 29

Simplify in Compilation, 7

Snap Menu, 125

Snapping, 123

check, 129

set, 124

Source Maps, 88

Spacing Controls, 126

Spline, 149

Split Lines, 139

Start

new map or layer, 93

to use ALACARTE, 12

Starting

ALACARTE, 46

self-guided tour, 15

State Plane zones, 110

Station File, Saving, 50

Stations Layer, 12

Steps in Preparing a Map, 85

figure, 87

Structural Data, 10

edit, 184

graphic entry, 183

select, 184

Structure Layer, 12, 92

Symbols, 197

annotation, 187

editors, 202

environment, 180

line colors, 135

line symbols, 199

node colors, 137

nodes, 137

oriented, 179

point symbols, 201

restore, 135

save, 135

structural, 10

symbol sets, 198

using symbols, 200

Symbolsets, 198

create or modify, 202

System Details, 35
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W
Watch File, 167

Water Boundaries, 158

Weed Tolerance, 126

Worksheet

compile digital map, 89

map projections, 109

Workspaces, 40

Workstation

configuration of, 38

single-user, 35

X
X-Terminals, 36

X-Windows

access from, 36

use of, 38

Z
Zones, state plane, 110

Zoom. See also draw

controls, 19, 69

kinds of, 70, 71

strategies, 71

Type

area, 162

line, 130

point, 182

polygon, 162

U
Unit Labels, 11

Units Layer, 91

UNIX, 44

Uses of  ALACARTE - ARC/INFO, 4

V
Version 1.0. See ALACARTE

Vertices

add, 142

align, 143

delete, 141

display, 141

edit, 140

move, 141

Vi editor, 45
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